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20.7 Utilizarea algoritmilor de procesare din consolă . . . . . . . . . . . . . . . . . . . . . . . . . . . 382
20.8 Writing new Processing algorithms as python scripts . . . . . . . . . . . . . . . . . . . . . . . . 388
20.9 Configurarea Aplicat,iilor Externe . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 391
20.10 QGIS Commander . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 399

21 Plugin-uri 401
21.1 Consola Python din QGIS . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 401
21.2 Plugin-uri QGIS . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 404
21.3 Folosirea Plugin-urilor de Bază QGIS . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 409
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CHAPTER 1

Preambul

This document is the original user guide of the described software QGIS. The software and hardware described
in this document are in most cases registered trademarks and are therefore subject to legal requirements. QGIS is
subject to the GNU General Public License. Find more information on the QGIS homepage, http://www.qgis.org.

Detaliile, datele s, i rezultatele din acest document au fost scrise s, i verificate în concordant,ă cu cele mai bune
cunos, tint,e ale autorilor s, i editorilor. Cu toate acestea, sunt posibile unele gres, eli, în ceea ce prives, te cont,inutul.

Prin urmare, datele nu sunt supuse plăt,ii unor drepturi sau garant,ii. Autorii s, i editorii nu au nici o responsabilitate
sau răspundere pentru es, ecurile s, i consecint,ele utilizării acestora. Raportarea posibilelor gres, eli este întotdeauna
binevenită.

This document has been typeset with reStructuredText. It is available as reST source code via github and online
as HTML and PDF via http://www.qgis.org/en/docs/. Translated versions of this document can be downloaded in
several formats via the documentation area of the QGIS project as well. For more information about contributing
to this document and about translating it, please visit http://qgis.org/en/site/getinvolved/index.html.

Link-urile din acest document

Acest document cont,ine link-uri interne s, i externe. Efectuarea unui clic pe o legătură internă permite deplasarea
în cadrul documentului, în timp ce un clic pe un link extern deschide o adresă de internet. Într-un document
PDF, link-urile interne s, i externe sunt albastre s, i sunt gestionate de către navigatorul implicit al sistemului. În
formularele HTML, navigatorul le afis, ează s, i le gestionează pe ambele în mod similar.

Autori s, i editori ai Ghidurilor de utilizare, instalare s, i dezvoltare:

Lista persoanelor care au contribuit la scrierea, revizuirea s, i traducerea următoarelor documente este disponibilă
la Contribut,ii.

Copyright (c) 2004 - 2016 QGIS Development Team

Internet: http://www.qgis.org

Licent,a acestui document

Se acordă permisiunea de copiere, distribuire s, i/sau de modificare a acestui document sub termenii GNU Free
Documentation License, versiunea 1.3 sau orice versiune ulterioară, publicată de către Free Software Foundation;
fără Sect,iunile Fixe s, i fără Textele Copert,ilor. O copie a acestei licent,e este inclusă în Anexa Licent,a GNU pentru
Documentat,ia liberă.
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CHAPTER 2

Cuvânt înainte

Bine at,i venit în lumea minunată a Sistemelor de Informat,ii Geografice (GIS)!

QGIS este un Sistem de Informat,ii Geografice cu sursă deschisă. Proiectul s-a născut în luna mai 2002, fiind urcat
pe SourceForge în luna iunie a aceluias, i an. Am muncit din greu pentru a face aplicat,ia GIS (care este, în mod
tradit,ional, un soft proprietar scump) o perspectivă viabilă pentru oricine care are acces la un calculator personal.
QGIS rulează în prezent pe majoritatea platformelor Unix, Windows, OS X. QGIS este dezvoltat folosind toolkit-
ul Qt (https://www.qt.io) s, i C++. Acest lucru demonstrează că QGIS rulează rapid s, i are o interfat,ă grafică (GUI)
plăcută, us, or de utilizat.

QGIS îs, i propune să fie un GIS prietenos cu utilizatorul, oferind funct,ii s, i caracteristici comune. Scopul init,ial
al proiectului a fost de a realiza un vizualizator de date GIS. QGIS a ajuns în punctul în care acesta este utilizat
de tot mai mult,i utilizatori pentru vizualizarea zilnică a datelor GIS. QGIS suportă un număr mare de formate de
date raster s, i vectoriale, cu posibilitatea de adăugare us, oară a suportului pentru noile formate, prin intermediul
arhitecturii de plugin-uri.

QGIS este distribuit sub Licent,a Publică Generală GNU (GPL). Dezvoltarea QGIS sub această licent,ă atestă că
putet,i inspecta s, i modifica codul sursă s, i garantează că, utilizatorul va avea întotdeauna acces la un program de
GIS gratuit, s, i care poate fi modificat în mod liber. Ar trebui să fi primit deja o copie completă a licent,ei alături de
aplicat,ia QGIS, pe care o putet,i găsi, de asemenea, în Anexa Licent,a Publică Generală GNU.

Tip: Documentat,ie la-zi
The latest version of this document can always be found in the documentation area of the QGIS website at
http://www.qgis.org/en/docs/.
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CHAPTER 3

Convent,ii

Această sect,iune descrie stilurile uniforme care vor fi folosite pe parcursul acestui manual.

3.1 Convent,iile GUI

Stilurile convenite pentru GUI sunt destinate imitării aspectului unui GUI. În general, un stil va reflecta aspectul
non-hover, astfel încât un utilizator poate scana vizual GUI-ul, pentru a găsi ceva care arată similar instruct,iunilor
din manual.

• Opt,iuni de Meniu: Layer → Add a Raster Layer or Settings → Toolbars → Digitizing

• Instrument: |mActionAddRasterLayer| Adaugă un Strat Raster

• Button : [Save as Default]

• Titlul Casetei de Dialog: Layer Properties

• Fila: General

• Caseta de bifare: Render

• Buton Radio: SRID Postgis EPSG ID

• Selectare număr:

• Selectare s, ir:

• Browse for a file:

• Selectare culoare:

• Cursor:

• Introducere Text:

O umbră indică o componentă GUI pe care se poate face clic.

3.2 Convent,ii pentru Text s, i Tastatură

Acest manual include, de asemenea, stiluri pentru text, comenzi pentru taste, s, i codificări pentru indicarea
diferitelor entităt,i, cum ar fi clasele sau metodele. Aceste stiluri nu corespund aspectului efectiv al vreunui text
sau vreunei codificări din QGIS.

• Hyperlinks: http://qgis.org

• Combinat,ii de taste: Apăsarea combinat,iei Ctrl+B, înseamnă t,inerea apăsată a tastei Ctrl s, i apoi apăsarea
tastei B.
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• Numele Fis, ierului: lakes.shp

• Numele Clasei: NewLayer

• Metoda: classFactory

• Server: myhost.de

• Text Utilizator: qgis --help

Liniile de cod sunt indicate printr-un font cu lăt,ime fixă:

PROJCS["NAD_1927_Albers",
GEOGCS["GCS_North_American_1927",

3.3 Instruct,iuni specifice platformelor

Secvent,ele GUI s, i mici cantităt,i de text pot fi formatate în modul următor: Clic pe Fis, ier QGIS →
Închidere pentru a ies, i din QGIS. Ret,inet,i că pe platformele Linux, Unix s, i Windows ar trebui să facet,i clic mai
întâi pe meniul File, apoi pe Quit, în timp ce pe platformele Macintosh OS X ar trebui să facet,i clic mai întâi pe
meniul QGIS s, i ulterior pe Quit.

Cantităt,i mai mari de text pot fi formatate ca o listă:

• Facet,i asta

• Procedat,i as, a

• Sau as, a

sau ca paragrafe:

Facet,i acest lucru s, i asta s, i asta. Apoi facet,i acest lucru s, i asta s, i asta, s, i asta s, i asta s, i asta, s, i asta s, i asta s, i
asta.

Do that. Then do that and that and that, and that and that and that, and that and that and that, and that and that.

Capturile care apar în ghidul de utilizare au fost create pe platforme diferite; platforma este indicat printr-o pic-
togramă specifică, pozit,ionată la sfârs, itul titlului figurii.
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CHAPTER 4

Funct,iuni

QGIS offers many common GIS functionalities provided by core features and plugins. A short summary of six
general categories of features and plugins is presented below, followed by first insights into the integrated Python
console.

4.1 Vizualizarea datelor

You can view and overlay vector and raster data in different formats and projections without conversion to an
internal or common format. Supported formats include:

• Spatially-enabled tables and views using PostGIS, SpatiaLite and MS SQL Spatial, Oracle Spatial, vector
formats supported by the installed OGR library, including ESRI shapefiles, MapInfo, SDTS, GML and
many more. See section Lucrul cu Datele Vectoriale.

• Formatele raster s, i imaginile acceptate de biblioteca GDAL (Geospatial Data Abstraction Library), cum ar
fi GeoTIFF, ERDAS IMG, ArcInfo ASCII GRID, JPEG, PNG s, i multe altele. Vedet,i sect,iunea Lucrul cu
Datele Raster.

• Date raster s, i vectoriale GRASS din bazele de date GRASS (locat,ie/set de hărt,i). Parcurget,i sect,iunea
Integrarea GRASS GIS.

• Date spat,iale online, servite de Servicii Web OGC, inclusiv WMS, WMTS, WCS, WFS, s, i WFS-T.
Parcurget,i sect,iunea Lucrul cu date OGC.

4.2 Explorarea datelor s, i compunerea hărt,ilor

Putet,i compune hărt,i, apoi să explorat,i în mod interactiv datele spat,iale prin intermediul interfet,ei grafice pri-
etenoase. Printre cele mai multe instrumente utile disponibile în GUI se includ:

• Navigatorul QGIS

• Reproiectarea Din-Zbor

• DB Manager

• Map composer

• Panoul de Vizualizare

• Semne de carte Spat,iale

• Instrumente de adnotare

• Identificarea/selectarea entităt,ilor

• Editarea/vizualizarea/căutarea atributelor

• Data-defined feature labelling
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• Instrumente de simbologie definită cu ajutorul datelor, pentru rastere s, i vectori

• Compozit,ia hărt,ilor pentru atlas, folosind straturile cu graticule

• North arrow scale bar and copyright label for maps

• Suport pentru salvarea s, i restaurarea proiectelor

4.3 Crearea, editarea, gestionarea s, i exportul datelor

Putet,i crea, edita, gestiona s, i exporta în diverse formate straturile raster sau vectoriale. QGIS oferă următoarele:

• Instrumente de digitizare pentru formatele acceptate de OGR s, i straturile vectoriale GRASS

• Ability to create and edit shapefiles and GRASS vector layers

• Plugin-ul de georeferent,iere pentru geocodarea imaginelor

• GPS tools to import and export GPX format, and convert other GPS formats to GPX or down/upload directly
to a GPS unit (On Linux, usb: has been added to list of GPS devices.)

• Suport pentru salvarea s, i editarea datelor OpenStreetMap

• Ability to create spatial database tables from shapefiles with DB Manager plugin

• Gestionarea îmbunătăt,ită a tabelelor bazei de date spat,iale

• Instrumente pentru gestionarea tabelelor cu atribute vectoriale

• Opt,iunea de a salva capturile de ecran ca imagini georeferent,iate

• Instrumentul DXF-Export cu capacităt,i sporite pentru exportul stilurilor s, i a plugin-urilor pentru a efectua
funct,ii similare CAD

4.4 Analiza datelor

You can perform spatial data analysis on spatial databases and other OGR- supported formats. QGIS currently
offers vector analysis, sampling, geoprocessing, geometry and database management tools. You can also use the
integrated GRASS tools, which include the complete GRASS functionality of more than 400 modules. (See sec-
tion Integrarea GRASS GIS.) Or, you can work with the Processing Plugin, which provides a powerful geospatial
analysis framework to call native and third-party algorithms from QGIS, such as GDAL, SAGA, GRASS and
more. (See section Introducere.)

4.5 Publicarea hărt,ilor de pe Internet

QGIS poate fi folosit ca s, i client WMS, WMTS, WMS-C sau WFS s, i WFS-T, s, i ca server WMS, WCS sau WFS.
(Vedet,i sect,iunea Lucrul cu date OGC.) În plus, putet,i publica datele pe Internet, folosind un server de web UMN
MapServer sau GeoServer.

4.6 Extinderea funct,ionalităt,ii QGIS prin intermediul plugin-urilor

QGIS poate fi adaptat nevoilor dumneavoastră speciale cu arhitectură de plugin-uri extensibile s, i biblioteci care
pot fi folosite pentru a crea plugin-uri. Putet,i crea chiar noi aplicat,ii cu C++ sau Python!
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4.6.1 Plugin-uri de bază

Plugin-urile de bază includ:

1. Coordinate Capture (Capture mouse coordinates in different CRSs)

2. DB Manager (Exchange, edit and view layers and tables from/to databases; execute SQL queries)

3. Dxf2Shp Converter (Convert DXF files to shapefiles)

4. eVIS (Visualize events)

5. GDALTools (Integrate GDAL Tools into QGIS)

6. Georeferencer GDAL (Add projection information to rasters using GDAL)

7. GPS Tools (Load and import GPS data)

8. GRASS (Integrate GRASS GIS)

9. Heatmap (Generate raster heatmaps from point data)

10. Interpolation Plugin (Interpolate based on vertices of a vector layer)

11. Metasearch Catalogue Client

12. Offline Editing (Allow offline editing and synchronizing with databases)

13. Oracle Spatial GeoRaster

14. Processing (formerly SEXTANTE)

15. Raster Terrain Analysis (Analyze raster-based terrain)

16. Road Graph Plugin (Analyze a shortest-path network)

17. Spatial Query Plugin

18. Topology Checker (Find topological errors in vector layers)

19. Zonal Statistics Plugin (Calculate count, sum, and mean of a raster for each polygon of a vector layer)

4.6.2 Plugin-urile Externe Python

QGIS oferă un număr tot mai mare de plugin-uri externe, scrise în Python, care sunt furnizate de către comunitate.
Aceste plugin-uri rezidă în depozitul oficial de plugin-uri, s, i pot fi instalate cu us, urint,ă cu ajutorul Instalatorului
de Plugin-uri Python. Parcurget,i sect,iunea Dialogul Plugin-urilor.

4.7 Consola Python

For scripting, it is possible to take advantage of an integrated Python console, which can be opened from menu:
Plugins → Python Console. The console opens as a non-modal utility window. For interaction with the QGIS en-
vironment, there is the qgis.utils.iface variable, which is an instance of QgsInterface. This interface
allows access to the map canvas, menus, toolbars and other parts of the QGIS application. You can create a script,
then drag and drop it into the QGIS window and it will be executed automatically.

For further information about working with the Python console and programming QGIS plugins and applications,
please refer to PyQGIS-Developer-Cookbook.
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4.8 Probleme Cunoscute

4.8.1 Limitarea numărului de fis, iere deschise

Dacă deschidet,i un proiect QGIS mare s, i suntet,i sigur că toate straturile sunt valide, dar unele straturi sunt marcate
ca fiind eronate, putet,i gestiona, probabil, această problemă. Linux (s, i alte sisteme de operare, de asemenea) are o
limită pentru fis, ierele deschise de către un proces. Limitele resurselor sunt per-proces s, i sunt mos, tenite. Comanda
internă ulimit, modifică limitele numai pentru procesul curent; noua limită va fi mos, tenită de către orice proces
copil.

Putet,i vedea toate informat,iile ulimit curente, tastând:

$ ulimit -aS

You can see the current allowed number of opened files per process with the following command on a console:

$ ulimit -Sn

To change the limits for an existing session, you may be able to use something like:

$ ulimit -Sn #number_of_allowed_open_files
$ ulimit -Sn
$ qgis

Pentru a remedia definitiv problema

Pe majoritatea sistemelor Linux, limitele resurselor sunt stabilite de modulul pam_limits, în conformitate
cu setările cont,inute în /etc/security/limits.conf sau /etc/security/limits.d/*.conf. Ar
trebui să putet,i edita acele fis, iere dacă avet,i privilegiul de root (de asemenea, prin intermediul sudo), dar va trebui
să vă conectat,i din nou pentru ca schimbările să aibă efect.

Mai multe informat,ii:

http://www.cyberciti.biz/faq/linux-increase-the-maximum-number-of-open-files/ http://linuxaria.com/article/open-
files-in-linux?lang=en
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CHAPTER 5

Ce este nou în QGIS 2.18

Această versiune cont,ine noi caracteristici s, i extinde interfat,a programatică fat,ă de versiunile anterioare. Vă
recomandăm să folosit,i această versiune în locul versiunilor anterioare.

This release includes hundreds of bug fixes and many new features and enhancements over QGIS
2.14 that will be described in this manual. You may also review the visual changelogs at
http://qgis.org/en/site/forusers/visualchangelogs.html.
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CHAPTER 6

Not,iuni de bază

This chapter gives a quick overview of installing QGIS, some sample data from the QGIS web page, and running
a first and simple session visualizing raster and vector layers.

6.1 Installation

Installation of QGIS is very simple. Standard installer packages are available for MS Windows and macOS. For
many flavors of GNU/Linux, binary packages (rpm and deb) or software repositories are provided to add to your in-
stallation manager. Get the latest information on binary packages at the QGIS website at http://download.qgis.org.

6.1.1 Installation from source

If you need to build QGIS from source, please refer to the installation instructions. They are dis-
tributed with the QGIS source code in a file called INSTALL. You can also find them online at
http://htmlpreview.github.io/?https://raw.github.com/qgis/QGIS/master/doc/INSTALL.html. If you want to build
a particular release, you should replace master by the release branch (commonly in the release-X_Y form)
in the above-mentioned link because instructions may differ.

6.1.2 Installation on external media

QGIS allows you to define a --configpath option that overrides the default path for user configuration (e.g.,
~/.qgis2 under Linux) and forces QSettings to use this directory, too. This allows you to, for instance, carry a
QGIS installation on a flash drive together with all plugins and settings. See section System Settings for additional
information.

6.1.3 Sample Data

The user guide contains examples based on the QGIS sample dataset.

The Windows installer has an option to download the QGIS sample dataset. If checked, the data will be down-
loaded to your My Documents folder and placed in a folder called GIS Database. You may use Windows
Explorer to move this folder to any convenient location. If you did not select the checkbox to install the sample
dataset during the initial QGIS installation, you may do one of the following:

• Utilizat,i datele GIS pe care le avet,i deja

• Download sample data from http://qgis.org/downloads/data/qgis_sample_data.zip

• Dezinstalat,i QGIS s, i reinstalat,i-l cu opt,iunea de descărcare a datelor bifată (recomandat numai dacă solut,iile
anterioare nu au avut succes)
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For GNU/Linux and macOS, there are not yet dataset installation packages available as rpm, deb
or dmg. To use the sample dataset, download the file qgis_sample_data as a ZIP archive from
http://qgis.org/downloads/data/ and unzip the archive on your system.

The Alaska dataset includes all GIS data that are used for examples and screenshots in the user guide; it also
includes a small GRASS database. The projection for the QGIS sample dataset is Alaska Albers Equal Area with
units feet. The EPSG code is 2964.

PROJCS["Albers Equal Area",
GEOGCS["NAD27",
DATUM["North_American_Datum_1927",
SPHEROID["Clarke 1866",6378206.4,294.978698213898,
AUTHORITY["EPSG","7008"]],
TOWGS84[-3,142,183,0,0,0,0],
AUTHORITY["EPSG","6267"]],
PRIMEM["Greenwich",0,
AUTHORITY["EPSG","8901"]],
UNIT["degree",0.0174532925199433,
AUTHORITY["EPSG","9108"]],
AUTHORITY["EPSG","4267"]],
PROJECTION["Albers_Conic_Equal_Area"],
PARAMETER["standard_parallel_1",55],
PARAMETER["standard_parallel_2",65],
PARAMETER["latitude_of_center",50],
PARAMETER["longitude_of_center",-154],
PARAMETER["false_easting",0],
PARAMETER["false_northing",0],
UNIT["us_survey_feet",0.3048006096012192]]

If you intend to use QGIS as a graphical front end for GRASS, you can find a selection of sample locations (e.g.,
Spearfish or South Dakota) at the official GRASS GIS website, http://grass.osgeo.org/download/sample-data/.

6.2 Launching QGIS

6.2.1 Starting and Stopping QGIS

Starting QGIS is done as you usually do for any other application on your platform. It means that you can launch
QGIS by:

• typing qgis at a command prompt, assuming that QGIS is added to your PATH or you’re in its installation
folder

• using the Applications menu if using a precompiled binary, the Start menu or the Dock

• dublu clic pe pictograma din folderul Aplicat,iilor sau pe o scurtătură de pe ecran.

• double clicking an existing QGIS project (.qgs) file. Note that this will also open the project

To stop QGIS, click:

• opt,iunea meniului Proiect → Închidere QGIS, sau folosit,i combinat,ia de taste Ctrl+Q.

• QGIS → Închidere QGIS, sau folosit,i combinat,ia de taste Cmd+Q.

• or use the red cross at the right top corner of the main interface of the application.

6.2.2 Command Line Options

In previous section you learned how to start QGIS. You will see that QGIS also provides further command line
options.
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QGIS supports a number of options when started from the command line. To get a list of the options, enter qgis
--help on the command line. The usage statement for QGIS is:

qgis --help

Returns:

QGIS - 2.16.1-Nødebo ’Nødebo’ (8545b3b)
QGIS is a user friendly Open Source Geographic Information System.
Usage: /usr/bin/qgis.bin [OPTION] [FILE]
OPTION:

[--snapshot filename] emit snapshot of loaded datasets to given file
[--width width] width of snapshot to emit
[--height height] height of snapshot to emit
[--lang language] use language for interface text
[--project projectfile] load the given QGIS project
[--extent xmin,ymin,xmax,ymax] set initial map extent
[--nologo] hide splash screen
[--noversioncheck] don’t check for new version of QGIS at startup
[--noplugins] don’t restore plugins on startup
[--nocustomization] don’t apply GUI customization
[--customizationfile] use the given ini file as GUI customization
[--optionspath path] use the given QSettings path
[--configpath path] use the given path for all user configuration
[--authdbdirectory path] use the given directory for authentication database
[--code path] run the given python file on load
[--defaultui] start by resetting user ui settings to default
[--dxf-export filename.dxf] emit dxf output of loaded datasets to given file
[--dxf-extent xmin,ymin,xmax,ymax] set extent to export to dxf
[--dxf-symbology-mode none|symbollayer|feature] symbology mode for dxf output
[--dxf-scale-denom scale] scale for dxf output
[--dxf-encoding encoding] encoding to use for dxf output
[--dxf-preset visiblity-preset] layer visibility preset to use for dxf output
[--help] this text
[--] treat all following arguments as FILEs

FILE:
Files specified on the command line can include rasters,
vectors, and QGIS project files (.qgs):
1. Rasters - supported formats include GeoTiff, DEM

and others supported by GDAL
2. Vectors - supported formats include ESRI Shapefiles

and others supported by OGR and PostgreSQL layers using
the PostGIS extension

Tip: Example Using command line arguments
You can start QGIS by specifying one or more data files on the command line. For example, assuming you are
in the qgis_sample_data directory, you could start QGIS with a vector layer and a raster file set to load on
startup using the following command: qgis ./raster/landcover.img ./gml/lakes.gml

Command line option --snapshot

This option allows you to create a snapshot in PNG format from the current view. This comes in handy when you
have a lot of projects and want to generate snapshots from your data.

Currently, it generates a PNG file with 800x600 pixels. This can be adjusted using the --width and --height
command line arguments. A filename can be added after --snapshot.

Command line option --lang

Based on your locale, QGIS selects the correct localization. If you would like to change your language, you can
specify a language code. For example, qgis --lang it starts QGIS in Italian localization.

Command line option --project
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Starting QGIS with an existing project file is also possible. Just add the command line option --project
followed by your project name and QGIS will open with all layers in the given file loaded.

Command line option --extent

To start with a specific map extent use this option. You need to add the bounding box of your extent in the
following order separated by a comma:

--extent xmin,ymin,xmax,ymax

Command line option --nologo

This command line argument hides the splash screen when you start QGIS.

command line option --noversioncheck

Don’t check for new version of QGIS at startup.

Command line option --noplugins

If you have trouble at start-up with plugins, you can avoid loading them at start-up with this option. They will still
be available from the Plugins Manager afterwards. Command line option --customizationfile

Using this command line argument, you can define a GUI customization file, that will be used at startup.

Command line option --nocustomization

Using this command line argument, existing GUI customization will not be applied at startup.

Command line option --optionspath

You can have multiple configurations and decide which one to use when starting QGIS with this option. See
Opţiuni to confirm where the operating system saves the settings files. Presently, there is no way to specify a file
to write settings to; therefore, you can create a copy of the original settings file and rename it. The option specifies
path to directory with settings. For example, to use /path/to/config/QGIS/QGIS2.ini settings file, use
option:

--optionspath /path/to/config/

Command line option --configpath

This option is similar to the one above, but furthermore overrides the default path for user configuration
(~/.qgis2) and forces QSettings to use this directory, too. This allows users to, for instance, carry a QGIS
installation on a flash drive together with all plugins and settings.

Command line option --authdbdirectory

Again, this option is similar to the one above but define the path to the directory where the authentication database
will be stored.

Command line option --code

This option can be used to run a given python file directly after QGIS has started.

For example, when you have a python file named load_alaska.py with following content:

from qgis.utils import iface
raster_file = "/home/gisadmin/Documents/qgis_sample_data/raster/landcover.img"
layer_name = "Alaska"
iface.addRasterLayer(raster_file, layer_name)

Assuming you are in the directory where the file load_alaska.py is located, you can start QGIS, load the
raster file landcover.img and give the layer the name ‘Alaska’ using the following command: qgis --code
load_alaska.py

Command line options --dxf-*
These options can be used to export QGIS project into a DXF file. Several options are available:

• –dxf-export: the DXF filename into which to export the layers;
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• –dxf-extent: the extent of the final DXF file;

• –dxf-symbology-mode: several values can be used here: none (no symbology), symbollayer (Symbol layer
symbology), feature (feature symbology);

• –dxf-scale-deno: the scale denominator of the symbology;

• –dxf-encoding: the file encoding;

• –dxf-preset: choose a visibility preset. These presets are defined in the layer tree, see Panoul Straturilor.

6.3 Sample Session: Load raster and vector layers

Now that you have QGIS installed and a sample dataset available, we would like to demonstrate a short and simple
QGIS sample session. We will visualize a raster and a vector layer. We will use:

• the landcover raster layer i.e., qgis_sample_data/raster/landcover.img

• and the lakes vector layer i.e., qgis_sample_data/gml/lakes.gml.

1. Start QGIS as seen in Starting and Stopping QGIS

2. Click on the Add Raster Layer icon.

3. Browse to the folder qgis_sample_data/raster/, select the ERDAS IMG file landcover.img
and click [Open].

4. If the file is not listed, check if the Files of type combo box at the bottom of the dialog is set on the
right type, in this case Erdas Imagine Images (*.img *.IMG).

5. Now click on the Add Vector Layer icon.

6. File should be selected as Source Type in the new Add vector layer dialog. Now click [Browse] to select
the vector layer.

7. Browse to the folder qgis_sample_data/gml/, select Geography Markup Language [GML]
[OGR] (*.gml *.GML) from the Filter combo box, then select the GML file lakes.gml and
click [Open]. In the Add vector layer dialog, click [OK]. The Coordinate Reference System Selector dialog
opens with NAD27 / Alaska Alberts selected, click [OK].

8. Zoom in a bit to your favourite area with some lakes.

9. Dublu clic pe stratul lakes din legenda hărt,ii pentru a deschide fereastra de dialog Properties.

10. Click on the Style tab and select a blue as fill color.

11. Click on the Labels tab and select Show labels for this layer in the drop-down menu to enable labeling.
Then from the Label with list, choose the NAMES field as the field containing labels.

12. To improve readability of labels, you can add a white buffer around them by clicking Buffer in the list on

the left, checking Draw text buffer and choosing 3 as buffer size.

13. Click [Apply]. Check if the result looks good, and finally click [OK].

You can see how easy it is to visualize raster and vector layers in QGIS. Let’s move on to the sections that follow
to learn more about the available functionality, features and settings, and how to use them.

6.4 Projects

The state of your QGIS session is considered a project. QGIS works on one project at a time. Settings are
considered as being either per-project or as a default for new projects (see section Opţiuni). QGIS can save the

state of your workspace into a project file using the menu options Project → Save or Project → Save
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As.... If the loaded project file on disk was meanwhile changed, by default, QGIS will ask you if you want to

overwrite the changes into the project file. This behavior is set by checking Prompt to save project and data
source changes when required under Settings → Options → General menu .

Load saved projects into a QGIS session using Project → Open..., Project → New from template or Project
→ Open Recent →.

At startup, a list of screenshot with the name and path of each of the most recent projects (up to ten) is shown
instead of a white and empty map canvas. This is a handy and quicker way to remember what a project was about
and double-click a row opens the selected project. If you’re willing to create a new project, just add new layers
and the list disappears.

If you wish to clear your session and start fresh, choose Project → New. Either of these menu options will
prompt you to save the existing project if changes have been made since it was opened or last saved.

The kinds of information saved in a project file include:

• Straturile adăugate

• Straturile care pot fi interogate

• Proprietăt,ile stratului, inclusiv simbolizarea s, i stilurile

• Proiect,ia pentru vizualizarea hărt,ii

• Ultima extindere vizualizată

• Print Composers

• Print Composer elements with settings

• Print Composer atlas settings

• Setări de digitizare

• Relat,iie Tabelei

• Macrocomenzile Proiectului

• Stiluri implicite ale proiectului

• Setările Plugin-urilor

• Setările QGIS server din fila de setări OWS a proprietăt,ilor proiectului

• Interogările stocate în DB Manager

The project file is saved in XML format, so it is possible to edit the file outside QGIS if you know what you are
doing. The file format has been updated several times compared with earlier QGIS versions. Project files from
older QGIS versions may not work properly any more. To be made aware of this, in the General tab under Settings

→ Options you should tick Warn when opening a project file saved with an older version of QGIS.

Whenever you save a project in QGIS a backup of the project file is made with the extension .qgs~.

6.5 Output

There are several ways to generate output from your QGIS session. We have discussed one already in section
Projects, saving as a project file. Here is a sampling of other ways to produce output files:

• Menu option Project → Save as Image... opens a file dialog where you select the name, path and type
of image (PNG, JPG and many other formats). A world file with extension PNGW or JPGW saved in the
same folder georeferences the image.

• Menu option Project → DXF Export... opens a dialog where you can define the ‘Symbology mode’, the
‘Symbology scale’ and vector layers you want to export to DXF. Through the ‘Symbology mode’ symbols
from the original QGIS Symbology can be exported with high fidelity.
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• Menu option Project → New Print Composer... opens a dialog where you can layout and print the
current map canvas (see section Print Composer).
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CHAPTER 7

QGIS GUI

When QGIS starts, you are presented with the GUI as shown in the figure (the numbers 1 through 5 in yellow
circles are discussed below).

Figure 7.1: Interfat,a QGIS cu datele es, antion pentru Alaska

Note: Aspectul ferestrelor (bara de titlu, etc) poate fi diferit, în funct,ie de sistemul de operare s, i de managerul de
ferestre.

The QGIS GUI is divided into five components:

1. Bara de Meniuri

2. Bare de instrumente

3. Panouri

4. Vizualizare Hartă

5. Bara de Stare

These five components of the QGIS interface are described in more detail in the following sections. Two more
sections present keyboard shortcuts and context help.
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7.1 Bara de Meniuri

The menu bar provides access to various QGIS features using a standard hierarchical menu. The top-level menus
and a summary of some of the menu options are listed below, together with the associated icons as they appear on
the toolbar, and keyboard shortcuts. The shortcuts presented in this section are the defaults; however, keyboard
shortcuts can also be configured manually using the Configure shortcuts dialog, opened from Settings → Configure
Shortcuts....

Although most menu options have a corresponding tool and vice-versa, the menus are not organized exactly like
the toolbars. The toolbar containing the tool is listed after each menu option as a checkbox entry. Some menu
options only appear if the corresponding plugin is loaded. For more information about tools and toolbars, see
section Bare de instrumente.

Note: QGIS is a cross-platform application meaning that though it provides you with the same tools, they may be
placed in different menus according to the operating system specification. The lists below show the most common
location and precise when there is a variation.

7.1.1 Proiect

Meniul Opt,iunilor Scurtătură Referint,ă Bara de Instrumente

Nou Ctrl+N see Projects Proiect

Open Ctrl+O see Projects Proiect
Nou după s, ablon → see Projects
Deschidere proiect recent → see Projects

Salvare Ctrl+S see Projects Proiect

Salvare Ca... Ctrl+Shift+S see Projects Proiect

Save as Image... see Output
DXF Export... see Output
DWG/DXF Import...

Project Properties... Ctrl+Shift+P see Projects

New Print Composer Ctrl+P see Print Composer Proiect

Composer manager... see Print Composer Proiect
Print Composers → see Print Composer

Ies, ire din QGIS Ctrl+Q

Under macOS, the Exit QGIS command corresponds to QGIS → Quit QGIS (Cmd+Q).
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7.1.2 Editare

Meniul Opt,iunilor Scurtătură Referint,ă Bara de
Instrumente

Anulare Ctrl+Z see Digitizare avansată Digitizare
Avansată

Refacere Ctrl+Shift+Zsee Digitizare avansată Digitizare
Avansată

Decupare entităt,i Ctrl+X see Digitizarea unui strat
vectorial existent

Digitizare

Copiere entităt,i Ctrl+C see Digitizarea unui strat
vectorial existent

Digitizare

Lipire Entităt,i Ctrl+V see Digitizarea unui strat
vectorial existent

Digitizare

Paste features as → see Lucrul cu Tabela de Atribute

Add Feature Ctrl+. see Digitizarea unui strat
vectorial existent

Digitizare

Add Circular String see Digitizarea unui strat
vectorial existent

Digitizare

Add Circular String by
Radius

see Digitizarea unui strat
vectorial existent

Digitizare

Mutare Entităt,(i) see Digitizarea unui strat
vectorial existent

Digitizare

S, tergere Select,ie see Digitizarea unui strat
vectorial existent

Digitizare

Modify Attributes of Selected
Features

see Editarea valorilor atributului Digitizare

Rotire Entităt,(i) see Digitizare avansată Digitizare
Avansată

Simplificare Entitate see Digitizare avansată Digitizare
Avansată

Adăugare Inel see Digitizare avansată Digitizare
Avansată

Adăugare Parte see Digitizare avansată Digitizare
Avansată

Umplere Inel see Digitizare avansată Digitizare
Avansată

S, tergere Inel see Digitizare avansată Digitizare
Avansată

S, tergere Parte see Digitizare avansată Digitizare
Avansată

Remodelare Entităt,i see Digitizare avansată Digitizare
Avansată

Decalare Curbă see Digitizare avansată Digitizare
Avansată

Divizare Entităt,i see Digitizare avansată Digitizare
Avansată

Divizare Părt,i see Digitizare avansată Digitizare
Avansată

Îmbinare Entităt,i Selectate see Digitizare avansată Digitizare
Avansată

Merge Attr. of Selected
Features

see Digitizare avansată Digitizare
Avansată

Node Tool see Digitizarea unui strat
vectorial existent

Digitizare

Rotirea Simbolurilor
Punctelor

see Digitizare avansată Digitizare
Avansată

Offset Point Symbols see Digitizare avansată Digitizare
Avansată
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After activating Toggle editing mode for a layer, you will enable the Add Feature icon in the Edit menu
depending on the layer type (point, line or polygon).

7.1.3 Edit (extra)

Meniul Opt,iunilor Scurtătură Referint,ă Bara de Instrumente

Add Feature see Digitizarea unui strat vectorial existent Digitizare

Add Feature see Digitizarea unui strat vectorial existent Digitizare

Add Feature see Digitizarea unui strat vectorial existent Digitizare
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7.1.4 Vizualizare

Meniul Opt,iunilor Scurtătură Referint,ă Bara de Instrumente

Deplasare Hartă see Transfocare s, i Deplasare Navigare în interiorul
hărt,ii

Deplasează Harta spre
Select,ie

Navigare în interiorul
hărt,ii

Mărire Ctrl+Alt++ see Transfocare s, i Deplasare Navigare în interiorul
hărt,ii

Mics, orare Ctrl+Alt+- see Transfocare s, i Deplasare Navigare în interiorul
hărt,ii

Selectare → see Selecting features Atribute

Identificare Entităt,i Ctrl+Shift+I see Identify Features Atribute
Măsurare → see Măsurarea Atribute

Sumar Statistic see Statistical Summary Panel Atribute

Transfocare la nivelul
Hărt,ii

Ctrl+Shift+F Navigare în interiorul
hărt,ii

Transfocare la nivelul
Stratului

Navigare în interiorul
hărt,ii

Transfocare la nivelul
Select,iei

Ctrl+J Navigare în interiorul
hărt,ii

Nivelul de Mărire
Anterior

Navigare în interiorul
hărt,ii

Nivelul de Mărire
Următor

Navigare în interiorul
hărt,ii

Zoom To Native
Resolution

Navigare în interiorul
hărt,ii

Decorat,ii → see Decorat,iuni
Mod de previzualizare →

Map Tips see Display Properties Atribute

Semn de Carte Nou... Ctrl+B see Semne de Carte Spat,iale Atribute

Afis, are Semne de Carte Ctrl+Shift+B see Semne de Carte Spat,iale Atribute

Actualizare F5 Navigare în interiorul
hărt,ii

Panouri → see Panouri s, i Bare de
Instrumente

Bare de Instrumente → see Panouri s, i Bare de
Instrumente

Comută în Modul Ecran
Complet

F11

Under Linux KDE, Panels →, Toolbars → and Toggle Full Screen Mode are rather placed in Settings menu.

Preview mode → is not available under macOS.
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7.1.5 Strat

Meniul Opt,iunilor Scurtătură Referint,ă Bara de
Instrumente

Creează Strat → see Creating new vector layers Manage Layers
Adaugă Strat → see Explorarea Formatelor de Date

s, i a Câmpurilor
Manage Layers

Încapsulare Straturi s, i Grupuri... see Imbricarea Proiectelor
Adăugare din Fis, ierul cu
Definit,iile Stratului...

Copy style see Salvarea s, i Partajarea
Proprietăt,ilor Stratului

Paste style see Salvarea s, i Partajarea
Proprietăt,ilor Stratului

Deschide Tabela de Atribute F6 see Lucrul cu Tabela de Atribute Atribute

Comută Editarea see Digitizarea unui strat vectorial
existent

Digitizare

Salvează Modificările aduse
Stratului

see Digitizarea unui strat vectorial
existent

Digitizare

Editări Curente → see Digitizarea unui strat vectorial
existent

Digitizare

Save As... see Creating new layers from an
existing layer

Save As Layer Definition File...

Elimină Strat/Grup Ctrl+D

Duplicate Layer(s)
Set Scale Visibility of Layer(s)
Setează CRS-ul statului(-urilor) Ctrl+Shift+C
Set Project CRS from Layer
Proprietăţi... see Dialogul Proprietăt,ilor

Vectoriale
Filtrare... Ctrl+F see Constructorul de Interogări

Etichetare see Proprietăt,ile Etichetelor

Add to Overview Ctrl+Shift+O Manage Layers

Add All To Overview

Remove All From Overview

Arată Toate Straturile Ctrl+Shift+U Manage Layers

Ascunde Toate Straturile Ctrl+Shift+H Manage Layers

Show selected Layers

Hide selected Layers
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7.1.6 Setări

Meniul Opt,iunilor Scurtătură Referint,ă Bara de Instrumente

Custom CRS... see Sistem Personalizat de Coordonate de Referint,ă

Style Manager... see Managerul de Stiluri
Configure shortcuts... see Combinat,ii de taste
Customization... see Personalizare
Opt,iuni... see Opţiuni

Opt,iuni de Acros, are... see Setarea Tolerant,ei Acros, ării s, i Căutarea Razei

Under Linux KDE, you’ll find more tools in Settings menu such as Project Properties, Panels →, Toolbars
→ and Toggle Full Screen Mode.

7.1.7 Plugin-uri

Meniul Opt,iunilor Scurtătură Referint,ă Bara de Instrumente

Manage and Install Plugins... see Dialogul Plugin-urilor
Python Console Ctrl+Alt+P

La prima startare a QGIS, nu vor fi încărcate toate plugin-urile de bază.

7.1.8 Vector

Meniul Opt,iunilor Scurtătură Referint,ă Bara de Instrumente
OpenStreetMap → see Importarea Vectorilor OpenStreetMap

Analysis Tools → see Meniul Vectorial

Research Tools → see Meniul Vectorial

Geoprocessing Tools → see Meniul Vectorial

Geometry Tools → see Meniul Vectorial

Data Management Tools → see Meniul Vectorial

When starting QGIS for the first time not all core plugins are loaded. Many of the above-mentioned sub-menus
require the core plugin Processing to be activated.

7.1.9 Raster

Meniul Opt,iunilor Scurtătură Referint,ă Bara de Instrumente
Raster calculator... see Calculatorul Raster
Align Raster... see Alinierea Rasterelor

Analysis → see Plugin-ul Instrumentelor GDAL

Projection → see Plugin-ul Instrumentelor GDAL

Conversion → see Plugin-ul Instrumentelor GDAL

Miscellaneous → see Plugin-ul Instrumentelor GDAL

Extraction → see Plugin-ul Instrumentelor GDAL

When starting QGIS for the first time not all core plugins are loaded. Many of the above-mentioned sub-menus
require the core plugin Processing to be activated.
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7.1.10 Bază de date

Meniul Opt,iunilor Scurtătură Referint,ă Bara de Instrumente
Database → see Plugin-ul DB Manager Baza de Date

La prima startare a QGIS, nu vor fi încărcate toate plugin-urile de bază.

7.1.11 Web

Meniul Opt,iunilor Scurtătură Referint,ă Bara de Instrumente
Metasearch see MetaSearch Catalog Client Web

La prima startare a QGIS, nu vor fi încărcate toate plugin-urile de bază.

7.1.12 Procesare

Meniul Opt,iunilor Scurtătură Referint,ă Bara de Instrumente

Toolbox see The toolbox

Modelator Grafic... see Modelatorul grafic

History and log... see Managerul istoricului

Options... see Configuring the processing framework

Results viewer... see Configurarea Aplicat,iilor Externe

Commander Ctrl+Alt+M see QGIS Commander

La prima startare a QGIS, nu vor fi încărcate toate plugin-urile de bază.

7.1.13 Ajutor

Meniul Opt,iunilor Scurtătură Referint,ă Bara de Instrumente

|mActionHelpContents| Cont,inutul fis, ierului de Ajutor
F1 Ajutor

What’s This? Shift+F1 Ajutor
Documentat,ie API
Raportat,i o problemă
Avet,i nevoie de suport comercial?

Pagina de Casă QGIS Ctrl+H

Check QGIS Version

About

QGIS Sponsors

7.1.14 QGIS

This menu is only available under macOS and contains some OS related commands.
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Meniul Opt,iunilor Scurtătură Referint,ă
Preferinţe
Despre QGIS
Hide QGIS
Show All
Hide Others
Închidere QGIS Cmd+Q

Preferences and About QGIS are the same commands as Settings → Options and Help → About. Quit QGIS
corresponds to Project → Exit QGIS under the other platforms.

7.2 Panouri s, i Bare de Instrumente

From the View menu (or Settings), you can switch on and off QGIS widgets (Panels →) or toolbars (Toolbars
→). You can (de)activate any of them by right-clicking the menu bar or a toolbar and choose the item you want.
Each panel or toolbar can be moved and placed wherever you feel comfortable within QGIS interface. The list
can also be extended with the activation of Core or external plugins.

7.2.1 Bare de instrumente

The toolbar provides access to most of the same functions as the menus, plus additional tools for interacting with
the map. Each toolbar item has pop-up help available. Hold your mouse over the item and a short description of
the tool’s purpose will be displayed.

Every toolbar can be moved around according to your needs. Additionally, they can be switched off using the
right mouse button context menu, or by holding the mouse over the toolbars.

Figure 7.2: Meniul barei de instrumente
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Tip: Restaurare bare de instrumente
If you have accidentally hidden a toolbar, you can get it back by choosing menu option View → Toolbars →

(or Settings → Toolbars →). If for some reason a toolbar (or any other widget) totally disappears from the
interface, you’ll find tips to get it back at restoring initial GUI.

7.2.2 Panouri

Besides toolbars, QGIS provides by default many panels to work with. Panels are special widgets that you can
interact with (selecting options, checking boxes, filling values...) in order to perform a more complex task.

Figure 7.3: Meniul Panourilor

Below are listed default panels provided by QGIS:

• the Panoul Straturilor

• the Browser Panel

• Advanced Digitizing Panel

• Spatial Bookmarks Panel

• GPS Information Panel

• Tile Scale Panel

• Identify Panel

• User Input Panel

• the Layer Order Panel

• the Layer Styling Panel

• the Statistical Summary Panel
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• the QGIS Overview Panel

• the Log Messages Panel

• the Undo/Redo Panel

• the Processing Toolbox

7.3 Vizualizare Hartă

Also called Map canvas, this is the “business end” of QGIS — maps are displayed in this area. The map displayed
in this window will depend on the vector and raster layers you have chosen to load.

When you add a layer (see e.g. Deschiderea datelor), QGIS automatically looks for its Coordinate Reference
System (CRS) and zooms to its extent if you work in a blank QGIS project. The layer’s CRS is then applied to the
project. If there are already layers in the project, and in the case the new layer has the same CRS as the project,
its features falling in the current map canvas extent will be visualized. If the new layer is in a different CRS from
the project’s, you must Enable on-the-fly CRS transformation from the Project → Project Properties → CRS (see
Define On The Fly (OTF) CRS Transformation). The added layer should now be visible if data are available in the
current view extent.

The map view can be panned, shifting the focus of the map display to another region, and it can be zoomed in and
out. Various other operations can be performed on the map as described in the Bare de instrumente description.
The map view and the legend are tightly bound to each other — the maps in view reflect changes you make in the
legend area.

Tip: Mărirea Hărt,ii folosind Rotit,a Mouse-ului
Putet,i utiliza rotit,a mouse-ului pentru a mări sau a mics, ora harta. Plasat,i cursorul mouse-ului în interiorul hărt,ii,
s, i mis, cat,i rotit,a înainte (dinspre dvs.) pentru a mări, s, i înapoi (înspre dvs.) pentru a mics, ora. Transfocarea are loc
din pozit,ia cursorului mouse-ului. Putet,i personaliza comportamentul de transfocare al rotit,ei mouse-ului folosind
meniul filei Map tools de sub Settings → Options.

Tip: Deplasarea Hărt,ii folosind Săget,ile s, i Bara de Spat,iu
You can use the arrow keys to pan the map. Place the mouse cursor inside the map area and click on the right
arrow key to pan east, left arrow key to pan west, up arrow key to pan north and down arrow key to pan south. You
can also pan the map using the space bar or the click on mouse wheel: just move the mouse while holding down
space bar or click on mouse wheel.

7.4 Bara de Stare

The status bar provides you with general information about the map view, and actions processed or available and
offers you tools to manage the map view.

On the left side of the status bar, you can get a summary of actions you’ve done (such as selecting features in
a layer, removing layer) or a long description of the tool you are hovering over (not available for all tools). On
startup, the bar status also informs you about availability of new or upgradeable plugins (if checked in Plugin
Manager settings).

In case of lengthy operations, such as gathering of statistics in raster layers or rendering several layers in map
view, a progress bar is displayed in the status bar to show the current progress of the action.

The Coordinate option shows the current position of the mouse, following it while moving across the map
view. You can set the unit (and precision) to use in the project properties, General tab. Click on the small button

at the left of the textbox to toggle between the Coordinate option and the Extents option that displays in map
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units, the coordinates of the current lower leftmost and upper rightmost points of the map view, as you pan and
zoom in and out.

Next to the coordinate display you will find the Scale display. It shows the scale of the map view. If you zoom in
or out, QGIS shows you the current scale. There is a scale selector, which allows you to choose among predefined
and custom scales to assign to the map view.

On the right side of the scale display you can define a current magnification level for your map view. This allows
to zoom in to a map without altering the map scale, making it easier to accurately tweak the positions of labels
and symbols. The magnification level is expressed as a percentage. If the Magnifier has a level of 100%, then
the current map is not magnified. Additionally, a default magnification value can be defined within Settings →
Options → Rendering → Rendering behaviour, which is very useful for high resolution screen to avoid too small
symbols.

To the right of the magnifier tool you can define a current clockwise rotation for your map view in degrees.

On the right side of the status bar, there is a small checkbox which can be used to temporarily prevent layers being
rendered to the map view (see section Randare).

To the right of the render functions, you find the Current CRS: icon with the EPSG code of the current project
CRS. Clicking on this lets you Enable ‘on the fly’ CRS transformation properties for the current project and apply
another CRS to the map view.

Finally, the Messages button opens the Log Messages Panel which informs you on underlying process (QGIS
startup, plugins loading, processing tools...)

Tip: Calculează Scara Corectă a Canevasului Hărt,ii
When you start QGIS, the default CRS is WGS 84 (epsg 4326) and units are degrees. This means that QGIS
will interpret any coordinate in your layer as specified in degrees. To get correct scale values, you can either
manually change this setting, e.g. to meters, in the General tab under Project → Project Properties, or you can

use the Current CRS: icon seen above. In the latter case, the units are set to what the project projection specifies
(e.g., +units=us-ft).

Note that CRS choice on startup can be set in Settings → Options → CRS.
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CHAPTER 8

Instrumente generale

8.1 Ajutor contextual

When you need help on a specific topic, you can access context help via the [Help] button available in most
dialogs — please note that third-party plugins can point to dedicated web pages.

8.2 Panouri

QGIS provides by default many panels to work with. Some of these panels are described below while others may
be found in different parts of the document. A complete list of default panels provided by QGIS is available at
Panouri.

8.2.1 Panoul Straturilor

The layers Panel lists all the layers in the project and helps you manage their visibility. A layer can be selected
and dragged up or down in the legend to change the Z-ordering. Z-ordering means that layers listed nearer the top
of the legend are drawn over layers listed lower down in the legend.

Note: The Z-ordering behavior can be overridden by the Layer Order panel.

At the top of the Layers panel, a toolbar allows you to:

• Open the layer styling dock: toggle the layer styling panel on and off.

• Add new group

• Manage Visibility: control visibility of layers and preset layers combination.

• Filter Legend by Map Content: only the layers that are set visible and whose features intersect the current map
canvas have their style rendered in the layers panel. Otherwise, a generic NULL symbol is applied to the
layer. Based on the layer symbology, this is a convenient way to identify which kind of features from which
layers cover your area of interest.

• Filter Legend by Expression: helps you apply an expression to remove from the selected layer tree styles that
have no feature satisfying the condition. This can be used for example to highlight features that are within
a given area/feature of another layer. From the drop-down list, you can edit and clear the expression set.

• Expand All or Collapse All layers and groups in the layers panel.

• and Remove Layer/Group currently selected.
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Figure 8.1: Layer Toolbar in Layers Panel

Note: Tools to manage the layers panel are also available to layout the map and legend items of the print composer

Preset the layers visibility

The button allows you to add Presets views in the legend. Presets are a way to save and easily restore a
combination of layers with their current style. To add a preset view, just set visible the layers you want, with their
desired symbology, and click on button. Choose Add Preset... from the drop-down menu and give a name to
the preset. The added preset is listed at the bottom of the drop-down menu and is recalled by clicking on it.

The Replace Preset → option helps you overwrite a preset content with the current map view while the Remove
Current Preset button deletes the active preset.

All the added presets are also present in the map composer in order to allow you to create a map layout based on
your specific views (see Proprietăt,i principale).

Overview of the context menu of the Layers panel

At the bottom of the toolbar, the main component of the Layers panel is the frame listing vector or raster layers
added to the project and, those layers can be organized in groups. Depending on the item selected in the panel, a
right-click shows a dedicated set of options presented below.
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Opţiune Strat Vectorial Strat Raster Grup

Zoom to Layer/Group

Show in Overview

Zoom to Native Resolution (100%)

Stretch Using Current Extent

Remove

Duplicate

Set Layer Scale Visibility

Zoom to Visible Scale

Set Layer/Group CRS

Set Project CRS from Layer

Stiluri →
Copy Style

Paste Style

Open Attribute Table

Toggle Editing

Current Edits → (in Edit mode)

Save As...

Save As Layer Definition File...

Filter...

Show Feature Count

Properties

Move to Top-level

Rename

Group Selected

Set Group WMS Data

Mutually Exclusive Group

Add Group

Table: Context menu from Layers Panel items

For GRASS vector layers, Toggle editing is not available. See section Digitizarea s, i editarea unui strat vectorial
GRASS for information on editing GRASS vector layers.

Interact with Groups and layers

Layers in the legend window can be organized into groups. There are two ways to do this:

1. Press the icon to add a new group. Type in a name for the group and press Enter. Now click on an
existing layer and drag it onto the group.

2. Select some layers, right click in the legend window and choose Group Selected. The selected layers will
automatically be placed in a new group.

To bring a layer out of a group, you can drag it out, or right click on it and choose Move to top-level; the layer is
placed at the same level than the group it was inside. Groups can also be nested inside other groups.

The checkbox for a group will show or hide all the layers in the group with one click.
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Enabling the Mutually Exclusive Group option you can make a group have only one layer visible at the same
time. Whenever a layer within the group is set visible the others will be toggled not visible.

It is possible to select more than one layer or group at the same time by holding down the Ctrl key while selecting
the layers with the left mouse button. You can then move all selected layers to a new group at the same time.

You may also delete more than one layer or group at once by selecting several items with the Ctrl key and
pressing Ctrl+D afterwards. This way, all selected layers or groups will be removed from the layers list.

Editing vector layer style

From the Layers panel, you have shortcuts to easily and quickly edit the layer rendering. Right-click on a vector
layer and select Styles → in the list in order to:

• see the currently applied styles to the layer. In case you defined many styles for the layer, you can switch
from one to another and have your layer rendering automatically updated in the map canvas.

• copy the current style, and when applicable, paste a copied style from another layer

• rename the current style, add a new one (which is actually a copy of the current one) or delete the current
style (when multiple styles available).

Note: The previous options are also available for raster layer.

Whether the features in the vector layer have all the same unique symbol or they are classified (in that case, the
layer is displayed in a tree structure with each class as sub-item), the following options are available at layer level
or class level:

• a Edit Symbol... button to open the The Symbol Selector dialog and update any property (symbol, size,
color...) of the layer or feature symbol. Double-clicking on a feature does also open the Symbol Selector
dialog.

• a Selectorul de Culoare widget with a Color Wheel from which you can click a color and have it automat-
ically update the symbol fill color. For convenience, Recent colors are available at the bottom of the color
wheel.

• a Show All Items and Hide All Items to toggle on or off the visibility of all the classes of features.
This avoids (un)checking items one by one.

Tip: Quickly share a layer style
From the context menu, copy the style of a layer and paste it to a group or a selection of layers: the style is applied
to all the layers that are of the same type (vector vs raster) as the original layer and, in case of vector, have the
same geometry type (point, line or polygon).

8.2.2 Working with the Legend independent layer order

There is a panel that allows you to define an independent drawing order for the layers panel. You can activate
it in the menu Settings → Panels → Layer Order Panel. This feature allows you to, for instance, order your
layers in order of importance, but still display them in the correct order (see figure_layer_order; you can notice
that the airports features are displayed over the alaska polygon despite their layers placement in the Layers

panel). Unchecking the Control rendering order box underneath the list of layers will cause a revert to default
behavior.

8.2.3 Layer Styling Panel

This panel is somehow a shortcut to some of the features of the layer properties dialog. It indeed offers you a quick
and handy way to define the rendering and the behavior of a layer, and to visualize its effects without opening the
layer properties dialog.
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Figure 8.2: Define a legend independent layer order

Besides avoiding you dealing with the modal and blocking dialog of the layer properties, it also avoids you
cluttering the screen with features dialogs given that it embeds most of them (color selector, effects properties,
rule edit, label substitution...): e.g., clicking color buttons inside the layer style panel causes the color selector
dialog to be opened inside the layer style panel itself rather than as a separate dialog.

From a drop-down list of current layers in the layer panel, select an item and:

• set its symbology, transparency, and histogram in case of raster layer. These options are the same available
in Dialogul Proprietăt,ilor Rasterului

• set its symbology, and labels. These options are the same available in Dialogul Proprietăt,ilor Vectoriale

• manage the associated style(s) as described in Managing Custom Styles

• follow the whole history of changes you applied to the layer style in the current project; you can therefore
cancel or restore to any state by selecting it in the list and hit [Apply] button.

Another powerful feature of this panel is the Live update checkbox. Tick it and your changes are automatically
rendered in the map canvas as you go on. You no longer need to hit the [Apply] button.

Tip: Add custom tabs to the Layer Styling panel
Using PyQGIS, you can set new tabs to manage layer properties in the Layer Styling Panel. See
https://nathanw.net/2016/06/29/qgis-style-dock-part-2-plugin-panels/ for an example.

8.2.4 Statistical Summary Panel

This panel can show some statistics on a specific vector layers. The panel allows users to choose:

• the vector layer;

• the column or the expression;

• filter statistics to selected features;
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Figure 8.3: Defining a layer symbology from the layer styling panel
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• refresh the informations;

• the statistics information to display with the bottom right button.

Statistic information available are (depending on the field’s type):

Statistici S, irul Întreg Zecimal Data

Număr

Count Distinct Value

Count Missing value

Sum

Mean

Abaterea Standard

Standard Deviation on Sample

Minimal value

Maximal value

Range

Minority

Majority

Variety

Prima Quartilă

A Treia Quartilă

Inter Quartile Range

Lungimea Minimă

Lungimea Maximă

Table: Statistics available for each field type

8.2.5 QGIS Overview Panel

In QGIS, you can use an overview panel that provides a full extent view of layers added to it. Within the view is
a rectangle showing the current map extent. This allows you to quickly determine which area of the map you are
currently viewing. Note that labels are not rendered to the map overview even if the layers in the map overview
have been set up for labelling. If you click and drag the red rectangle in the overview that shows your current
extent, the main map view will update accordingly.

8.2.6 Log Messages Panel

When loading or processing some operations, you can track and follow messages that appear in different tabs

using the Log Messages Panel. It can be activated using the most right icon in the bottom status bar.

8.2.7 Undo/Redo Panel

For each layer being edited, this panel shows the list of actions done, allowing to quickly undo a set of actions by
simply selecting the action listed above. More details at Undo and Redo edits.
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Figure 8.4: Show statistics on a field
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8.3 Randare

În mod implicit, QGIS face toate straturile vizibile de fiecare dată când canevasul hărt,ii este actualizat. Între
evenimentele care declans, ează o actualizare de canevas sunt incluse:

• Adding a layer

• Panning or zooming

• Resizing the QGIS window

• Changing the visibility of a layer or layers

QGIS permite controlarea procesului de randare în mai multe moduri.

8.3.1 Randarea Dependentă de Scară

Scale-dependent rendering allows you to specify the minimum and maximum scales at which a layer (raster or
vector) will be visible. To set scale-dependent rendering, open the Properties dialog by double-clicking on the

layer in the legend. On the General tab, tick the Scale dependent visibility checkbox and enter the Minimum
(exclusive) and Maximum (inclusive) scale values.

You can also activate the scale dependent visibility on a layer from the Layers panel. Right-click on the layer and
in the context menu, select Set Layer Scale Visibility.

The Set to current canvas scale button helps you use the current map canvas scale as boundary of the range visibility.

Note: When a layer is not rendered in the map canvas due to the map scale out of its visibility scale range, the
layer is greyed in the Layers panel and a new option Zoom to Visible Scale appears in the layer context menu.
Select it and the map is zoomed to the layer’s nearest visibility scale.

8.3.2 Controarea Randării Hărt,ilor

Randarea hărt,ii poate fi controlată în diverse moduri, as, a cum este descris mai jos.

Suspendarea Randării

To suspend rendering, click the Render checkbox in the lower right corner of the status bar. When the
Render checkbox is not checked, QGIS does not redraw the canvas in response to any of the events described in
section Randare. Examples of when you might want to suspend rendering include:

• Adding many layers and symbolizing them prior to drawing

• Adding one or more large layers and setting scale dependency before drawing

• Adding one or more large layers and zooming to a specific view before drawing

• Any combination of the above

Bifarea casetei Randare activează randarea s, i provoacă o reîmprospătare imediată a canevasului hărt,ii.

Setarea Opt,iunilor de Adăugare a Stratului

You can set an option to always load new layers without drawing them. This means the layer will be added to
the map, but its visibility checkbox in the legend will be unchecked by default. To set this option, choose menu

option Settings → Options and click on the Rendering tab. Uncheck the By default new layers added to the
map should be displayed checkbox. Any layer subsequently added to the map will be off (invisible) by default.
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Oprirea Randării

To stop the map drawing, press the ESC key. This will halt the refresh of the map canvas and leave the map
partially drawn. It may take a bit of time between pressing ESC and the time the map drawing is halted.

Note: În acest moment nu este posibilă oprirea randării — acest lucru a fost dezactivat în portarea de Qt4, din
cauza problemelor s, i a defectelor Interfet,ei cu Utilizatorul (UI).

Influent,area Calităt,ii Randării

QGIS are o opt,iune de influent,are a calităt,ii randării hărt,ii. Aleget,i opt,iunea de meniu Setări → Opt,iuni, facet,i

clic pe fila Randare, apoi selectat,i sau deselectat,i caseta care Face ca liniile să apară mai put,in zimt,ate, cu
pret,ul unei reduceri a vitezei de desenare.

Accelerează randarea

Există două setări care vă permit să îmbunătăt,i viteza de randare. Deschidet,i dialogul opt,iunilor QGIS folosind
Setări → Opt,iuni, fila Randare, apoi bifând sau debifând următoarele casete:

• Use render caching where possible to speed up redraws

• Straturile se randează în paralel, utilizând mai multe nuclee CPU s, i Maximum de nuclee utilizate.

• The map renders in the background onto a separate image and each Map Update interval, the content
from this (off-screen) image will be taken to update the visible screen representation. However, if rendering
finishes faster than this duration, it will be shown instantaneously.

• With Enable Feature simplification by default for newly added layers, you simplify features’ geometry
(less nodes) and as a result, they quickly display. Be aware that you can also face rendering inconsistencies.

8.4 Salvarea s, i Partajarea Proprietăt,ilor Stratului

8.4.1 Managing Custom Styles

When a vector layer is added to map canvas, QGIS uses by default a random symbol/color to render its features.
You can however set a default symbol in Project → Project Properties → Default styles that will be applied to
each newly added layer according to its geometry type.

But, most of the time, you’d prefer to have a custom and more complex style that can be applied automatically or
manually (with less efforts) to the layers. You can achieve this goal using the Style combobox at the bottom of the
Layer Properties dialog. This combobox provides you with functions to create, load and manage styles.

A style stores any information set in the layer properties dialog to render or interact with the features (including
symbology, labeling, action, diagram... settings) for vector layer, or the pixels (band or color rendering, trans-
parency, pyramids, histogram ...) for raster.

By default, the style applied to a loaded layer is named default. Once you have got the ideal and appropriate

rendering for your layer, you can save it by clicking the Style combobox and choose:

• Rename Current: The active style gets renamed and updated with the current options

• Add: A new style is created using the current options. By default, it will be saved in the QGIS project file.
See below to save the style in another file or a database

• Remove: delete unwanted style, in case you have more than one style defined for the layer.
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Figure 8.5: Vector layer style combobox options

At the bottom of the Style drop-down list, you see the styles set for the layer and the active one is checked.

Note that each time you validate the layer properties dialog, the active style is updated with the changes you’ve
done.

You can create as many styles as you wish for a layer but only one can be active at a time. Combined to layer
visibility preset, this offers a quick and powerful way to manage complex projects with few layers (no need to
duplicate any layer in the map legend).

Tip: Manage styles from layer context menu
Right-click on the layer in Layers Panel to add, rename or remove layer style.

8.4.2 Storing Style in a File or a Database

While created styles from the Style combobox are by default saved inside the project and can be copied and pasted
from layer to layer in the project, it’s also possible to save them outside the project so that they can be loaded in
another project.

Save in plain text file

Clicking the Style → Save Style, you can save the style as a:

• QGIS layer style file (.qml)

• or SLD file (.sld), only available for vector layers.

Used on file based format layers (.shp, .tab...), Save as Default generates a .qml file along the layer (with
the same name). SLDs can be exported from any type of renderer – single symbol, categorized, graduated or
rule-based – but when importing an SLD, either a single symbol or rule-based renderer is created. That means that
categorized or graduated styles are converted to rule-based. If you want to preserve those renderers, you have to
stick to the QML format. On the other hand, it can be very handy sometimes to have this easy way of converting
styles to rule-based.
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Save in database

Vector layer style can also be stored in a database if the layer datasource is a database provider. Supported
formats are PostGIS, GeoPackage, SpatiaLite, MSSQL and Oracle. The layer style is saved inside a table (named
layer_styles) of the database. Click on Save Style → Save in database item then fill in the dialog to define a
style name, add a description, a .ui file if applicable and check if the style should be the default style.

You can save several styles for a single table in the database. However each table can have only one default
style. Default style can be saved in the layer database or in the QGIS local database, a SQLite database in the
~/.qgis2/ directory (where QGIS stores its local settings).

Figure 8.6: Save Style in database Dialog

Tip: Sharing style files between databases
You can only save your style in a database if the layer comes from such a database. You can’t mix databases (layer
in Oracle and style in MSSQL for instance). Use instead a plain text file if you want the style to be shared among
databases.

Note: You may encounter issues to restore the layer_styles table from a PostgreSQL database backup.
Follow QGIS layer_style table and database backup to fix that.

Load style

When loading a layer in QGIS, if a default style already exists for this layer, QGIS loads the layer with this style.
Also Style → Restore Default looks for and loads that file when pressed, replacing current style of the layer.

The Style → Load Style helps you apply any saved style to a layer. While plain text file style (.sld or .qml) can
be applied to any layer whatever its format is, loading styles stored in database is only possible if the layer is from
the same database or the style is stored in the QGIS local database.

The Load Style from Database dialog displays a list of related styles to the layer found in the database and all the
other styles saved in it, with name and description.

Tip: Quickly share a layer style within the project
You can also share layer style within a project without importing a file or database style: right-click on the layer
in the Layers Panel and, from the Styles combobox , copy the style of a layer and paste it to a group or a selection
of layers: the style is applied to all the layers that are of the same type (vector vs raster) as the original layer and,
in case of vector, have the same geometry type (point, line or polygon).
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8.5 Selectorul de Culoare

The select color dialog will appear whenever you push the icon to choose a color. The
features of this dialog depends on the state of the Use native color chooser dialogs parameter checkbox in Settings
→ Options → General menu. When checked, the color dialog used is the one of the OS being used. Otherwise,
QGIS custom color chooser is used.

Tip: Dynamically change the color with the live-updating option
Check the Use live-updating color chooser dialogs option in the Settings → Options → General menu to have the
color applied to your items as soon as you pick it in the color chooser dialog.

The custom color chooser dialog has four different tabs which allow you to select colors by color ramp,
color wheel, color swatches or color picker (not available under ).

Whatever method you use, the selected color is always described through color sliders for HSV (Hue, Saturation,
Value) and RGB (Red, Green, Blue) values. The color is also identifiable as a HTML notation. Finally, there is an
opacity slider to set transparency level.

Modifying a color is as simple as clicking in the color wheel or ramp or in any of the color parameters sliders. You
can adjust such parameters with the spinbox beside or, handy, scrolling the mouse wheel over the corresponding
slider. You can also typeset the color html notation.

The dialog also provides a visual comparison between the current (applied to widget) and the new (being selected)
colors. Thanks to drag-and-drop, any of these colors can be saved in a slot for an easy access.

Figure 8.7: Fila de selectare a gamei de culori

With color ramp or color wheel tab, you can browse to all possible color combinations and apply it to the item.

In the color swatches tab, you can choose from a preselected list of color palettes:

• Recent colors,

• Standard colors, a user-defined list of colors set under Settings → Options → Colors menu

• or Project colors, a user-defined list of colors set under Project → Project Properties → Default Styles.
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The latest palettes can be modified thanks to the and buttons at the bottom of the frame. The ... button
nearby the palette combobox also offers several options to:

• copy, paste, import or export colors

• create, import or remove color palettes. Check the Show in Color Buttons option to add the custom palette
to the color selector widget (see figure_color_selector).

Figure 8.8: Color selector switcher tab

Another option is to use the color picker which allows you to sample a color from under your mouse pointer at
any part of QGIS or even from another application by pressing the space bar. Please note that the color picker is
OS dependent and is currently not supported by macOS.

Tip: Quick color modification

Click the drop-down arrow at the right of the color box button to display a widget for a quick
color selection, either in the color wheel or from existing color palettes. You can also use it to copy or paste a
color.

8.6 Modurile de Fuziune

QGIS offers different options for special rendering effects with these tools that you may previously only know
from graphics programs. Blending modes can be applied on layers, on features but also on print composer items:

• Normal: This is the standard blend mode, which uses the alpha channel of the top pixel to blend with the
pixel beneath it. The colors aren’t mixed.

• Lighten: This selects the maximum of each component from the foreground and background pixels. Be
aware that the results tend to be jagged and harsh.

• Screen: Light pixels from the source are painted over the destination, while dark pixels are not. This mode
is most useful for mixing the texture of one item with another item (e.g., you can use a hillshade to texture
another layer).

• Dodge: Dodge will brighten and saturate underlying pixels based on the lightness of the top pixel. So,
brighter top pixels cause the saturation and brightness of the underlying pixels to increase. This works best
if the top pixels aren’t too bright; otherwise the effect is too extreme.
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Figure 8.9: Meniul rapid al selectorului de culoare
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• Addition: This blend mode simply adds pixel values of one item with the other. In case of values above
one (in the case of RGB), white is displayed. This mode is suitable for highlighting features.

• Darken: This creates a resultant pixel that retains the smallest components of the foreground and back-
ground pixels. Like lighten, the results tend to be jagged and harsh.

• Multiply: Here, the numbers for each pixel of the top item are multiplied with the corresponding pixels for
the bottom item. The results are darker pictures.

• Burn: Darker colors in the top item cause the underlying items to darken. Burn can be used to tweak and
colorise underlying layers.

• Overlay: This mode combines the multiply and screen blending modes. In the resulting picture, light parts
become lighter and dark parts become darker.

• Soft light: This is very similar to overlay, but instead of using multiply/screen it uses color burn/dodge.
This is supposed to emulate shining a soft light onto an image.

• Hard light: Hard light is also very similar to the overlay mode. It’s supposed to emulate projecting a very
intense light onto an image.

• Difference: Difference subtracts the top pixel from the bottom pixel, or the other way around, to always get
a positive value. Blending with black produces no change, as the difference with all colors is zero.

• Subtract: This blend mode simply subtracts pixel values of one item from the other. In case of negative
values, black is displayed.

8.7 Transfocare s, i Deplasare

QGIS dispune de instrumente de deplasare sau transfocare în zona de interes.

Apart from using the pan and zoom-in / zoom-out icons on the toolbar with the mouse, navigating can also
be done with the mouse wheel, spacebar and the arrow keys. A Zoom factor can be set under the Settings →
Options → Map tools menu to define the scale behavior while zooming.

8.7.1 With the mouse wheel

You can press the mouse wheel to pan inside of the main window (on macOS, you may need to hold cmd key).
You can roll the mouse wheel to zoom in and out on the map; the mouse cursor position will be the center of the
zoomed area of interest. Holding down Ctrl while rolling the mouse wheel results in a finer zoom.

8.7.2 With the arrow keys

Panning the map is possible with the arrow keys. Place the mouse cursor inside the map area, and click on the
right arrow key to pan east, left arrow key to pan west, up arrow key to pan north, and down arrow key to pan
south.

You can also use the space bar to temporarily cause mouse movements to pan the map. The PgUp and PgDown
keys on your keyboard will cause the map display to zoom in or out following the zoom factor set. Pressing Ctrl
+ or Ctrl - also performs an immediate zoom in/out on the map canvas.

When certain map tools are active (Identify, Measure...), you can perform a zoom by holding down Shift and
dragging a rectangle on the map to zoom to that area. This is enabled for the map tools which are not selection
tools (since they use Shift for adding to selection) nor edit tools.
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8.8 Măsurarea

8.8.1 Informat,ii generale

QGIS provides four means of measuring geometries:

• the interactive measurement tools ,

• measuring in the Field Calculator,

• derived measures in the Identify Features tool,

• and a vector analysis tool: Vector → Geometry Tools → Export/Add Geometry Columns

Measuring works within projected coordinate systems (e.g., UTM) and unprojected data. The first three measuring
tools behave equally to global project settings:

• If “on the fly” CRS transformation (see Define On The Fly (OTF) CRS Transformation) is enabled, the
default measurement metric is - different from most other GIS - ellipsoidal, using the ellipsoid defined in
File → Project properties → General. This is true both when geographic and projected coordinate systems
are defined for the project.

• If you want to calculate the projected / planimetric area or distance using cartesian maths, the measure-
ment ellipsoid has to be set to “None / Planimetric” (File → Project properties → CRS). However, with a
geographic (= unprojected) CRS defined for the data and project, area and distance measurement will be
ellipsoidal.

• If “on the fly” CRS transformation is disabled, the measurement metric is planimetric when the project co-
ordinate system is projected and ellipsoidal when the project coordinate system is unprojected / geographic.

However, neither the identify tool nor the field calculator will transform your data to the project CRS before
measuring. If you want to achieve this, you have to use the vector analysis tool: Vector → Geometry Tools →
Export/Add Geometry Columns. Here, measurement is by default planimetric except if you choose the ellipsoidal
measure.

8.8.2 Measure length, areas and angles interactive

Click the icon in the Attribute toolbar to begin measurements. The downward arrow near the icon helps you

switch to the convenient tool to measure length, area or angle. The default unit used in the dialog is
the one set in Project → Project Properties → General menu.

Note: Configuring the measure tool
While measuring length or area, clicking the Configuration button at the bottom of the widget helps you define
in menu Settings → Options → Map Tools the rubberband color, the precision of the measurements and the unit
behavior. You can also choose your preferred measurement or angle units but keep in mind that those values are
superseded in the current project by options made in Project → Project Properties → General menu.

All measuring modules use the snapping settings from the digitizing module (see section Setarea Tolerant,ei
Acros, ării s, i Căutarea Razei). So, if you want to measure exactly along a line feature, or around a polygon
feature, first set its layer snapping tolerance. Now, when using the measuring tools, each mouse click (within the
tolerance setting) will snap to that layer.

By default, Measure Line: QGIS measures real distances between given points according to a defined ellipsoid.
The tool then allows you to click points on the map. Each segment length, as well as the total, shows up in the
measure window. To stop measuring, click your right mouse button.

Note that you can use the drop-down list near the total to interactively change the measurement units while mea-
suring. This unit is kept for the widget until a new or another project is opened.
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The Info section in the dialog explains how calculations are made according to CRS settings available.

Figure 8.10: Măsurarea Distant,ei

Measure Area: Areas can also be measured. In the measure window, the accumulated area size appears. Right-
click to stop drawing. The Info section is also available as well as the ability to switch between different area
units.

Figure 8.11: Măsurarea Ariei

Measure Angle: You can also measure angles. The cursor becomes cross-shaped. Click to draw the first segment
of the angle you wish to measure, then move the cursor to draw the desired angle. The measure is displayed in a
pop-up dialog.

Figure 8.12: Măsurarea Unghiului

8.9 Selecting features

QGIS provides several tools to select features in the map canvas. Selection tools are available in View → Select
menu or in the Attributes toolbar.

Note: Selection tools work with the currently active layer.

8.9.1 Selecting manually in the map canvas

To select one or several features with the mouse, you can use one of the following tools:

• Select Features by area or single click
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• Selectare Entităt,i după un Poligon

• Selectare Entităt,i în Mod Liber

• Selectare Entităt,i după o Rază

Note: Except the Select Features by Polygon tool, these manual selection tools allow you to select feature(s) in the
map canvas with a single click.

While using the Select Feature(s) tool, holding Shift or Ctrl toggles whether feature is selected (ie either
adds to the current selection or remove from it).

For the other tools, different behaviors can be performed holding:

• Shift: add features to the current selection

• Ctrl: substract features from the current selection

• Ctrl + Shift: intersect with current selection, ie only keep overlapping features from the current se-
lection

• Alt: select features that are totally within the selection shape. Combined to Shift or Ctrl keys, you can
add or substract features to/from the current selection.

8.9.2 Automatic selection

The other selection tools, also available from the Attribute table, perform a selection based on feature’s attribute or
its selection state (note that attribute table and map canvas show the same information, so if you select one feature
in attribute table, it will be selected in map canvas also):

• Select By Expression... allows user to select features using expression dialog.

• Select Features By Value... or press F3

• Deselect Features from All Layers or press Ctrl+Shift+A to deselect all selected features in all layers.

• Select All Features or press Ctrl+A to select all features in the current layer.

• Invert Feature Selection to invert the selection in the current layer.

For example, if you want to find regions that are boroughs from regions.shp of the QGIS sample data, you

can use the Select features using an Expression icon. Then, you open the Fields and Values menu and choose the field
that you want to query. Double-click the field ‘TYPE_2’ and also click [Load all unique values] in the right
panel. From the list, choose and double-click ‘Borough’. In the Expression field, then you’d write the following
query:

"TYPE_2" = ’Borough’

From the expression builder dialog, you can also use the Function list → Recent (Selection) to make a selection that
you used before. The dialog remembers the last 20 used expressions. See Expresii chapter for more information
and some example.

Tip: Save your selection into a new file
Users can save selected features into a New Temporary Scratch Layer or a New Vector Layer using Edit →
Copy Features and Edit → Paste Features as in the wanted format.
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8.9.3 Select Features By Value

This selection tool opens the layer’s feature form allowing the user to choose, for each field, which value to look
for, if the search should be case sensitive, and the operation that should be used.

Figure 8.13: Filter/Select features using form dialog

Alongside each field, there is a drop-down list with the operation options to control the search behaviour. The
common options are:

• Exclude Field - The field will not be used for searching

• Equal to (=)

• Not equal to

• Is missing (null)

• Is not missing (not null)

For numeric and datetime fields, the additional options are:

• Greater than (>)

• Less than (<)

• Greater than or equal to (>=)

• Less than or equal to (<=)

• Between (inclusive)

• Is not between (inclusive)

For text fields, the additional options are:

• Contains

• Does not contain

For the text options above, it is also possible to use the Case sensitive option.

After setting all search options, you can use the Select features button to select the matching features. The drop-
down options are:

• Select features

• Add to current selection

• Filter current selection

• Remove from current current selection

You can also clean all search options using the Reset form button.
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8.10 Configurarea suprascrierii definită de date

Beside many options in the vector layer properties dialog or settings in the print composer, you can find a
Data defined override icon. Thanks to expressions based on layer attributes or item settings, prebuild or custom functions
and variables, this tool allows you to set dynamic value for the concerned parameter. When enabled, the value
returned by this widget is applied to the parameter regardless its normal value (checkbox, textbox, slider...).

Clicking the Data defined override icon shows following entries:

• Description... that indicates if the option is enabled, which input is expected, the valid input type and the
current definition. Hovering over the widget also pops up these information;

• Field type: an entry to select from the layer’s fields that match the valid input type;

• an entry to list the Variable available;

• Edit... button to create or edit the expression to use;

• Paste and Copy buttons;

• Clear button to remove the setup.

Parameters that can be used with data-defined tools are:

• Style and symbols parameters

• Labels parameters

• Composer parameters

Tip: Use right-click to (de)activate the data overriding

You can enable or disable a configured data-defined override button by simply clicking the widget with the mouse
right button.

Note: When the data-defined override option is setup correctly the icon is yellow or ; if it is broken, the
icon is red or .

8.11 Identify Features

The Identify tool allows you to interact with the map canvas and get information on features in a pop-up window.
To identify features, use:

• View → Identify Features menu,

• or press Ctrl + Shift + I (or Cmd + Shift + I),

• or click the Identify Features icon on the Attributes toolbar.

8.11.1 Using the Identify Features tool

QGIS offers two ways to identify features with the Identify Features tool:

• left click will identify features according to the mode set in the Identify Results panel

• right click will fetch all the snapped features from all the visible layers. This will open a context menu,
allowing the user to choose more precisely the features to identify.

8.10. Configurarea suprascrierii definită de date 55



QGIS User Guide, Release 2.18

Tip: Filter the layers to query with the Identify Features tool

Uncheck the Identifiable column in Project → (or Settings →), Project Properties → Identify layers menu in

front of a layer to avoid it being queried when using the Identify Features in a mode other than Current Layer.
This is a handy way to return features from only layers that are of interest for you.

If you click on feature(s), the Identify Results dialog will list information about the clicked feature(s). The default
view is a tree view where the first item is the name of the layer and its children are its identified feature(s). Each
feature is described by the name of a field along with its value. This field is the one set in Layer Properties →
Display. Then follows all the other information about the feature.

8.11.2 Feature informations

The Identify Results dialog can be customized to display custom fields, but by default it will display three kinds
of information:

• Actions: Actions can be added to the identify feature windows. The action is run by clicking on the action
label. By default, only one action is added, namely View feature form for editing. You can define
more actions in the layer’s properties dialog (see Proprietăt,ile Act,iunilor).

• Derived: This information is calculated or derived from other information. This includes:

– general information about the feature and its geometry: feature id, length or perimeter and area in map
units depending on its geometry, the count of spatial parts and the number of the clicked part in case
of multi-geometry, the count of vertices in the feature and the number of the closest one to the point
clicked

– coordinates information: the X and Y (and Z/M if available) coordinate values of the clicked point,
the feature closest vertex and its first and last vertices. In case you click on a curved line using the info
tool, QGIS will also display the radius of that section in the panel result.

• Atributele datelor: Aceasta este lista câmpurilor s, i valorilor atributelor, pentru entitatea pe care s-a efectuat
click.

Note: Links in feature’s attributes are clickable from the Identify Results panel and will open in your default web
browser.

Figure 8.14: Identify Results dialog

8.11.3 The Identify Results dialog

At the top of the window, you have seven icons:
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• Expandare arbore

• Restrângere arbore

• Default behavior to define whether next identified features information should be collapsed or expanded

• View the feature form

• Clear Results

• Copy selected feature to clipboard

• Se imprimă răspunsul HTML selectat

At the bottom of the window, you have the Mode and View comboboxes. With the Mode combobox you can define
from which layers features should be identified:

• Current layer : only features from the selected layer are identified. The layer may not be visible in the
canvas.

• Top down, stop at first: for only features from the upper visible layer.

• Top down: for all features from the visible layers. The results are shown in the panel.

• and Layer selection: opens a context menu where the user selects the layer to identify features from.
Operates like a right-click. Only the chosen features will be shown in the result panel.

Note: Identify tool configuration
You can configure the identify feature in Project → Project Properties in the Identify layers tab. The table allows
user to select layer(s) that can be used by this tool to identify features (column Identifiable). You can also put this
layer in read-only mode with the checkbox in the last column.

The View can be set as Tree, Table or Graph. ‘Table’ and ‘Graph’ views can only be set for raster layers.

The identify tool allows you to Auto open a form. If checked, each time a single feature is identified QGIS will
open a form showing its attributes. This is a handy way to quickly edit a feature’s attributes.

Alte funct,ii pot fi găsite în meniul contextual al elementului identificat. De exemplu, din meniul contextual putet,i:

• Vizualiza formularul entităt,ii

• Transfocare pe entitate

• Copia entităt,i: Copierea tuturor entităt,ilor geometrice s, i a atributelor

• Toggle feature selection: Adds identified feature to selection

• Copia valoarea atributului: Copie doar valoarea atributului pe care facet,i clic

• Copiere atribute entitate: Copiază atributele entităt,ii

• S, terge rezultatele: Elimină rezultatele din fereastră

• Elimina evident,ierea: Anulează evident,ierea entităt,ilor de pe hartă

• Evident,iază tot

• Evident,iere strat

• Activa stratul: Aleget,i un strat pentru a fi activat

• Afis, a proprietăt,ile straturilor: Deschide fereastra de proprietăt,i a unui strat

• Expandează tot

• Restrânge tot
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8.12 Instrumente de Adnotare

The Text Annotation tool in the attribute toolbar provides the possibility to place formatted text in a balloon on the
QGIS map canvas. Use the Text Annotation tool and click into the map canvas.

Figure 8.15: Dialogul de adnotare text

Double clicking on the item opens a dialog with various options. There is the text editor to enter the formatted text
and other item settings. For instance, there is the choice of having the item placed on a map position (displayed
by a marker symbol) or to have the item on a screen position (not related to the map). The item can be moved by
map position (by dragging the map marker) or by moving only the balloon. The icons are part of the GIS theme,
and they are used by default in the other themes, too.

The Move Annotation tool allows you to move the annotation on the map canvas.

8.12.1 Html annotations

The Html Annotation tools in the attribute toolbar provides the possibility to place the content of an html file in a
balloon on the QGIS map canvas. Using the Html Annotation tool, click into the map canvas and add the path to
the html file into the dialog.

8.12.2 SVG annotations

The SVG Annotation tool in the attribute toolbar provides the possibility to place an SVG symbol in a balloon on
the QGIS map canvas. Using the SVG Annotation tool, click into the map canvas and add the path to the SVG file
into the dialog.

8.12.3 Form annotations

Additionally, you can also create your own annotation forms. The Form Annotation tool is useful to display
attributes of a vector layer in a customized Qt Designer form (see figure_custom_annotation). This is similar
to the designer forms for the Identify features tool, but displayed in an annotation item. Also see this video
https://youtu.be/0pDBuSbQ02o?t=2m25s from Tim Sutton for more information.
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Figure 8.16: Customized qt designer annotation form

Note: If you press Ctrl+T while an Annotation tool is active (move annotation, text annotation, form annota-
tion), the visibility states of the items are inverted.

8.13 Semne de Carte Spat,iale

Spatial Bookmarks allow you to “bookmark” a geographic location and return to it later. By default, bookmarks
are saved on the computer, meaning that they are available from any project in the same computer. If you wish to
store the bookmark in the project file (.qgs) then you can do this by selecting the In Project checkbox.

8.13.1 Crearea unui Semn de Carte

Pentru a crea un semn de carte:

1. Deplasare sau transfocare în zona de interes.

2. Select the menu option View → New Bookmark or press Ctrl-B. The Spatial Bookmark panel opens with
the newly created bookmark.

3. Introducet,i un nume descriptiv pentru marcaj (până la 255 de caractere).

4. Check the In Project box if you wish to save the bookmark in the project file.

5. Apăsat,i Enter pentru a adăuga marcajul, sau efectuat,i clic oriunde.

Ret,inet,i că putet,i avea mai multe marcaje cu acelas, i nume.

8.13.2 Lucrul cu Marcaje

To use or manage bookmarks, select the menu option View → Show Bookmarks. The Spatial Bookmarks panel
allows you to:

• Transfocare pe Marcaj: selectat,i marcajul dorit făcând clic pe el, apoi pe Transfocare pe Marcaj. Putet,i
transfoca, de asemenea, la un marcaj, efectuând un dublu-clic pe el.

• S, tergerea unui Marcaj: selectat,i marcajul, apoi facet,i clic pe S, tergere Marcaj. Confirmat,i alegerea dvs.
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• Import or Export a bookmark: To share or transfer your bookmarks between computers you can use the
Import/Export Bookmarks pull down menu in the Spatial Bookmarks dialog. All the bookmarks are trans-
ferred.

8.14 Imbricarea Proiectelor

Sometimes, you’d like to keep in different projects a bunch of layers with the same style. You can either create a
default style for these layers or embed them from another project to save you tons of work.

Embed layers and groups from an existing project has some advantages over styling:

• all types of layers (vector or raster, local or online...) can be added

• fetching groups and layers, you can keep the same tree structure of the “background” layers in your different
projects

• While the embedded layers are editable, you can’t change their properties such as symbology, labels, forms,
default values, actions... This ensures homogeneity throughout the projects

• modify the items in the original project and changes are propagated to all the other projects.

If you want to embed content from other project files into your project, select Layer → Embed Layers and Groups
and:

1. Press to look for a project; you can see the content of the project (see figure_embed_dialog).

2. Press Ctrl ( or Cmd) and click on the layers and groups you wish to retrieve.

3. Press [OK]. The selected layers and groups are embedded in the Layer panel and can be visualized in the
map canvas now. Names of embedded items appear in italic to distinguish them from regular layers and
groups.

Figure 8.17: Selectat,i straturile s, i grupurile pentru încapsulare

Like any other layer, an embedded layer can be removed from the project by right-click on the layer and choose
Remove.

Tip: Change rendering of an embedded layer
It’s not possible to change rendering of an embedded layer, unless you make the changes in the original project
file. However, right-click on a layer and select Duplicate creates a layer which is fully-featured and not dependent
to the original project. You can then safely remove the linked layer.

8.15 Decorat,iuni

The Decorations of QGIS include the Grid, the Copyright Label, the North Arrow and the Scale Bar. They are
used to ‘decorate’ the map by adding cartographic elements.
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8.15.1 Grilă

Grid vă permite să adăugat,i o ret,ea de coordonate s, i să coordonat,i adnotările din canevasul hărt,ii.

Figure 8.18: Dialogul Grilei

1. Select from menu View → Decorations → Grid. The dialog starts (see figure_decorations_grid).

2. Activate the Enable grid checkbox and set grid definitions according to the layers loaded in the map
canvas.

3. Activate the Draw annotations checkbox and set annotation definitions according to the layers loaded
in the map canvas.

4. Click [Apply] to verify that it looks as expected or [OK] if you’re satisfied.

8.15.2 Eticheta Drepturilor de Autor

Copyright label adds a copyright label using the text you prefer to the map.

Figure 8.19: Dialogul Drepturilor de Autor

1. Select from menu View → Decorations → Copyright Label. The dialog starts (see fig-
ure_decorations_copyright).

8.15. Decorat,iuni 61



QGIS User Guide, Release 2.18

2. Make sure the Enable Copyright Label checkbox is checked.

3. Enter the text you want to place on the map. You can use HTML as shown in the example.

4. Aleget,i pozit,ionarea etichetei cu ajutorul casetei combinate Pozit,ionare .

5. You can refine the placement of the item by setting a Horizontal and/or Vertical Marging from (Canvas)
Edge. These values can be a distance in Millimeter or Pixels or set as Percentage of the width or height of
the map canvas.

6. You can change the color to apply.

7. Click [Apply] to verify that it looks as expected or [OK] if you’re satisfied.

In the example above, which is the default, QGIS places a copyright symbol followed by the date in the lower
right-hand corner of the map canvas.

8.15.3 Săgeata Nordului

North Arrow places a simple north arrow on the map canvas. Currently, there is only one style available. You can
adjust the angle of the arrow or let QGIS set the direction automatically. If you choose to let QGIS determine the
direction, it makes its best guess as to how the arrow should be oriented. For placement of the arrow, you have
four options, corresponding to the four corners of the map canvas. You can refine the placement of the arrow by
setting a Horizontal and/or Vertical Marging from (Canvas) Edge. These values can be a distance in Millimeter
or Pixels or set as Percentage of the width or height of the map canvas.

Figure 8.20: Dialogul Săget,ii Nordului

8.15.4 Scara Grafică

Scale Bar adaugă o simplă scară grafică în canevasul hărt,ii. Putet,i controla stilul s, i pozit,ionarea, precum s, i
etichetarea bării.

QGIS only supports displaying the scale in the same units as your map frame. So if the units of your layers are in
meters, you can’t create a scale bar in feet. Likewise, if you are using decimal degrees, you can’t create a scale
bar to display distance in meters.

Pentru a adăuga o scară grafică:

1. Select from menu View → Decorations → Scale Bar. The dialog starts (see figure_decorations_scale).

2. Make sure the Enable scale bar checkbox is checked.

3. Choose the style from the Scale bar style combo box.

4. Select the color for the bar Color of bar or use the default black color.
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Figure 8.21: Dialogul Scării Grafice

5. Set the Size of bar .

6. Optionally, check Automatically snap to round number on resize to display values easy-to-read.

7. Choose the placement from the Placement combo box.

8. You can refine the placement of the item by setting a Horizontal and/or Vertical Marging from (Canvas)
Edge. These values can be a distance in Millimeter or Pixels or set as Percentage of the width or height of
the map canvas.

9. Click [Apply] to verify that it looks as expected or [OK] if you’re satisfied.

Tip: Settings of Decorations
When you save a .qgs project, any changes you have made to Grid, North Arrow, Scale Bar and Copyright will
be saved in the project and restored the next time you load the project.

8.16 Autentificarea

QGIS has facility to store/retrieve authentication credentials in a secure manner. Users can securely save cre-
dentials into authentication configurations, which are stored in a portable database, can be applied to server or
database connections, and safely referenced by their ID tokens in project or settings files. For more information
see Sistem de Autentificare.

A master password needs to be set up when initializing the authentication system and its portable database.

8.17 Variables

In QGIS, you can use variables to store useful recurrent values (e.g. the project’s title, or the user’s full name) that
can be used in expressions. Variables can be defined at the application’s global level, project level, layer level,
composition level, and composer’s item level. Just like CSS cascading rules, variables can be overwritten - e.g., a
project level variable will overwrite any application’s global level variables set with the same name. You can use
these variables to build text strings or other custom expressions using the @ character before the variable name.
For example in composer creating a label with this content:

This map was made using QGIS [% @qgis_version %]. The project file for this
map is: [% @project_path %]

Va produce o etichetă care arată în felul următor:
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This map was made using QGIS 2.14. The project file for this map is:
/gis/qgis-user-conference-2015.qgs

Besides the preset read-only variables, you can define your own custom variables for any of the levels mentioned
above. You can manage:

• global variables from the Settings → Options menu;

• project’s variables from Project properties (see Proprietăţi Proiect);

• vector layer’s variables from the Layer Properties dialog (see Dialogul Proprietăt,ilor Vectoriale);

• composition’s variables from the Composition panel in the Print composer (see Composition Panel);

• and composer item’s variables from the Item properties panel in the Print composer (see Composer Items
Common Options).

To differentiate from editable variables, read-only variable’s names and values are emphasized in italic. On the
other hand, higher level variables overwritten by lower level ones are strike through.

Figure 8.22: Variables editor at the project’s level

Note: You can read more about variables and find some examples in Nyall Dawson’s Exploring variables in
QGIS 2.12, part 1, part 2 and part 3 blog posts.
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CHAPTER 9

QGIS Configuration

QGIS is highly configurable through the Settings menu. Choose between Options, Project Properties and Cus-
tomization.

Note: QGIS follows desktop guidelines for the location of options and project properties item. Consequently
related to the OS you are using, location of some of items described below could be in the Project or the Settings
menu.

9.1 Opţiuni

Some basic options for QGIS can be selected using the Options dialog. Select the menu option Settings →
Options. You can modify the options according to your needs. Some of the changes may require a restart of QGIS
before they will be effective.

The tabs where you can customize your options are described below.

9.1.1 Setări Generale

Aplicat,ie

• Select the Style (QGIS restart required) and choose between ‘Oxygen’, ‘Windows’, ‘Motif’, ‘CDE’,
‘Plastique’ and ‘Cleanlooks’.

• Define the Icon theme . It can be ‘default’ or ‘Night Mapping’.

• Define the Icon size .

• Define the Font and its Size. The font can be Qt default or a user-defined one.

• Change the Timeout for timed messages or dialogs .

• Hide splash screen at startup

• Show tips at startup

• Check QGIS version at startup to keep you informed if a newer version is released

• QGIS-styled group boxes

• Use native color chooser dialogs (see Selectorul de Culoare)

• Use live-updating color chooser dialogs (see Selectorul de Culoare)

• Canvas rotation support (restart required)
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Fis, ierele proiectului

• Open project on launch (choose between ‘New’, ‘Most recent’, ‘Welcome Page’, and ‘Specific’).

When choosing ‘Specific’ use the to define the project to use by default. The ‘Welcome Page’ displays
a list of recent projects with screenshot.

• Create new project from default project. You have the possibility to press on Set current project as
default or on Reset default. You can browse through your files and define a directory where you find your
user-defined project templates. This will be added to Project → New From Template. If you first activate

Create new project from default project and then save a project in the project templates folder.

• Prompt to save project and data source changes when required

• Se solicită confirmarea atunci când un strat va fi eliminat

• Warn when opening a project file saved with an older version of QGIS

• Enable macros . This option was created to handle macros that are written to perform an action on
project events. You can choose between ‘Never’, ‘Ask’, ‘For this session only’ and ‘Always (not recom-
mended)’.

9.1.2 System Settings

SVG paths

Add or Remove Path(s) to search for Scalable Vector Graphic (SVG) symbols. These SVG files are then available
to symbolize features or decorate your map composition.

Căile plugin-urilor

Add or Remove Path(s) to search for additional C++ plugin libraries

QSettings

It helps you Reset user interface to default settings (restart required) if you made any customization.

Mediu

Variabilele de mediu ale sistemului pot fi acum vizualizate, iar multe dintre ele pot fi configurate în grupul Envi-
ronment (v. figure_environment_variables). Acest lucru este util pentru platforme, cum ar fi Mac, unde interfat,a
unei aplicat,ii nu mos, tenes, te în mod obligatoriu variabilele de mediu ale utilizatorului. De asemenea, este util s, i
la stabilirea/vizualizarea variabilelor de mediu pentru seturile de instrumente externe, controlate de instrumentele
Processing (ex.: SAGA, GRASS), s, i pentru a depana ies, irile provenite din anumite sect,iuni ale codului sursă.

• Use custom variables (restart required - include separators). You can [Add] and [Remove] variables.
Already-defined environment variables are displayed in Current environment variables, and it’s possible to

filter them by activating Show only QGIS-specific variables.

9.1.3 Data Sources Settings

Atributele şi tabela entităt,ii

• Open attribute table in a dock window

• Copy features as ‘Plain text, no geometry’, ‘Plain text, WKT geometry’, or ‘GeoJSON’ when pasting fea-
tures in other applications.

• Attribute table behavior : set filter on the attribute table at the opening. There are three possibilities:
‘Show all features’, ‘Show selected features’ and ‘Show features visible on map’.
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Figure 9.1: Variabilele de mediu ale sistemului din QGIS

• Default view: define the view mode of the attribute table at every opening. It can be ‘Remember last view’,
‘Table view’ or ‘Form view’.

• Attribute table row cache . This row cache makes it possible to save the last loaded N attribute rows
so that working with the attribute table will be quicker. The cache will be deleted when closing the attribute
table.

• Representation for NULL values. Here, you can define a value for data fields containing a NULL value.

Tip: Improve opening of big data attribute table
When working with layers with big amount of records, opening the attribute table may be slow as the dialog
request all the rows in the layer. Setting the Attribute table behavior to Show features visible on map will make
QGIS request only the features in the current map canvas when opening the table, allowing a quick data loading.

Note that data in this attribute table instance will be always tied to the canvas extent it was opened with, meaning
that selecting Show All Features within such a table will not display new features. You can however update the
set of displayed features by changing the canvas extent and selecting Show Features Visible On Map option in
the attribute table.

Gestiunea surselor de date

• Scanează elementele valide din navigator . Se poate alege ‘Verificare extensie’ sau ‘Verificare
cont,inut fis, ier’.

• Scan for contents of compressed files (.zip) in browser dock . ‘No’, ‘Basic scan’ and ‘Full scan’ are
possible.

• Prompt for raster sublayers when opening. Some rasters support sublayers — they are called subdatasets
in GDAL. An example is netCDF files — if there are many netCDF variables, GDAL sees every variable
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as a subdataset. The option allows you to control how to deal with sublayers when a file with sublayers is
opened. You have the following choices:

– ‘Always’: Always ask (if there are existing sublayers)

– ‘If needed’: Ask if layer has no bands, but has sublayers

– ‘Never’: Never prompt, will not load anything

– ‘Load all’: Never prompt, but load all sublayers

• Ignore shapefile encoding declaration. If a shapefile has encoding information, this will be ignored by
QGIS.

• Adăugare straturi PostGIS printr-un dublu clic s, i selectarea modului extins

• Adăugare straturi Oracle printr-un dublu clic s, i selectarea modului extins

• Execută expresiile pe server, dacă este posibil

Calea Ascunsă fat, ă de Navigator

This widget lists all the folder you chose to hide from the Browser panel. Removing a folder from the list will
make it available in the Browser panel.

9.1.4 Rendering Settings

Figure 9.2: Rendering tab of Project Properties dialog

Comportamentul randării

• By default new layers added to the map should be displayed

• Se foloses, te memoria tampon, acolo unde este posibil, pentru a se accelera redesenarea
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• Straturile se randează în paralel, utilizând mai multe nuclee CPU

• Max nuclee de utilizat

• Intervalul de reactualizare a hărt,ii (implicit 250 ms)

• Activează simplificarea implicită a entităt,ilor, pentru straturile nou adăugate

• Pragul de Simplificare

• Simplification algorithm: This option performs a local “on-the-fly” simplification on feature’s and speeds
up geometry rendering. It doesn’t change the geometry fetched from the data providers. This is important
when you have expressions that use the feature geometry (e.g. calculation of area) - it ensures that these
calculations are done on the original geometry, not on the simplified one. For this purpose, QGIS provides
three algorithms: ‘Distance’ (default), ‘SnapToGrid’ and ‘Visvalingam’.

• Simplify on provider side if possible: the geometries are simplified by the provider (PostGIS, Oracle...)
and unlike the local-side simplification, geometry-based calculations may be affected

• Scara maximă la care stratul ar trebui să fie simplificat

• Magnification level (see the magnifier)

Note: Besides the global setting, feature simplification can be set for any specific layer from its Layer properties
→ Rendering menu.

Calitatea randării

• Liniile vor apărea mai put,in zimt,ate, cu pret,ul unei pierderi de performant,ă la desenare

Segmentare curbă

• Segmentation tolerance: this setting controls the way circular arcs are rendered. The smaller maximum an-
gle (between the two consecutive vertices and the curve center, in degrees) or maximum difference (distance
between the segment of the two vertices and the curve line, in map units), the more straight line segments
will be used during rendering.

• Tolerance type: it can be ‘Maximum angle’ or ‘Maximum distance’

Rastere

• With RGB band selection, you can define the number for the Red, Green and Blue band.

Îmbunătăţirea contrastului

• Single band gray . A single band gray can have ‘No stretch’, ‘Stretch to MinMax’, ‘Stretch and Clip
to MinMax’ and also ‘Clip to MinMax’.

• Multi band color (byte/band) . Options are ‘No stretch’, ‘Stretch to MinMax’, ‘Stretch and Clip to
MinMax’ and ‘Clip to MinMax’.

• Multi band color (>byte/band) . Options are ‘No stretch’, ‘Stretch to MinMax’, ‘Stretch and Clip to
MinMax’ and ‘Clip to MinMax’.

• Limits (minimum/maximum) . Options are ‘Cumulative pixel count cut’, ‘Minimum/Maximum’,
‘Mean +/- standard deviation’.

• Limitele reducerii numărului cumulat de pixeli

• Multiplicator pentru Abaterea Standard

Depanare

• Map canvas refresh
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9.1.5 Setările Culorilor

This menu allows you to add some custom color that you can find in each color dialog window of the renderers.
You will see a set of predefined colors in the tab: you can delete or edit all of them. Moreover you can add the
color you want and perform some copy and paste operations. Finally you can export the color set as a gpl file or
import them.

9.1.6 Canvas and Legend Settings

Default map appearance (overridden by project properties)

• Define a Selection color and a Background color.

Layer legend

• Double click action in legend . You can either ‘Open layer properties’, ‘Open attribute table’ or ‘Open
layer styling dock’ with the double click.

• The following Legend item styles are possible:

– Capitalise layer names

– Bold layer names

– Bold group names

– Display classification attribute names

– Create raster icons (may be slow)

– you can also set the WMS getLegendGraphic Resolution

9.1.7 Map tools Settings

This tab offers some options regarding the behavior of the Identify tool.

• Search radius for identifying and displaying map tips is a tolerance distance within which the identify tool
will depict results as long as you click within this tolerance.

• Highlight color allows you to choose with which color should features being identified be highlighted.

• Buffer determines a buffer distance to be rendered from the outline of the identify highlight.

• Minimum width determines how thick should the outline of a highlighted object be.

Instrumentul de măsură

• Defines, te Culoarea benzii elastice a instrumentelor de măsurare

• Definire Număr de zecimale

• Keep base unit to not automatically convert large numbers (e.g., meters to kilometers)

• Preferred distance units (‘Meters’, ‘Kilometers’, ‘Feet’, ‘Yards’, ‘Miles’, ‘Nautical Miles’, ‘Degrees’ or
‘Map Units’ )

• Preferred area units (‘Square meters’, ‘Square kilometers’, ‘Square feet’, ‘Square yards’, ‘Square miles’,
‘Hectares’, ‘Acres’, ‘Square nautical miles’, ‘Square degrees” or ‘Map Units’)

• Preferred angle units (‘Degrees’, ‘Radians’, ‘Gon/gradians’, ‘Minutes of arc’, ‘Seconds of arc’ or
‘Turns/revolutions’)

Deplasare s, i transfocare

• Define a Zoom factor for zoom tools or wheel mouse
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Scări predefinite

Here, you find a list of predefined scales. With the and buttons you can add or remove your personal
scales. You can also import or export scales from/to a .XML file. Note that you still have the possibility to remove
your changes and reset to the predefined list.

9.1.8 Composer Settings

Valori implicite pentru compozit,ie

You can define the Default font used within the print composer.

Aspectul grilei

• Definit,i Stilul grilei (‘Solid’, ‘Puncte’, ‘Cruciulit,e’)

• Definit,i Culoarea grilei

Grilă s, i de ghidaje implicite

• Definit,i Spat,ierea grilei .

• Define the Grid offset for x and y

• Definit,i Tolerant,a acros, ării .

Composer Paths

• Define Path(s) to search for extra print templates: a list of folders with custom composer templates to use
while creating new one.

9.1.9 Digitizing Settings

This tab helps you configure general settings when editing vector layer (attributes and geometry).

Creare entitate

• Suppress attribute form pop-up after feature creation

• Reuse last entered attribute values

• Validate geometries. Editing complex lines and polygons with many nodes can result in very slow rendering.
This is because the default validation procedures in QGIS can take a lot of time. To speed up rendering, it is
possible to select GEOS geometry validation (starting from GEOS 3.3) or to switch it off. GEOS geometry
validation is much faster, but the disadvantage is that only the first geometry problem will be reported.

Bandă elastică

• Define Rubberband Line width, Line color and Fill color

• Don’t update rubberband during node editing

Acros, are

• Open snapping options in a dock window (QGIS restart required)

• Define Default snap mode (‘To vertex’, ‘To segment’, ‘To vertex and segment’, ‘Off’)

• Defines, te Tolerant,a de acros, are implicită, în unităt,i de hartă sau în pixeli

• Defines, te Raza de căutare pentru editarea vertecs, ilor, în unităt,i de hartă sau în pixeli

Simbolurile vertexului

• Arată simbolurile numai pentru entităt,ile selectate

• Define vertex Marker style (‘Cross’ (default), ‘Semi transparent circle’ or ‘None’)

9.1. Opţiuni 71



QGIS User Guide, Release 2.18

• Defines, te Dimensiunea simbolului pentru vertex

Instrument pentru curba de decalare

The next 3 options refer to the Offset Curve tool in Digitizare avansată. Through the various settings, it is possible
to influence the shape of the line offset. These options are possible starting from GEOS 3.3.

• Join style: ‘Round’, ‘Mitre’ or ‘Bevel’

• Segmentele cvadrantului

• Miter limit

9.1.10 Setările GDAL

GDAL is a data exchange library for raster files. In this tab, you can Edit create options and Edit Pyramids Options
of the raster formats. You can define which GDAL driver is to be used for a raster format, as in some cases more
than one GDAL driver is available.

9.1.11 CRS Settings

Default CRS for new projects

• Don’t enable ‘on the fly’ reprojection

• Automatically enable ‘on the fly’ reprojection if layers have different CRS

• Enable ‘on the fly’ reprojection by default

• Select a CRS and Always start new projects with this CRS

CRS-ul pentru noile straturi

This area allows you to define the action to take when a new layer is created, or when a layer without a CRS is
loaded.

• Se cere CRS-ul

• Utilizează CRS-ul proiectului

• Use default CRS

Transformări de datum implicite

• Ask for datum transformation when no default is defined

• With the ‘on-the-fly’ CRS transformation enabled and the above option checked, adding layers of different
CRS opens the Select datum transformations dialog. This offers you to select the most appropriate trans-
formation settings. Validating this dialog with the ‘Remember selection’ option checked populates the table
under CRS → Default datum transformations with information about ‘Source CRS’ and ‘Destination CRS’
as well as ‘Source datum transform’ and ‘Destination datum transform’. From now, QGIS automatically

uses the selected datum transformation for further transformation between these two CRSs until you
remove it from the list.

You can use the button to add a datum transformation if you know its parameters (source and destination
ellipsoids and the numbers from the transformation table). You then need to manually enter each setting.

Note: For more information on how QGIS handles layers projection, please read the dedicated section at Lucrul
cu Proiect,ii.
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9.1.12 Locale Settings

• Override system locale and Locale to use instead

• Information about active system locale

9.1.13 Authentication Settings

In the Authentication tab you can set authentication configurations and manage PKI certificates. See Sistem de
Autentificare for more details.

9.1.14 Network Tab

Generalităt,i

• Definit,i Adresa de căutare WMS ca fiind, în mod implicit, http://geopole.org/wms/search?search=\%1\&type=rss

• Definire Timpul de as, teptare pentru cererile de ret,ea (ms) - implicit este 60000

• Define Default expiration period for WMS Capabilities (hours) - default is 24

• Definire Perioada de expirare prestabilită pentru plăcut,ele WMS-C/WMTS (ore) - implicit este 24

• Define Max retry in case of tile or feature request errors

• Definire User-Agent

Setările memoriei tampon

Define the Directory and a Size for the cache.

• Use proxy for web access and define ‘Host’, ‘Port’, ‘User’, and ‘Password’.

• Set the Proxy type according to your needs.

– Default Proxy: Proxy is determined based on the application proxy set using

– Socks5Proxy: Generic proxy for any kind of connection. Supports TCP, UDP, binding to a port (in-
coming connections) and authentication.

– HttpProxy: Implemented using the “CONNECT” command, supports only outgoing TCP connections;
supports authentication.

– HttpCachingProxy: Implemented using normal HTTP commands, it is useful only in the context of
HTTP requests.

– FtpCachingProxy: Implemented using an FTP proxy, it is useful only in the context of FTP requests.

Excluding some URLs can be added to the text box below the proxy settings (see Figure_Network_Tab).

If you need more detailed information about the different proxy settings, please refer to the manual of the under-
lying QT library documentation at http://doc.qt.io/qt-4.8/qnetworkproxy.html#ProxyType-enum

Tip: Folosirea Proxi-urilor
Using proxies can sometimes be tricky. It is useful to proceed by ‘trial and error’ with the above proxy types, to
check if they succeed in your case.

9.1.15 Variables Settings

The Variables tab lists all the variables available at the global-level.
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Figure 9.3: Setările proxy din QGIS
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It also allows the user to manage global-level variables. Click the button to add a new custom global-level

variable. Likewise, select a custom global-level variable from the list and click the button to remove it.

More information about variables in the Variables section.

9.1.16 Advanced Settings

Depending on your OS, all the settings related to QGIS (UI, tools, data providers, default values, plugins options...)
are saved:

• in a text file: $HOME/.config/QGIS/QGIS2.conf

• in the properties list file: $HOME/Library/Preferences/org.qgis.qgis.plist

• in the registry under: HKEY\CURRENT_USER\Software\QGIS\qgis

The Advanced tab offers you in a single place, regardless your OS, means to manage these settings through the
Advanced Settings Editor. After you promise to be careful, the widget is populated with a tree of all QGIS settings,
which you can directly edit.

Warning: Avoid using the Advanced tab settings blindly
Be careful while modifying items in this dialog given that changes are automatically applied. Doing changes
without knowledge can break your QGIS installation in various ways.

9.2 Proprietăţi Proiect

In the properties window for the project under Project → Project Properties (or Settings → Project Proper-
ties), you can set project-specific options.

The project-specific options overwrite their equivalent in the options described above.

• In the General tab, the general settings let you:

– give a title to the project beside the project file path

– choose the color to use for features when they are selected

– choose the background color: the color to use for the map canvas

– set whether the path to layers in the project should be saved as absolute (full) or as relative to the
project file location. You may prefer relative path when both layers and project files can be moved or
shared or if the project is accessed from computers on different platforms.

– choose to avoid artifacts when project is rendered as map tiles. Note that checking this option can lead
to performance degradation.

Calculating areas and distances is a common need in GIS. However, these values are really tied to the
underlying projection settings. The Measurements frame lets you control these parameters. You can indeed
choose:

– the ellipsoid to use: it can be an existing one, a custom one (you’ll need to set values of the semi-major
and semi-minor axis) or None/Planimetric.

– the units for distance measurements for length and perimeter and the units for area measurements.
These settings, which default to the units set in QGIS options but then overrides it for the current
project, are used in:

* Bara de actualizare a câmpului din tabela de atribute

* Operat,iunile din calculatorul de câmpuri

* Identify tool derived length, perimeter and area values
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* Unitatea implicită se afis, ează în dialogul de măsurare

The Coordinate display allows you to choose and customize the format of units to use to display the mouse
coordinate in the status bar and the derived coordinates shown via the identify tool.

Finally, you can define a project scale list, which overrides the global predefined scales.

Figure 9.4: Fila Generalităt,ilor din fereastra cu Proprietăt,ile Proiectului

• The CRS tab enables you to choose the Coordinate Reference System for this project, and to enable on-
the-fly re-projection of raster and vector layers when displaying layers from a different CRS. For more
information on projection’s handling in QGIS, please read Lucrul cu Proiect,ii section.

• With the Identify layers tab, you set (or disable) which layers will respond to the identify tool. By default,
layers are set queryable.

You can also set whether a layer should appear as read-only, meaning that it can not be edited by the
user, regardless of the data provider’s capabilities. Although this is a weak protection, it remains a quick
and handy configuration to avoid end-users modifying data when working with file-based layers.

• The Default Styles tab lets you control how new layers will be drawn when they do not have an existing
.qml style defined. You can also set the default transparency level for new layers and whether symbols
should have random colors assigned to them. There is also an additional section where you can define
specific colors for the running project. You can find the added colors in the drop down menu of the color
dialog window present in each renderer.

• The tab OWS Server allows you to configure your project in order to publish it online. Here you can
define information about the QGIS Server WMS and WFS capabilities, extent and CRS restrictions. More
information available in section Prepare a project to serve and subsequent.
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• The Macros tab is used to edit Python macros for projects. Currently, only three macros are available:
openProject(), saveProject() and closeProject().

Figure 9.5: Setările macro din QGIS

• The Relations tab is used to define 1:n relations. The relations are defined in the project properties dialog.
Once relations exist for a layer, a new user interface element in the form view (e.g. when identifying a
feature and opening its form) will list the related entities. This provides a powerful way to express e.g. the
inspection history on a length of pipeline or road segment. You can find out more about 1:n relations support
in Section Creating one or many to many relations.

• In the Data Sources tab, you can:

– Evaluate default values on provider side: When adding new features in a PostGreSQL table, fields
with default value constraint are evaluated and populated at the form opening, and not at the commit
moment. This means that instead of an expression like nextval(’serial’), the field in the Add
Feature form will display expected value (e.g., 25).

– Automatically create transaction groups where possible: When this mode is turned on, all (post-
gres) layers from the same database are synchronised in their edit state, i.e. when one layer is put into
edit state, all are, when one layer is committed or one layer is rolled back, so are the others. Also,
instead of buffering edit changes locally, they are directly sent to a transaction in the database which
gets committed when the user clicks save layer. Note that you can (de)activate this option only if no
layer is being edited in the project.

• The Variables tab lists all the variables available at the project’s level (which includes all global variables).

Besides, it also allows the user to manage project-level variables. Click the button to add a new custom

project-level variable. Likewise, select a custom project-level variable from the list and click the button
to remove it. More information on variables usage in the General Tools Variables section.

9.3 Personalizare

The customization dialog lets you (de)activate almost every element in the QGIS user interface. This can be very
useful if you want to provide your end-users with a ‘light’ version of QGIS, containing only the icons, menus or
panels they need.

Note: Pentru aplicarea modificărilor, trebuie să repornit,i QGIS.
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Figure 9.6: Dialogul de Personalizare

Ticking the Enable customization checkbox is the first step on the way to QGIS customization. This enables
the toolbar and the widget panel from which you can uncheck and thus disable some GUI items.

Elementul configurabil poate fi:

• a Menu or some of its sub-menus from the Bara de Meniuri

• un întreg Panou (see Panouri s, i Bare de Instrumente)

• the Status bar described in Bara de Stare or some of its items

• a Toolbar: the whole bar or some of its icons

• or any widget from any dialog in QGIS: label, button, combobox...

With Switch to catching widgets in main application, you can click on an item in QGIS interface that you want to be hidden
and QGIS automatically unchecks the corresponding entry in the Customization dialog.

Once you setup your configuration, click [Apply] or [Ok] to validate your changes. This configuration becomes
the one used by default by QGIS at the next startup.

The modifications can also be saved in a .ini file using Save To File button. This is a handy way to share a

common QGIS interface among multiple users. Just click on Load from File from the destination computer in
order to import the .ini file. You can also run command line tools and save various setups for different use cases
as well.

Tip: Restaurează cu us, urint, ă setările QGIS predefinite
The initial QGIS GUI configuration can be restored by one of the methods below:

• unchecking Enable customization option in the Customization dialog or click the Check All button

• pressing the [Reset] button in the QSettings frame under Settings → Options menu, System tab

• launching QGIS at a command prompt with the following command line qgis --nocustomization

• setting to false the value of UI → Customization → Enabled variable under Settings → Options menu,
Advanced tab (see the warning).

In most cases, you need to restart QGIS in order to have the change applied.

9.4 Combinat,ii de taste

QGIS provides default keyboard shortcuts for many features. You can find them in section Bara de Meniuri. Ad-
ditionally, the menu option Settings → Configure Shortcuts... allows you to change the default keyboard shortcuts
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and add new keyboard shortcuts to QGIS features.

Figure 9.7: Define shortcut options

Configuration is very simple. Just select a feature from the list and click on :

• [Change] and press the new combination you want to assign as new shortcut

• [Set none] to clear any assigned shortcut

• or [Set default] to backup the shortcut to its original and default value.

Proceed as above for any other tools you wish to customize. Once you have finished your configuration, simply
[Close] the dialog to have your changes applied. You can also [Save] the changes as an .XML file and [Load]
them into another QGIS installation.
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CHAPTER 10

Lucrul cu Proiect,ii

QGIS permite utilizatorilor să definească un CRS (sistem de coordonate de referint,ă) global s, i la nivel de proiect,
pentru straturi fără un CRS predefinit. De asemenea, permite utilizatorului să definească sisteme de coordonate
de referint,ă personalizate s, i acceptă proiect,ia din-zbor (OTF) a straturilor vectoriale s, i raster. Toate aceste entităt,i
permit utilizatorului să afis, eze straturi cu CRS-uri diferite s, i să le suprapună în mod corespunzător.

10.1 Privire de ansamblu asupra Suportului Proiect,iei

QGIS has support for approximately 2,700 known CRSs. Definitions for each CRS are stored in a SQLite database
that is installed with QGIS. Normally, you do not need to manipulate the database directly. In fact, doing so may
cause projection support to fail. Custom CRSs are stored in a user database. See section Sistem Personalizat de
Coordonate de Referint,ă for information on managing your custom coordinate reference systems.

The CRSs available in QGIS are based on those defined by the European Petroleum Search Group (EPSG) and
the Institut Geographique National de France (IGNF) and are largely abstracted from the spatial reference tables
used in GDAL. EPSG identifiers are present in the database and can be used to specify a CRS in QGIS.

In order to use OTF projection, either your data must contain information about its coordinate reference system or
you will need to define a global, layer or project-wide CRS. For PostGIS layers, QGIS uses the spatial reference
identifier that was specified when the layer was created. For data supported by OGR, QGIS relies on the presence
of a recognized means of specifying the CRS. In the case of shapefiles, this means a file containing the well-known
text (WKT) specification of the CRS. This projection file has the same base name as the shapefile and a .prj
extension. For example, a shapefile named alaska.shp would have a corresponding projection file named
alaska.prj.

Whenever you select a new CRS, the layer units will automatically be changed in the General tab of the Project

Properties dialog under the Project (or Settings) menu.

10.2 Specificat,ii Globale de Proiect,ie

QGIS starts each new project using the global default projection. The global default CRS is EPSG:4326 - WGS 84
(proj=longlat +ellps=WGS84 +datum=WGS84 +no_defs), and it comes predefined in QGIS. This

default can be changed via the Select CRS button in the first section, which is used to define the default coordinate
reference system for new projects, as shown in figure_projection_options. This choice will be saved for use in
subsequent QGIS sessions.

When you use layers that do not have a CRS, you need to define how QGIS responds to these layers. This can be
done globally or project-wide in the CRS tab under Settings → Options.

The options shown in figure_projection_options are:

• Se cere CRS-ul
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Figure 10.1: Fila CRS din Dialogul Opt,iunilor QGIS

• Utilizează CRS-ul proiectului

• Utilizează CRS-ul implicit, afis, at mai jos

If you want to define the coordinate reference system for a certain layer without CRS information, you can also do
that in the General tab of the raster and vector properties dialog (see General Properties for rasters and General
Properties for vectors). If your layer already has a CRS defined, it will be displayed as shown in General tab in
vector layers properties dialog.

Tip: CRS in the Layers Panel
Right-clicking on a layer in the Layers Panel (section Panoul Straturilor) provides two CRS shortcuts. Set layer
CRS takes you directly to the Coordinate Reference System Selector dialog (see figure_projection_project). Set
project CRS from Layer redefines the project CRS using the layer’s CRS.

10.3 Define On The Fly (OTF) CRS Transformation

QGIS supports on the fly CRS transformation for both raster and vector data. However, OTF is not activated by
default. When OTF is off, each layer is drawn using the coordinates as read from the data source. When OTF is
on, each layer’s coordinates are transformed to the CRS of the project.

There are three ways to enable On The Fly CRS Transformation:

• Select Project Properties → CRS from the Project ( or Settings) menu. You can then activate the

Enable on the fly CRS transformation (OTF) checkbox in the CRS tab and select the CRS to use
(see Coordinate Reference System Selector)
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• Click on the CRS status icon in the lower right-hand corner of the status bar, leading you to the previous
dialog.

• Turn OTF on by default in the CRS tab of the Settings → Options dialog by selecting Enable ‘on
the fly’ reprojection by default or Automatically enable ‘on the fly’ reprojection if layers have different CRS.

If you have already loaded a layer and you want to enable OTF reprojection, the best practice is to open the

CRS tab of the Project Properties dialog, activate the Enable ‘on the fly’ CRS transformation checkbox, and

select a CRS. The CRS status icon will no longer be greyed out, and all layers will be OTF projected to the CRS
shown next to the icon.

Figure 10.2: Dialogul Proprietăt,ilor de Proiect,ie

10.4 Coordinate Reference System Selector

This dialog helps you assign a Coordinate Reference System to a project or a layer, provided a set of projection
databases. Items in the dialog are:

• Filter: If you know the EPSG code, the identifier, or the name for a coordinate reference system, you can
use the search feature to find it. Enter the EPSG code, the identifier or the name.

• Recently used coordinate reference systems: If you have certain CRSs that you frequently use in your
everyday GIS work, these will be displayed in this list. Click on one of these items to select the associated
CRS.

• Coordinate reference systems of the world: This is a list of all CRSs supported by QGIS, including
Geographic, Projected and Custom coordinate reference systems. To define a CRS, select it from the list by
expanding the appropriate node and selecting the CRS. The active CRS is preselected.

• PROJ.4 text: This is the CRS string used by the PROJ.4 projection engine. This text is read-only and
provided for informational purposes.

Tip: Looking for a layer CRS? Use the CRS selector.
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Sometimes, you receive a layer and you don’t know its projection. Assuming that you have another layer with a
valid crs that should overlaps with it, enable the OTF reprojection and, in the General tab of the Layer properties
dialog, use the Coordinate Reference System selector to assign a projection. Your layer position is then moved
accordingly. You may have to do some trial and error in order to find the right position, hence its original CRS.

Note: When operating across layers, for example, computing intersections between two layers, it is important
that both layers have the same CRS. To change the projection of an existing layer, it is insufficient to simply
change the CRS in that layer’s properties. Instead you must save the layer as a new layer, and choose the desired
CRS for the new layer.

10.5 Sistem Personalizat de Coordonate de Referint,ă

If QGIS does not provide the coordinate reference system you need, you can define a custom CRS. To define a

CRS, select Custom CRS... from the Settings menu. Custom CRSs are stored in your QGIS user database. In
addition to your custom CRSs, this database also contains your spatial bookmarks and other custom data.

Figure 10.3: Dialogul CRS-urilor Personalizate

Defining a custom CRS in QGIS requires a good understanding of the PROJ.4 projection library. To begin, refer to
“Cartographic Projection Procedures for the UNIX Environment - A User’s Manual” by Gerald I. Evenden, U.S.
Geological Survey Open-File Report 90-284, 1990 (available at ftp://ftp.remotesensing.org/proj/OF90-284.pdf).
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Acest manual descrie utilizarea proj.4 s, i a utilitarelor aferente, pentru linia de comandă. Parametrii cartografici
utilizat,i cu proj.4 sunt descris, i în manualul de utilizare, fiind identici cu cei utilizat,i de QGIS.

P entru a defini un utilizator CRS, dialogul de Definire a Sistemului de Coordonate de Referint,ă necesită doar doi
parametri:

1. Un nume descriptiv

2. Parametrii cartografici în format PROJ.4

Pentru a crea un nou CRS, facet,i clic pe butonul Adăugare CRS nou, apoi introducet,i un nume descriptiv s, i
parametrii CRS.

Notat,i că Parametrii trebuie să înceapă cu un bloc +proj=, pentru a reprezenta noul sistem de coordonate.

You can test your CRS parameters to see if they give sane results. To do this, enter known WGS 84 latitude and
longitude values in North and East fields, respectively. Click on [Calculate], and compare the results with the
known values in your coordinate reference system.

10.6 Transformări de datum implicite

OTF depends on being able to transform data into a ‘default CRS’, and QGIS uses WGS84. For some CRS there
are a number of transforms available. QGIS allows you to define the transformation used otherwise QGIS uses a
default transformation.

In the CRS tab under Settings → Options you can:

• set QGIS to ask you when it needs define a transformation using Ask for datum transformation when no
default is defined

• edit a list of user defaults for transformations.

QGIS asks which transformation to use by opening a dialogue box displaying PROJ.4 text describing the source
and destination transforms. Further information may be found by hovering over a transform. User defaults can be
saved by selecting Remember selection.
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CHAPTER 11

Gestiunea Surselor de Date

11.1 Deschiderea datelor

Ca parte a unui ecosistem Software cu Sursă Deschisă, QGIS este construit pe diferite biblioteci care, combinate
cu furnizorii proprii, oferă posibilităt,i de a citi s, i de a scrie într-o mult,ime de formate:

• Vector data formats include ESRI formats (shapefiles, geodatabases...), MapInfo and MicroStation file for-
mats, AutoCAD DWG/DXF, GeoPackage, GeoJSON, GRASS, GPX, KML, Comma Separated Values, and
many more... Read the complete list of OGR vector supported formats;

• Raster data formats include ArcInfo Binary Grid, ArcInfo ASCII Grid, JPEG, GeoTIFF, ERDAS IMAGINE,
MBTiles, R or Idrisi rasters, ASCII Gridded XYZ, GDAL Virtual, SRTM, Sentinel Data, and many more...
Read the complete list of raster supported formats;

• Database formats include PostgreSQL/PostGIS, SQLite/SpatiaLite, Oracle, DB2 or MSSQL Spatial,
MySQL...;

• Support of web data services (WM(T)S, WFS, WCS, CSW, ArcGIS Servers...) is also handled by QGIS
providers (see QGIS ca s, i Client de Date OGC);

• De asemenea, putet,i să citit,i fis, ierele acceptate din dosarele arhivate s, i să utilizat,i formatele native QGIS,
cum ar fi straturile virtuale s, i cele de memorie.

As of the date of this document, more than 80 vector and 140 raster formats are supported by the GDAL/OGR and
QGIS native providers.

Note: Not all of the listed formats may work in QGIS for various reasons. For example, some require external
proprietary libraries, or the GDAL/OGR installation of your OS may not have been built to support the format you
want to use. To have a list of available formats, run the command line ogrinfo --formats (for vector) or
check settings → Options → GDAL menu (for raster) in QGIS.

11.1.1 Panoul Navigatorului

QGIS Browser is one of the main panels of QGIS that lets you quickly and easily add your data to projects. It
helps you navigate in your filesystem and manage geodata, regardless the type of layer (raster, vector, table), or
the datasource format (plain or compressed files, database, web services).

To add a layer into a project:

1. right-click on QGIS toolbar and check Browser Panel to activate it or select it from the menu View →

Panels (or Settings → Panels);

2. a browser tree with your filesystem, databases and web services is displayed;

3. find the layer in the list;

87

http://www.gdal.org/ogr_formats.html
http://www.gdal.org/formats_list.html
http://www.gdal.org/


QGIS User Guide, Release 2.18

4. right-click on its name and select Add selected layer(s). Your layer is now added to the Layers Panel and
can be viewed in the map canvas.

Note: You can also add a layer or open a QGIS project directly from the Browser panel by double-clicking its
name or by drag-and-drop into the map canvas.

Once a file is loaded, you can zoom around it using the map navigation tools. To change the style of a layer, open
the Layer Properties dialog by double clicking on the layer name or by right-clicking on the name in the legend
and choosing Properties from the context menu. See section Style Properties for more information on setting
symbology of vector layers.

At the top of the Browser panel, you find some icons that help you to:

• Add Selected Layers: you can also add data into the map canvas by selecting Add selected layer(s) from the
layer’s context menu;

• Refresh the browser tree;

• Filter Browser to search for specific data. Enter a search word or wildcard and the browser will filter the tree
to only show paths to matching DB tables, filenames or folders – other data or folders won’t be displayed.
See the Browser Panel(2) example on the figure_browser_panels. The comparison can be case-sensitive or
not. It can also be set to:

– normal: return any item containing the search text;

– using wildcard(s): fine tune the search using ? and/or * characters to specify the position of the
search text;

– using a regular expression.

• Collapse All the whole tree;

• Enable/disable properties widget: when toggled on, a new widget is added at the bottom of the panel showing, if
applicable, metadatas of the selected item.

Right-click an item in the browser tree helps you to:

• in case of file or table, display its metadata or open it in your project. Tables can even be renamed, deleted
or truncated;

• in case of folder, bookmark it into your favourites, hide it from the browser tree. Hidden folders can be
managed from the Settings → Options → Data Sources tab;

• create connection to databases or web servers;

• refresh, rename or delete schema.

You can also import files into databases or copy tables from one schema/database to another one with a simple
drag-and-drop. There is a second browser panel available to avoid long scrolling while dragging. Just select the
file and drag-and-drop from one panel to the other.

Tip: Add layers to QGIS by simple drag-and-drop from your OS file browser
You can also add file(s) to the project by drag-and-dropping them from your operating system file browser to the
Layers Panel or the map canvas.

11.1.2 The DB Manager

The DB Manager Plugin is another one of the main and native tools to integrate and manage spatial database
formats supported by QGIS (PostGIS, SpatiaLite, GeoPackage, Oracle Spatial, MSSQL, DB2, Virtual layers) in
one user interface. It can be activated from the Plugins → Manage and Install Plugins... menu.
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Figure 11.1: Panourile Navigatorului QGIS, unul lângă altul

The DB Manager Plugin provides several features:

• connect to databases and display its structure and contents;

• preview tables of databases;

• add layers to map canvas, either by double-click or drag-and-drop;

• add layers to a database from the QGIS Browser or from another database;

• create and add output of SQL queries to the map canvas;

• create virtual layers.

More information on DB Manager capabilities are exposed in Plugin-ul DB Manager.

11.1.3 Provider-based loading tools

Beside Browser Panel and DB Manager, the main tools provided by QGIS to add layers regardless the format,
you’ll also find tools that are specific to data providers.

Note: Some external plugins also propose tools to open specific format files in QGIS.

Încărcarea unui strat dintr-un fis, ier

To load a layer from a file, you can:

• for vector data (like Shapefile, Mapinfo or dxf layer), click on Add Vector Layer toolbar button, select the

Layer → Add Layer → Add Vector Layer menu option or press Ctrl+Shift+V. This will bring up a
new window (see figure_vector_add) from which you can check File and click on [Browse]. You can
also specify the encoding for the file if desired.
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Figure 11.2: DB Manager dialog

Figure 11.3: Add Vector Layer Dialog
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• for raster layers, click on the Add Raster Layer icon, select the Layer → Add Layer → Add Raster Layer
menu option or type Ctrl+Shift+R.

That will bring up a standard open file dialog (see figure_vector_open), which allows you to navigate the file

system and load a shapefile, a geotiff or other supported data source. The selection box Filter allows you
to preselect some supported file formats. Only the formats that have been well tested appear in the list. Other
untested formats can be loaded by selecting All files (*.*).

Figure 11.4: Open an OGR Supported Vector Layer Dialog

Selecting a file from the list and clicking [Open] loads it into QGIS. More than one layer can be loaded at the same
time by holding down the Ctrl or Shift key and clicking on multiple items in the dialog. Figure_vector_loaded
shows QGIS after loading the alaska.shp file.

Note: Because some formats like MapInfo (e.g., .tab) or Autocad (.dxf) allow mixing different types of
geometry in a single file, loading such format in QGIS opens a dialog to select geometries to use in order to have
one geometry per layer.

Using the Add Vector Layer tool:

• You can also load specific formats like ArcInfo Binary Coverage, UK. National Transfer
Format, as well as the raw TIGER format of the US Census Bureau or OpenfileGDB. To do that,
you’d need to select Directory as Source type. In this case a directory can be selected in the dialog after
pressing [Browse].

• With the Database source type you can select an existing database connection or create one to
the selected database type. Available database types are ODBC, OGDI Vectors, Esri Personal
Geodatabase, MySQL as well as PostgreSQL or MSSQL.

Pressing the [New] button opens the Create a New OGR Database Connection dialog whose parameters are
among the ones you can find in Creating a stored Connection. Pressing [Open] you can select from the
available tables for example of the PostGIS enabled database.

• The last source type, Protocol, enables to open data from the web using for example GeoJSON or
CouchDB format. After selecting the type you have to fill URI of the source.

Tip: Load layers and projects from mounted external drives on macOS
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Figure 11.5: QGIS with Shapefile of Alaska loaded

On macOS, portable drives that are mounted beside the primary hard drive do not show up as expected under File
→ Open Project. We are working on a more macOS-native open/save dialog to fix this. As a workaround, you can
type /Volumes in the File name box and press Enter. Then you can navigate to external drives and network
mounts.

Importing a delimited text file

Delimited text file (e.g. .csv, .txt) can be loaded in QGIS using the tools described above. However, loaded
this way, it’ll show up like a simple table data. Sometimes, delimited text files can contain geometric data you’d

want to visualize; this is what the Add Delimited Text Layer is designed for.

Click the toolbar icon Add Delimited Text Layer in the Manage layers toolbar to open the Create a Layer from a
Delimited Text File dialog, as shown in figure_delimited_text.

First, select the file to import (e.g., qgis_sample_data/csv/elevp.csv) by clicking on the [Browse]
button. Once the file is selected, QGIS attempts to parse the file with the most recently used delimiter. To enable
QGIS to properly parse the file, it is important to select the correct delimiter. You can specify a delimiter by
activating:

• CSV (comma separated values);

• Custom delimiters, choosing among some predefined delimiters like comma, space, tab,
semicolon...;

• or Regular expression delimiter and entering text into the Expression field. For example, to change the
delimiter to tab, use \t (this is a regular expression for the tab character).

Once the file is parsed, set Geometry definition to Point coordinates and choose the X and Y fields from the

dropdown lists. If the coordinates are defined as degrees/minutes/seconds, activate the DMS coordinates
checkbox.
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Figure 11.6: Delimited Text Dialog

Finally, enter a layer name (e.g., elevp), as shown in figure_delimited_text. To add the layer to the map, click
[OK]. The delimited text file now behaves as any other map layer in QGIS.

There is also a helper option that allows you to trim leading and trailing spaces from fields — Trim fields.

Also, it is possible to Discard empty fields. If necessary, you can force a comma to be the decimal separator

by activating Decimal separator is comma.

If spatial information is represented by WKT, activate the Well Known Text option and select the field with the
WKT definition for point, line or polygon objects. If the file contains non-spatial data, activate No geometry
(attribute only table) and it will be loaded as an ordinal table.

Additionally, you can enable:

• Use spatial index to improve the performance of displaying and spatially selecting features;

• Use subset index;

• Watch file to watch for changes to the file by other applications while QGIS is running.

Importing a DXF or DWG file

DXF and DWG files can be added to QGIS by simple drag-and-drop from the common Browser Panel. You’ll be
prompted to select the sublayers you’d like to add to the project. Layers are added with random style properties.

Note: DXF files containing several geometry types (point, line and/or polygon), the name of the layer will be
made from <filename.dxf> entities <geometry type>.

To keep the dxf/dwg structure and its symbology in QGIS, you may want to use the dedicated Project →
DWG/DXF Import... tool. Indeed, the DWG/DXF Import dialog allows you to import into GeoPackage database
any element of the drawing file.

In the dialog, you have to:

• Input a location for a GeoPackage file, that will be created to store the DWG/DXF content to;

• Specify which coordinate system the data in the DWG data is in;
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• Then use the [Import] button to select the DWG/DXF file to use (one per geopackage). The GeoPackage
database will be automatically populated with the drawing file content. Depending on the size of the *CAD
file, this could take some time;

• The Expand block references will transform the existing blocks into normal elements;

• the Use curves promotes the output layers geometry type to a curved one.

After the .dwg or .dxf data is imported into the GeoPackage database the frame in the lower half of the dialog
is populated with the list of layers from the imported file. There you can select which layers to add to the QGIS
project:

• At the top, set a Group name to group the drawing files in the project;

• Check layers to show: Each selected layer is added to an ad hoc group which contains vector layers for the
point, line, label and area features of the drawing layer. The style of each layer is setup so that it resembles
the look it originally had in *CAD;

• Check whether layer should be visible at opening;

• Alternatively using the Merge layers option places all layers in a single group;

• Press [OK] to open the layers in QGIS.

Importarea Vectorilor OpenStreetMap

In recent years, the OpenStreetMap project has gained popularity because in many countries no free geodata such
as digital road maps are available. The objective of the OSM project is to create a free editable map of the world
from GPS data, aerial photography or local knowledge. To support this objective, QGIS provides support for OSM
data.

Using the Browser Panel, you can load a .osm file to the map canvas, in which case you’ll get a dialog to select
sublayers based on the geometry type. The loaded layers will contain all the data of that geometry type in the file
and keep the osm file data structure.

To avoid working with a such complex data structure, and be able to select only features you need based on their
tags, QGIS provides a core and fully integrated OpenStreetMap import tool:

• To connect to the OSM server and download data, open the menu Vector → OpenStreetMap → Download
data.... You can skip this step if you already obtained an .osm XML file using JOSM, Overpass API or any
other source;

• The menu Vector → OpenStreetMap → Import Topology from XML... will convert your .osm file into a
SpatiaLite database and create a corresponding database connection;

• The menu Vector → OpenStreetMap → Export Topology to SpatiaLite... then allows you to open the
database connection, select the type of data you want (points, lines, or polygons) and choose tags to im-

port. This creates a SpatiaLite geometry layer that you can add to your project by clicking on the
Add SpatiaLite Layer toolbar button or by selecting the Add SpatiaLite Layer... option from the Layer menu
(see section Straturile SpatiaLite).

GPS

Loading GPS data in QGIS can be done using the core plugin: GPS Tools. Instructions are described in Section
Plugin-ul GPS.

GRASS

Working with GRASS vector data is described in Section Integrarea GRASS GIS.
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Straturile SpatiaLite

The first time you load data from a SpatiaLite database, begin by:

• clicking on the Add SpatiaLite Layer toolbar button;

• selecting the Add SpatiaLite Layer... option from the Layer → Add Layer menu;

• or by typing Ctrl+Shift+L.

This will bring up a window that will allow you either to connect to a SpatiaLite database already known to QGIS,
which you can choose from the drop-down menu, or to define a new connection to a new database. To define a
new connection, click on [New] and use the file browser to point to your SpatiaLite database, which is a file with
a .sqlite extension.

QGIS also supports editable views in SpatiaLite.

Database related tools

Creating a stored Connection

In order to read and write tables from the many database formats QGIS supports you’ll need to create a connection
to that database. While QGIS Browser Panel is the simplest and recommanded way to connect and use databases
within, QGIS provides specific tools you can use to connect to each of them and load their tables:

• Add PostGIS Layer... or by typing Ctrl+Shift+D

• Add MSSQL Spatial Layer or by typing Ctrl+Shift+M

• Add Oracle Spatial Layer... or typing Ctrl+Shift+O

• Add DB2 Spatial Layer... or typing Ctrl+Shift+2

These tools are accessible either from the Manage Layers Toolbar or the Layer → Add Layer → menu. Connecting
to SpatiaLite database is described at Straturile SpatiaLite.

Tip: Create connection to database from the QGIS Browser Panel
Select the corresponding database format in the Browser tree, right-click and choose connect will provide you
with the database connection dialog.

Most of the connection dialogs follow a common basis that will be described below using the PostGreSQL
database tool as example.

The first time you use a PostGIS data source, you must create a connection to a database that contains the data.
Begin by clicking the appropriate button as exposed above, opening an Add PostGIS Table(s) dialog (see fig-
ure_add_postgis_tables). To access the connection manager, click on the [New] button to display the Create a
New PostGIS Connection dialog.

The parameters required for a PostGIS connection are exposed below. For the other database types, see their
differences at Particular Connection requirements.

• Name: A name for this connection. It can be the same as Database.

• Service: Service parameter to be used alternatively to hostname/port (and potentially database). This can be
defined in pg_service.conf. Check the PostgreSQL Service connection file section for more details.

• Host: Name of the database host. This must be a resolvable host name such as would be used to open a
TCP/IP connection or ping the host. If the database is on the same computer as QGIS, simply enter localhost
here.

• Port: Port number the PostgreSQL database server listens on. The default port for PostGIS is 5432.
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Figure 11.7: Create a New PostGIS Connection Dialog

• Database: Numele bazei de date.

• SSL mode: How the SSL connection will be negotiated with the server. Note that massive speed-ups in
PostGIS layer rendering can be achieved by disabling SSL in the connection editor. The following options
are available:

– Disable: Only try an unencrypted SSL connection;

– Allow: Try a non-SSL connection. If that fails, try an SSL connection;

– Prefer (the default): Try an SSL connection. If that fails, try a non-SSL connection;

– Require: Only try an SSL connection.

• Username: User name used to log in to the database.

• Password: Password used with Username to connect to the database.

You can save any or both of the username and password parameters, in which case they will be used by
default each time you need to connect to this database. If not saved, you’ll be prompted to fill the missing
credentials to connect to the database in next QGIS sessions; meanwhile the connection parameters you
entered are stored in a temporary internal cache and returned whenever a username/password for the same
database is requested, until you close the current QGIS process.

Warning: QGIS User Settings and Security
In the Authentication tab, saving username and password will keep unprotected credentials in the con-
nection configuration. Those credentials will be visible if, for instance, you shared the project file with
someone. Therefore, it’s advisable to save your credentials in a Authentication configuration instead
(Configurations tab - See Sistem de Autentificare for more details) or in a service connection file (see
PostgreSQL Service connection file for example).

Optionally, depending on the type of database, you can activate the following checkboxes:
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• Only show layers in the layer registries

• Don’t resolve type of unrestricted columns (GEOMETRY)

• Only look in the ‘public’ schema

• Also list tables with no geometry

• Use estimated table metadata

Tip: Use estimated table metadata to speed up operations
When initializing layers, various queries may be needed to establish the characteristics of the geometries stored
in the database table. When the Use estimated table metadata option is checked, these queries examine only a
sample of the rows and use the table statistics, rather than the entire table. This can drastically speed up operations
on large datasets, but may result in incorrect characterization of layers (eg. the feature count of filtered layers
will not be accurately determined) and may even cause strange behaviour in case columns that are supposed to be
unique actually are not.

Once all parameters and options are set, you can test the connection by clicking on the [Test connection] button
or apply it hitting [OK]. From the Add PostGIS Table(s), click now on [Connect] and the dialog is filled with
tables from the selected database (as shown in figure_add_postgis_tables).

Particular Connection requirements

Because of database type particularities, provided options are all the same for all the databases. Below are exposed
these connection specificities.

PostgreSQL Service connection file The service connection file allows PostgreSQL connection parameters to
be associated with a single service name. That service name can then be specified by a client and the associated
settings will be used.

It’s called .pg_service.conf under *nix systems (GNU/Linux, macOS etc.) and pg_service.conf on
Windows.

The service file looks like:

[water_service]
host=192.168.0.45
port=5433
dbname=gisdb
user=paul
password=paulspass

[wastewater_service]
host=dbserver.com
dbname=water
user=waterpass

Note: There are two services in the above example: water_service and wastewater_service. You can
use these to connect from QGIS, pgAdmin etc. by specifying only the name of the service you want to connect to
(without the enclosing brackets). If you want to use the service with psql you need to do something like export
PGSERVICE=water_service before doing your psql commands.

Note: You can find all the parameters here

Note: If you don’t want to save the passwords in the service file you can use the .pg_pass option.
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On *nix operating systems (GNU/Linux, macOS etc.) you can save the .pg_service.conf file in the user’s
home directory and the PostgreSQL clients will automatically be aware of it. For example, if the logged user is
web, .pg_service.conf should be saved in the /home/web/ directory in order to directly work (without
specifying any other environment variables).

You can specify the location of the service file by creating a PGSERVICEFILE environment variable (e.g. run
the export PGSERVICEFILE=/home/web/.pg_service.conf command under your *nix OS to tem-
porarily set the PGSERVICEFILE variable)

You can also make the service file available system-wide (all users) either by placing the .pg_service.conf
file at pg_config --sysconfdir or by adding the PGSYSCONFDIR environment variable to specify the
directory containing the service file. If service definitions with the same name exist in the user and the system file,
the user file takes precedence.

Warning: There are some caveats under Windows:
• The service file should be saved as pg_service.conf and not as .pg_service.conf.
• The service file should be saved in Unix format in order to work. One way to do it is to open it with

Notepad++ and Edit → EOL Conversion → UNIX Format → File save.
• You can add environmental variables in various ways; a tested one, known to work reliably, is Control

Panel → System and Security → System → Advanced system settings → Environment Variables adding
PGSERVICEFILE and the path of the type C:\Users\John\pg_service.conf

• After adding an environment variable you may also need to restart the computer.

Connecting to Oracle Spatial The spatial features in Oracle Spatial aid users in managing geographic and
location data in a native type within an Oracle database. In addition to some of the options in Creating a stored
Connection, the connection dialog proposes:

• Database: SID or SERVICE_NAME of the Oracle instance;

• Port: Port number the Oracle database server listens on. The default port is 1521;

• Workspace: Workspace to switch to.

Optionally, you can activate following checkboxes:

• Only look in metadata table: restricts the displayed tables to those that are in the
all_sdo_geom_metadata view. This can speed up the initial display of spatial tables;

• Only look for user’s tables: when searching for spatial tables, restrict the search to tables that are owned
by the user;

• Also list tables with no geometry: indicates that tables without geometry should also be listed by default;

• Use estimated table statistics for the layer metadata: when the layer is set up, various metadata are
required for the Oracle table. This includes information such as the table row count, geometry type and
spatial extents of the data in the geometry column. If the table contains a large number of rows, determining
this metadata can be time-consuming. By activating this option, the following fast table metadata operations
are done: Row count is determined from all_tables.num_rows. Table extents are always determined
with the SDO_TUNE.EXTENTS_OF function, even if a layer filter is applied. Table geometry is determined
from the first 100 non-null geometry rows in the table;

• Only existing geometry types: only list the existing geometry types and don’t offer to add others;

• Include additional geometry attributes.

Tip: Oracle Spatial Layers
Normally, an Oracle Spatial layer is defined by an entry in the USER_SDO_METADATA table.
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Connecting to DB2 Spatial In addition to some of the options described in Creating a stored Connection, the
connection to a DB2 database (see DB2 Spatial Layers for more information) can be specified using either a
Service/DSN name defined to ODBC or using the driver, host and port information.

An ODBC Service/DSN connection requires the service name defined to ODBC.

A driver/host/port connection requires:

• Driver: Name of the DB2 driver. Typically this would be IBM DB2 ODBC DRIVER.

• DB2 Host: Name of the database host. This must be a resolvable host name such as would be used to
open a TCP/IP connection or ping the host. If the database is on the same computer as QGIS, simply enter
localhost here.

• DB2 Port: Port number the DB2 database server listens on. The default DB2 LUW port is 50000. The
default DB2 z/OS port is 446.

Tip: Straturile DB2 Spatial
A DB2 Spatial layer is defined by a row in the DB2GSE.ST_GEOMETRY_COLUMNS view.

Note: In order to work effectively with DB2 spatial tables in QGIS, it is important that tables have an INTEGER
or BIGINT column defined as PRIMARY KEY and if new features are going to be added, this column should also
have the GENERATED characteristic.

It is also helpful for the spatial column to be registered with a specific spatial reference identifier (most often 4326
for WGS84 coordinates). A spatial column can be registered by calling the ST_Register_Spatial_Column
stored procedure.

Connecting to MSSQL Spatial In addition to some of the options in Creating a stored Connection, creating
a new MSSQL connection dialog proposes you to fill a Provider/DSN name. You can also display available
databases.

Încărcarea unui Strat al unei Baze de date

Once you have one or more connections defined to a database (see section Creating a stored Connection), you
can load layers from it. Of course, this requires having available data. See e.g. section Importing Data into
PostgreSQL for a discussion on importing data into a PostGIS database.

To load a layer from a database, you can perform the following steps:

1. Open the “Add <database> table(s)” dialog (see Creating a stored Connection),

2. Choose the connection from the drop-down list and click [Connect].

3. Select or unselect Also list tables with no geometry.

4. Optionally, use some Search Options to reduce the list of tables to those matching your search. You can
also set this option before you hit the [Connect] button, speeding this way the database fetching.

5. Find the layer(s) you wish to add in the list of available layers.

6. Select it by clicking on it. You can select multiple layers by holding down the Shift key while clicking.

7. If applicable, use the [Set Filter] button (or double-click the layer) to start the Query builder dialog (See
section Constructorul de Interogări) and define which features to load from the selected layer. The filter
expression appears in the sql column. This restriction can be removed or edited in the Layer Properties →
General → Provider Feature Filter frame.

8. The checkbox in the Select at id column that is activated by default gets the features ids without the
attributes and speed in most cases the data loading.

9. Click on the [Add] button to add the layer to the map.
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Figure 11.8: Add PostGIS Table(s) Dialog

Tip: Load database table(s) from the Browser Panel
Like simple files, connected database are also listed in the Browser Panel. Hence, you can load tables from
databases using the Browser:

1. Find the layer to use with the Filter Browser tool at the top the browser panel (see Panoul Navigatorului for
the search options);

2. select and drag-and-drop it in the map canvas.

11.1.4 QGIS Custom formats

QGIS proposes two custom formats you can load in the application using their own loading tool:

• Temporary Scratch Layer: a memory layer that is bound to the project it’s opened with (see Creating a new
Temporary Scratch Layer for more information)

• Virtual Layers: a layer resulting from a query on other layer(s) (see Creating virtual layers for more infor-
mation)

11.1.5 Connecting to web services

With QGIS you can have access to different types of OGC web services (WM(T)S, WFS(-T), CSW ...). Thanks
to QGIS Server, you can also publish these services. Description of these capabilities and how-to are provided in
chapter Lucrul cu date OGC.

11.2 Crearea Straturilor

Layers can be created in many ways, including:
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• empty layers from scratch;

• layers from existing layers;

• layers from the clipboard;

• layers as a result of an SQL-like query based on one or many layers: the virtual layer.

QGIS also provides tools to import/export different formats.

11.2.1 Creating new vector layers

QGIS allows you to create new Shapefile layers, new SpatiaLite layers, new GPX layers and new Temporary
Scratch layers. Creation of a new GRASS layer is supported within the GRASS plugin. (Please refer to section
Crearea unui nou strat vectorial GRASS for more information on creating GRASS vector layers.)

Crearea unui nou strat de tip Fis, ier Shape

To create a new Shapefile layer, choose Create Layer → New Shapefile Layer... from the Layer menu. The
New Shapefile Layer dialog will be displayed as shown in figure_create_shapefile. Choose the type of layer (point,
line or polygon) and the CRS (coordinate reference system).

Note that QGIS does not yet support creation of 2.5D features (i.e., features with X,Y,Z coordinates).

Figure 11.9: Crearea unui dialog pentru un nou Fis, ier Shape

To complete the creation of the new Shapefile layer, add the desired attributes by specifying a name and type
for each attribute and clicking on the [Add to fields list] button. A first ‘id’ column is added by default but

can be removed, if not wanted. Only Decimal number , Whole number , Text data and Date

attributes are supported. Additionally, depending on the attribute type, you can also define the length and
precision of the new attribute column. Once you are happy with the attributes, click [OK] and provide a name for
the Shapefile. QGIS will automatically add the .shp extension to the name you specify. Once the Shapefile has
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been created, it will be added to the map as a new layer, and you can edit it in the same way as described in section
Digitizarea unui strat vectorial existent.

Creating a new SpatiaLite layer

To create a new SpatiaLite layer for editing, choose New → New SpatiaLite Layer... from the Layer menu.
The New SpatiaLite Layer dialog will be displayed as shown in Figure_create_spatialite.

Figure 11.10: Creating a New SpatiaLite layer dialog

The first step is to select an existing SpatiaLite database or to create a new SpatiaLite database. This can be done

with the browse button to the right of the database field. Then, add a name for the new layer, define the

layer type, and specify the coordinate reference system with [Specify CRS]. If desired, you can select Create
an autoincrementing primary key.

To define an attribute table for the new SpatiaLite layer, add the names of the attribute columns you want to create
with the corresponding column type, and click on the [Add to attribute list] button. Once you are happy with the
attributes, click [OK]. QGIS will automatically add the new layer to the legend, and you can edit it in the same
way as described in section Digitizarea unui strat vectorial existent.

Further management of SpatiaLite layers can be done with the DB Manager. See Plugin-ul DB Manager.
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Creating a new GeoPackage layer

To create a new GeoPackage layer go to Layer → New → New GeoPackage Layer.... The New GeoPackage
Layer dialog will be displayed as shown in figure_create_geopackage.

The first step is to select an existing GeoPackage or create a new one. This can be done by pressing the ellipses
[...] button at the right of the Database field. Then, give a name for the new layer, define the layer type and specify
the coordinate reference system with [Specify CRS].

To define an attribute table for the new GeoPackage layer, add the names of the attribute columns you want to
create with the corresponding column type, and click on the [Add to fields list] button. Once you are happy with
the attributes, click [OK]. QGIS will automatically add the new layer to the legend, and you can edit it in the same
way as described in section Digitizarea unui strat vectorial existent.

Creating a new GPX layer

To create a new GPX file, you need to load the GPS plugin first. Plugins → Plugin Manager... opens the

Plugin Manager Dialog. Activate the GPS Tools checkbox.

When this plugin is loaded, choose New → Create new GPX Layer... from the Layer menu. In the Save new
GPX file as dialog, choose where to save the new file and press [Save]. Three new layers are added to the Layers
Panel: waypoints, routes and tracks with predefined structure.

Creating a new Temporary Scratch Layer

Temporary Scratch Layers are in-memory layers, meaning that they are not saved on disk and will be discarded
when QGIS is closed. They can be handy to store features you temporarily need or as intermediate layers during
geoprocessing operations.

Empty, editable temporary scratch layers can be defined using Layer → Create Layer → New Temporary Scratch
Layer. Here you can create Multipoint, Multiline and Multipolygon Layers beneath Point, Line and

Polygon layers.

You can also create Temporary Scratch Layers from the clipboard. See Creating new layers from the clipboard.

11.2.2 Creating new layers from an existing layer

Both raster and vector layers can be saved in a different format and/or reprojected to a different coordinate refer-
ence system (CRS) using the Save As... function in the layer context menu (by right-clicking in the layer in the
layer tree) or in the Layer → Save As... menu.

Common parameters

The Save As dialog shows several parameters to change the behavior when saving the layer. Common parameters
for raster and vector are:

• Format

• File name

• CRS can be changed to reproject the data

• Add saved file to map to add the new layer to the canvas

• Extent (possible values are layer, Map view or user-defined extent)

However, some parameters are specific to raster and vector formats:
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Figure 11.11: Creating a New GeoPackage layer dialog
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Raster specific parameters

• Output mode (it can be raw data or rendered image)

• Rezolut,ie

• Create Options: advanced options (file compression, block sizes, colorimetry...) to fine tune the output file.
See the gdal-ogr driver documentation.

• Pyramids creation

• VRT Tiles

• No data values

Figure 11.12: Saving as a new raster layer

Vector specific parameters

Depending on the format of export, some of these options are available or not:

• Encoding

• Save only selected features

• Select fields to export and their export options. In case you set your fields behavior with some Edit widgets,

e.g. value map, you can keep the displayed values in the layer by checking Replace all selected raw
fields values by displayed values.

• Symbology export: can be used mainly for DXF export and for all file formats who manage OGR feature
styles (see note below) as DXF, KML, tab file formats:

– No symbology: default style of the application that reads the data

– Feature symbology: save style with OGR Feature Styles (see note below)
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– Symbol Layer symbology: save with OGR Feature Styles (see note below) but export the same
geometry multiple times if there are multiple symbology symbol layers used

– A Scale value can be applied to the latest options.

Note: OGR Feature Styles are a way to store style directly in the data as a hidden attribute. Only some formats
can handle this kind of information. KML, DXF and TAB file formats are such formats. For advanced users, you
can read the OGR Feature Styles specification document.

• Geometry: you can configure the geometry capabilities of the output layer

– geometry type: keep the original geometry of the features when set to Automatic, otherwise removes
or overrides it with any type. You can add an empty geometry column to an attribute table, remove the
geometry column of a spatial layer.

– Force multi-type: force creation of multi-geometry features in the layer

– Include z-dimension to geometries.

Tip: Overriding layer geometry type makes it possible to do things like save a geometryless table (e.g. .csv
file) into a shapefile WITH any type of geometry (point, line, polygon), so that geometries can then be manually

added to rows with the Add Part tool .

• Datasources Options, Layer Options or Custom Options which allow you to configure some advanced pa-
rameters. See the gdal-ogr driver documentation.

Figure 11.13: Saving as a new vector layer

When saving a vector layer into an existing file, depending on the capabilities of the output format (Geopackage,
SpatiaLite, FileGDB...), the user can decide whether to:
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• overwrite the whole file

• overwrite only the target layer (the layer name is configurable)

• append features to the existing target layer

• append features, add new fields if there are any.

For formats like ESRI Shapefile, MapInfo .tab, feature append is also available.

11.2.3 Creating new DXF files

Besides the Save As... dialog which provides options to export a single layer to another format, including *.DXF,
QGIS provides another tool to export multiple layers as a single DXF layers. It’s accessible in the Project → DXF
Export... menu.

The DXF Export dialog allows the user to:

• indicate the destination layer file;

• choose the symbology mode and scale (see the OGR Feature Styles note);

• select the encoding and CRS;

• check the loaded layers to include in the DXF files or pick them from an existing visibility preset.

For each layer, you can choose a field whose values are used to split features in generated destination layers

in the DXF output. You can also choose to Use the layer title as name if set and keep features grouped.

• choose to only Export features intersecting the current map extent.

11.2.4 Creating new layers from the clipboard

Features that are on the clipboard can be pasted into a new layer. To do this, Select some features, copy them to
the clipboard, and then paste them into a new layer using Edit → Paste Features as → and choosing:

• New Vector Layer...: you need to select the layer CRS, poping up the Save vector layer as... dialog from
which you can select any supported data format (see Creating new layers from an existing layer for param-
eters);

• or Temporary Scratch Layer...: you need to select the layer CRS and give a name.

A new layer, filled with selected features and their attributes is created and added to map canvas if asked.

Note: Creating layers from clipboard applies to features selected and copied within QGIS and also to features
from another source defined using well-known text (WKT).

11.2.5 Creating virtual layers

Virtual layers are a special kind of vector layer. They allow you to define a layer as the result of an SQL query in-
volving any number of other vector layers that QGIS is able to open. Virtual layers do not carry data by themselves
and can be seen as views to other layers.

To create a virtual layer, open the virtual layer creation dialog by clicking on Add Virtual Layer in the Layer menu
or from the corresponding toolbar.

The dialog allows you to specify a Layer name and an SQL Query. The query can use the name (or id) of loaded
vector layers as tables, as well as their field names as columns.

For example, if you have a layer called airports, you can create a new virtual layer called
public_airports with an SQL query like:
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SELECT *
FROM airports
WHERE USE = "Civilian/Public"

The SQL query will be executed, regardless of the underlying provider of the airports layer, even if this
provider does not directly support SQL queries.

Figure 11.14: Create virtual layers dialog

Joins and complex queries can also be created, for example, to join airports and country information:

SELECT airports.*, country.population
FROM airports
JOIN country
ON airports.country = country.name

Note: It’s also possible to create virtual layers using the SQL window of Plugin-ul DB Manager.

Embedding layers for use in queries

Besides the vector layers available in the map canvas, the user can add layers to the Embedded layers list, which
he can use in queries without the need to have them showing in the map canvas or Layers panel.

To embed a layer, click Add and provide the Local name, Provider, Encoding and the path to the Source.

The Import button allows adding layers loaded in the map canvas into the Embedded layers list. This allows to
later remove those layers from the Layers panel without breaking any existent query.

Supported query language

The underlying engine uses SQLite and SpatiaLite to operate.

It means you can use all of the SQL your local installation of SQLite understands.
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Functions from SQLite and spatial functions from SpatiaLite can also be used in a virtual layer query. For instance,
creating a point layer out of an attribute-only layer can be done with a query similar to:

SELECT id, MakePoint(x, y, 4326) as geometry
FROM coordinates

Functions of QGIS expressions can also be used in a virtual layer query.

To refer the geometry column of a layer, use the name geometry.

Contrary to a pure SQL query, all the fields of a virtual layer query must be named. Don’t forget to use the as
keyword to name your columns if they are the result of a computation or function call.

Probleme legate de performant,ă

With default parameters set, the virtual layer engine will try its best to detect the type of the different columns of
the query, including the type of the geometry column if one is present.

This is done by introspecting the query when possible or by fetching the first row of the query (LIMIT 1) at last
resort. Fetching the first row of the result just to create the layer may be undesirable for performance reasons.

The creation dialog allows to specify different parameters:

• Unique identifier column: this option allows specifying which field of the query represents unique integer
values that QGIS can use as row identifiers. By default, an autoincrementing integer value is used. Defining
a unique identifier column allows to speed up the selection of rows by id.

• No geometry: this option forces the virtual layer to ignore any geometry field. The resulting layer is an
attribute-only layer.

• Geometry Column: this option allows to specify the name of the column that is to be used as the geometry
of the layer.

• Geometry Type: this option allows to specify the type of the geometry of the virtual layer.

• Geometry CRS: this option allows to specify the coordinate reference system of the virtual layer.

Special comments

The virtual layer engine tries to determine the type of each column of the query. If it fails, the first row of the
query is fetched to determine column types.

The type of a particular column can be specified directly in the query by using some special comments.

The syntax is the following: /*:type*/. It has to be placed just after the name of a column. type can be either
int for integers, real for floating point numbers or text.

For instance:

SELECT id+1 as nid /*:int*/
FROM table

The type and coordinate reference system of the geometry column can also be set thanks to special comments
with the following syntax /*:gtype:srid*/ where gtype is the geometry type (point, linestring,
polygon, multipoint, multilinestring or multipolygon) and srid an integer representing the
EPSG code of a coordinate reference system.

Use of indexes

When requesting a layer through a virtual layer, indexes of this source layer will be used in the following ways:

• if an = predicate is used on the primary key column of the layer, the underlying data provider will be asked
for a particular id (FilterFid)
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• for any other predicates (>, <=, !=, etc.) or on a column without a primary key, a request built from an
expression will be used to request the underlying vector data provider. It means indexes may be used on
database providers if they exist.

A specific syntax exists to handle spatial predicates in requests and triggers the use of a spatial index: a hidden
column named _search_frame_ exists for each virtual layer. This column can be compared for equality to a
bounding box. Example:

SELECT *
FROM vtab
WHERE _search_frame_=BuildMbr(-2.10,49.38,-1.3,49.99,4326)

Spatial binary predicates like ST_Intersects are significantly sped up when used in conjunction with this
spatial index syntax.

11.3 Explorarea Formatelor de Date s, i a Câmpurilor

11.3.1 Datele raster

Raster data in GIS are matrices of discrete cells that represent features on, above or below the earth’s surface. Each
cell in the raster grid has the same size, and cells are usually rectangular (in QGIS they will always be rectangular).
Typical raster datasets include remote sensing data, such as aerial photography, or satellite imagery and modelled
data, such as an elevation matrix.

Unlike vector data, raster data typically do not have an associated database record for each cell. They are geocoded
by pixel resolution and the x/y coordinate of a corner pixel of the raster layer. This allows QGIS to position the
data correctly in the map canvas.

QGIS makes use of georeference information inside the raster layer (e.g., GeoTiff) or in an appropriate world file
to properly display the data.

11.3.2 Datele Vectoriale

Many of the features available in QGIS work the same, regardless the vector data source. However, because of the
differences in formats specifications (ESRI shapefiles, MapInfo and MicroStation file formats, AutoCAD DXF,
PostGIS, SpatiaLite, DB2, Oracle Spatial and MSSQL Spatial databases, and many more), QGIS may handle
differently some of their properties. This section describes how to work with these specificities.

Note: QGIS supports (multi)point, (multi)line, (multi)polygon, CircularString, CompoundCurve, CurvePolygon,
MultiCurve, MultiSurface feature types, all with Z and/or M values.

You should note also that some drivers don’t support some of these feature types like CircularString, Compound-
Curve, CurvePolygon, MultiCurve, MultiSurface feature type. QGIS will convert them to (multi)polygon feature.

ESRI Shapefiles

The ESRI shapefile is still one of the most used vector file format in QGIS. However, this file format has some
limitation that some other file format have not (like Geopackage, spatialite). Support is provided by the OGR
Simple Feature Library.

A shapefile actually consists of several files. The following three are required:

1. Fis, ierul .shp care cont,ine geometriile entităt,ii

2. .dbf file containing the attributes in dBase format

3. .shx index file
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Shapefiles also can include a file with a .prj suffix, which contains the projection information. While it is very
useful to have a projection file, it is not mandatory. A shapefile dataset can contain additional files. For further
details, see the ESRI technical specification at http://www.esri.com/library/whitepapers/pdfs/shapefile.pdf.

Improving Performance for Shapefiles

To improve the performance of drawing a shapefile, you can create a spatial index. A spatial index will improve
the speed of both zooming and panning. Spatial indexes used by QGIS have a .qix extension.

Use these steps to create the index:

• Load a shapefile (see Panoul Navigatorului);

• Open the Layer Properties dialog by double-clicking on the shapefile name in the legend or by right-clicking
and choosing Properties from the context menu.

• In the General tab, click the [Create Spatial Index] button.

Problem loading a shape .prj file

If you load a shapefile with a .prj file and QGIS is not able to read the coordinate reference system from that
file, you will need to define the proper projection manually within the General tab of the Layer Properties dialog
of the layer by clicking the [Specify...] button. This is due to the fact that .prj files often do not provide the
complete projection parameters as used in QGIS and listed in the CRS dialog.

For the same reason, if you create a new shapefile with QGIS, two different projection files are created: a .prj
file with limited projection parameters, compatible with ESRI software, and a .qpj file, providing the complete
parameters of the used CRS. Whenever QGIS finds a .qpj file, it will be used instead of the .prj.

Delimited Text Files

Tabular data is a very common and widely used format because of its simplicity and readability – data can be
viewed and edited even in a plain text editor. A delimited text file is an attribute table with each column separated
by a defined character and each row separated by a line break. The first row usually contains the column names. A
common type of delimited text file is a CSV (Comma Separated Values), with each column separated by a comma.

Such data files can also contain positional information in two main forms:

• As point coordinates in separate columns

• As well-known text (WKT) representation of geometry

QGIS allows you to load a delimited text file as a layer or ordinal table. But first check that the file meets the
following requirements:

1. The file must have a delimited header row of field names. This must be the first line in the text file.

2. The header row must contain field(s) with geometry definition. These field(s) can have any name.

3. The X and Y coordinates (if geometry is defined by coordinates) must be specified as numbers. The coor-
dinate system is not important.

4. If you have any data that is not a string (text) and the file is a CSV file, you must have a CSVT file (see
section CSVT Files).

As an example of a valid text file, we import the elevation point data file elevp.csv that comes with the QGIS
sample dataset (see section Sample Data):

X;Y;ELEV
-300120;7689960;13
-654360;7562040;52
1640;7512840;3
[...]

Some items to note about the text file:

1. The example text file uses ; (semicolon) as delimiter. Any character can be used to delimit the fields.
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2. The first row is the header row. It contains the fields X, Y and ELEV.

3. No quotes (") are used to delimit text fields.

4. The X coordinates are contained in the X field.

5. The Y coordinates are contained in the Y field.

CSVT Files

When loading CSV files, the OGR driver assumes all fields are strings (i.e. text) unless it is told otherwise. You
can create a CSVT file to tell OGR (and QGIS) what data type the different columns are:

Type Name Exemplu
Număr întreg Întreg 4
Număr zecimal Real 3.456
Date Date (YYYY-MM-DD) 2016-07-28
Time Time (HH:MM:SS+nn) 18:33:12+00
Date & Time DateTime (YYYY-MM-DD HH:MM:SS+nn) 2016-07-28 18:33:12+00

The CSVT file is a ONE line plain text file with the data types in quotes and separated by commas, e.g.:

"Integer","Real","String"

You can even specify width and precision of each column, e.g.:

"Integer(6)","Real(5.5)","String(22)"

This file is saved in the same folder as the .csv file, with the same name, but .csvt as the extension.

You can find more information at GDAL CSV Driver.

Others valuable informations for advanced users

Features with curved geometries (CircularString, CurvePolygon and CompoundCurve) are supported. Here are
three examples of such geometry types as a delimited text with WKT geometries:

Label;WKT_geom
CircularString;CIRCULARSTRING(268 415,227 505,227 406)
CurvePolygon;CURVEPOLYGON(CIRCULARSTRING(1 3, 3 5, 4 7, 7 3, 1 3))
CompoundCurve;COMPOUNDCURVE((5 3, 5 13), CIRCULARSTRING(5 13, 7 15,

9 13), (9 13, 9 3), CIRCULARSTRING(9 3, 7 1, 5 3))

Delimited Text supports also Z and M coordinates in geometries:

LINESTRINGM(10.0 20.0 30.0, 11.0 21.0 31.0)

Straturi PostGIS

PostGIS layers are stored in a PostgreSQL database. The advantages of PostGIS are its spatial indexing, filtering
and querying capabilities it provides. Using PostGIS, vector functions such as select and identify work more
accurately than they do with OGR layers in QGIS.

Tip: Straturi PostGIS
Normally, a PostGIS layer is defined by an entry in the geometry_columns table. QGIS can load layers that do
not have an entry in the geometry_columns table. This includes both tables and views. Defining a spatial view
provides a powerful means to visualize your data. Refer to your PostgreSQL manual for information on creating
views.
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This section contains some details on how QGIS accesses PostgreSQL layers. Most of the time, QGIS should
simply provide you with a list of database tables that can be loaded, and it will load them on request. However,
if you have trouble loading a PostgreSQL table into QGIS, the information below may help you understand any
QGIS messages and give you direction on changing the PostgreSQL table or view definition to allow QGIS to
load it.

Cheie primară

QGIS requires that PostgreSQL layers contain a column that can be used as a unique key for the layer. For tables,
this usually means that the table needs a primary key, or a column with a unique constraint on it. In QGIS, this
column needs to be of type int4 (an integer of size 4 bytes). Alternatively, the ctid column can be used as primary
key. If a table lacks these items, the oid column will be used instead. Performance will be improved if the column
is indexed (note that primary keys are automatically indexed in PostgreSQL).

QGIS offers a checkbox Select at id that is activated by default. This option gets the ids without the attributes
which is faster in most cases.

Vizualizare

If the PostgreSQL layer is a view, the same requirement exists, but views do not always have primary keys or
columns with unique constraints on them. You have to define a primary key field (has to be integer) in the QGIS
dialog before you can load the view. If a suitable column does not exist in the view, QGIS will not load the layer.
If this occurs, the solution is to alter the view so that it does include a suitable column (a type of integer and either
a primary key or with a unique constraint, preferably indexed).

As for table, a checkbox Select at id is activated by default (see above for the meaning of the checkbox). It can
make sense to disable this option when you use expensive views.

QGIS layer_style table and database backup

If you want to make a backup of your PostGIS database using the pg_dump and pg_restore commands, and
the default layer styles as saved by QGIS fail to restore afterwards, you need to set the XML option to DOCUMENT
and the restore will work.

SET XML OPTION DOCUMENT;

Filter database side

QGIS allows to filter features already on server side. Check the Settings → Options → Data Sources →
Execute expressions on postgres server-side if possible checkbox to do so. Only supported expressions will be sent
to the database. Expressions using unsupported operators or functions will gracefully fallback to local evaluation.

Support of PostgreSQL data types

Most of common data types are supported by the PostgreSQL provider: integer, float, varchar, geometry and
timestamp.

Array data types are not supported.

Importing Data into PostgreSQL

Data can be imported into PostgreSQL/PostGIS using several tools, including the DB Manager plugin and the
command line tools shp2pgsql and ogr2ogr.
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DB Manager

QGIS comes with a core plugin named DB Manager. It can be used to load shapefiles and other data formats, and
it includes support for schemas. See section Plugin-ul DB Manager for more information.

shp2pgsql

PostGIS includes an utility called shp2pgsql that can be used to import shapefiles into a PostGIS-enabled database.
For example, to import a shapefile named lakes.shp into a PostgreSQL database named gis_data, use the
following command:

shp2pgsql -s 2964 lakes.shp lakes_new | psql gis_data

This creates a new layer named lakes_new in the gis_data database. The new layer will have a spatial
reference identifier (SRID) of 2964. See section Lucrul cu Proiect,ii for more information on spatial reference
systems and projections.

Tip: Exporting datasets from PostGIS
Like the import tool shp2pgsql, there is also a tool to export PostGIS datasets as shapefiles: pgsql2shp. This is
shipped within your PostGIS distribution.

ogr2ogr

Besides shp2pgsql and DB Manager, there is another tool for feeding geodata in PostGIS: ogr2ogr. This is part
of your GDAL installation.

To import a shapefile into PostGIS, do the following:

ogr2ogr -f "PostgreSQL" PG:"dbname=postgis host=myhost.de user=postgres
password=topsecret" alaska.shp

This will import the shapefile alaska.shp into the PostGIS database postgis using the user postgres with the
password topsecret on host server myhost.de.

Note that OGR must be built with PostgreSQL to support PostGIS. You can verify this by typing (in )

ogrinfo --formats | grep -i post

If you prefer to use PostgreSQL’s COPY command instead of the default INSERT INTO method, you can export

the following environment variable (at least available on and ):

export PG_USE_COPY=YES

ogr2ogr does not create spatial indexes like shp2pgsl does. You need to create them manually, using the normal
SQL command CREATE INDEX afterwards as an extra step (as described in the next section Îmbunătăt,irea
Performant,ei).

Îmbunătăt,irea Performant,ei

Retrieving features from a PostgreSQL database can be time-consuming, especially over a network. You can im-
prove the drawing performance of PostgreSQL layers by ensuring that a PostGIS spatial index exists on each layer
in the database. PostGIS supports creation of a GiST (Generalized Search Tree) index to speed up spatial searches
of the data (GiST index information is taken from the PostGIS documentation available at http://postgis.net).

Tip: You can use the DBManager to create an index to your layer. You should first select the layer and click on
Table → Edit table, go to Indexes tab and click on [Add spatial index].
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The syntax for creating a GiST index is:

CREATE INDEX [indexname] ON [tablename]
USING GIST ( [geometryfield] GIST_GEOMETRY_OPS );

Note that for large tables, creating the index can take a long time. Once the index is created, you should perform
a VACUUM ANALYZE. See the PostGIS documentation (POSTGIS-PROJECT Literatură s, i Referint,e Web) for
more information.

The following is an example of creating a GiST index:

gsherman@madison:~/current$ psql gis_data
Welcome to psql 8.3.0, the PostgreSQL interactive terminal.

Type: \copyright for distribution terms
\h for help with SQL commands
\? for help with psql commands
\g or terminate with semicolon to execute query
\q to quit

gis_data=# CREATE INDEX sidx_alaska_lakes ON alaska_lakes
gis_data-# USING GIST (the_geom GIST_GEOMETRY_OPS);
CREATE INDEX
gis_data=# VACUUM ANALYZE alaska_lakes;
VACUUM
gis_data=# \q
gsherman@madison:~/current$

Vector layers crossing 180° longitude

Many GIS packages don’t wrap vector maps with a geographic reference system (lat/lon) crossing the 180 degrees
longitude line (http://postgis.refractions.net/documentation/manual-2.0/ST_Shift_Longitude.html). As result, if
we open such a map in QGIS, we will see two far, distinct locations, that should appear near each other. In
Figure_vector_crossing, the tiny point on the far left of the map canvas (Chatham Islands) should be within the
grid, to the right of the New Zealand main islands.

Figure 11.15: Map in lat/lon crossing the 180° longitude line

A work-around is to transform the longitude values using PostGIS and the ST_Shift_Longitude function. This
function reads every point/vertex in every component of every feature in a geometry, and if the longitude coordi-
nate is < 0°, it adds 360° to it. The result is a 0° - 360° version of the data to be plotted in a 180°-centric map.

Utilizare

• Import data into PostGIS (Importing Data into PostgreSQL) using, for example, the DB Manager plugin.

• Use the PostGIS command line interface to issue the following command (in this example,
“TABLE” is the actual name of your PostGIS table): gis_data=# update TABLE set
the_geom=ST_Shift_Longitude(the_geom);
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Figure 11.16: Crossing 180° longitude applying the ST_Shift_Longitude function

• If everything went well, you should receive a confirmation about the number of features that were updated.
Then you’ll be able to load the map and see the difference (Figure_vector_crossing_map).

SpatiaLite Layers

If you want to save a vector layer to SpatiaLite format, you can do this by right clicking the layer in the legend.
Then, click on Save as..., define the name of the output file, and select ‘SpatiaLite’ as format and the CRS. Also,
you can select ‘SQLite’ as format and then add SPATIALITE=YES in the OGR data source creation option field.
This tells OGR to create a SpatiaLite database. See also http://www.gdal.org/ogr/drv_sqlite.html.

QGIS also supports editable views in SpatiaLite.

If you want to create a new SpatiaLite layer, please refer to section Creating a new SpatiaLite layer.

Tip: SpatiaLite data management Plugins
For SpatiaLite data management, you can also use several Python plugins: QSpatiaLite, SpatiaLite Manager or
DB Manager (core plugin, recommended). If necessary, they can be downloaded and installed with the Plugin
Installer.

DB2 Spatial Layers

IBM DB2 for Linux, Unix and Windows (DB2 LUW), IBM DB2 for z/OS (mainframe) and IBM DashDB products
allow users to store and analyse spatial data in relational table columns. The DB2 provider for QGIS supports the
full range of visualization, analysis and manipulation of spatial data in these databases.

User documentation on these capabilities can be found at the DB2 z/OS KnowledgeCenter, DB2 LUW Knowl-
edgeCenter and DB2 DashDB KnowledgeCenter.

For more information about working with the DB2 spatial capabilities, check out the DB2 Spatial Tutorial on IBM
DeveloperWorks.

The DB2 provider currently only supports the Windows environment through the Windows ODBC driver.

The client running QGIS needs to have one of the following installed:

• DB2 LUW

• IBM Data Server Driver Package

• IBM Data Server Client
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If you are accessing a DB2 LUW database on the same machine or using DB2 LUW as a client, the DB2 executa-
bles and supporting files need to be included in the Windows path. This can be done by creating a batch file like
the following with the name db2.bat and including it in the directory %OSGEO4W_ROOT%/etc/ini.

@echo off
REM Point the following to where DB2 is installed
SET db2path=C:\Program Files (x86)\sqllib
REM This should usually be ok - modify if necessary
SET gskpath=C:\Program Files (x86)\ibm\gsk8
SET Path=%db2path%\BIN;%db2path%\FUNCTION;%gskpath%\lib64;%gskpath%\lib;%path%
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CHAPTER 12

Lucrul cu Datele Vectoriale

12.1 Biblioteca Simbolurilor

12.1.1 Managerul de Stiluri

The Style Manager is the place where users can manage and create generic symbols to be used in several QGIS
projects. You can open it with the Settings → Style Manager or from the Style tab in the vector layer’s Properties.
It allows users to:

• create, edit and remove symbols

• organize symbols in custom groups

• export and import symbols.

Figure 12.1: Managerul de Stiluri

Groups and smart groups

You can organize symbols into different categories. These categories, listed in the panel at the left, can be static
(called Group) or dynamic (named Smart Group). A group is smart when its symbols are dynamically fetched
according to conditions set. See figure_smart_group:

To create a group, right click on an existing group or on the main Groups directory in the left of the dialog. You

can also select a group and click the Add Group button. The new group will be a sub-group of the selected one.

Create Smart Group is similar to creating group, but instead select Smart Groups. The dialog box allows user
to choose the expression to select symbols in order to appear in the smart group (contains some tags, member of
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a group, have a string in its name, etc.). Any symbol that satisfies the entered condition(s) is automatically added
to the smart group.

Figure 12.2: Crearea unui Grup Inteligent

To remove a group or a smart group, right click on the group and select Remove Group or select it and push
Remove Group button.

Unlike the smart groups that automatically fetch their belonged symbols, simple groups are filled by the user. To
add a symbol into a group, you can either right click on a symbol, choose Apply Group and then the group name.

There is a second way to add several symbols into a group: just select the group, click and choose Group
Symbols. All symbols display a checkbox that allows you to add the symbol into the selected groups. When
selection is finished, you can click the same button, and choose Finish Grouping.

All the symbols that are not placed under a custom group belong to a default group named Ungrouped.

Add, Edit, Remove Symbol

Selecting a group returns in the right panel, if applicable, the list of symbols of the group (including its subgroups).
These symbols are organized in four different tabs:

• Marker for point symbols

• Line for linear symbols

• Fill for surface symbols

• and Gama de Culori.

To delete a symbol you no longer need, just select it and click Remove item (also available through right-click).
The symbol will be deleted from the local symbols database.

The symbol list can be modified by adding new symbols with Add item button or modifying existing ones with
Edit item. See The Symbol Selector for further information.

Share symbols

The Share item tool, at the right bottom of the Style Library dialog, offers options to easily share symbols with
others: users can indeed export their symbols and import symbols to their library.

Exporting symbols

You can export the selected symbols to PNG, SVG or XML file formats. Exporting to PNG or SVG (both not
available for color ramp symbols) creates a file for each selected symbol, and the SVG folder can be added to
SVG Paths in Settings → Options to e.g. share these symbols on a network. The XML format generates a single
file containing all the selected symbols. This file can then be imported in another user’s style library.

Importing symbols
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You can extend your symbols library by importing new symbols. Just select Import from the drop-down list
at the right bottom of the dialog. In the new dialog, you’ll need to :

• indicate the source of the symbols (it can be a .xml file on the disk or an url),

• give the name of the group under which the symbols will be put

• select the symbols you want to add to your library

• and press Import.

Note that import and export options are also available through right-click.

Figure 12.3: Importing symbols

Gama de Culori

The Color ramp tab in the Style Manager presents different types of color ramps you can use to style layers.

To create a custom color ramp, activate the Color ramp tab and click the Add item button. The button reveals a
drop-down list to choose the ramp type:

• Gradient: given a start and end colors, generate a color ramp which can be continuous or discrete. With
double-clicking the ramp preview, you can add as many intermediate color stops as you want.

• Random: creates a random set of colors based on range of values for hue, saturation, value and opacity and
a number of colors (classes)

• ColorBrewer: a set of predefined discrete color gradients you can custom the number of colors in the ramp

• or cpt-city: an access to a whole catalog of color gradients to locally save as gradient color.

Tip: Easily custom the color stops of the gradient color ramp
Double-clicking the ramp preview or drag-and-drop a color from the color spot onto the ramp preview adds a new
color stop. Each color stop can be tweaked using the Selectorul de Culoare widgets or by plotting each of its
parameters. You can also reposition it using the mouse, the arrow keys (combine with Shift key for a larger
move) or the Relative position spinbox. Pressing Delete stop as well as DEL key removes the selected color stop.

You can use the Invert option while classifying the data with a color ramp. See figure_color_custom_ramp for
an example of a custom color ramp and figure_color_cpt_city for the cpt-city Colors dialog.

The cpt-city option opens a new dialog with hundreds of themes included ‘out of the box’.
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Figure 12.4: Exemplu de gradient de culoare personalizat, cu multiple opriri
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Figure 12.5: dialogul cpt-city cu sute de game de culori
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12.1.2 The Symbol Selector

The Symbol selector is the main dialog to design a symbol. You can create or edit Marker, Line or Fill Symbols.

Figure 12.6: Designing a Marker symbol

Two main components structure the symbol selector dialog:

• the symbol tree, showing symbol layers that are combined afterwards to shape a new global symbol

• and settings to configure the selected symbol layer in the tree.

The symbol layer tree

A symbol can consist of several Symbol layers. The symbol tree shows the overlay of these symbol layers that are
combined afterwards to shape a new global symbol. Besides, a dynamic symbol representation is updated as soon
as symbol properties change.

A set of tools is available to manage the symbol tree items and according to the level selected, you’ll get enabled
different tools at the bottom of the dialog to:

• add new symbol layer: you can stack as many symbols as you want

• remove the selected symbol layer

• lock colors of symbol layer: a locked color stays unchanged when user changes the color at the global
(or upper) symbol level

• duplicate a (group of) symbol layer(s)
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• move up or down the symbol layer

Configuring a symbol

In QGIS, configuring a symbol is done in two steps: the symbol and then the symbol layer.

Simbolul

At the top level of the tree, it depends on the layer geometry and can be of Marker, Line or Fill type. Each
symbol can embed one or more symbols (including, of any other type) or symbol layers.

You can setup some parameters that apply to the global symbol:

• Unit: it can be Millimeter, Pixels or Map unit

• Transparent,ă

• Color: when this parameter is changed by the user, its value is echoed to all unlocked sub-symbols color

• Size and Rotation for marker symbols

• Width for line symbols

Note: The Data-defined override button beside the last layer-related parameters is inactive when setting the
symbol from the Style manager dialog. When the symbol is connected to a map layer, this button offers access to
the size assistant dialog which helps to create proportional or multivariate analysis rendering.

The symbols used at this level are items you can pick from the symbols library. A list of available symbols of the
same type from your symbol library is shown and can be filtered by selecting a group in the drop-down list just
above. Click the Save button to add the designed symbol to your symbol library.

With the Advanced option, you can:

• set the symbol levels: defining the way symbol layers are connected to each other in the map canvas (see
Symbols levels for more information)

• and for line and fill symbols, clip features to canvas extent.

Tip: Note that once you have set the size in the lower levels of the Symbol layers dialog, the size of the whole
symbol can be changed with the Size (for marker symbols) or the Width (for line symbols) menu in the first level
again. The size of the lower levels changes accordingly, while the size ratio is maintained.

The symbol layer

At a lower level of the tree, you can customize the symbol layers. The available symbol layer types depend on the

upper symbol type. You can apply on the symbol layer paint effects to enhance its rendering.

Because describing all the options of all the symbol layer types would not be possible, only particular and signi-
ficative ones are mentioned below.

Parametri comuni Some common options and widgets are available to build a symbol layer, regardless it’s of
marker, line or fill sub-type:

• the color selector widget to ease color manipulation

• Units: it can be Millimeter, Pixels or Map unit

• the data-defined override widget near almost all options, extending capabilities of customizing each symbol
(see Configurarea suprascrierii definită de date for more information)
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Note: While the description below assumes that the symbol layer type is bound to the feature geometry, keep
in mind that you can embed symbol layers in each others. In that case, the lower level symbol layer parameter
(placement, offset...) might be bound to the upper-level symbol, and not to the feature geometry itself.

Simbolurile Marcajului Appropriate for point geometry features, marker symbols have several Symbol layer
types:

• Simple marker (default);

• Ellipse marker: a simple marker symbol layer, with customizable width and height;

• Filled marker: similar to the simple marker symbol layer, except that it uses a fill sub symbol to render the
marker. This allows use of all the existing QGIS fill (and outline) styles for rendering markers, e.g. gradient
or shapeburst fills;

• Font marker: use installed fonts as marker symbols;

• Geometry generator (see Generatorul de Geometrii);

• Vector Field marker (see The Vector Field Marker);

• SVG marker: provides you with images from your SVG paths (set in Settings → Options → System menu)
to render as marker symbol. Each SVG file colors and outline can be adapted.

Note: Requirements for a customizable SVG marker symbol

To have the possibility to change the colors of a SVG marker, you have to add the placeholders
param(fill) for fill color, param(outline) for outline color and param(outline-width) for
stroke width. These placeholders can optionally be followed by a default value, e.g.:

<svg width="100%" height="100%">
<rect fill="param(fill) #ff0000" stroke="param(outline) #00ff00" stroke-width="param(stroke-width) 10" width="100" height="100">
</rect>
</svg>

For each marker symbol layer type, you can set some of the following properties:

• Color for the fill and/or stroke, using all the capabilities of the Selectorul de Culoare widget;

• Dimensiune

• Outline style

• Outline width

• Îmbinare stiluri

• Rotation

• Offset X,Y: You can shift the symbol in the x- or y- direction;

• Anchor point.

In most of the marker symbols dialog, you also have a frame with previews of predefined symbols you can choose
from.

Simbolurile Liniei Appropriate for line geometry features, line symbols have following symbol layer types:

• Simple line (default): available settings are:

– Culoare

– Pen width

– Pen style
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– Îmbinare stiluri

– Stilul capătului

– Decalaj

– Use custom dash pattern: overrides the Pen style setting with a custom dash.

• Arrow: draws lines as curved (or not) arrows with a single or a double head with configurable width, length
and thickness. To create a curved arrow the line feature must have at least three vertices. It also uses a fill
symbol such as gradients or shapeburst to render the arrow body. Combined with the geometry generator,
this type of layer symbol helps you representing flow maps;

• Geometry generator (see Generatorul de Geometrii);

• Marker line: displays a marker symbol along the line. It can be at a regular distance or based on its
geometry: first, last or each vertex, on central point or on every curve point. You can set an offset along the
line for the marker symbol, or offset the line itself. The Rotate marker option allows you to set whether the
marker symbol should follow the line orientation or not.

Fill Symbols Appropriate for polygon geometry features, fill symbols have also several symbol layer types:

• Simple fill (default): the following settings are available:

– Fill color

– Outline color

– Stilul de umplere

– Outline style

– Outline width

– Îmbinare stiluri

– Offset X,Y

• Centroid fill: places a marker symbol at the centroid of the visible feature. The position of the marker may
however not be the real centroid of the feature because calculation takes into account the polygon(s) clipped
to area visible in map canvas for rendering and ignores holes. Use Generatorul de Geometrii if you want
the exact centroid.

The marker can be placed on every part of a multi-part feature or only on its biggest part, and forced to be
inside the polygon;

• Geometry generator (see geometry_generator_symbol);

• Gradient fill: uses a radial, linear or conical gradient, based on either simple two color gradients or a
predefined gradient color ramp to fill polygon layers. Gradient can be rotated and applied on a single
feature basis or across the whole map extent. Also start and end points can be set via coordinates or using
the centroid (of feature or map);

• Line pattern fill: fills the polygon with a hatching pattern of line symbol layer. You can set the spacing
between lines and an offset from the feature boundary;

• Point pattern fill: fills the polygon with a hatching pattern of marker symbol layer. You can set the spacing
between lines and an offset from the feature boundary;

• Raster image fill: you can fill polygons with a tiled raster image. Options include (data defined) file name,
opacity, image size (in pixels, mm or map units), coordinate mode (feature or view) and rotation;

• SVG fill: fills the polygon using SVG markers;

• Shapeburst fill: this option buffered a gradient fill, where a gradient is drawn from the boundary of a
polygon towards the polygon’s centre. Configurable parameters include distance from the boundary to
shade, use of color ramps or simple two color gradients, optional blurring of the fill and offsets;

• Outline: Arrow: uses a line arrow symbol layer to represent the polygon boundary;
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• Outline: Marker line: uses a marker line symbol layer to represent the polygon boundary;

• Outline: simple line: uses a simple line symbol layer to represent the polygon boundary. The Draw line
only inside polygon option helps polygon borders inside the polygon and can be useful to clearly represent
adjacent polygon boundaries.

Note: When geometry type is polygon, you can choose to disable the automatic clipping of lines/polygons to the
canvas extent. In some cases this clipping results in unfavourable symbology (e.g. centroid fills where the centroid
must always be the actual feature’s centroid).

Generatorul de Geometrii Available with all types of symbols, the geometry generator symbol layer allows to
use expression syntax to generate a geometry on the fly during the rendering process. The resulting geometry does
not have to match with the original geometry type and you can add several differently modified symbol layers on
top of each other.

Câteva exemple:

-- render the centroid of a feature
centroid( $geometry )

-- visually overlap features within a 100 map units distance from a point
-- feature, i.e generate a 100m buffer around the point
buffer( $geometry, 100 )

-- Given polygon layer1( id1, layer2_id, ...) and layer2( id2, fieldn...)
-- render layer1 with a line joining centroids of both where layer2_id = id2
make_line( centroid( $geometry ),

centroid( geometry( get_feature( ’layer2’, ’id2’, attribute(
$currentfeature, ’layer2_id’) ) )

)

The Vector Field Marker The vector field marker is used to display vector field data such as earth deformation,
tidal flows, and the like. It displays the vectors as lines (preferably arrows) that are scaled and oriented according
to selected attributes of data points. It can only be used to render point data; line and polygon layers are not drawn
by this symbology.

The vector field is defined by attributes in the data, which can represent the field either by:

• cartesian components (x and y components of the field)

• or polar coordinates: in this case, attributes define Length and Angle. The angle may be measured either
clockwise from north, or Counterclockwise from east, and may be either in degrees or radians.

• or as height only data, which displays a vertical arrow scaled using an attribute of the data. This is appro-
priate for displaying the vertical component of deformation, for example.

The magnitude of field can be scaled up or down to an appropriate size for viewing the field.

12.2 Dialogul Proprietăt,ilor Vectoriale

The Layer Properties dialog for a vector layer provides general settings to manage appearance of layer features
in the map (symbology, labeling, diagrams), interaction with the mouse (actions, map tips, form design). It also
provides information about the layer.

To access the Layer Properties dialog, double-click on a layer in the legend or right-click on the layer and select
Properties from the pop-up menu.

Note: Depending on the external plugins you have installed, new tabs may be added to the layer properties dialog.
Those are not presented below.
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Tip: Live update rendering
The Layer Styling Panel provides you with some of the common features of the Layer properties dialog and is a
good modeless widget that you can use to speed up the configuration of the layer styles and automatically view
your changes in the map canvas.

Note: Because properties (symbology, label, actions, default values, forms...) of embedded layers (see Imbricarea
Proiectelor) are pulled from the original project file and to avoid changes that may break this behavior, the layer
properties dialog is made unavailable for these layers.

12.2.1 General Properties

Use this tab to make general settings for the vector layer. There are several options available:

Layer Info

• Set the Layer name to display in the Layers Panel

• Display the Layer source of the vector layer

• Define the Data source encoding to define provider-specific options and to be able to read the file

Sistem de Coordonate de Referint,ă

• Displays the layer’s Coordinate Reference System (CRS) as a PROJ.4 string. You can change the layer’s

CRS, selecting a recently used one in the drop-down list or clicking on Select CRS button (see Coordinate
Reference System Selector). Use this process only if the CRS applied to the layer is a wrong one or if none
was applied. If you wish to reproject your data into another CRS, rather use layer reprojection algorithms
from Processing or Save it into another layer.

• Create a Spatial Index (only for OGR-supported formats)

• Update Extents information for a layer

Vizibilitate în funcţie de scară

You can set the Maximum (inclusive) and Minimum (exclusive) scale, defining a range of scale in which features

will be visible. Out of this range, they are hidden. The Set to current canvas scale button helps you use the current
map canvas scale as boundary of the range visibility. See Randarea Dependentă de Scară for more information.

Constructorul de Interogări

Under the Provider Feature Filter frame, the Query Builder allows you to define a subset of the features in the
layer using a SQL-like WHERE clause and to display the result in the main window. As long as the query is
active, only the features corresponding to its result are available in the project. The query result can be saved as a
new vector layer.

The Query Builder is accessible through the eponym term at the bottom of the General tab in the Layer Properties.
Under Feature subset, click on the [Query Builder] button to open the Query builder. For example, if you have
a regions layer with a TYPE_2 field, you could select only regions that are borough in the Provider specific
filter expression box of the Query Builder. Figure_vector_querybuilder shows an example of the Query Builder
populated with the regions.shp layer from the QGIS sample data. The Fields, Values and Operators sections
help you to construct the SQL-like query.
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QGIS User Guide, Release 2.18

Figure 12.7: General tab in vector layers properties dialog

Figure 12.8: Constructorul de Interogări
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The Fields list contains all attribute columns of the attribute table to be searched. To add an attribute column to
the SQL WHERE clause field, double click its name in the Fields list. Generally, you can use the various fields,
values and operators to construct the query, or you can just type it into the SQL box.

The Values list lists the values of an attribute table. To list all possible values of an attribute, select the attribute in
the Fields list and click the [all] button. To list the first 25 unique values of an attribute column, select the attribute
column in the Fields list and click the [Sample] button. To add a value to the SQL WHERE clause field, double
click its name in the Values list.

The Operators section contains all usable operators. To add an operator to the SQL WHERE clause field, click
the appropriate button. Relational operators ( = , > , ...), string comparison operator (LIKE), and logical operators
(AND, OR, ...) are available.

The [Test] button shows a message box with the number of features satisfying the current query, which is useful
in the process of query construction. The [Clear] button clears the text in the SQL WHERE clause text field.
The [OK] button closes the window and selects the features satisfying the query. The [Cancel] button closes the
window without changing the current selection.

QGIS treats the resulting subset acts as if it were the entire layer. For example if you applied the filter above for
‘Borough’, you can not display, query, save or edit Anchorage, because that is a ‘Municipality’ and therefore not
part of the subset.

The only exception is that unless your layer is part of a database, using a subset will prevent you from editing the
layer.

12.2.2 Style Properties

The Style tab provides you with a comprehensive tool for rendering and symbolizing your vector data. You
can use tools that are common to all vector data, as well as special symbolizing tools that were designed for the
different kinds of vector data. However all types share the following dialog structure: in the upper part, you have a
widget that helps you prepare the classification and the symbol to use for features and at the bottom the Randarea
stratului widget.

Tip: Exportare simbologie vectorială
You have the option to export vector symbology from QGIS into Google *.kml, *.dxf and MapInfo *.tab files.
Just open the right mouse menu of the layer and click on Save As... to specify the name of the output file and its
format. In the dialog, use the Symbology export menu to save the symbology either as Feature symbology → or as
Symbol layer symbology →. If you have used symbol layers, it is recommended to use the second setting.

Randarea entităt,ilor

The renderer is responsible for drawing a feature together with the correct symbol. Regardless layer geometry
type, there are four common types of renderers: single symbol, categorized, graduated and rule-based. For point
layers, there are a point displacement and a heatmap renderers available while polygon layers can also be rendered
with the inverted polygons and 2.5 D renderers.

There is no continuous color renderer, because it is in fact only a special case of the graduated renderer. The
categorized and graduated renderers can be created by specifying a symbol and a color ramp - they will set the
colors for symbols appropriately. For each data type (points, lines and polygons), vector symbol layer types are
available. Depending on the chosen renderer, the dialog provides different additional sections.

Note: If you change the renderer type when setting the style of a vector layer the settings you made for the
symbol will be maintained. Be aware that this procedure only works for one change. If you repeat changing the
renderer type the settings for the symbol will get lost.
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Render cu Simbol Unic

The Single Symbol renderer is used to render all features of the layer using a single user-defined symbol. See
The Symbol Selector for further information about symbol representation.

Figure 12.9: Proprietăt,ile liniei cu simbol unic

Tip: Edit symbol directly from layer panel
If in your Layers Panel you have layers with categories defined through categorized, graduated or rule-based style
mode, you can quickly change the fill color of the symbol of the categories by right-clicking on a category and

choose the color you prefer from a color wheel menu. Right-clicking on a category will also give you access to
the options Hide all items, Show all items and Edit symbol.

No Symbols Renderer

The No Symbols renderer is a special use case of the Single Symbol renderer as it applies the same rendering
to all features. Using this renderer, no symbol will be drawn for features, but labeling, diagrams and other non-
symbol parts will still be shown.

Selections can still be made on the layer in the canvas and selected features will be rendered with a default symbol.
Features being edited will also be shown.

This is intended as a handy shortcut for layers which you only want to show labels or diagrams for, and avoids the
need to render symbols with totally transparent fill/border to achieve this.
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Renderul Categorisit

The Categorized renderer is used to render the features of a layer, using a user-defined symbol whose aspect
reflects the discrete values of a field or an expression. The Categorized menu allows you to

• select an existing field (using the Column listbox) or

• type or build an expression using the Set column expression. The expression used to classify features can be
of any type; it can for example:

– be a comparison, e.g. myfield >= 100, $id = @atlas_featureid, myfield % 2 = 0,
within( $geometry, @atlas_geometry ). In this case, QGIS returns values 1 (True) and
0 (False).

– combine different fields, e.g. concat( field1, ’ ’, field2 ) particularly useful when you
want to process classification on two or more fields simultaneously.

– be a calculation on fields, e.g. myfield % 2, year( myfield ) field_1 + field_2.

– be used to transform linear values in discrete classes, e.g.:

CASE WHEN x > 1000 THEN ’Big’ ELSE ’Small’ END

– combine several discrete values in one single category, e.g.:

CASE
WHEN building IN (’residence’, ’mobile home’) THEN ’residential’
WHEN building IN (’commercial’, ’industrial’) THEN ’Commercial and Industrial’
END

Note: While you can use any kind of expression to categorize features, for some complex expressions it
might be simpler to use rule-based rendering.

• the symbol (using the The Symbol Selector dialog) which will be used as base symbol for each class;

• the range of colors (using the Color ramp listbox) from which color applied to the symbol is selected.

Then click on [Classify] button to create classes from the distinct value of the attribute column. Each class can be
disabled unchecking the checkbox at the left of the class name.

To change symbol, value and/or label of the class, just double click on the item you want to change.

Right-click shows a contextual menu to Copy/Paste, Change color, Change transparency, Change output unit,
Change symbol width.

The example in figure_categorized_symbology shows the category rendering dialog used for the rivers layer of
the QGIS sample dataset.

Tip: Selectează s, i modifică simboluri multiple
The Symbology allows you to select multiple symbols and right click to change color, transparency, size, or width
of selected entries.

Tip: Match categories to symbol name
In the [Advanced] menu, under the classes, you can choose one of the two first actions to match symbol name to
a category name in your classification. Matched to saved symbols match category name with a symbol name from
your Style Manager. Match to symbols from file match category name to a symbol name from an external file.

12.2. Dialogul Proprietăt,ilor Vectoriale 133
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Figure 12.10: Categorized Symbolizing options

Renderul Gradat

The Graduated renderer is used to render all the features from a layer, using an user-defined symbol whose
color or size reflects the assignment of a selected feature’s attribute to a class.

Like the Categorized Renderer, the Graduated Renderer allows you to define rotation and size scale from specified
columns.

Also, analogous to the Categorized Renderer, it allows you to select:

• The attribute (using the Column listbox or the Set column expression function)

• The symbol (using the Symbol selector dialog)

• Formatul legendei s, i precizia

• Metoda utilizată pentru a schimba culoarea sau dimensiunea simbolului

• The colors (using the color Ramp list) if the color method is selected

• The size (using the size domain and its unit)

Then you can use the Histogram tab which shows an interactive histogram of the values from the assigned field or
expression. Class breaks can be moved or added using the histogram widget.

Note: You can use Statistical Summary panel to get more information on your vector layer. See Statistical
Summary Panel.

Back to the Classes tab, you can specify the number of classes and also the mode for classifying features within
the classes (using the Mode list). The available modes are:

• Equal Interval: each class has the same size (e.g. values from 0 to 16 and 4 classes, each class has a size of
4);

• Quantile: each class will have the same number of element inside (the idea of a boxplot);

• Natural Breaks (Jenks): the variance within each class is minimal while the variance between classes is
maximal;
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• Standard Deviation: classes are built depending on the standard deviation of the values;

• Pretty Breaks: Computes a sequence of about n+1 equally spaced nice values which cover the range of the
values in x. The values are chosen so that they are 1, 2 or 5 times a power of 10. (based on pretty from the
R statistical environment http://astrostatistics.psu.edu/datasets/R/html/base/html/pretty.html)

The listbox in the center part of the Style tab lists the classes together with their ranges, labels and symbols that
will be rendered.

Click on Classify button to create classes using the chosen mode. Each classes can be disabled unchecking the
checkbox at the left of the class name.

To change symbol, value and/or label of the class, just double click on the item you want to change.

Right-click shows a contextual menu to Copy/Paste, Change color, Change transparency, Change output unit,
Change symbol width.

The example in figure_graduated_symbology shows the graduated rendering dialog for the rivers layer of the
QGIS sample dataset.

Figure 12.11: Opt,iunile de Simbolizare Gradată

Tip: Hărt,i tematice bazate pe expresii
Categorized and graduated thematic maps can be created using the result of an expression. In the properties dialog

for vector layers, the attribute chooser is extended with a Set column expression function. So you don’t need to write
the classification attribute to a new column in your attribute table if you want the classification attribute to be a
composite of multiple fields, or a formula of some sort.
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Simbolul Proport,ional s, i Analiză Multivariată

Proportional Symbol and Multivariate Analysis are not rendering types available from the Style rendering drop-
down list. However with the Size Assistant options applied over any of the previous rendering options, QGIS
allows you to display your point and line data with such representation. Creating proportional symbol

Proportional rendering is done by first applying to the layer the Render cu Simbol Unic. Once you set the symbol,

at the upper level of the symbol tree, the Data-defined override button available beside Size or Width options
(for point or line layers respectively) provides tool to create proportional symbology for the layer. An assistant is

moreover accessible through the menu to help you define size expression.

Figure 12.12: Varying size assistant

The assistant lets you define:

• The attribute to represent, using the Field listbox or the Set column expression function (see Expresii)

• the scale method of representation which can be ‘Flannery’, ‘Surface’ or ‘Radius’

• The minimum and maximum size of the symbol

• The range of values to represent: The down pointing arrow helps you fill automatically these fields with the
minimum (or zero) and maximum values returned by the chosen attribute or the expression applied to your
data.

• An unique size to represent NULL values.

To the right side of the dialog, you can preview the features representation within a live-update widget. This
representation is added to the layer tree in the layer legend and is also used to shape the layer representation in the
print composer legend item.

The values presented in the varying size assistant above will set the size ‘Data-defined override’ with:

coalesce(scale_exp(Importance, 1, 20, 2, 10, 0.57), 1)

Crearea analiză multivariate

O randare a unei analize multivariată vă ajută să evaluat,i relat,ia dintre două sau mai multe variabile, astfel, una
poate fi reprezentată printr-o gamă de culoare, pe când cealaltă poate fi reprezentată printr-o mărime.

The simplest way to create multivariate analysis in QGIS is to first apply a categorized or graduated rendering on
a layer, using the same type of symbol for all the classes. Then, clicking on the symbol [Change] button above
the classification frame, you get the The Symbol Selector dialog from which, as seen above, you can activate and
set the size assistant option either on size (for point layer) or width (for line layer).

Like the proportional symbol, the size-related symbol is added to the layer tree, at the top of the categorized or
graduated classes symbols. And both representation are also available in the print composer legend item.
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Figure 12.13: Multivariate example

Rule-based Renderer

The Rule-based renderer is used to render all the features from a layer, using rule-based symbols whose aspect
reflects the assignment of a selected feature’s attribute to a class. The rules are based on SQL statements. The
dialog allows rule grouping by filter or scale, and you can decide if you want to enable symbol levels or use only
the first-matched rule.

To create a rule, activate an existing row by double-clicking on it, or click on ‘+’ and click on the new rule. In the

Rule properties dialog, you can define a label for the rule. Press the button to open the expression string
builder. In the Function List, click on Fields and Values to view all attributes of the attribute table to be searched.
To add an attribute to the field calculator Expression field, double click on its name in the Fields and Values list.
Generally, you can use the various fields, values and functions to construct the calculation expression, or you can
just type it into the box (see Expresii). You can create a new rule by copying and pasting an existing rule with
the right mouse button. You can also use the ‘ELSE’ rule that will be run if none of the other rules on that level
matches. Since QGIS 2.8 the rules appear in a tree hierarchy in the map legend. Just double-click the rules in
the map legend and the Style tab of the layer properties appears showing the rule that is the background for the
symbol in the tree.

The example in figure_rule_based_symbology shows the rule-based rendering dialog for the rivers layer of the
QGIS sample dataset.

Point displacement Renderer

The Point Displacement renderer works to visualize all features of a point layer, even if they have the same
location. To do this, the symbols of the points are placed on a displacement circle around one center symbol or on
several concentric circles.

Note: You can still render features with other renderer like Single symbol, Graduated, Categorized or Rule-Based
renderer using the Renderer drop-down list then the Renderer Settings... button.
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Figure 12.14: Opt,iunile de Simbolizare bazată pe reguli

Figure 12.15: Dialogul de deplasare a punctelor
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Inverted Polygon Renderer

The Inverted Polygon renderer allows user to define a symbol to fill in outside of the layer’s polygons. As
above you can select subrenderers, namely Single symbol, Graduated, Categorized, Rule-Based or 2.5D renderer.

Figure 12.16: Dialogul Poligonului Invers

Heatmap Renderer

With the Heatmap renderer you can create live dynamic heatmaps for (multi)point layers. You can specify
the heatmap radius in pixels, mm or map units, choose and edit a color ramp for the heatmap style and use a slider
for selecting a trade-off between render speed and quality. You can also define a maximum value limit and give a
weight to points using a field or an expression. When adding or removing a feature the heatmap renderer updates
the heatmap style automatically.

2.5D Renderer

Using the 2.5D renderer it’s possible to create a 2.5D effect on your layer’s features. You start by choosing a
Height value (in map units). For that you can use a fixed value, one of your layer’s fields, or an expression. You
also need to choose an Angle (in degrees) to recreate the viewer position (0° means west, growing in counter clock
wise). Use advanced configuration options to set the Roof Color and Wall Color. If you would like to simulate
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Figure 12.17: Fereasta plugin-ului Heatmap

solar radiation on the features walls, make sure to check the Shade walls based on aspect option. You can also
simulate a shadow by setting a Color and Size (in map units).

Tip: Using 2.5D effect with other renderers
Once you have finished setting the basic style on the 2.5D renderer, you can convert this to another renderer (single,
categorized, graduated). The 2.5D effects will be kept and all other renderer specific options will be available for
you to fine tune them (this way you can have for example categorized symbols with a nice 2.5D representation
or add some extra styling to your 2.5D symbols). To make sure that the shadow and the “building” itself do not
interfere with other nearby features, you may need to enable Symbols Levels ( Advanced → Symbol levels...). The
2.5D height and angle values are saved in the layer’s variables, so you can edit it afterwards in the variables tab of
the layer’s properties dialog.

Randarea stratului

From the Style tab, you can also set some options that invariabily act on all features of the layer:

• Layer transparency : You can make the underlying layer in the map canvas visible with
this tool. Use the slider to adapt the visibility of your vector layer to your needs. You can also make a
precise definition of the percentage of visibility in the the menu beside the slider.

• Layer blending mode and Feature blending mode: You can achieve special rendering effects with these tools
that you may previously only know from graphics programs. The pixels of your overlaying and underlaying
layers are mixed through the settings described in Modurile de Fuziune.

• Apply paint effects on all the layer features with the Draw Effects button.

• Control feature rendering order allows you, using features attributes, to define the z-order in which they

shall be rendered. Activate the checkbox and click on the button beside. You then get the Define Order
dialog in which you:

– choose a field or build an expression to apply to the layer features

– set in which order the fetched features should be sorted, i.e. if you choose Ascending order, the
features with lower value are rendered under those with upper value.
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Figure 12.18: 2.5D dialog

– define when features returning NULL value should be rendered: first or last.

You can add several rules of ordering. The first rule is applied to all the features in the layer, z-ordering
them according to the value returned. Then, for each group of features with the same value (including those
with NULL value) and thus same z-level, the next rule is applied to sort its items among them. And so on...

Figure 12.19: Opţiuni de randare a stratului

Alte Setări

Symbols levels

For renderers that allow stacked symbol layers (only heatmap doesn’t) there is an option to control the rendering
order of each symbol’s levels.

For most of the renderers, you can access the Symbols levels option by clicking the [Advanced] button below
the saved symbols list and choosing Symbol levels. For the Rule-based Renderer the option is directly available
through [Symbols levels] button, while for Point displacement Renderer renderer the same button is inside the
Rendering settings dialog.

To activate symbols levels, select the Enable symbol levels. Each row will show up a small sample of the
combined symbol, its label and the individual symbols layer divided into columns with a number next to it. The
numbers represent the rendering order level in which the symbol layer will be drawn. Lower values levels are
drawn first, staying at the bottom, while higher values are drawn last, on top of the others.
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Figure 12.20: Dialogul Nivelurilor simbolului

Note: If symbols levels are deactivated, the complete symbols will be drawn according to their respective features
order. Overlapping symbols will simply obfuscate to other below. Besides, similar symbols won’t “merge” with
each other.

Figure 12.21: Symbol levels activated (A) and deactivated (B) difference

Efecte de Desenare

In order to improve layer rendering and avoid (or at least reduce) the resort to other software for final rendering of

maps, QGIS provides another powerful functionality: the Draw Effects options, which adds paint effects for
customizing the visualization of vector layers.

The option is available in the Layer Properties –> Style dialog, under the Layer rendering group (applying to the
whole layer) or in symbol layer properties (applying to corresponding features). You can combine both usage.

Paint effects can be activated by checking the Draw effects option and clicking the Customize effects button,
that will open the Effect Properties Dialog (see figure_effects_source). The following effect types, with custom
options are available:

• Source: Draws the feature’s original style according to the configuration of the layer’s properties. The
transparency of its style can be adjusted.
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Figure 12.22: Efecte de Desenare: Dialogul sursă

• Blur: Adds a blur effect on the vector layer. The options that someone can change are the Blur type (Stack
or Gaussian blur), the strength and transparency of the blur effect.

• Colorize: This effect can be used to make a version of the style using one single hue. The base will always

be a grayscale version of the symbol and you can use the Grayscale to select how to create it (options

are: ‘lightness’, ‘luminosity’ and ‘average’). If Colorise is selected, it will be possible to mix another
color and choose how strong it should be. You can also control the Brightness, contrast and saturation
levels of the resulting symbol.

• Drop Shadow: Using this effect adds a shadow on the feature, which looks like adding an extra dimension.
This effect can be customized by changing the offset degrees and radius, determining where the shadow
shifts towards to and the proximity to the source object. Drop Shadow also has the option to change the blur
radius, the transparency and the color of the effect.

• Inner Shadow: This effect is similar to the Drop Shadow effect, but it adds the shadow effect on the inside
of the edges of the feature. The available options for customization are the same as the Drop Shadow effect.

• Inner Glow: Adds a glow effect inside the feature. This effect can be customized by adjusting the spread
(width) of the glow, or the Blur radius. The latter specifies the proximity from the edge of the feature where
you want any blurring to happen. Additionally, there are options to customize the color of the glow, with a
single color or a color ramp.

• Outer Glow: This effect is similar to the Inner Glow effect, but it adds the glow effect on the outside of the
edges of the feature. The available options for customization are the same as the Inner Glow effect.

• Transform: Adds the possibility of transforming the shape of the symbol. The first options available
for customization are the Reflect horizontal and Reflect vertical, which actually create a reflection on the
horizontal and/or vertical axes. The 4 other options are:

– Shear: slants the feature along the x and/or y axis

– Scale: enlarges or minimizes the feature along the x and/or y axis by the given percentage

– Rotation: turns the feature around its center point

– and Translate changes the position of the item based on a distance given on the x and/or the y axis.

There are some common options available for all draw effect types. Transparency and Blend mode options work
similar to the ones described in Randarea stratului and can be used in all draw effects except for the transform
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Figure 12.23: Draw Effects: Blur dialog

Figure 12.24: Efecte de Desenare: Dialogul de colorizare
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Figure 12.25: Draw Effects: Drop Shadow dialog

Figure 12.26: Efecte de Desenare: Dialogul Umbrei Interioare
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Figure 12.27: Efecte de Desenare: Dialogul Strălucirii Interioare

Figure 12.28: Efecte de Desenare: Dialogul Strălucirii Exterioare
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Figure 12.29: Efecte de Desenare: Dialogul de transformare

one.

One or more draw effects can used at the same time. You activate/deactivate an effect using its checkbox in the

effects list. You can change the selected effect type by using the Effect type option. You can reorder the

effects using Move up and Move down buttons, and also add/remove effects using the Add effect and
Remove effect buttons.

There is also a Draw mode option available for every draw effect, and you can choose whether to render
and/or to modify the symbol. Effects render from top to bottom.’Render only’ mode means that the effect will be
visible while the ‘Modify only’ mode means that the effect will not be visible but the changes that it applies will
be passed to the next effect (the one immediately below). The ‘Render and Modify’ mode will make the effect
visible and pass any changes to the next effect. If the effect is in the top of the effects list or if the immediately
above effect is not in modify mode, then it will use the original source symbol from the layers properties (similar
to source).

12.2.3 Proprietăt,ile Etichetelor

The Labels properties provides you with all the needed and appropriate capabilities to configure smart labeling
on vector layers. This dialog can also be accessed from the Layer Styling panel, or using the Layer Labeling Options

icon of the Labels toolbar.

Setarea unei etichete

The first step is to choose the labeling method from the drop-down list. There are four options available:

• No labels

• Show labels for this layer

• Rule-based labeling
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• and Blocking: allows to set a layer as just an obstacle for other layer’s labels without rendering any labels
of its own.

The next steps assume you select the Show labels for this layer option, enabling following tabs that help you
configure the labeling:

• Text

• Formatting

• Buffer

• Background

• Shadow

• Placement

• Rendering

It also enables the Label with drop-down list, from which you can select an attribute column to use. Click if
you want to define labels based on expressions - See Definirea etichetelor pe baza expresiilor.

The following steps describe simple labeling without using the Data defined override functions, which are situated
next to the drop-down menus - see Folosirea suprascrierii definit,iilor de date pentru etichetare for a use case.

Figure 12.30: Layer labeling settings - Text tab
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Text tab

In the Text tab, you can define the Font, Style, and Size of your labels’ text (see Figure_labels). There are options
available to set the labels’ Color and Transparency. Use the Type case option to change the capitalization style of
the text. You have the possibility to render the text as ‘All uppercase’, ‘All lowercase’ or ‘Capitalize first letter’.
In Spacing, you can change the space between words and between individual letters. Finally, use the Blend mode
option to determine how your labels will mix with the map features below them (see more about it in Modurile de
Fuziune).

The Apply label text substitutes option gives you ability to specify a list of texts to substitute to texts in feature
labels (e.g., abbreviating street types). Replacement texts are thus used to display labels in the map canvas. Users
can also export and import lists of substitutes to make reuse and sharing easier.

Formatting tab

In the Formatting tab, you can define a character for a line break in the labels with the Wrap on character option.
You can also format the Line Height and the alignment. For the latter, typical values are available (left, right, and
center), plus Follow label placement for point layers. When set to this mode, text alignment for labels will be
dependent on the final placement of the label relative to the point. E.g., if the label is placed to the left of the point,
then the label will be right aligned, while if it is placed to the right, it will be left aligned.

For line vector layers you can include Line directions symbols to help determine the lines directions. They work
particularly well when used with the curved or Parallel placement options from the Placement tab. There are
options to set the symbols position, and to reverse direction.

Use the Formatted numbers option to format numeric labels. You can set the number of Decimal places. By

default, 3 decimal places will be used. Use the Show plus sign if you want to show the plus sign in positive
numbers.

Buffer tab

To create a buffer around the labels, activate the Draw text buffer checkbox in the Buffer tab. You can set the

buffer’s Size, color, and Transparency. The buffer expands from the label’s outline , so, if the color buffer’s fill
checkbox is activated, the buffer interior is filled. This may be relevant when using partially transparent labels or

with non-normal blending modes, which will allow seeing behind the label’s text. Deactivating color buffer’s
fill checkbox (while using totally transparent labels) will allow you to create outlined text labels.

Background tab

In the Background tab, you can define with Size X and Size Y the shape of your background. Use Size type to
insert an additional ‘Buffer’ into your background. The buffer size is set by default here. The background then
consists of the buffer plus the background in Size X and Size Y. You can set a Rotation where you can choose
between ‘Sync with label’, ‘Offset of label’ and ‘Fixed’. Using ‘Offset of label’ and ‘Fixed’, you can rotate the
background. Define an Offset X,Y with X and Y values, and the background will be shifted. When applying
Radius X,Y, the background gets rounded corners. Again, it is possible to mix the background with the underlying
layers in the map canvas using the Blend mode (see Modurile de Fuziune).

Shadow tab

Use the Shadow tab for a user-defined Drop shadow. The drawing of the background is very variable. Choose
between ‘Lowest label component’, ‘Text’, ‘Buffer’ and ‘Background’. The Offset angle depends on the orienta-

tion of the label. If you choose the Use global shadow checkbox, then the zero point of the angle is always
oriented to the north and doesn’t depend on the orientation of the label. You can influence the appearance of the
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shadow with the Blur radius. The higher the number, the softer the shadows. The appearance of the drop shadow
can also be altered by choosing a blend mode.

Placement tab

Choose the Placement tab for configuring label placement and labeling priority. Note that the placement options
differ according to the type of vector layer, namely point, line or polygon.

Pozit,ionarea straturilor de tip punct With the Cartographic placement mode, point labels are generated
with a better visual relationship with the point feature, following ideal cartographic placement rules. Labels can
be placed at a set Distance either from the point feature itself or from the bounds of the symbol used to represent
the feature. The latter option is especially useful when the symbol size isn’t fixed, e.g. if it’s set by a data defined
size or when using different symbols in a categorized renderer.

În mod implicit, destinat,iile de plasare au următoarea prioritate:

1. dreapta sus

2. stânga sus

3. dreapta jos

4. stânga jos

5. mijloc dreapta

6. mijloc stânga

7. sus, put,in spre dreapta

8. jos, put,in spre stânga.

Placement priority can, however, be customized or set for an individual feature using a data defined list of priori-
tised positions. This also allows only certain placements to be used, so e.g. for coastal features you can prevent
labels being placed over the land.

The Around point setting places the label in an equal radius (set in Distance) circle around the feature. The
placement of the label can even be constrained using the Quadrant option.

With the Offset from point, labels are placed at a fixed offset from the point feature. You can select the Quadrant
in which to place your label. You are also able to set the Offset X,Y distances between the points and their labels
and can alter the angle of the label placement with the Rotation setting. Thus, placement in a selected quadrant
with a defined rotation is possible.

Pozit,ionarea straturilor de tip linie Label options for line layers include Parallel, Curved or Hor-

izontal. For the Parallel and Curved options, you can set the position to Above line, On line and

Below line. It’s possible to select several options at once. In that case, QGIS will look for the optimal label
position. For Parallel and curved placement options, you can also use the line orientation for the position of the
label. Additionally, you can define a Maximum angle between curved characters when selecting the Curved
option (see Figure_labels_placement_line).

For all three placement options, in Repeat, you can set up a minimum distance for repeating labels. The distance
can be in mm or in map units.

Pozit,ionarea straturilor de tip poligon You can choose one of the following options for placing labels in
polygons (see figure_labels_placement_polygon):

• Offset from centroid,

• Horizontal (slow),
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Figure 12.31: Label placement examples in lines

• Around centroid,

• Liber (lent),

• Using perimeter,

• and Using perimeter (curved).

In the Offset from centroid settings you can specify if the centroid is of the visible polygon or whole polygon.
That means that either the centroid is used for the polygon you can see on the map or the centroid is determined
for the whole polygon, no matter if you can see the whole feature on the map. You can place your label within a
specific quadrant, and define offset and rotation.

The Around centroid setting places the label at a specified distance around the centroid. Again, you can define
visible polygon or whole polygon for the centroid.

With the Horizontal (slow) or Free (slow) options, QGIS places at the best position either a horizontal or a rotated
label inside the polygon.

With the Using perimeter option, the label will be drawn next to the polygon boundary. The label will behave like

the parallel option for lines. You can define a position and a distance for the label. For the position, Above

line, On line, Below line and Line orientation dependent position are possible. You can specify the
distance between the label and the polygon outline, as well as the repeat interval for the label.

The Using perimeter (curved) option helps you draw the label along the polygon boundary, using a curved labeling.
In addition to the parameters available with Using perimeter setting, you can set the Maximum angle between
curved characters polygon, either inside or outside.

In the priority section you can define the priority with which labels are rendered for all three vector layer types
(point, line, polygon). This placement option interacts with the labels from other vector layers in the map canvas.
If there are labels from different layers in the same location, the label with the higher priority will be displayed
and the others will be left out.

Fila randării

In the Rendering tab, you can tune when the labels can be rendered and their interaction with other labels and
features.

Under Label options, you find the scale-based and the Pixel size-based visibility settings.

The Label z-index determines the order in which labels are rendered, as well in relation with other feature labels in
the layer (using data-defined override expression), as with labels from other layers. Labels with a higher z-index
are rendered on top of labels (from any layer) with lower z-index.

Additionally, the logic has been tweaked so that if 2 labels have matching z-indexes, then:
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Figure 12.32: Label placement examples in polygons

• if they are from the same layer, the smaller label will be drawn above the larger label

• if they are from different layers, the labels will be drawn in the same order as their layers themselves (ie
respecting the order set in the map legend).

Note that this setting doesn’t make labels to be drawn below the features from other layers, it just controls the
order in which labels are drawn on top of all the layer’s features.

While rendering labels and in order to display readable labels, QGIS automatically evaluates the position of the

labels and can hide some of them in case of collision. You can however choose to Show all labels for this
layer (including colliding labels) in order to manually fix their placement.

With data-defined expressions in Show label and Always Show you can fine tune which labels should be rendered.

Under Feature options, you can choose to label every part of a multi-part feature and limit the number of features
to be labeled. Both line and polygon layers offer the option to set a minimum size for the features to be labeled,
using Suppress labeling of features smaller than. For polygon features, you can also filter the labels to show
according to whether they completely fit within the feature or not. For line features, you can choose to Merge
connected lines to avoid duplicate labels, rendering a quite airy map in conjunction with the Distance or Repeat
options in Placement tab.

From the Obstacles frame, you can manage the covering relation between labels and features. Activate the
Discourage labels from covering features option to decide whether features of the layer should act as obstacles
for any label (including labels from other features in the same layer). An obstacle is a feature QGIS tries as far as
possible to not place labels over. Instead of the whole layer, you can define a subset of features to use as obstacles,

using the data-defined override control next to the option.

The priority control slider for obstacles allows you to make labels prefer to overlap features
from certain layers rather than others. A Low weight obstacle priority means that features of the layer are less
considered as obstacles and thus more likely to be covered by labels. This priority can also be data-defined, so
that within the same layer, certain features are more likely to be covered than others.
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For polygon layers, you can choose the type of obstacle features could be by minimising the labels placement:

• over the feature’s interior: avoids placing labels over the interior of the polygon (prefers placing labels
totally outside or just slightly inside the polygon)

• or over the feature’s boundary: avoids placing labels over boundary of the polygon (prefers placing labels
outside or completely inside the polygon). E.g., it can be useful for regional boundary layers, where the
features cover an entire area. In this case, it’s impossible to avoid placing labels within these features, and
it looks much better to avoid placing them over the boundaries between features.

Etichetarea bazată pe reguli

With rule-based labeling multiple label configurations can be defined and applied selectively on the base of ex-
pression filters and scale range, as in Rule-based rendering.

To create a rule, select the Rule-based labeling option in the main drop-down list from the Labels tab and click

the button at the bottom of the dialog. Then fill the new dialog with a description and an expression to filter
features. You can also set a scale range in which the label rule should be applied. The other options available in
this dialog are the common settings seen beforehand.

Figure 12.33: Setările unei reguli

A summary of existing rules is shown in the main dialog (see figure_labels_rule_based). You can add multiple

rules, reorder or imbricate them with a drag-and-drop. You can as well remove them with the button or edit

them with button or a double-click.
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Figure 12.34: Panoul de etichetare bazată pe reguli

Definirea etichetelor pe baza expresiilor

Whether you choose simple or rule-based labeling type, QGIS allows using expressions to label features.

Click the icon near the Label with drop-down list in the Labels tab of the properties dialog. In fig-
ure_labels_expression, you see a sample expression to label the alaska regions with name and area size, based on
the field ‘NAME_2’, some descriptive text, and the function $area in combination with format_number()
to make it look nicer.

Figure 12.35: Folosirea expresiilor pentru etichetare

Expression based labeling is easy to work with. All you have to take care of is that:

• You need to combine all elements (strings, fields, and functions) with a string concatenation function such
as concat, + or ||. Be aware that in some situations (when null or numeric value are involved) not all of
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these tools will fit your need.

• Strings are written in ‘single quotes’.

• Fields are written in “double quotes” or without any quote.

Să aruncăm o privire asupra câtorva exemple:

1. Label based on two fields ‘name’ and ‘place’ with a comma as separator:

"name" || ’, ’ || "place"

Returnează:

John Smith, Paris

2. Label based on two fields ‘name’ and ‘place’ with other texts:

’My name is ’ + "name" + ’and I live in ’ + "place"
’My name is ’ || "name" || ’and I live in ’ || "place"
concat(’My name is ’, name, ’ and I live in ’, "place")

Returnează:

My name is John Smith and I live in Paris

3. Label based on two fields ‘name’ and ‘place’ with other texts combining different concatenation functions:

concat(’My name is ’, name, ’ and I live in ’ || place)

Returnează:

My name is John Smith and I live in Paris

Or, if the field ‘place’ is NULL, returns:

My name is John Smith

4. Multi-line label based on two fields ‘name’ and ‘place’ with a descriptive text:

concat(’My name is ’, "name", ’\n’ , ’I live in ’ , "place")

Returnează:

My name is John Smith
I live in Paris

5. Label based on a field and the $area function to show the place’s name and its rounded area size in a
converted unit:

’The area of ’ || "place" || ’ has a size of ’
|| round($area/10000) || ’ ha’

Returnează:

The area of Paris has a size of 10500 ha

6. Create a CASE ELSE condition. If the population value in field population is <= 50000 it is a town,
otherwise it is a city:

concat(’This place is a ’,
CASE WHEN "population <= 50000" THEN ’town’ ELSE ’city’ END)

Returnează:

This place is a town
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As you can see in the expression builder, you have hundreds of functions available to create simple and very
complex expressions to label your data in QGIS. See Expresii chapter for more information and examples on
expressions.

Folosirea suprascrierii definit,iilor de date pentru etichetare

With the Data defined override functions, the settings for the labeling are overridden by entries in the attribute table.
It can be used to set values for most of the labeling options described above. See the widget’s description and
manipulation in Configurarea suprascrierii definită de date section.

The Label Toolbar

The Label Toolbar provides some tools to manipulate label or diagram properties, but only if the
corresponding data-defined option is indicated (otherwise, buttons are disabled). Layer might also need to be in
edit mode.

Figure 12.36: The Label toolbar

While for readability, label has been used below to describe the Label toolbar, note that when mentioned in
their name, the tools work almost the same way with diagrams:

• Pin/Unpin Labels And Diagrams that has data-defined position. By clicking or draging an area, you pin label(s).
If you click or drag an area holding Shift, label(s) are unpinned. Finally, you can also click or drag an
area holding Ctrl to toggle the pin status of label(s).

• Highlight Pinned Labels And Diagrams. If the vector layer of the label is editable, then the highlighting is green,
otherwise it’s blue.

• Move Label And Diagram that has data-defined position. You just have to drag the label to the desired place.

• Show/Hide Labels And Diagrams that has data-defined visbility. If you click or drag an area holding Shift,
then label(s) are hidden. When a label is hidden, you just have to click or drag an area around the feature’s
point to restore its visibility.

• Rotate Label. Click the label and move around and you get the text rotated.

• Change Label. It opens a dialog to change the clicked label properties; it can be the label itself, its coordi-
nates, angle, font, size... as long as this property has been mapped to a field.

Warning: Label tools overwrite current field values
Using the Label toolbar to customize the labeling actually writes the new value of the property in the mapped
field. Hence, be careful to not inadvertently replace data you may need later!

Customize the labels from the map canvas

Combined with the Label Toolbar, the data defined override setting helps you manipulate labels in the map canvas

(move, edit, rotate). We now describe an example using the data-defined override function for the Move label

function (see figure_labels_data_defined).

1. Importă lakes.shp din setul de date es, antion al QGIS.
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2. Double-click the layer to open the Layer Properties. Click on Labels and Placement. Select Offset from
centroid.

3. Look for the Data defined entries. Click the icon to define the field type for the Coordinate. Choose
xlabel for X and ylabel for Y. The icons are now highlighted in yellow.

Figure 12.37: Labeling of vector polygon layers with data-defined override

4. Transfocare către un lac.

5. Set editable the layer using the Toggle Editing button.

6. Go to the Label toolbar and click the icon. Now you can shift the label manually to another position
(see figure_labels_move). The new position of the label is saved in the xlabel and ylabel columns of
the attribute table.

7. Using Generatorul de Geometrii with the expression below, you can also add a linestring symbol layer to
connect each lake to its moved label:

make_line( centroid( $geometry ), make_point( "xlabel", "ylabel" ) )

Figure 12.38: Moved labels
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QGIS User Guide, Release 2.18

12.2.4 Fields Properties

The Fields tab helps you organize the fields of the selected dataset and the way you can interact with the

feature’s attributes. The buttons New field and Delete field can be used when the dataset is in Editing mode.

You can rename fields by double-clicking in the fields name (note that you should switch to editing mode to edit
the field name). This is only supported for data providers like PostgreSQL, Oracle, Memory layer and some OGR
layer depending the OGR data format and version.

You can define some alias to display human readable fields in the feature form or the attribute table. In this case,
you don’t need to switch to editing mode. Alias are saved in project file.

Comments can be added by clicking in the comment field of the column but if you are using a PostgreSQL layer,
comment of the column could be the one in the PostgreSQL table if set. Comments are saved in the QGIS project
file as for the alias.

The dialog also lists read-only characteristics of the field such as its type, type name, length and
precision. When serving the layer as WMS or WFS, you can also check here which fields could be retrieved.

Figure 12.39: Field properties tab

Configure the field behavior

Within the Fields tab, you also find an Edit widget column. This column can be used to define values or a range
of values that are allowed to be added to the specific attribute table column. It also helps to set the type of widget
used to fill or display values of the field, in the attribute table or the feature form. If you click on the [Edit widget]
button, a dialog opens, where you can define different widgets.

Common settings

Regardless the type of widget applied to the field, there are some common properties you can set to control whether
and how a field can be edited:

• Editable: uncheck this to set the field read-only (not manually modifiable) when the layer is in edit mode.
Note that checking this setting doesn’t override any edit limitation from the provider.

158 Chapter 12. Lucrul cu Datele Vectoriale



QGIS User Guide, Release 2.18

Figure 12.40: Dialog to select an edit widget for an attribute column
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• Label on top: places the field name above or beside the widget in the feature form

• Default value: for new features, automatically populates by default the field with a predefined value or an
expression-based one. For example, you can:

– use $x, $length, $area to populate a field with the feature’s x coordinate, length, area or any
geometric information at its creation;

– incremente a field by 1 for each new feature using maximum("field")+1;

– save the feature creation datetime using now();

– use variables in expressions, making it easier to e.g. insert the operator name (@user_full_name),
the project file path (@project_path), ...

A preview of the resulting default value is displayed at the bottom of the widget.

Note: The Default value option is not aware of the values in any other field of the feature being
created so it won’t be possible to use an expression combining any of those values i.e using an expression
like concat(field1, field2) may not work.

• Constraints: you can constrain the value to insert in the field. This constraint can be:

– Not null: force the user to provide a value

– based on a custom expression: e.g. regexp_match(col0,’A-Za-z’) to ensure that the value
of the field col0 has only alphabetical letter.

A short description of the constraint can be added and will be displayed at the top of the form as a
warning message when the value supplied does not match the constraint.

Edit widgets

The available widgets are:

• Checkbox: Displays a checkbox, and you can define what attribute is added to the column when the check-
box is activated or not.

• Classification: Displays a combo box with the values used for classification, if you have chosen ‘unique
value’ as legend type in the Style tab of the properties dialog.

• Color: Displays a color button allowing user to choose a color from the color dialog window.

• Date/Time: Displays a line field which can open a calendar widget to enter a date, a time or both. Column
type must be text. You can select a custom format, pop-up a calendar, etc.

• Enumeration: Opens a combo box with values that can be used within the columns type. This is currently
only supported by the PostgreSQL provider.

• External Resource: Uses a “Open file” dialog to store file path in a relative or absolute mode. It can also
be used to display a hyperlink (to document path), a picture or a web page.

• File Name: Simplifies the selection by adding a file chooser dialog.

• Hidden: A hidden attribute column is invisible. The user is not able to see its contents.

• Photo: Field contains a filename for a picture. The width and height of the field can be defined.

• Range: Allows you to set numeric values from a specific range. The edit widget can be either a slider or a
spin box.

• Relation Reference: This widget lets you embed the feature form of the referenced layer on the feature
form of the actual layer. See Creating one or many to many relations.

• Text Edit (default): This opens a text edit field that allows simple text or multiple lines to be used. If you
choose multiple lines you can also choose html content.
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• Unique Values: You can select one of the values already used in the attribute table. If ‘Editable’ is activated,
a line edit is shown with autocompletion support, otherwise a combo box is used.

• UUID Generator: Generates a read-only UUID (Universally Unique Identifiers) field, if empty.

• Value Map: A combo box with predefined items. The value is stored in the attribute, the description is
shown in the combo box. You can define values manually or load them from a layer or a CSV file.

• Value Relation: Offers values from a related table in a combobox. You can select layer, key column and
value column. Several options are available to change the standard behaviours: allow null value, order by
value, allow multiple selections and use of autocompleter. The forms will display either a drop-down list or
a line edit field when completer checkbox is enabled.

• Web View: Field contains a URL. The width and height of the field is variable.

Tip: Relative Path in widgets
If the path which is selected with the file browser is located in the same directory as the .qgs project file or below,
paths are converted to relative paths. This increases portability of a .qgs project with multimedia information
attached. This is enabled only for File Name, Photo and Web View at this moment.

Customize a form for your data

By default, when you click on a feature with the Identify Features tool or switch the attribute table to the form view
mode, QGIS displays a form with tabulated textboxes (one per field). This rendering is the result of the default
Autogenerate value of the Layer properties → Fields → Attribute editor layout setting. Thanks to the widget
setting, you can improve this dialog.

You can furthermore define built-in forms (see figure_fields_form), e.g. when you have objects with many at-
tributes, you can create an editor with several tabs and named groups to present the attribute fields.

Figure 12.41: Resulting built-in form with tabs and named groups
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The drag and drop designer

Choose Drag and drop designer from the Attribute editor layout combobox to layout the features form
within QGIS. Then, drag and drop rows from the Fields frame to the Label panel to have fields added to your
custom form.

You can also use categories (tab or group frames) to better structure the form. The first step is to use the icon
to create a tab in which fields and groups will be displayed (see figure_fields_layout). You can create as many

categories as you want. The next step will be to assign to each category the relevant fields, using the icon.
You’d need to select the targeted category beforehand. You can use the same fields many times.

Figure 12.42: Dialogul de creare a categoriilor cu ajutorul Editorului de atribute

You can configure tabs or groups with a double-click. QGIS opens a form in which you can:

• choose to hide or show the item label

• rename the category

• set over how many columns the fields under the category should be distributed

• enter an expression to control the category visibility. The expression will be re-evaluated everytime values
in the form change and the tab or groupbox shown/hidden accordingly.

• show the category as a group box (only available for tabs)

With a double-click on a field label, you can also specify whether the label of its widget should be visible or not
in the form.

In case the layer is involved in one to many relations (see Creating one or many to many relations),
referencing layers are listed in the Relations frame and their form can be embedded in the current layer form by
drag-and-drop. Like the other items, double-click the relation label to configure some options:

• choose to hide or show the item label

• show the link button

• show the unlink button
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Provide an ui-file

The Provide ui-file option allows you to use complex dialogs made with Qt-Designer. Using a UI-file
allows a great deal of freedom in creating a dialog. Note that, in order to link the graphical objects (textbox,
combobox...) to the layer’s fields, you need to give them the same name.

Use the Edit UI to define the path to the file to use.

You’ll find some example in the Creating a new form lesson of the QGIS-training-manual-index-reference.
For more advanced information, see http://nathanw.net/2011/09/05/qgis-tips-custom-feature-forms-with-python-
logic/.

Enhance your form with custom functions

QGIS forms can have a Python function that is called when the dialog is opened. Use this function to add extra
logic to your dialogs. The form code can be specified in three different ways:

• load from the environment: use a function, for example in startup.py or from an installed
plugin)

• load from an external file: a file chooser will appear in that case to allow you to select a Python
file from your filesystem

• provide code in this dialog: a Python editor will appear where you can directly type the func-
tion to use.

In all cases you must enter the name of the function that will be called (open in the example below).

Un exemplu este (în modulul MyForms.py):

def open(dialog,layer,feature):
geom = feature.geometry()
control = dialog.findChild(QWidged,"My line edit")

Reference in Python Init Function like so: open

12.2.5 Joins Properties

The Joins tab allows you to join a loaded attribute table to a loaded vector layer. After clicking , the
Add vector join dialog appears. As key columns, you have to define a join layer you want to connect with the
target vector layer. Then, you have to specify the join field that is common to both the join layer and the target

layer. Now you can also specify a subset of fields from the joined layer based on the checkbox Choose which
fields are joined. As a result of the join, all information from the join layer and the target layer are displayed in
the attribute table of the target layer as joined information. If you specified a subset of fields only these fields are
displayed in the attribute table of the target layer.

QGIS currently has support for joining non-spatial table formats supported by OGR (e.g., CSV, DBF and Excel),
delimited text and the PostgreSQL provider (see figure_joins).

În plus, adăugarea dialogului de îmbinare vectorială vă permite să:

• Cache join layer in virtual memory

• Creează indexul atributului pe baza câmpului de jonct,iune

• Aleget,i câmpurile care vor fi îmbinate

• Create a Custom field name prefix
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Figure 12.43: Alătură un tabel de atribute unui strat vectorial existent

12.2.6 Proprietăt,ile Diagramelor

The Diagrams tab allows you to add a graphic overlay to a vector layer (see figure_diagrams_attributes).

The current core implementation of diagrams provides support for:

• pie charts, a circular statistical graphic divided into slices to illustrate numerical proportion. The arc length
of each slice is proportional to the quantity it represents,

• text diagrams, a horizontaly divided circle showing statistics values inside

• and histograms.

Tip: Switch quickly between types of diagrams
Given that the settings are almost common to the different types of diagram, when designing your diagram, you
can easily change the diagram type and check which one is more appropriate to your data without any loss.

For each type of diagram, the properties are divided into several tabs:

• Atribute

• Appearance

• Dimensiune

• Plasament

• Opt,iuni

• Legendă

Atribute

Attributes defines which variables to display in the diagram. Use add item button to select the desired fields into
the ‘Assigned Attributes’ panel. Generated attributes with Expresii can also be used.
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You can move up and down any row with click and drag, sorting how attributes are displayed. You can also change
the label in the ‘Legend’ column or the attribute color by double-clicking the item.

This label is the default text displayed in the legend of the print composer or of the layer tree.

Figure 12.44: Diagram properties - Attributes tab

Appearance

Appearance defines how the diagram looks like. It provides general settings that do not interfere with the statistic
values such as:

• the graphic transparency, its outline width and color

• the width of the bar in case of histogram

• the circle background color in case of text diagram, and the font used for texts

• the orientation of the left line of the first slice represented in pie chart. Note that slices are displayed
clockwise.

In this tab, you can also manage the diagram visibility:

• by removing diagrams that overlap others or Show all diagrams even if they overlap each other

• by selecting a field with Data defined visibility to precisely tune which diagrams should be rendered

• by setting the scale visibility

Dimensiuni

Size is the main tab to set how the selected statistics are represented. The diagram size units can be ‘Map Units’
or ‘Millimeters’. You can use :

• Fixed size, an unique size to represent the graphic of all the features, except when displaying histogram

• or Scaled size, based on an expression using layer attributes.
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Figure 12.45: Diagram properties - Appearance tab

Figure 12.46: Diagram properties - Size tab
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Pozit,ionare

Placement helps to define diagram position. According to the layer geometry type, it offers different options for
the placement:

• ‘Over the point’ or ‘Around the point’ for point geometry. The latter variable requires a radius to follow.

• ‘Over the line’ or ‘Around the line’ for line geometry. Like point feature, the last variable requires a distance
to respect and user can specify the diagram placement relative to the feature (‘above’, ‘on’ and/or ‘below’
the line) It’s possible to select several options at once. In that case, QGIS will look for the optimal position
of the diagram. Remember that here you can also use the line orientation for the position of the diagram.

• ‘Over the centroid’, ‘Around the centroid’ (with a distance set), ‘Perimeter’ and anywhere ‘Inside polygon’
are the options for polygon features.

The diagram can also be placed using feature data by filling the X and Y fields with an attribute of the feature.

The placement of the diagrams can interact with the labeling, so you can detect and solve position conflicts
between diagrams and labels by setting the Priority slider or the z-index value.

Figure 12.47: Vector properties dialog with diagram properties, Placement tab

Opţiuni

The Options tab has settings only in case of histogram. You can choose whether the bar orientation should be
‘Up’, ‘Down’, ‘Right’ and ‘Left’.

Legend

From the Legend tab, you can choose to display items of the diagram in the Panoul Straturilor, besides the layer
symbology. It can be:

• the represented attributes: color and legend text set in Attributes tab

• and if applicable, the diagram size, whose symbol you can customize.

When set, the diagram legend items are also available in the print composer legend, besides the layer symbology.

Studiu de Caz

We will demonstrate an example and overlay on the Alaska boundary layer a text diagram showing temperature
data from a climate vector layer. Both vector layers are part of the QGIS sample dataset (see section Sample Data).

1. First, click on the Load Vector icon, browse to the QGIS sample dataset folder, and load the two vector
shape layers alaska.shp and climate.shp.
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2. Dublu clic pe stratul climate din legenda hărt,ii, pentru a deschide fereastra de dialog a Proprietăt,ilor
Stratului.

3. Click on the Diagrams tab and from the Diagram type combo box, select ‘Text diagram’.

4. In the Appearance tab, we choose a light blue as background color, and in the Size tab, we set a fixed size
to 18 mm.

5. In the Position tab, placement could be set to ‘Around Point’.

6. In the diagram, we want to display the values of the three columns T_F_JAN, T_F_JUL and T_F_MEAN.

So, in the Attributes tab first select T_F_JAN and click the button, then repeat with T_F_JUL and
finally T_F_MEAN.

7. Now click [Apply] to display the diagram in the QGIS main window.

8. You can adapt the chart size in the Size tab. Activate the Scaled size and set the size of the diagrams on
the basis of the maximum value of an attribute and the Size option. If the diagrams appear too small on the

screen, you can activate the Increase size of small diagrams checkbox and define the minimum size of
the diagrams.

9. Change the attribute colors by double clicking on the color values in the Assigned attributes field. Fig-
ure_diagrams_mapped gives an idea of the result.

10. Finally, click [Ok].

Figure 12.48: Diagrama datelor de temperatură, suprapusă pe o hartă

Remember that in the Position tab, a Data defined position of the diagrams is possible. Here, you can use
attributes to define the position of the diagram. You can also set a scale-dependent visibility in the Appearance
tab.

The size and the attributes can also be an expression. Use the button to add an expression. See Expresii
chapter for more information and example.

Using data-defined override

As mentioned above, you can use some custom data-defined to tune the diagrams rendering:

• position in Placement tab by filling X and Y fields

• visibility in Appearance tab by filling the Visibility field

See Folosirea suprascrierii definit,iilor de date pentru etichetare for more information.
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12.2.7 Proprietăt,ile Act,iunilor

QGIS provides the ability to perform an action based on the attributes of a feature. This can be used to
perform any number of actions, for example, running a program with arguments built from the attributes of a
feature or passing parameters to a web reporting tool.

Figure 12.49: Dialogul de ansamblu al act,iunilor, cu unele act,iuni de probă

Actions are useful when you frequently want to run an external application or view a web page based on one or
more values in your vector layer. They are divided into six types and can be used like this:

• Act,iunile generice Mac, Windows s, i Unix lansează un proces extern.

• Act,iunile Python execută o expresie Python.

• Act,iunile generice s, i Python sunt vizibile oriunde.

• Mac, Windows and Unix actions are visible only on the respective platform (i.e., you can define three ‘Edit’
actions to open an editor and the users can only see and execute the one ‘Edit’ action for their platform to
run the editor).

There are several examples included in the dialog. You can load them by clicking on [Create default actions].
To edit any of the examples, double-click its row. One example is performing a search based on an attribute value.
This concept is used in the following discussion.

Definirea Act,iunilor

To define an attribute action, open the vector Layer Properties dialog and click on the Actions tab. In the Actions

tab, click the Add a new action to open the Edit Action dialog.

Select the action Type and provide a descriptive name for the action. The action itself must contain the name of
the application that will be executed when the action is invoked. You can add one or more attribute field values as
arguments to the application. When the action is invoked, any set of characters that start with a % followed by the
name of a field will be replaced by the value of that field. The special characters %% will be replaced by the value
of the field that was selected from the identify results or attribute table (see using_actions below). Double quote
marks can be used to group text into a single argument to the program, script or command. Double quotes will be
ignored if preceded by a backslash.
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If you have field names that are substrings of other field names (e.g., col1 and col10), you should indicate that
by surrounding the field name (and the % character) with square brackets (e.g., [%col10]). This will prevent
the %col10 field name from being mistaken for the %col1 field name with a 0 on the end. The brackets will be
removed by QGIS when it substitutes in the value of the field. If you want the substituted field to be surrounded
by square brackets, use a second set like this: [[%col10]].

Using the Identify Features tool, you can open the Identify Results dialog. It includes a (Derived) item that contains
information relevant to the layer type. The values in this item can be accessed in a similar way to the other fields
by proceeding the derived field name with (Derived).. For example, a point layer has an X and Y field, and
the values of these fields can be used in the action with %(Derived).X and %(Derived).Y. The derived
attributes are only available from the Identify Results dialog box, not the Attribute Table dialog box.

Two example actions are shown below:

• konqueror http://www.google.com/search?q=%nam

• konqueror http://www.google.com/search?q=%%

In the first example, the web browser konqueror is invoked and passed a URL to open. The URL performs a
Google search on the value of the nam field from our vector layer. Note that the application or script called
by the action must be in the path, or you must provide the full path. To be certain, we could rewrite the first
example as: /opt/kde3/bin/konqueror http://www.google.com/search?q=%nam. This will
ensure that the konqueror application will be executed when the action is invoked.

The second example uses the %% notation, which does not rely on a particular field for its value. When the action
is invoked, the %% will be replaced by the value of the selected field in the identify results or attribute table.

Folosirea Act,iunilor

Actions can be invoked from either the Identify Results dialog, an Attribute Table dialog or from Run Fea-

ture Action (recall that these dialogs can be opened by clicking Identify Features or Open Attribute Table or
Run Feature Action). To invoke an action, right click on the feature and choose the action from the pop-up menu (they
should have been enabled to be displayed in the attribute table). Actions are listed in the popup menu by the name
you assigned when defining the action. Click on the action you wish to invoke.

Dacă invocat,i o act,iune care utilizează notat,ia %%, facet,i clic dreapta pe valoarea câmpului din dialogul de Identi-
ficare a Rezultatelor sau pe dialogul Tabelei de atribute, pe care dorit,i să le transmitet,i aplicat,iei sau script-ului.

Here is another example that pulls data out of a vector layer and inserts it into a file using bash and the echo com-

mand (so it will only work on or perhaps ). The layer in question has fields for a species name taxon_name,
latitude lat and longitude long. We would like to be able to make a spatial selection of localities and export
these field values to a text file for the selected record (shown in yellow in the QGIS map area). Here is the action
to achieve this:

bash -c "echo \"%taxon_name %lat %long\" >> /tmp/species_localities.txt"

După selectarea câtorva localităt,i s, i desfăs, urarea act,iunii pentru fiecare dintre ele, deschiderea fis, ierului de ies, ire
va prezenta ceva de genul:

Acacia mearnsii -34.0800000000 150.0800000000
Acacia mearnsii -34.9000000000 150.1200000000
Acacia mearnsii -35.2200000000 149.9300000000
Acacia mearnsii -32.2700000000 150.4100000000

As an exercise, we can create an action that does a Google search on the lakes layer. First, we need to determine
the URL required to perform a search on a keyword. This is easily done by just going to Google and doing a
simple search, then grabbing the URL from the address bar in your browser. From this little effort, we see that the
format is http://google.com/search?q=qgis, where QGIS is the search term. Armed with this information, we can
proceed:

1. Asigurat,i-vă că stratul lakes este încărcat.
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2. Open the Layer Properties dialog by double-clicking on the layer in the legend, or right-click and choose
Properties from the pop-up menu.

3. Click on the Actions tab.

4. click Add a new action.

5. Introducet,i un nume pentru act,iune, cum ar fi Google Search.

6. Pentru act,iune, trebuie să furnizăm numele programului extern care va rula. În acest caz, putem folosi
Firefox. În cazul în care programul nu se află în variabila Path, trebuie să-i furnizat,i calea completă.

7. Following the name of the external application, add the URL used for doing a Google search, up to but not
including the search term: http://google.com/search?q=

8. The text in the Action field should now look like this: firefox http://google.com/search?q=

9. Click on the drop-down box containing the field names for the lakes layer. It’s located just to the left of
the [Insert] button.

10. From the drop-down box, select ‘NAMES’ and click [Insert].

11. Act,iunea textului dvs. acum arată astfel:

firefox http://google.com/search?q=%NAMES

12. To finalize and add the action, click the [OK] button.

Figure 12.50: Edit action dialog configured with the example

This completes the action, and it is ready to use. The final text of the action should look like this:

firefox http://google.com/search?q=%NAMES

We can now use the action. Close the Layer Properties dialog and zoom in to an area of interest. Make sure the
lakes layer is active and identify a lake. In the result box you’ll now see that our action is visible:

When we click on the action, it brings up Firefox and navigates to the URL
http://www.google.com/search?q=Tustumena. It is also possible to add further attribute fields to the ac-
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Figure 12.51: Selectarea entitatăt,ii s, i alegerea act,iunii

tion. Therefore, you can add a + to the end of the action text, select another field and click on [Insert Field]. In
this example, there is just no other field available that would make sense to search for.

You can define multiple actions for a layer, and each will show up in the Identify Results dialog.

You can also invoke actions from the attribute table by selecting a row and right-clicking, then choosing the action
from the pop-up menu.

There are all kinds of uses for actions. For example, if you have a point layer containing locations of images or
photos along with a file name, you could create an action to launch a viewer to display the image. You could also
use actions to launch web-based reports for an attribute field or combination of fields, specifying them in the same
way we did in our Google search example.

We can also make more complex examples, for instance, using Python actions.

Usually, when we create an action to open a file with an external application, we can use absolute paths, or
eventually relative paths. In the second case, the path is relative to the location of the external program executable
file. But what about if we need to use relative paths, relative to the selected layer (a file-based one, like a shapefile
or SpatiaLite)? The following code will do the trick:

command = "firefox"
imagerelpath = "images_test/test_image.jpg"
layer = qgis.utils.iface.activeLayer()
import os.path
layerpath = layer.source() if layer.providerType() == ’ogr’

else (qgis.core.QgsDataSourceURI(layer.source()).database()
if layer.providerType() == ’spatialite’ else None)

path = os.path.dirname(str(layerpath))
image = os.path.join(path,imagerelpath)
import subprocess
subprocess.Popen( [command, image ] )

We just have to remember that the action is one of type Python and the command and imagerelpath variables must
be changed to fit our needs.

But what about if the relative path needs to be relative to the (saved) project file? The code of the Python action
would be:

command = "firefox"
imagerelpath = "images/test_image.jpg"
projectpath = qgis.core.QgsProject.instance().fileName()
import os.path
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path = os.path.dirname(str(projectpath)) if projectpath != ’’ else None
image = os.path.join(path, imagerelpath)
import subprocess
subprocess.Popen( [command, image ] )

Another Python action example is the one that allows us to add new layers to the project. For instance, the
following examples will add to the project respectively a vector and a raster. The names of the files to be added to
the project and the names to be given to the layers are data driven (filename and layername are column names of
the table of attributes of the vector where the action was created):

qgis.utils.iface.addVectorLayer(’/yourpath/[% "filename" %].shp’,
’[% "layername" %]’, ’ogr’)

Pentru a adăuga un raster (o imagine TIF în acest exemplu), devine:

qgis.utils.iface.addRasterLayer(’/yourpath/[% "filename" %].tif’,
’[% "layername" %]’)

12.2.8 Display Properties

This tab is specifically created for map tips: display a message in the map canvas when hovering over a feature
of the active layer. This message can either be the value of a Field or a more complex and full HTML text
mixing fields, expressions and html tags (multiline, fonts, images, hyperlink ...).

To activate Map Tips, select the menu option View → Map Tips or click on the Map Tips icon. Map tip is a
cross-session feature meaning that once activated, it stays on and apply to any set layer in any project, even in
future QGIS sessions until it’s toggled off.

Figures Display Code and Mapped show an example of HTML code and how it behaves in map canvas.

Figure 12.52: HTML code for map tip

12.2.9 Rendering Properties

QGIS offers support for on-the-fly feature generalisation. This can improve rendering times when drawing

many complex features at small scales. This feature can be enabled or disabled in the layer settings using the
Simplify geometry option. There is also a global setting that enables generalisation by default for newly added
layers (see global simplification for more information).

Note: Feature generalisation may introduce artefacts into your rendered output in some cases. These may include
slivers between polygons and inaccurate rendering when using offset-based symbol layers.
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Figure 12.53: Map tip made with HTML code

Figure 12.54: Dialogul de Simplificare a Stratului de Geometrie
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While rendering extremely detailed layers (e.g. polygon layers with a huge number of nodes), this can cause
composer exports in PDF/SVG format to be huge as all nodes are included in the exported file. This can also make
the resultant file very slow to work with/open in other programs.

Checking Force layer to render as raster forces these layers to be rasterised so that the exported files won’t
have to include all the nodes contained in these layers and the rendering is therefore sped up.

You can also do this by forcing the composer to export as a raster, but that is an all-or-nothing solution, given that
the rasterisation is applied to all layers.

12.2.10 Metadata Properties

The Metadata tab consists of Description, Attribution, MetadataURL, LegendUrl and Properties sections.

In the Properties section, you get general information about the layer, including specifics about the type and loca-
tion, number of features, feature type, and editing capabilities. The Extents table provides you with information
on the layer extent and the Layer Spatial Reference System, which is information about the CRS of the layer. This
can provide a quick way to get useful information about the layer.

Additionally, you can add or edit a title and abstract for the layer in the Description section. It’s also possible to
define a Keyword list here. These keyword lists can be used in a metadata catalog. If you want to use a title from
an XML metadata file, you have to fill in a link in the DataUrl field.

Use Attribution to get attribute data from an XML metadata catalog.

In MetadataUrl, you can define the general path to the XML metadata catalog. This information will be saved in
the QGIS project file for subsequent sessions and will be used for QGIS server.

In the LegendUrl section, you can provide the url of a legend image in the url field. You can use the Format
drop-down option to apply the appropriate format of the image. Currently png, jpg and jpeg image formats are
supported.

Figure 12.55: Metadata tab in vector layers properties dialog

Tip: Comutarea rapidă între diferite reprezentări ale straturilor
Using the Styles → Add combobox at the bottom of the Layer Properties dialog, you can save as many combi-
nations of layer properties settings (symbology, labeling, diagram, fields form, actions...) as you want. Then,
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simply switch between styles from the context menu of the layer in Layers Panel to automatically get different
representations of your data.

12.2.11 Variables Properties

The Variables tab lists all the variables available at the layer’s level (which includes all global and project’s
variables).

It also allows the user to manage layer-level variables. Click the button to add a new custom layer-level

variable. Likewise, select a custom layer-level variable from the list and click the button to remove it.

More information on variables usage in the General Tools Variables section.

12.2.12 Proprietăt,ile Legendei

The Legend tab provides you with a list of widgets you can embed within the layer tree in the Layers panel.
The idea is to have a way to quickly access some actions that are often used with the layer (setup transparency,
filtering, selection, style or other stuff...).

By default, QGIS provides transparency widget but this can be extended by plugins registering their own widgets
and assign custom actions to layers they manage.

12.3 Expresii

Based on layer data and prebuilt or user defined functions, Expressions offer a powerful way to manipulate
attribute value, geometry and variables in order to dynamically change the geometry style, the content or position
of the label, the value for diagram, the height of a composer item, select some features, create virtual field ...

12.3.1 Constructorul expresiilor de tip s, ir

Main dialog to build expressions, the Expression string builder is available from many parts in QGIS and, can
particularly be accessed when:

• făcând clic pe butonul ;

• selecting features with the Select By Expression... tool;

• editing attributes with e.g. the Field calculator tool;

• manipulating symbology, label or composer item parameters with the Data defined override tool (see Config-
urarea suprascrierii definită de date);

• building a geometry generator symbol layer;

• doing some geoprocessing.

Dialogul Constructorului de Expresii oferă acces la:

• Expression tab which, thanks to a list of predefined functions, helps to write and check the expression to
use;

• Function Editor tab which helps to extend the list of functions by creating custom ones.

Some use cases of expressions:
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• De la câmp Calculator, se calculează câmpul “pop_density” folosind câmpurile existente “total_pop” s, i
“area_km2”:

"total_pop" / "area_km2"

• Actualizarea câmpului “density_level” cu categorii, în funct,ie de valorile “pop_density”:

CASE WHEN "pop_density" < 50 THEN ’Low population density’
WHEN "pop_density" >= 50 and "pop_density" < 150 THEN ’Medium population density’
WHEN "pop_density" >= 150 THEN ’High population density’

END

• Aplicarea unui stil categorisit pentru toate entităt,ile, în funct,ie de pret,ul mediu al casei, dacă este mai mică
sau mai mare de 10000C pe metru pătrat:

"price_m2" > 10000

• Folosind instrumentul de “Selectare După Expresie...”, selectat,i toate entităt,ile care reprezintă zonele cu
“Densitate ridicată a populat,iei” s, i în care pret,ul mediu pentru o casă este mai mare de 10000C pe metru
pătrat:

"density_level" = ’High population density’ and "price_m2" > 10000

Likewise, the previous expression could also be used to define which features should be labeled or shown
in the map.

Using expressions offers you a lot of possibilities.

Tip: Use named parameters to improve the expression reading
Some functions require many parameters to be set. The expression engine supports the use of named parameters.
This means that instead of writing the cryptic expression clamp( 1, 2, 9), you can use clamp( min:=1,
value:=2, max:=9). This also allows arguments to be switched, e.g. clamp( value:=2, max:=9,
min:=1). Using named parameters helps clarify what the arguments for an expression function refer to, which
is helpful when you are trying to interpret an expression at a later date!

12.3.2 List of functions

The Expression tab provides the main interface to write expressions using functions, layer’s fields and values. It
contains widgets to:

• type expressions using functions and/or fields. At the bottom of the dialog, is displayed the result of the
expression evaluated on the first feature of the layer.

• select the appropriate function among a list, organized in groups. A search box is available to filter the list
and quickly find a particular function or field. Double-clicking on the item’s name adds it to the expression
being written.

• display help for each function selected. When a field is selected, this widget shows a sample of its values.
Double-clicking a value adds it to the expression.

Operatori

Acest grup cuprinde operatorii (ex.: +, -, *). De notat că pentru majoritatea funct,iilor matematice de mai jos, în
cazul în care una dintre intrări are valoarea NULL, atunci rezultatul este NULL.
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Figure 12.56: Fila Expresiilor

Funct,ia Descriere
a + b Adunarea a două valori (a plus b)
a - b Scăderea a două valori (a minus b)
a * b Înmult,irea a două valori (a înmult,it cu b)
a / b Împărt,irea a două valori (a împărt,it la b)
a % b Restul împărt,irii lui a la b (ex.: 7 % 2 = 1, sau 2 se potrives, te de trei ori în 7, având

restul 1)
a ^ b Puterea a două valori (de exemplu, 2^2=4 or 2^3=8)
a < b Compară două valori s, i le evaluează la 1, dacă valoarea din stânga este mai mică decât

cea din dreapta. (a este mai mic decât b)
a <= b Compares two values and evaluates to 1 if the left value isless than or equal to the right

value
a <> b Compară două valori, s, i le evaluează la 1 dacă acestea nu sunt egale
a = b Compară două valori s, i le evaluează la 1, dacă acestea sunt egale
a != b a s, i b nu sunt egale
a > b Compară două valori s, i le evaluează la 1, dacă valoarea din stânga este mai mare decât

cea din dreapta (a este mai mare decât b)
a >= b Compară două valori s, i le evaluează la 1, dacă valoarea din stânga este mai mare sau

egală cu cea din dreapta
a ~ b a se potrives, te cu expresia regulată b
|| Îmbină două valori într-un s, ir. Dacă una dintre valori este NULL, atunci rezultatul va fi

NULL.
‘\n’ Introduce o nouă linie într-un s, ir
LIKE Returnează 1 dacă primul parametru se potrives, te cu modelul furnizat
ILIKE Returnează 1 dacă primul parametru se potrives, te, în mod insensibil la context, cu

modelul furnizat. (ILIKE poate fi folosit în loc de LIKE, pentru a realiza o identificare
insensibilă la context)

a IS b Stabiles, te dacă două valori sunt identice. Returnează 1 dacă a este similar cu b
a OR b Returns 1 when condition a or condition b is true
a AND b Returns 1 when conditions a and b are true
NOT Neagă o condit,ie
nume de coloană
“numele coloanei”

Valoarea din câmpul reprezentat de numele coloanei; a se vedea mai jos, pentru a nu
face confuzie cu ghilimelele simple

‘s, ir’ o valoare de tip s, ir; a se vedea mai sus, pentru a nu face confuzie cu ghilimelele duble
NULL valoarea NULL
a IS NULL a nu are nici o valoare
a IS NOT NULL a are o valoare
a IN
(value[,value])

a se află în lista de valori

a NOT IN
(value[,value])

a nu se află în lista de valori
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Note: About fields concatenation
You can concatenate strings using either || or +. The latter also means sum up expression. So if you have an
integer (field or numeric value) this can be error prone. In this case, you should use ||. If you concatenate two
string values, you can use both.

Câteva exemple:

• Îmbină un s, ir cu o valoare din numele unei coloane:

’My feature’’s id is: ’ || "gid"
’My feature’’s id is: ’ + "gid" => triggers an error as gid is an integer
"country_name" + ’(’ + "country_code" + ’)’
"country_name" || ’(’ || "country_code" || ’)’

• Testat,i dacă atributul câmpului “description” începe cu s, irul ‘Hello’ (notat,i pozit,ia caracterului %):

"description" LIKE ’Hello%’

Conditionals

Acest grup cont,ine funct,ii care gestionează verificările condit,ionale din expresii.

Funct,ia Descriere
CASE WHEN ...
THEN ... END

Evaluează o expresie s, i returnează un rezultat dacă este adevărat. Avet,i
posibilitatea să testat,i mai multe condit,ii

CASE WHEN ...
THEN ... ELSE ...
END

Evaluează o expresie s, i returnează diverse rezultate, în funct,ie de valorile
returnate, true sau false. Avet,i posibilitatea de a testa mai multe condit,ii

coalesce Returnează prima valoare non-NULL din lista de expresii
if Teste o condit,ie s, i returnează un rezultat diferit, în funct,ie de verificarea

condit,ională
regexp_match Returns true if any part of a string matches the supplied regular expression

Câteva exemple:

• Trimite înapoi o valoare în cazul în care prima condit,ie este adevărată, altfel, transmite o altă valoare:

CASE WHEN "software" LIKE ’%QGIS%’ THEN ’QGIS’ ELSE ’Other’ END

Funct,iile Matematice

Acest grup cont,ine funct,ii matematice (ex.: rădăcina pătrată, sin s, i cos).
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Funct,ia Descriere
abs Returnează valoarea absolută a unui număr
acos Returnează cosinusul invers al unei valori, în radiani
asin Returnează sinusul invers al unei valori, în radiani
atan Returns the inverse tangent of a value in radians
atan2(y,x) Returns the inverse tangent of y/x by using the signs of the two arguments to determine the

quadrant of the result
az-
imuth(a,b)

Returnează azimutul, în funct,ie de nord, ca unghiul măsurat în radiani, în sens orar, pe verticală,
de la punctul a la punctul b

ceil Rotunjes, te în sus un număr
clamp Restrict,ionează într-un interval specificat o valoare de intrare
cos Returnează cosinusul unei valori, în radiani
degrees Convertes, te din radiani în grade
exp Returnează exponentul unei valori
floor Rotunjes, te în jos un număr
ln Returnează logaritmul natural al expresiei transmise
log Returnează valoarea logaritmului pentru valoarea s, i baza transmise
log10 Returnează valoarea logaritmului în baza 10 pentru expresia transmisă
max Returns the largest value in a set of values
min Returns the smallest value in a set of values
pi Returnează valoarea pi, pentru calcule
radians Convertes, te din grade în radiani
rand Returnează un număr aleator întreg, în intervalul specificat de argumentele minim s, i maxim

(inclusiv).
randf Returnează un număr aleator zecimal, în intervalul specificat de argumentele minim s, i maxim

(inclusiv)
round Rotunjes, te la numărul de pozit,ii zecimale
scale_exp Transformă o valoare dată dintr-un domeniu de intrare la un interval de ies, ire, folosind o curbă

exponent,ială
scale_linear Transformă o valoare dată dintr-un domeniu de intrare la un interval de ies, ire, folosind o

interpolare liniară
sin Returnează sinusul unui unghi
sqrt Returnează rădăcina pătrată a unei valori
tan Returnează tangenta unui unghi

Aggregates Functions

This group contains functions which aggregate values over layers and fields.
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Funct,ia Descriere
aggregate Returns an aggregate value calculated using features from another layer
concatenate Returns the all aggregated strings from a field or expression joined by a delimiter
count Returns the count of matching features
count_distinct Returns the count of distinct values
count_missing Returns the count of missing (null) values
iqr Returns the calculated inter quartile range from a field or expression
majority Returns the aggregate majority of values (most commonly occurring value) from a field or

expression
max_length Returns the maximum length of strings from a field or expression
maximum Returns the aggregate maximum value from a field or expression
mean Returns the aggregate mean value from a field or expression
median Returns the aggregate median value from a field or expression
min_length Returns the minimum length of strings from a field or expression
minimum Returns the aggregate minimum value from a field or expression
minority Returns the aggregate minority of values (least commonly occurring value) from a field or

expression
q1 Returns the calculated first quartile from a field or expression
q3 Returns the calculated third quartile from a field or expression
range Returns the aggregate range of values (maximum - minimum) from a field or expression
rela-
tion_aggregate

Returns an aggregate value calculated using all matching child features from a layer
relation

stdev Returns the aggregate standard deviation value from a field or expression
sum Returns the aggregate summed value from a field or expression

Exemple:

• Return the maximum of the “passengers” field from features in the layer grouped by “station_class” field:

maximum("passengers", group_by:="station_class")

• Calculate the total number of passengers for the stations inside the current atlas feature:

aggregate(’rail_stations’,’sum’,"passengers",
intersects(@atlas_geometry, $geometry))

• Return the mean of the “field_from_related_table” field for all matching child features using the
‘my_relation’ relation from the layer:

aggregate_relation(’my_relation’, ’mean’, "field_from_related_table")

sau:

aggregate_relation(relation:=’my_relation’, calculation := ’mean’,
expression := "field_from_related_table")

Funct,iile Culorilor

Acest grup cont,ine funct,ii pentru manipularea culorilor.
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Funct,ia Descriere
color_cmyk Returnează o reprezentare de tip s, ir a unei culori, în funct,ie de componentele ei cyan, magenta,

galben s, i negru
color_cmyka Returnează o reprezentare de tip s, ir a unei culori, în funct,ie de componentele ei cyan, magenta,

galben, negru s, i alpha (transparent,ă)
color_hsl Returnează o reprezentare de tip s, ir a culorii, pe baza atributelor nuant,ei, saturat,iei s, i

luminozităt,ii
color_hsla Returnează o reprezentare de tip s, ir a culorii, pe baza atributelor nuant,ei, saturat,iei, luminozităt,ii

s, i alpha (transparent,ă)
color_hsv Returnează o reprezentare de tip s, ir a culorii, pe baza atributelor nuant,ei, saturat,iei s, i valorii
color_hsva Returnează o reprezentare de tip s, ir a culorii, pe baza atributelor nuant,ei, saturat,iei, valorii s, i

alpha (transparent,ă)
color_part Returnează o componentă specifică dintr-un s, ir de culoare, de exemplu, o componentă ros, ie sau

o componentă alfa
color_rgb Returnează o reprezentare de tip s, ir a culorii, pe baza componentelor ros, ie, verde s, i albastră
color_rgba Returnează o reprezentare de tip s, ir a culorii, pe baza componentelor ros, ie, verde, albastră s, i

alpha (transparent,ă)
darker Returnează o culoare, de tip s, ir, mai închisă (sau mai deschisă)
lighter Returnează o culoare, de tip s, ir, mai deschisă (sau mai închisă)
project_colorReturnează o culoare din schema de culori a proiectului
ramp_color Returnează o reprezentare de tip s, ir a culorii, dintr-un interval de culori
set_color_partSetează o componentă de culoare specifică pentru un s, ir de culoare, cum ar fi o componentă

ros, ie sau o componentă alfa

Conversions Functions

Acest grup cont,ine funct,ii pentru transformarea dintr-un tip de dată în altul (ex.: din s, ir în întreg, din întreg în s, ir).

Funct,ia Descriere
to_date Convertes, te un s, ir într-un obiect de tip dată
to_datetime Convertes, te un s, ir într-un obiect datetime
to_int Convertes, te un s, ir într-un număr întreg
to_interval Convertes, te un s, ir într-un interval (poate fi folosit pentru a returna zilele, orele, lunile, etc

dintr-o dată)
to_real Convertes, te un s, ir într-un număr real
to_string Convertes, te un număr într-un s, ir
to_time Convertes, te un s, ir într-un obiect time

Funct,ii Personalizate

This group contains functions created by the user. See Editorul de Funct,ii for more details.

Funct,ii pentru Dată s, i Oră

Acest grup cont,ine funct,ii care gestionează datele calendaristice s, i ora.
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Funct,ia Descriere
age Returnează diferent,a dintre două date sau de tip datetimes, sub formă de interval
day Extrage ziua dintr-o dată sau dintr-o valoare datetime, sau numărul de zile dintr-un interval.
day_of_week Returnează un număr corespunzător zilei din săptămână, pentru data sau valoarea datetime

specificată
hour Extrage partea corespunzătoare orei dintr-o valoare datetime sau time, sau numărul de ore

dintr-un interval
minute Extrage partea corespunzătoare minutelor dintr-o valoare datetime sau time, sau numărul de

minute dintr-un interval.
month Extrage partea corespunzătoare lunii dintr-o valoare datetime sau time, sau numărul lunii

dintr-un interval.
now Returnează data s, i ora curente
secundă Extrage partea corespunzătoare secundelor dintr-o valoare time sau datetime, sau numărul de

secunde dintr-un interval
week Extrage numărul săptămânii dintr-o valoare date sau datetime, sau numărul de săptămâni

dintr-un interval
year Extrage partea corespunzătoare anului dintr-o valoare datetime sau time, sau numărul de ani

dintr-un interval

This group also shares several functions with the Conversions Functions ( to_date, to_time, to_datetime,
to_interval) and Funct,ii pentru S, iruri (format_date) groups.

Câteva exemple:

• Get today’s month and year in the “month_number/year” format:

format_date(now(),’MM/yyyy’)
-- Returns ’03/2017’

Besides these functions, subtracting dates, datetimes or times using the - (minus) operator will return an interval.

Adding or subtracting an interval to dates, datetimes or times, using the + (plus) and - (minus) operators, will
return a datetime.

• Get the number of days until QGIS 3.0 release:

to_date(’2017-09-29’) - to_date(now())
-- Returns <interval: 203 days>

• The same with time:

to_datetime(’2017-09-29 12:00:00’) - to_datetime(now())
-- Returns <interval: 202.49 days>

• Get the datetime of 100 days from now:

now() + to_interval(’100 days’)
-- Returns <datetime: 2017-06-18 01:00:00>

Note: Storing date and datetime and intervals on fields
The ability to store date, time and datetime values directly on fields may depend on the data source’s provider (e.g.,
shapefiles accept date format, but not datetime or time format). The following are some suggestions to overcame
this limitation.

date, Datetime and time can be stored in text type fields after using the to_format() function.

Intervals can be stored in integer or decimal type fields after using one of the date extraction functions (e.g.,
day() to get the interval expressed in days)

Fields and Values

Cont,ine o listă de câmpuri dintr-un strat.
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Generally, you can use the various fields, values and functions to construct the calculation expression, or you can
just type it into the box.

To display the values of a field, you just click on the appropriate field and choose between Load top 10 unique
values and Load all unique values. On the right side, the Field Values list opens with the unique values. At the
top of the list, a search box helps filtering the values. To add a value to the expression you are writing, double
click its name in the list.

Sample values can also be accessed via right-click. Select the field name from the list, then right-click to access a
context menu with options to load sample values from the selected field.

Fields name should be double-quoted in the expression. Values or string should be simple-quoted.

Funct,ii pentru Potrivirea Fuzzy

Acest grup cont,ine funct,ii pentru comparat,ii fuzzy între valori.

Funct,ia Descriere
ham-
ming_distance

Returnează numărul de caractere la pozit,iile corespunzătoare acelora din s, irurilor de intrare,
ale căror caractere sunt diferite

levensheim Returnează numărul minim de modificări de caractere (inserări, s, tersături sau înlocuiri)
necesare pentru a schimba un s, ir într-altul. Măsoară similitudinea dintre două s, iruri

longest_common_substringReturnează cel mai lung subs, ir comun dintre două s, iruri
soundex Returnează reprezentarea Soundex a unui s, ir de caractere

Funct,ii Generale

Acest grup cont,ine diverse funct,ii generale.

Funct,ia Descriere
eval Evaluează o expresie care este transmisă într-un s, ir. Foloses, te pentru a extinde parametrii

dinamici transmis, i ca variabile de context sau câmpuri
layer_propertyReturnează o proprietate a unui strat sau o valoare a metadatelor sale. Aceasta poate fi numele

stratului, crs-ul, tipul geometriei, numărul de entităt,i...
var Returnează valoarea stocată într-o variabilă specificată. A se vedea funct,iile variabile de mai jos

Funct,ii Geometrice

Acest grup cont,ine funct,ii care operează asupra geometriei obiectelor (de ex.: lungimea, suprafat,a).

Funct,ia Descriere
$area Returnează aria entităt,ii curente
$geometry Returnează geometria entităt,ii curente (se poate folosi pentru prelucrarea cu alte funct,ii)
$length Returnează lungimea entităt,ii curente de tip linie
$perimeter Returnează perimetrul entităt,ii curente de tip poligon
$x Returns the x coordinate of the current feature
$x_at(n) Returns the x coordinate of the nth node of the current feature’s geometry
$y Returns the y coordinate of the current feature
$y_at(n) Returns the y coordinate of the nth node of the current feature’s geometry
angle_at_vertex Returns the bisector angle (average angle) to the geometry for a specified vertex on a linestring geometry. Angles are in degrees clockwise from north
area Returnează aria unei entităt,i de geometrie poligonală. Calculele sunt în Sistemul de Referint,ă Spat,ială al acestei geometrii
azimuth Returns the north-based azimuth as the angle in radians measured clockwise from the vertical on point_a to point_b
boundary Returns the closure of the combinatorial boundary of the geometry (ie the topological boundary of the geometry).
bounds Returns a geometry which represents the bounding box of an input geometry. Calculations are in the Spatial Reference System of this geometry
bounds_height Returns the height of the bounding box of a geometry. Calculations are in the Spatial Reference System of this geometry
bounds_width Returns the width of the bounding box of a geometry. Calculations are in the Spatial Reference System of this geometry
buffer Returns a geometry that represents all points whose distance from this geometry is less than or equal to distance. Calculations are in the Spatial Reference System of this geometry

Continued on next page
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Table 12.1 – continued from previous page
Funct,ia Descriere
centroid Returns the geometric center of a geometry
closest_point Returnează cel mai apropiat punct al unei geometrii fat,ă de o alta
combine Returnează combinat,ia a două geometrii
contains(a,b) Returnează 1 (true) dacă s, i numai dacă nici un punct al geometriei b nu se află în exteriorul geometriei a, s, i cel put,in un punct din interiorul lui b se află în interiorul lui a
convex_hull Returns the convex hull of a geometry (this represents the minimum convex geometry that encloses all geometries within the set)
crosses Returnează 1 (true) dacă geometriile respective au unele puncte interioare, dar nu toate, în comun
difference(a,b) Returns a geometry that represents that part of geometry a that does not intersect with geometry b
disjoint Returnează 1 (true) dacă geometriile nu partajează nici un fel de spat,iu
distance Returns the minimum distance (based on Spatial Reference System) between two geometries in projected units
distance_to_vertex Returns the distance along the geometry to a specified vertex
end_point Returns the last node from a geometry
exterior_ring Returns a line string representing the exterior ring of a polygon geometry, or null if the geometry is not a polygon
extrude(geom,x,y) Returns an extruded version of the input (Multi-) Curve or (Multi-)Linestring geometry with an extension specified by x and y
geom_from_gml Returnează geometria dintr-o reprezentare GML a unei geometrii
geom_from_wkt Returnează o geometrie creată dintr-o reprezentare Well-Known Text (WKT)
geom_to_wkt Returnează reprezentarea Well-Known Text (WKT) a unei geometrii, fără metadatele SRID
geometrie Returnează geometria unei entităt,i
geometry_n Returnează geometria n dintr-o colect,ie de geometrii, sau null dacă geometria de intrare nu reprezintă o colect,ie
interior_ring_n Returnează inel interior n dintr-o geometrie poligonală, sau null dacă geometria de intrare nu reprezintă un poligon
intersection Returns a geometry that represents the shared portion of two geometries
intersects Testează dacă o geometrie intersectează o alta. Returnează 1 (true) dacă geometriile se intersectează spat,ial (partajează oricare parte din spat,iu) s, i 0 în caz contrar
intersects_bbox Tests whether a geometry’s bounding box overlaps another geometry’s bounding box. Returns 1 (true) if the geometries spatially intersect (share any portion of space) their bounding box, or 0 if they don’t
is_closed Returns true if a line string is closed (start and end points are coincident), false if a line string is not closed, or null if the geometry is not a line string
length Returnează lungimea unei entităt,i cu geometria de tip linie (sau lungimea unui s, ir de caractere)
line_interpolate_angle Returns the angle parallel to the geometry at a specified distance along a linestring geometry. Angles are in degrees clockwise from north.
line_interpolate_point Returns the point interpolated by a specified distance along a linestring geometry.
line_locate_point Returns the distance along a linestring corresponding to the closest position the linestring comes to a specified point geometry.
line_merge Returns a (Multi-)LineString geometry, where any connected LineStrings from the input geometry have been merged into a single linestring.
m Returns the m value of a point geometry
make_line Creează o geometrie de tip linie, dintr-o serie de geometrii de tip punct
make_point(x,y,z,m) Returns a point geometry from x and y (and optional z or m) values
make_point_m(x,y,m) Returns a point geometry from x and y coordinates and m values
make_polygon Creează o geometrie de tip poligon, dintr-un inel exterior s, i dintr-o serie de geometrii inelare interioare
nodes_to_points Returns a multipoint geometry consisting of every node in the input geometry
num_geometries Returnează numărul de geometrii dintr-o colect,ie geometrică, sau null dacă geometria de intrare nu reprezintă o colect,ie
num_interior_rings Returnează numărul de inele interioare dintr-un poligon sau dintr-o colect,ie geometrică, sau null dacă geometria de intrare nu reprezintă un poligon sau o colect,ie
num_points Returnează numărul de vertecs, i dintr-o geometrie
num_rings Returnează numărul de inele (incluzând inelele exterioare) dintr-un poligon sau dintr-o colect,ie geometrică, sau null dacă geometria de intrare nu reprezintă un poligon sau o colect,ie
order_parts Ordonează părt,ile unei MultiGeometrii după anumite criterii
overlaps Testează dacă o geometrie se suprapune peste alta. Returnează 1 (true) dacă geometriile partajează un spat,iu, sunt de aceeas, i dimensiune, dar nu sunt complet cont,inute una în cealaltă
perimeter Returnează perimetrul unei entităt,i de geometrie poligonală. Calculele sunt în Sistemul de Referint,ă Spat,ială al acestei geometrii
point_n Returns a specific node from a geometry
point_on_surface Returns a point guaranteed to lie on the surface of a geometry
proiect Returns a point projected from a start point using a distance and bearing (azimuth) in radians
relate Testează sau returnează Modelul Dimensional Extins cu 9 Intersect,ii (DE-9IM), de reprezentare a relat,iilor dintre două geometrii
reverse Reverses the direction of a line string by reversing the order of its vertices
segments_to_lines Returns a multi line geometry consisting of a line for every segment in the input geometry
shortest_line Returnează cea mai scurtă linie care unes, te două geometrii. Linia rezultată va începe la geometria 1 s, i se va încheia la geometria 2
start_point Returns the first node from a geometry
sym_difference Returns a geometry that represents the portions of two geometries that do not intersect
touches Testează dacă o geometrie o atinge pe alta. Returnează 1 (true) dacă geometriile respective au cel put,in un punct în comun, dar interioarele lor nu se intersectează
transform Returns the geometry transformed from the source CRS to the destination CRS
translate Returns a translated version of a geometry. Calculations are in the Spatial Reference System of this geometry
union Returnează o geometrie care reprezintă setul de puncte reunit al geometriilor
within (a,b) Testează dacă o geometrie este cont,inută în alta. Returnează 1 (true) dacă geometria a este complet inclusă în geometria b

Continued on next page
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Table 12.1 – continued from previous page
Funct,ia Descriere
x Returns the x coordinate of a point geometry, or the x coordinate of the centroid for a non-point geometry
x_min Returns the minimum x coordinate of a geometry. Calculations are in the Spatial Reference System of this geometry
x_max Returns the maximum x coordinate of a geometry. Calculations are in the Spatial Reference System of this geometry
y Returns the y coordinate of a point geometry, or the y coordinate of the centroid for a non-point geometry
y_min Returns the minimum y coordinate of a geometry. Calculations are in the Spatial Reference System of this geometry
y_max Returns the maximum y coordinate of a geometry. Calculations are in the Spatial Reference System of this geometry
z Returns the z coordinate of a point geometry

Câteva exemple:

• You can manipulate the current geometry with the variable $geometry to create a buffer or get the point on
surface:

buffer( $geometry, 10 )
point_on_surface( $geometry )

• Return the x coordinate of the current feature’s centroid:

x( $geometry )

• Trimite înapoi o valoare în funct,ie de suprafat,a entităt,ii:

CASE WHEN $area > 10 000 THEN ’Larger’ ELSE ’Smaller’ END

Record Functions

Acest grup cont,ine funct,ii care operează asupra identificatorilor de înregistrare.

Funct,ia Descriere
$current-
feature

Returnează entitatea care este evaluată în mod curent. Se poate utiliza cu funct,ia ‘atribut’ pentru
a evalua valorile atributelor din entitatea curentă.

$id Returnează id-ul entităt,ii din rândul curent
$map Returns the id of the current map item if the map is being drawn in a composition, or “canvas” if

the map is being drawn within the main QGIS window
$rownum Returns the number of the current row
$scale Returns the current scale of the map canvas
atribut Returns the value of a specified attribute from a feature
get_feature Returns the first feature of a layer matching a given attribute value
uuid Generates a Universally Unique Identifier (UUID) for each row. Each UUID is 38 characters

long.

Câteva exemple:

• Returnează prima entitate din stratul “LayerA”, al cărui câmp “id” are aceeas, i valoare ca s, i câmpul “nume”
al entităt,ii curente (un fel de relat,ie):

get_feature( ’layerA’, ’id’, attribute( $currentfeature, ’name’) )

• Se calculează aria entităt,ii îmbinate, din exemplul anterior:

area( geometry( get_feature( ’layerA’, ’id’, attribute( $currentfeature, ’name’) ) ) )

Funct,ii pentru S, iruri

Acest grup cont,ine funct,ii care operează asupra s, irurilor, (de ex: înlocuirea, conversia în majuscule).
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Funct,ia Descriere
char Returns the character associated with a unicode code
concat Concatenează mai multe s, iruri într-unul
format Formatează un s, ir folosind argumentele furnizate
for-
mat_date

Formatează un tip de dată sau un s, ir într-un format personalizat de tip text

for-
mat_number

Returnează un număr formatat, cu separatorul local pentru mii (trunchiază, de asemenea, la
numărul de cifre specificate)

left(string,
n)

Returnează un subs, ir care cont,ine n caractere din stânga s, irului

length Returnează lungimea unui s, ir (sau lungimea unei entităt,i cu geometria de tip linie)
lower Convertes, te un s, ir în litere mici
lpad Returns a string with supplied width padded using the fill character
reg-
exp_replace

Returnează s, irul înlocuit cu expresia regulată furnizată

reg-
exp_substr

Returnează port,iunea dintr-un s, ir care se potrives, te cu expresia regulată specificată

replace Returns a string with the supplied string replaced
right(string,
n)

Returnează un subs, ir care cont,ine n caractere din stânga s, irului

rpad Returns a string with supplied width padded using the fill character
strpos Returns the index of a regular expression in a string
substr Returnează o parte dintr-un s, ir
title Convertes, te, în nume proprii, toate cuvintele unui s, ir (toate cuvintele fiind scrise cu minuscule,

având o majusculă la început).
trim Elimină toate spat,iile albe de la începutul s, i de la sfârs, itul unui s, ir (spat,ii, tab-uri, etc)
upper Convertes, te un s, ir în majuscule.
wordwrap Returnează un s, ir cu un număr maxim/minim de caractere per linie

Funct,ii Recente

This group contains recently used functions. Any expression used in the Expression dialog is added to the list,
sorted from the more recent to the less one. This helps to quickly retrieve any previous expression.

Funct,ii Variabile

Acest grup cuprinde variabile dinamice referitoare la aplicat,ie, fis, ierul de proiect s, i alte setări. Aceasta înseamnă
că anumite funct,ii pot nu fie disponibile, în funct,ie de context:

• din dialogul Select by expression

• din dialogul Field calculator

• din dialogul cu proprietăt,ile stratului

• from the print composer

Pentru a utiliza aceste funct,ii într-o expresie, acestea ar trebui să fie precedate de caracterul @ (ex.:
@row_number). Sunt luate în considerare:

Funct,ia Descriere
atlas_feature Returnează entitatea curentă a atlasului (ca obiect entitate)
atlas_featureid Returnează ID-ul entităt,ii curente a atlasului
atlas_featurenumber Returns the number of pages in composition
atlas_filename Returnează numele curent al fis, ierului atlasului
atlas_geometry Returnează geometria entităt,ii curente a atlasului
atlas_pagename Returnează numele paginii curente a atlasului

Continued on next page
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Table 12.2 – continued from previous page
Funct,ia Descriere
atlas_totalfeatures Returnează numărul total de entităt,i din atlas
grid_axis Returnează axele actuale ale adnotării din grilă (de exemplu, ‘x’ pentru longitudine, ‘y’ pentru latitudine)
grid_number Returnează valoarea actuală a adnotării din grilă
item_id Returns the composer item user ID (not necessarily unique)
item_uuid Returns the composer item unique ID
layer_id Returnează ID-ul stratului curent
layer_name Returnează numele stratului curent
layout_dpi Returnează rezolut,ia compozit,iei (DPI)
layout_numpages Returns the number of pages in the composition
layout_pageheight Returns the composition height in mm
layout_pagewidth Returns the composition width in mm
map_extent_center Returnează entitatea de tip punct din centrul hărt,ii
map_extent_height Returnează înalt,imea curentă a hărt,ii
map_extent_width Returnează lăt,imea curentă a hărt,ii
map_id Returns the ID of current map destination. This will be ‘canvas’ for canvas renders, and the item ID for composer map renders
map_rotation Returnează rotat,ia curentă a hărt,ii
map_scale Returnează scara curentă a hărt,ii
project_filename Returns the filename of current project
project_folder Returns the folder for current project
project_path Returns the full path (including file name) of current project
project_title Returnează titlul proiectului curent
qgis_os_name Returnează numele Sistemului de Operare curent, ex.: ‘windows’, ‘linux’ sau ‘osx’
qgis_platform Returnează platforma QGIS, ex.: ‘desktop’ sau ‘server’
qgis_release_name Returnează numele versiunii curente de QGIS
qgis_version Returnează textul versiunii curente de QGIS
qgis_version_no Returnează numărul versiunii curente de QGIS
symbol_angle Returnează unghiul simbolului utilizat pentru randarea entităt,ii (valabil numai pentru însemnele simbolurilor)
symbol_color Returnează culoarea simbolului utilizat pentru a randa entitatea
user_account_name Returnează numele de cont al utilizatorului curent din sistemul de operare
user_full_name Returnează numele utilizatorului curent din sistemul de operare
row_number Stochează numărul rândului curent
valoare Returnează valoarea curentă

12.3.3 Editorul de Funct,ii

With the Function Editor, you are able to define your own Python custom functions in a comfortable way.

The function editor will create new Python files in .qgis2\python\expressions folder and will auto load
all functions defined when starting QGIS. Be aware that new functions are only saved in the expressions
folder and not in the project file. If you have a project that uses one of your custom functions you will need to also
share the .py file in the expressions folder.

Iată un scurt exemplu cu privire la modul de creare a propriilor funct,ii:

@qgsfunction(args="auto", group=’Custom’)
def myfunc(value1, value2, feature, parent):

pass

The short example creates a function myfunc that will give you a function with two values. When using the
args=’auto’ function argument the number of function arguments required will be calculated by the number
of arguments the function has been defined with in Python (minus 2 - feature, and parent).

This function then can be used with the following expression:

myfunc(’test1’, ’test2’)
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Figure 12.57: Fila Editorului de Funct,ii

Your function will be implemented in the Custom functions group of the Expression tab after using the Run Script
button.

Mai multe informat,ii despre crearea de cod Python pot fi găsite în PyQGIS-Developer-Cookbook.

The function editor is not only limited to working with the field calculator, it can be found whenever you work
with expressions.

‘ ‘

12.4 Lucrul cu Tabela de Atribute

The attribute table displays information on features of a selected layer. Each row in the table represents a feature
(with or without geometry), and each column contains a particular piece of information about the feature. Features
in the table can be searched, selected, moved or even edited.

12.4.1 Foreword: Spatial and non-spatial tables

QGIS allows you to load spatial and non-spatial layers. This currently includes tables supported by OGR and
delimited text, as well as the PostgreSQL, MSSQL, SpatiaLite, DB2 and Oracle provider. All loaded layers are
listed in the Layers Panel. Whether a layer is spatially enabled or not determines whether you can interact with it
on the map.

Non-spatial tables can be browsed and edited using the attribute table view. Furthermore, they can be used for
field lookups. For example, you can use columns of a non-spatial table to define attribute values, or a range of
values that are allowed, to be added to a specific vector layer during digitizing. Have a closer look at the edit
widget in section Fields Properties to find out more.

12.4.2 Introducing the attribute table interface

To open the attribute table for a vector layer, activate the layer by clicking on it in the Panoul Straturilor. Then,

from the main Layer menu, choose Open Attribute Table. It is also possible to right-click on the layer and

choose Open Attribute Table from the drop-down menu, or to click on the Open Attribute Table button in
the Attributes toolbar.
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This will open a new window that displays the feature attributes for the layer (figure_attributes_table). According
to the setting in Settings → Options → Data sources menu, the attribute table will open in a docked window or
a regular window. The total number of features in the layer and the number of currently selected/filtered features
are shown in the attribute table title, as well as if the layer is spatially limited.

Figure 12.58: Tabela de Atribute pentru stratul regiunilor

Butoanele din partea de sus a ferestrei tabelei de atribute oferă următoarele funct,ionalităt,i:
Pictogramă Etichetă Purpose Default Shortcut

Comutare mod de editare Enable editing functionalities Ctrl+E

Toggle multi edit mode Update multiple fields of many features

Save Edits Save current modifications Ctrl+S

Reload the table

Add feature Add new geometryless feature

S, terge entităt,ile selectate Remove selected features from the layer

Select features using an Expression

Selectează Tot Select all features in the layer Ctrl+A

Invert selection Invert the current selection in the layer Ctrl+R

Deselect all Deselect all features in the current layer Ctrl+Shift+A

Filter/Select features using form Ctrl+F

Move selected to top Move selected rows to the top of the table

Pan map to the selected rows Ctrl+P

Zoom map to the selected rows Ctrl+J

Copy selected rows to clipboard Ctrl+C

Paste features from clipboard Insert new features from copied ones Ctrl+V

New field Add a new field to the data source Ctrl+W

Delete field Remove a field from the data source Ctrl+L

Open field calculator Update field for many features in a row Ctrl+I

Formatare condit,ionată Enable table formatting

Table Attribute 1: Available Tools
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Note: Depending on the format of the data and the OGR library built with your QGIS version, some tools may
not be available.

Below these buttons is the Quick Field Calculation bar (enabled only in edit mode), which allows to quickly apply

calculations to all or part of the features in the layer. This bar uses the same expressions as the Field Calculator

(see Editarea valorilor atributului).

Tip: Skip WKT geometry

If you want to use attribute data in external programs (such as Excel), use the Copy selected rows to clipboard but-

ton. You can copy the information without vector geometries if you deactivate the Copy geometry in WKT
representation from attribute table option in Settings → Options → Data Sources menu.

Table view vs Form view

QGIS provides two view modes to easily manipulate data in the attribute table:

• the Table view, displaying values of multiple features in a tabular mode, each row representing a feature
and each column a field;

• and the Form view which shows identifiers of features in a first panel and displays only the attributes of
the clicked identifier in the second one. Form view uses the layer fields configuration (see Fields Properties).

You can switch from one mode to the other by clicking the convenient icon at the bottom right of the dialog.

You can also specify the Default view mode at the opening of the attribute table in Settings → Options → Data
Sources menu. It can be ‘Remember last view’, ‘Table view’ or ‘Form view’.

Configuring the columns

Right-click in a column header when in table view to have access to tools that help you configure what can be
displayed in the attribute table and how.

Hiding and organizing columns and enabling actions

By right-clicking in a column header, you can choose to hide it from the attribute table. To change several columns
behavior at once, unhide a column or change the order of the columns, choose Organize columns .... In the new
dialog, you can:

• check/uncheck columns you want to show or hide

• drag-and-drop items to reorder the columns in the attribute table. Note that this change is for the table
rendering and does not alter the fields order in the layer datasource

• enable a new virtual Actions column that displays in each row a drop-down box or button list of actions for
each row, see Proprietăt,ile Act,iunilor for more information about actions.

Resizing columns widths

Columns width can be set through a right-click on the column header and select either:

• Set width... to enter the desired value. By default, the current value is displayed in the widget

• Autosize to resize at the best fit the column.

It can also be changed by dragging the boundary on the right of the column heading. The new size of the column
is maintained for the layer, and restored at the next opening of the attribute table.
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Figure 12.59: Attribute table in form view (top) vs table view (bottom)
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Sorting columns

The table can be sorted by any column, by clicking on the column header. A small arrow indicates the sort
order (downward pointing means descending values from the top row down, upward pointing means ascending
values from the top row down). You can also choose to sort the rows with the sort option of the column header
context menu and write an expression, e.g. to sort the row using multiple columns you can write concat(col0,
col1).

In form view, features identifier can be sorted using the Sort by preview expression option.

Tip: Sorting based on columns of different types
Trying to sort an attribute table based on columns of string and numeric types may lead to unexpected re-
sult because of the concat("USE", "ID") expression returning string values (ie, ’Borough105’ <
’Borough6’). You can workaround this by using eg concat("USE", lpad("ID", 3, 0)) which re-
turns ’Borough105’ > ’Borough006’.

Formatting of table cells using conditions

Conditional formatting settings can be used to highlight in the attribute table features you may want to put a
particular focus on, using custom conditions on feature’s:

• geometry (e.g., identifying multi-parts features, small area ones or in a defined map extent...);

• or field value (e.g., comparing values to a threshold, identifying empty cells...)

You can enable the conditional formatting panel clicking on at the top right of the attributes window in table
view (not available in form view).

The new panel allows user to add new rules to format rendering of Field or Full row. Adding new rule opens
a form to define:

• the name of the rule;

• a condition using any of the expression builder functions;

• the formatting: it can be choosen from a list of predefined formats or created based on properties like:

– background and text colors;

– use of icon;

– bold, italic, underline, or strikeout;

– fontul.

12.4.3 Interacting with features in an attribute table

Selectare entităt,i

In table view, each row in the attribute table displays the attributes of a unique feature in the layer. Selecting a row
selects the feature and likewise, selecting a feature in the map canvas (in case of geometry enabled layer) selects
the row in the attribute table. If the set of features selected in the map canvas (or attribute table) is changed, then
the selection is also updated in the attribute table (or map canvas) accordingly.

Rows can be selected by clicking on the row number on the left side of the row. Multiple rows can be marked by
holding the Ctrl key. A continuous selection can be made by holding the Shift key and clicking on several
row headers on the left side of the rows. All rows between the current cursor position and the clicked row are
selected. Moving the cursor position in the attribute table, by clicking a cell in the table, does not change the row
selection. Changing the selection in the main canvas does not move the cursor position in the attribute table.
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Figure 12.60: Formatarea condit,ională a unei tabelelor cu atribute

In form view of the attribute table, features are by default identified in the left panel by the value of their displayed
field (see Display Properties). This identifier can be replaced using the drop-down list at the top of the panel,
either by selecting an existing field or using a custom expression. You can also choose to sort the list of features
from the drop-down menu.

Click a value in the left panel to display the feature’s attributes in the right one. To select a feature, you need to
click inside the square symbol at the left of the identifier. By default, the symbol turns into yellow. Like in the
table view, you can perform multiple feature selection using the keyboard combinations previously exposed.

Beyond selecting features with the mouse, you can perform automatic selection based on feature’s attribute using
tools available in the attribute table toolbar, such as (see section Automatic selection and following one for more
information and use case):

• Select By Expression...

• Select Features By Value...

• Deselect Features from All Layers

• Select All Features

• Invert Feature Selection.

It is also possible to select features using the Filtering and selecting features using forms.

Filtrarea entităt,ilor

Once you have selected features in the attribute table, you may want to display only these records in the table.
This can be easily done using the Show Selected Features item from the drop-down list at the bottom left of the
attribute table dialog. This list offers the following filters:

• Afişează Toate Entităt,ile

• Show Selected Features

• Show Features visible on map

• Show Edited and New Features
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• Field Filter - allows the user to filter based on value of a field: choose a column from a list, type a value and
press Enter to filter. Then, only the matching features are shown in the attribute table.

• Advanced filter (Expression) - Opens the expression builder dialog. Within it, you can create complex
expressions to match table rows. For example, you can filter the table using more that one field. See
Expresii for more information.

It is also possible to filter features using the Filtering and selecting features using forms.

Note: Filtering records out of the attribute table does not filter features out of the layer; they are simply momen-
taneously hidden from the table and can be accessed from the map canvas or by removing the filter. For filters that
do hide features from the layer, use the Query Builder.

Tip: Update datasource filtering with Show Features Visible on Map

When for performance reasons, features shown in attribute table are spatially limited to the canvas extent at its
opening (see Data Source Options for a how-to), selecting Show Features Visible on Map on a new canvas extent
updates the spatial restriction.

Filtering and selecting features using forms

Clicking the Filter/Select features using form or pressing Ctrl+F the attribute table dialog will switch to form view
and all widgets are replaced with their search variant.

From this point onwards, this tool functionality is similar to the one described in the Select Features By Value,
where you can find descriptions of all operators and selecting modes.

Moreover, in the attribute table case, there is also a Filter features button that allows filtering features instead of
selecting them (by creating an Advanced Filter (Expression) for the user).

Figure 12.61: Attribute table filtered by the filter form

If there are already filtered features, you can refine the filter using the drop-down list next to the Filter features
button. The options are:

• Filter within (“AND”)

• Extend filter (“OR”)

To clear the filter, either select Show all features option mentioned in Filtrarea entităt,ilor, or click the clear the
expression and click [Apply].
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12.4.4 Using action on features

Users have several possibilities to manipulate feature with the contextual menu like:

• Select all (Ctrl+A) the features

• Copy the content of a cell in the clipboard with Copy cell content.

• Zoom to feature without having to select it beforehand

• Open form. It toggles attribute table into form view with a focus on the clicked feature

Figure 12.62: Copy cell content button

If you want to use attribute data in external programs (such as Excel, LibreOffice, QGIS or a custom web applica-

tion), select one or more row(s) and use the Copy selected rows to clipboard button or press Ctrl+C. In Settings →
Options → Data Sources menu you can define the format to paste to with Copy features as dropdown list:

• Plain text, no geometry,

• Plain text, WKT geometry,

• GeoJSON

You can also display a list of actions in this contextual menu. This is enabled in the Layer properties → Actions
tab. See Proprietăt,ile Act,iunilor for more information on actions.

Saving selected features as new layer

The selected features can be saved as any OGR-supported vector format and also transformed into another coor-
dinate reference system (CRS). In the contextual menu of the layer, from the Layers Panel, click on Save as to
define the name of the output file, its format and CRS (see section Creating new layers from an existing layer).

To save the selection ensure that the Save only selected features is selected. It is also possible to specify OGR
creation options within the dialog.

12.4.5 Editarea valorilor atributului

Editing attribute values can be done by:

• typing the new value directly in the cell, whether the attribute table is in table or form view. Changes are
hence done cell by cell, feature by feature;

• using the field calculator: update in a row a field that may already exist or to be created but for multiple
features; it can be used to create virtual fields.

• using the quick field calculation bar: same as above but for only existing field

• or using the multi edit mode: update in a row multiple fields for multiple features.
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Using the Field Calculator

The Field Calculator button in the attribute table allows you to perform calculations on the basis of existing
attribute values or defined functions, for instance, to calculate length or area of geometry features. The results can
be written to a new attribute field, a virtual field, or they can be used to update values in an existing field.

The field calculator is available on any layer that supports edit. When you click on the field calculator icon the
dialog opens (see figure_field_calculator). If the layer is not in edit mode, a warning is displayed and using the
field calculator will cause the layer to be put in edit mode before the calculation is made.

Based on the Expression Builder dialog, the field calculator dialog offers a complete interface to define an expres-
sion and apply it to an existing or a newly created field. To use the field calculator dialog, you first must select
whether you want to only update selected features, create a new attribute field where the results of the calculation
will be added or update an existing field.

Figure 12.63: Calculatorul de Câmpuri

If you choose to add a new field, you need to enter a field name, a field type (integer, real, date or string) and if
needed, the total field length and the field precision. For example, if you choose a field length of 10 and a field
precision of 3, it means you have 6 digits before the dot, then the dot and another 3 digits for the precision.

A short example illustrates how field calculator works when using the Expression tab. We want to calculate the
length in km of the railroads layer from the QGIS sample dataset:

1. Încărcat,i fis, ierul shape railroads.shp în QGIS s, i efectuat,i pe Deschiderea Tabelei de Atribute.

2. Clic pe Comutare în modul de editiare, apoi deschidet,i dialogul Calculatorului de Câmpuri.

3. Selectat,i caseta de bifare pentru Crearea unui nou câmp, în scopul salvării calculelor într-un nou câmp.

4. Add length as Output field name and real as Output field type, and define Output field length to be 10
and Precision, 3.

5. Acum, facet,i dublu clic pe funct,ia $length din grupul Geometry pentru a-l adăuga în Câmpul calcula-
torului de expresii.
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6. Complete the expression by typing / 1000 in the Field calculator expression box and click [Ok].

7. Acum, putet,i găsi noul câmp length în tabelul de atribute.

Creating a Virtual Field

A virtual field is a field based on an expression calculated on the fly, meaning that its value is automatically updated
as soon as the underlying parameter changes. The expression is set once; you no longer need to recalculate the
field each time underlying values change. For example, you may want to use a virtual field if you need area to
be evaluated as you digitize features or to automatically calculate a duration between dates that may change (e.g.,
using now() function).

Note: Utilizarea Câmpurilor Virtuale
• Virtual fields are not permanent in the layer attributes, meaning that they’re only saved and available in the

project file they’ve been created.

• A field can be set virtual only at its creation and the expression used can’t be changed later: you’ll need to
delete and recreate that field.

Using the Quick Field Calculation Bar

While Field calculator is always available, the quick field calculation bar on top of the attribute table is only visible
if the layer is in edit mode. Thanks to the expression engine, it offers a quicker access to edit an already existing
field.

In quick field calculation bar, you simply need to:

• select the existing field name in the drop-down list

• fill the textbox with an expression you directly write or build using the expression button

• and click on [Update All], [Update Selected] or [Update Filtered] button according to your need.

Editing multiple fields

Unlike the previous tools, multi edit mode allows multiple attributes of different features to be edited simultane-
ously. When the layer is toggled to edit, multi edit capabilities are accessible:

• using the Toggle multi edit mode button from the toolbar inside the attribute table dialog,

• or selecting Edit → Modify attributes of selected features menu.

In order to edit multiple fields in a row:

1. select the features you want to edit;

2. from the attribute table toolbar, click the button. This will toggle the dialog to its form view. Feature
selection could also be made at this step;

3. at the right side of the attribute table, fields (and values) of selected features are shown. New widgets appear
next to each field allowing for display of the current multi edit state:

• the field contains different values for selected features. It’s shown empty and each feature will
keep its original value. You can reset the value of the field from the drop-down list of the widget.

• all selected features have the same value for this field and the value displayed in the form will be
kept.

198 Chapter 12. Lucrul cu Datele Vectoriale



QGIS User Guide, Release 2.18

• the field has been edited and the entered value will be applied to all the selected features. A
message appears at the top of the dialog, inviting you to either apply or reset your modification.

Clicking any of these widgets allows you to either set the current value for the field or reset to original value,
meaning that you can roll back changes on a field-by-field basis.

4. make the changes to the fields you want and click on Apply changes in the upper message text or any other
feature in the left panel.

Changes will apply to all selected features. If no feature is selected, the whole table is updated with your changes.

Modifications are made as a single edit command. So pressing Undo will rollback the attribute changes for all
selected features at once.

Note: Unlike the tool from the attribute table, hitting the Edit → Modify Attributes of Selected Features option
provides you with a modal dialog to fill attributes changes. Hence, features selection is required before execution.

Figure 12.64: Editing fields of multiple features

Note: Multi edit mode is only available for auto generated and drag and drop forms (see Customize a form for
your data); it is not supported by custom ui forms.

12.4.6 Creating one or many to many relations

Relations are a technique often used in databases. The concept is that features (rows) of different layers (tables)
can belong to each other.

Introducing 1-N relations

As an example you have a layer with all regions of alaska (polygon) which provides some attributes about its name
and region type and a unique id (which acts as primary key).

Then you get another point layer or table with information about airports that are located in the regions and you
also want to keep track of these. If you want to add them to the regions layer, you need to create a one to many
relation using foreign keys, because there are several airports in most regions.
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Figure 12.65: Regiunile cu aeroporturi din Alaska

Layers in 1-N relations

QGIS makes no difference between a table and a vector layer. Basically, a vector layer is a table with a geometry.
So you can add your table as a vector layer. To demonstrate the 1-n relation, you can load the regions shapefile
and the airports shapefile which has a foreign key field (fk_region) to the layer regions. This means, that
each airport belongs to exactly one region while each region can have any number of airports (a typical one to
many relation).

Foreign keys in 1-N relations

In addition to the already existing attributes in the airports attribute table, you’ll need another field fk_region
which acts as a foreign key (if you have a database, you will probably want to define a constraint on it).

This field fk_region will always contain an id of a region. It can be seen like a pointer to the region it belongs
to. And you can design a custom edit form for editing and QGIS takes care of the setup. It works with different
providers (so you can also use it with shape and csv files) and all you have to do is to tell QGIS the relations
between your tables.

Defining 1-N relations (Relation Manager)

The first thing we are going to do is to let QGIS know about the relations between the layers. This is done in
Project → Project Properties.... Open the Relations tab and click on [Add Relation].

• name is going to be used as a title. It should be a human readable string, describing, what the relation is
used for. We will just call say Airports in this case.

• referencing layer also considered as child layer, is the one with the foreign key field on it. In our case, this
is the airports layer

• referencing field will say, which field points to the other layer so this is fk_region in this case

• referenced layer also considered as parent layer, is the one with the primary key, pointed to, so here it is
the regions layer

• referenced field is the primary key of the referenced layer so it is ID

• id will be used for internal purposes and has to be unique. You may need it to build custom forms. If you
leave it empty, one will be generated for you but you can assign one yourself to get one that is easier to
handle.
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Figure 12.66: Managerul de Relat,ii

Forms for 1-N relations

Now that QGIS knows about the relation, it will be used to improve the forms it generates. As we did not change
the default form method (autogenerated) it will just add a new widget in our form. So let’s select the layer region
in the legend and use the identify tool. Depending on your settings, the form might open directly or you will have
to choose to open it in the identification dialog under actions.

Figure 12.67: Dialogul de identificare a regiunilor, cu relat,iile între aeroporturi

As you can see, the airports assigned to this particular region are all shown in a table. And there are also some
buttons available. Let’s review them shortly

• The button is for toggling the edit mode. Be aware that it toggles the edit mode of the airport layer,
although we are in the feature form of a feature from the region layer. But the table is representing features
of the airport layer.

• The button will add a new feature to the airport layer. And it will assign the new airport to the current
region by default.
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• The button will delete the selected airport permanently.

• The symbol will open a new dialog where you can select any existing airport which will then be assigned
to the current region. This may be handy if you created the airport on the wrong region by accident.

• The symbol will unlink the selected airport from the current region, leaving them unassigned (the
foreign key is set to NULL) effectively.

• The two buttons to the right switch between table view and form view where the later let’s you view all the
airports in their respective form.

If you work on the airport table, a new widget type is available which lets you embed the feature form of the
referenced region on the feature form of the airports. It can be used when you open the layer properties of the
airports table, switch to the Fields menu and change the widget type of the foreign key field ‘fk_region’ to Relation
Reference.

If you look at the feature dialog now, you will see, that the form of the region is embedded inside the airports form
and will even have a combobox, which allows you to assign the current airport to another region.

Figure 12.68: Dialogul de identificare a aeroportului, cu relat,iile între regiuni

Introducing many-to-many (N-M) relations

N-M relations are many-to-many relation between two tables. For instance, the airports and airlines
layers: an airport receives several airline companies and an airline company flies to several airports.

In such case, we need a pivot table to list all airlines for all airports. In QGIS, you should setup two one-to-many
relations as explained above:

• a relation between airlines table and the pivot table;

• and a second one between airports table and the pivot table.

When we add a new child (i.e. a company to an airport), QGIS will add a new row in the pivot table and in the
airlines table. If we link a company to an airport, QGIS will only add a row in the pivot table.

In case you want to remove a link, an airline or an airport, QGIS won’t remove the row in the pivot table. The
database administrator should add a ON DELETE CASCADE instruction in the foreign key constraint:

ALTER TABLE location.airlines
ADD CONSTRAINT location_airlines_airports_id_fkey

FOREIGN KEY (id)
REFERENCES location.airports(id)

ON DELETE CASCADE;

Note: Combining N-M relation with automatic transaction group
You should enable the transaction mode in Project Properties → Data Sources → when working on such context.
QGIS should be able to add or update row(s) in all tables (airlines, airports and the pivot tables).
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Finally, adding such relations in a form is done in the same way that for a one-to-many relation. The Relations
panel in the Fields properties of the vector layer will let the user add the relation in the form. It will appear as a
Many to many relation.

12.5 Editarea

QGIS supports various capabilities for editing OGR, SpatiaLite, PostGIS, MSSQL Spatial and Oracle Spatial
vector layers and tables.

Note: Procedura pentru editarea straturilor GRASS este diferită - a se vedea sect,iunea Digitizarea s, i editarea
unui strat vectorial GRASS pentru detalii.

Tip: Editări Concurente
Această versiune de QGIS nu sesizează dacă altcineva editează o entitate în acelas, i timp cu dvs. Vor fi păstrate
doar editările salvate de către ultima persoană.

12.5.1 Setarea Tolerant,ei Acros, ării s, i Căutarea Razei

Pentru o editare optimă s, i exactă a geometriilor din straturile vectoriale, trebuie să setăm o valoare corespunzătoare
pentru tolerant,a acros, ării s, i pentru raza de căutare a nodurilor din entităt,i.

Toleranţa de acros, are

Snapping tolerance is the distance QGIS uses to search for the closest vertex and/or segment you are trying to
connect to when you set a new vertex or move an existing vertex. If you aren’t within the snapping tolerance,
QGIS will leave the vertex where you release the mouse button, instead of snapping it to an existing vertex and/or
segment. The snapping tolerance setting affects all tools that work with tolerance.

1. A general, project-wide snapping tolerance can be defined by choosing Settings → Options..., Digitizing
tab. You can select between ‘To vertex’, ‘To segment’ or ‘To vertex and segment’ as default snap mode.
You can also define a default snapping tolerance and a search radius for vertex edits. The tolerance can be
set either in map units or in pixels. The advantage of choosing pixels is that the snapping tolerance doesn’t
have to be changed after zoom operations. In our small digitizing project (working with the Alaska dataset),
we define the snapping units in feet. Your results may vary, but something on the order of 300 ft at a scale
of 1:10000 should be a reasonable setting.

2. A layer-based snapping tolerance that overrides the global snapping options can be defined by choosing
Settings → Snapping options. It enables and adjusts snapping mode and tolerance on a layer basis (see
figure_edit_snapping ). This dialog offers three different modes to select the layer(s) to snap to:

• Current layer: only the active layer is used, a convenient way to ensure topology within the layer being
edited

• All layers: a quick and simple setting for all visible layers in the project so that the pointer snaps to all
vertices and/or segments. In most cases it is sufficient to use this snapping mode.

• Avansat: dacă trebuie să editat,i un strat s, i să acros, at,i nodurile sale fat,ă de un alt strat, asigurat,i-vă că at,i
selectat stratul de destinat,ie s, i cres, tet,i tolerant,a de acros, are. În plus, acros, area nu va avea loc pentru
straturile care nu sunt selectate în caseta de dialog a opt,iunilor de acros, are, indiferent de tolerant,a
globală. Prin urmare, asigurat,i-vă că at,i bifat acele straturi fat,ă de care dorit,i acros, area.

Tip: Controlat,i lista de straturi pentru acros, are
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Figure 12.69: Editat,i opt,iunilor de acros, are în funct,ie de strat (Mod avansat)

The Snapping Options dialog is by default populated with parameters (mode, tolerance, units) set in the global
Digitizing tab. To avoid layers being checked by default in the Advanced mode and hence set snappable, define
the Default Snap mode to Off.

Snapping tolerance can be set in pixels or map units (the units of the map view). While in the Advanced
layer selection mode, it is possible to use a snapping tolerance that refers to layer units, the units of the
reprojected layer when ‘on-the-fly’ CRS transformation is on.

Raza de căutare

Search radius is the distance QGIS uses to search for the closest vertex you are trying to select when you click
on the map. If you aren’t within the search radius, QGIS won’t find and select any vertex for editing. The search
radius for vertex edits can be defined under Settings → Options → Digitizing tab. This is the same place where
you define the general, project-wide snapping tolerance.

Snap tolerance and search radius are set in map units or pixels, so you may find you need to experiment to
get them set right. If you specify too big of a tolerance, QGIS may snap to the wrong vertex, especially if you are
dealing with a large number of vertices in close proximity. Set search radius too small, and it won’t find anything
to move.

12.5.2 Editarea topologică

Besides layer-based snapping options, you can also define topological functionalities in the Snapping options...

dialog in the Settings (or File) menu. Here, you can define Enable topological editing, and/or for polygon

layers, activate the Avoid Intersections option.

Editarea editării topologice

Opt,iunea de Activare a editării topologice foloses, te la îmbunătăt,irea editării s, i la ment,inerea granit,elor comune
pentru mozaicurile cu entităt,i. QGIS ‘detectează’ o granit,ă comună în funct,ie de entităt,i, as, a că este suficient doar
să mutat,i un vertex/segment, iar QGIS va asigura actualizarea celorlalte entităt,i învecinate.

Evitarea intersecţiilor pentru poligoanele noi

O a doua opt,iune topologică denumită Evitare intersect,ii vă împiedică să desenat,i noi entităt,i care se suprapun
peste altele. Serves, te la digitizarea mai rapidă a poligoanelor adiacente. Dacă avet,i deja un poligon, este posibil,
cu această opt,iune să digitizat,i un al doilea poligon adiacent, astfel încât ambele poligoane să se suprapună, apoi
QGIS va decupa al doilea poligon după limitele celui existent. Avantajul este că nu trebuie să digitizat,i toate
vertexurile limitei comune.
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Note: If the new geometry is totally covered by existing ones, it gets cleared and the new feature will have no
geometry when allowed by the provider, otherwise saving modifications will make QGIS pop-up an error message.

Warning: Use cautiously the Avoid Intersections option
Because the option cuts or clears geometry of any overlaping feature from any polygon layer, do not forget to
uncheck this option once you no longer need it otherwise, you can get unexpected geometries.

Activarea acros, ării la intersect,ii

Another option is to use Enable snapping on intersection. It allows you to snap on an intersection of back-
ground layers, even if there’s no vertex on the intersection.

Verificatorul de Geometrii

Un plugin de bază poate ajuta utilizatorul să găsească erorile de geometrie. Putet,i găsi mai multe informat,ii despre
acest plugin la Plugin-ul Verificator de Geometrie.

12.5.3 Digitizarea unui strat vectorial existent

By default, QGIS loads layers read-only. This is a safeguard to avoid accidentally editing a layer if there is a slip
of the mouse. However, you can choose to edit any layer as long as the data provider supports it (see Explorarea
Formatelor de Date s, i a Câmpurilor), and the underlying data source is writable (i.e., its files are not read-only).

Tip: Restrict edit permission on layers within a project
From the Project → Project properties → Identify tab, You can choose to set any layer read-only regardless
the provider permission. This can be a handy way, in a multi-users environment to avoid unauthorized users to
mistakenly edit layers (e.g., shapefile), hence potentially corrupt data. Note that this setting only applies inside
the current project.

In general, tools for editing vector layers are divided into a digitizing and an advanced digitiz-
ing toolbar, described in section Digitizare avansată. You can select and unselect both under
View → Toolbars →. Using the basic digitizing tools, you can perform the following functions:

Pictogramă Scop Pictogramă Scop

Editări curente Activarea/dezactivarea editării

Adăugare Entităt,i: Captura unui Punct Adăugare Entităt,i: Captura unei Linii

Adăugare Entităt,i: Captura unui Poligon Move Feature

Add Circular String Add Circular String By Radius

Node Tool S, tergere Select,ie

Decupare Entităt,i Copiere Entităt,i

Lipire Entităt,i Salvează modificările stratului

Editarea Tabelei: Bara instrumentelor de editare de bază, pentru straturile vectoriale

Note that while using any of the digitizing tools, you can still zoom or pan in the map canvas without losing the
focus on the tool.

All editing sessions start by choosing the Toggle editing option found in the context menu of a given layer, from
the attribute table dialog, the digitizing toolbar or the Edit menu.
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Once the layer is in edit mode, additional tool buttons on the editing toolbar will become available and markers
will appear at the vertices of all features unless Show markers only for selected features option under Settings →
Options... → Digitizing menu is checked.

Tip: Salvat,i cu Regularitate

Amintit,i-vă să Salvat,i Modificările Stratului cu regularitate. Aceasta va confirma, de asemenea, că sursa de date poate
accepta modificările.

Adăugare Entităt,i

You can use the Add Feature, Add Feature or Add Feature icons on the toolbar to add new feature (point, line
and polygon) into the current layer.

The next buttons Add circular string or Add circular string by radius allow users to add line or polygon features with a
circular geometry.

To create features with these tools, you first digitize the geometry then enter its attributes. To digitize the geometry,
left-click on the map area to create the first point of your new feature.

For linear or curved geometries, keep on left-clicking for each additional point you wish to capture or use au-
tomatic tracing capability to accelerate the digitization. You can switch back and forth between linear Add fea-
ture tool and curved Add circular string... tools to create compound curved geometry. Pressing Delete or
Backspace key reverts the last node you add. When you have finished adding points, right-click anywhere on
the map area to confirm you have finished entering the geometry of that feature.

Note: Curved geometries are stored as such only in compatible data provider
Although QGIS allows to digitize curved geometries within any editable data format, you need to be using a data
provider (e.g. PostGIS, GML or WFS) that supports curves to have features stored as curved, otherwise QGIS
segmentizes the circular arcs. The memory layer provider also supports curves.

Tip: Customize the digitizing rubber band
While capturing polygon, the by-default red rubber band can hide underlying features or places you’d like to
capture a point. This can be fixed by setting a lower opacity (or alpha channel) to the rubber band’s Fill Color in
Settings → Options → Digitizing menu. You can also avoid the use of the rubber band by checking Don’t update
rubber band during node editing.

The attribute window will appear, allowing you to enter the information for the new feature. Figure_edit_values
shows setting attributes for a fictitious new river in Alaska. However, in the Digitizing menu under the Settings →
Options menu, you can also activate:

• Suppress attributes pop-up windows after each created feature to avoid the form opening

• or Reuse last entered attribute values to have fields automatically filled at the opening of the form and
just have to type changing values.

With the Move Feature(s) icon on the toolbar, you can move existing features.

Node Tool

For shapefile-based or MapInfo layers as well as SpatiaLite, PostgreSQL/PostGIS, MSSQL Spatial, and Oracle

Spatial tables, the Node Tool provides manipulation capabilities of feature vertices similar to CAD programs. It
is possible to simply select multiple vertices at once and to move, add or delete them altogether. The node tool
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Figure 12.70: Completat,i Dialogul Valorilor pentru Atribute, după digitizarea unei noi entităt,i vectoriale

also works with ‘on the fly’ projection turned on and supports the topological editing feature. This tool is, unlike
other tools in QGIS, persistent, so when some operation is done, selection stays active for this feature and tool.

It is important to set the property Settings → Options → Digitizing → Search Radius: to a number
greater than zero. Otherwise, QGIS will not be able to tell which vertex is being edited and will display a warning.

Tip: Simbolurile Vertexului
The current version of QGIS supports three kinds of vertex markers: ‘Semi-transparent circle’, ‘Cross’ and ‘None’.
To change the marker style, choose Options from the Settings menu, click on the Digitizing tab and select the
appropriate entry.

Operaţiuni de bază

Start by activating the Node Tool and selecting a feature by clicking on it. Red boxes will appear at each vertex
of this feature.

• Selecting vertices: You can select vertices by clicking on them one at a time, by clicking on an edge to
select the vertices at both ends, or by clicking and dragging a rectangle around some vertices. When a
vertex is selected, its color changes to blue. To add more vertices to the current selection, hold down the
Ctrl key while clicking. Hold down Ctrl when clicking to toggle the selection state of vertices (vertices
that are currently unselected will be selected as usual, but also vertices that are already selected will become
unselected).

• Adding vertices: To add a vertex, simply double click near an edge and a new vertex will appear on the
edge near to the cursor. Note that the vertex will appear on the edge, not at the cursor position; therefore, it
should be moved if necessary.

• Deleting vertices: Select the vertices and click the Delete key. Deleting all the vertices of a feature
generates, if compatible with the datasource, a geometryless feature. Note that this doesn’t delete the

complete feature, just the geometry part; To delete a complete feature use the Delete Selected tool.

• Moving vertices: Select all the vertices you want to move, click on a selected vertex or edge and drag in the
direction you wish to move. All the selected vertices will move together. If snapping is enabled, the whole
selection can jump to the nearest vertex or line.

Each change made with the node tool is stored as a separate entry in the Undo dialog. Remember that all operations
support topological editing when this is turned on. On-the-fly projection is also supported, and the node tool
provides tooltips to identify a vertex by hovering the pointer over it.

Tip: Move features with precision

The Move Feature tool doesn’t currently allow to snap features while moving. Using the Node Tool, select
ALL the vertices of the feature, click a vertex, drag and snap it to a target vertex: the whole feature is moved and
snapped to the other feature.
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The Vertex Editor

With activating the Node Tool on a feature, QGIS opens the Vertex Editor panel listing all the vertices of the
feature with their x, y (z, m if applicable) coordinates and r (for the radius, in case of circular geometry). Simply
select a row in the table does select the corresponding vertex in the map canvas, and vice versa. Simply change
a coordinate in the table and your vertex position is updated. You can also select multiple rows and delete them
altogether.

Figure 12.71: Vertex editor panel showing selected nodes

Tăiere, Copiere s, i Lipire Entităt,i

Selected features can be cut, copied and pasted between layers in the same QGIS project, as long as destination

layers are set to Toggle editing beforehand.

Tip: Transform polygon into line and vice-versa using copy/paste
Copy a line feature and paste it in a polygon layer: QGIS pastes in the target layer a polygon whose boundary
corresponds to the closed geometry of the line feature. This is a quick way to generate different geometries of the
same data.

Features can also be pasted to external applications as text. That is, the features are represented in CSV format,
with the geometry data appearing in the OGC Well-Known Text (WKT) format. WKT and GeoJSON features
from outside QGIS can also be pasted to a layer within QGIS.

When would the copy and paste function come in handy? Well, it turns out that you can edit more than one layer
at a time and copy/paste features between layers. Why would we want to do this? Say we need to do some work
on a new layer but only need one or two lakes, not the 5,000 on our big_lakes layer. We can create a new layer
and use copy/paste to plop the needed lakes into it.

Ca un exemplu, vom copia unele lacuri într-un nou strat:

1. Încărcat,i stratul din care dorit,i să copiat,i (stratul sursă)

2. Încărcat,i sau creat,i stratul în care dorit,i să copiat,i (stratul t,intă)

3. Începet,i editarea stratului t,intă

4. Activat,i stratul sursă, făcând clic pe el în legendă
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5. Folosit,i instrumentul de Selectare a Entităt,ilor după arie sau cu un singur clic pentru a selecta entit(ăt,ile) din stratul
sursă

6. Clic pe instrumentul de Copiere Entităt,i

7. Activat,i stratul destinat,ie, făcând clic pe el în legendă

8. Clic pe instrumentul de Lipire Entităt,i

9. Dezactivat,i editarea s, i salvat,i modificările.

What happens if the source and target layers have different schemas (field names and types are not the same)?
QGIS populates what matches and ignores the rest. If you don’t care about the attributes being copied to the target
layer, it doesn’t matter how you design the fields and data types. If you want to make sure everything - the feature
and its attributes - gets copied, make sure the schemas match.

Note: Congruent,a Entităt,ilor Inserate
If your source and destination layers use the same projection, then the pasted features will have geometry identical
to the source layer. However, if the destination layer is a different projection, then QGIS cannot guarantee the ge-
ometry is identical. This is simply because there are small rounding-off errors involved when converting between
projections.

Tip: Copie un atribut de tip s, ir în altul**

If you have created a new column in your attribute table with type ‘string’ and want to paste values from another
attribute column that has a greater length the length of the column size will be extended to the same amount. This
is because the GDAL Shapefile driver starting with GDAL/OGR 1.10 knows to auto-extend string and integer
fields to dynamically accommodate for the length of the data to be inserted.

S, tergerea Entităt,ilor Selectate

If we want to delete an entire feature (attribute and geometry), we can do that by first selecting the geometry using

the regular Select Features by area or single click tool. Selection can also be done from the attribute table. Once you

have the selection set, press Delete or Backspace key or use the Delete Selected tool to delete the features.
Multiple selected features can be deleted at once.

The Cut Features tool on the digitizing toolbar can also be used to delete features. This effectively deletes the

feature but also places it on a “spatial clipboard”. So, we cut the feature to delete. We could then use the
Paste Features tool to put it back, giving us a one-level undo capability. Cut, copy, and paste work on the currently
selected features, meaning we can operate on more than one at a time.

Salvarea Straturilor Modificate

When a layer is in editing mode, any changes remain in the memory of QGIS. Therefore, they are not commit-
ted/saved immediately to the data source or disk. If you want to save edits to the current layer but want to continue

editing without leaving the editing mode, you can click the Save Layer Edits button. When you turn editing mode

off with Toggle editing (or quit QGIS for that matter), you are also asked if you want to save your changes or
discard them.

If the changes cannot be saved (e.g., disk full, or the attributes have values that are out of range), the QGIS
in-memory state is preserved. This allows you to adjust your edits and try again.

Tip: Integritatea Datelor
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It is always a good idea to back up your data source before you start editing. While the authors of QGIS have
made every effort to preserve the integrity of your data, we offer no warranty in this regard.

Saving multiple layers at once

This feature allows the digitization of multiple layers. Choose Save for Selected Layers to save all changes

you made in multiple layers. You also have the opportunity to Rollback for Selected Layers, so that the

digitization may be withdrawn for all selected layers. If you want to stop editing the selected layers, Cancel
for Selected Layer(s) is an easy way.

Aceleas, i funct,ii sunt disponibile pentru editarea tuturor straturilor proiectului.

Tip: Use transaction group to edit, save or rollback multiple layers changes at once
When working with layers from the same PostGreSQL database, activate the Automatically create transaction
groups where possible option in Project → Project Properties → Data Sources to sync their behavior (enter or
exit the edit mode, save or rollback changes at the same time).

12.5.4 Digitizare avansată

Pictogramă Scop Pictogramă Scop

Activarea Instrumentelor de Digitizare Avansată Activarea Urmăririi

Anulare Refacere

Rotire Enti(tăt,i) Simplificare Entitate

Adăugare Inel Adăugare Parte

Umplere Inel

Ştergere Inel Ştergere Parte

Curba de Compensare Remodelare Entităt,i

Divizare Părt,i Divizare Entităt,i

Unificare Atribute pentru Entităt,ile Selectate Unificare Entităt,i Selectate

Rotit,i Simbolurile Punctelor Offset Point Symbols

Editarea Avansată a Tabelei: Bara instrumentelor avansate de editare a straturilor vectoriale

Anulare/Restabilire

The Undo and Redo tools allows you to undo or redo vector editing operations. There is also a dockable
widget, which shows all operations in the undo/redo history (see Figure_edit_undo). This widget is not displayed
by default; it can be displayed by right-clicking on the toolbar and activating the Undo/Redo Panel checkbox. The
Undo/Redo capability is however active, even if the widget is not displayed.

When Undo is hit or Ctrl+Z (or Cmd+Z) pressed, the state of all features and attributes are reverted to the
state before the reverted operation happened. Changes other than normal vector editing operations (for example,
changes done by a plugin) may or may not be reverted, depending on how the changes were performed.

To use the undo/redo history widget, simply click to select an operation in the history list. All features will be
reverted to the state they were in after the selected operation.
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Figure 12.72: Pas, ii de Anulare/Restabilire a Digitizării

Rotire Enti(tăt,i)

Use Rotate Feature(s) to rotate one or multiple features in the map canvas. Press the Rotate Feature(s) icon and
then click on the feature to rotate. Either click on the map to place the rotated feature or enter an angle in the user
input widget. If you want to rotate several features, they shall be selected first.

If you enable the map tool with feature(s) selected, its (their) centroid appears and will be the rotation anchor
point. If you want to move the anchor point, hold the Ctrl button and click on the map to place it.

If you hold Shift before clicking on the map, the rotation will be done in 45 degree steps, which can be modified
afterwards in the user input widget.

To abort feature rotation, you need to click on Rotate Feature(s) icon.

Simplificare Entitate

The Simplify Feature tool allows you to reduce the number of vertices of a feature, as long as the geometry
remains valid. With the tool you can also simplify many features at once or multi-part features.

First, click on the feature or drag a rectangle over the features. A dialog where you can define a tolerance in map
units, layer units or pixels pops up and a colored and simplified copy of the feature(s), using the given
tolerance, appears over them. QGIS calculates the amount of vertices that can be deleted while maintaining the
geometry. The higher the tolerance is the more vertices can be deleted. When the expected geometry fits your
needs just click the [OK] button. The tolerance you used will be saved when leaving a project or when leaving an
edit session. So you can go back to the same tolerance the next time when simplifying a feature.

To abort feature simplification, you need to click on Simplify Feature icon.

Note: Unlike the feature simplification option in Settings → Options → Rendering menu which simplifies the

geometry just for rendering, the Simplify Feature tool permanently modifies feature’s geometry in data source.

Adăugare Parte

You can Add Part to a selected feature generating a multipoint, multiline or multipolygon feature. The new part
must be digitized outside the existing one which should be selected beforehand.

The Add Part can also be used to add a geometry to a geometryless feature. First, select the feature in the

attribute table and digitize the new geometry with the Add Part tool.
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Ştergere Parte

The Delete Part tool allows you to delete parts from multifeatures (e.g., to delete polygons from a multi-polygon
feature). This tool works with all multi-part geometries: point, line and polygon. Furthermore, it can be used to
totally remove the geometric component of a feature. To delete a part, simply click within the target part.

Adăugare Inel

You can create ring polygons using the Add Ring icon in the toolbar. This means that inside an existing area, it
is possible to digitize further polygons that will occur as a ‘hole’, so only the area between the boundaries of the
outer and inner polygons remains as a ring polygon.

Umplere Inel

You can use the Fill Ring function to add a ring to a polygon and add a new feature to the layer at the same time.

Using this tool, you simply have to digitize a polygon within an existing one. Thus you need not first use the
Add Ring icon and then the Add feature function anymore.

Ştergere Inel

The Delete Ring tool allows you to delete rings within an existing polygon, by clicking inside the hole. This
tool only works with polygon and multi-polygon features. It doesn’t change anything when it is used on the outer
ring of the polygon.

Remodelare Entităt,i

You can reshape line and polygon features using the Reshape Features tool on the toolbar. For lines, it replaces the
line part from the first to the last intersection with the original line.

Figure 12.73: Reshape line

Tip: Extend linestring geometries with reshape tool
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Use the Reshape Features tool to extend existing linestring geometries: snap to the first or last vertex of the line
and draw a new one. Validate and the feature’s geometry becomes the combination of the two lines.

For polygons, it will reshape the polygon’s boundary. For it to work, the reshape tool’s line must cross the
polygon’s boundary at least twice. To draw the line, click on the map canvas to add vertexes. To finish it, just
right-click. Like with the lines, only the segment between the first and the last intersections is considered. The
reshape line’s segments that are inside the polygon will result in cropping it, where the ones outside the polygon
will extend it.

Figure 12.74: Reshape polygon

With polygons, reshaping can sometimes lead to unintended results. It is mainly useful to replace smaller parts
of a polygon, not for major overhauls, and the reshape line is not allowed to cross several polygon rings, as this
would generate an invalid polygon.

Note: The reshape tool may alter the starting position of a polygon ring or a closed line. So, the point that is
represented ‘twice’ will not be the same any more. This may not be a problem for most applications, but it is
something to consider.

Curbe de Compensare

The Offset Curve tool creates parallel shifts of line layers. The tool can be applied to the edited layer (the
geometries are modified) or also to background layers (in which case it creates copies of the lines / rings and adds
them to the edited layer). It is thus ideally suited for the creation of distance line layers. The User Input dialog
pops-up, showing the displacement distance.

To create a shift of a line layer, you must first go into editing mode and activate the Offset Curve tool. Then click
on a feature to shift it. Move the mouse and click where wanted or enter the desired distance in the user input

widget. Your changes may then be saved with the Save Layer Edits tool.

QGIS options dialog (Digitizing tab then Curve offset tools section) allows you to configure some parameters
like Join style, Quadrant segments, Miter limit.
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Divizare Entităt,i

You can split features using the Split Features icon on the toolbar. Just draw a line across the feature you want to
split.

Divizare părt,i

In QGIS it is possible to split the parts of a multi part feature so that the number of parts is increased. Just draw a

line across the part you want to split using the Split Parts icon.

Tip: Split a polyline feature in one-click

A single click on a snapped vertex of a line feature with the Split Features or Split Parts tool is enough to have
it split into new features or parts.

Unificat,i entităt,ile selectate

The Merge Selected Features tool allows you to create a new feature by merging existing ones: their ge-
ometries are merged to generate a new one. If features don’t have common boundaries, a multipoly-
gon/multipolyline/multipoint feature is created.

First, select several features. Then press the Merge Selected Features button. In the new dialog, you can select at the
top of the dialog which value to apply to each field of the new feature. That value can be:

• picked from the attributes of the initial features,

• an aggregation of the initial features attributes (Minimum, Maximum, Median, Sum, Count Concatenation...
depending on the type of the field. see Statistical Summary Panel for the full list of functions),

• skipped, meaning that the field will be empty,

• or manually entered, at the bottom of the rows.

Unificat,i atributele pentru entităt,ile selectate

The Merge Attributes of Selected Features tool allows you to apply same attributes to features without merging their
boundaries. The dialog is the same as the Merge Selected Features tool’s except that unlike that tool,
selected objects are kept with their geometry while some of their attributes are made identical.

Rotit,i Simbolurile Punctelor

The Rotate Point Symbols allows you to change the rotation of point symbols in the map canvas. First of all, you

must apply to the symbol a data-defined rotation: in the Layer Properties → Style dialog, click the Data-
defined override widget near the Rotation option of the highest level (preferably) of the symbol layers and choose
a field in the Field Type combobox. Values of this field are hence used to rotate each feature’s symbol accordingly.

Note: As a global option, setting the rotation field at the first level of the symbol applies it to all the underlying
levels while setting it at a lower level will rotate only this symbol layer (unless you have a single symbol layer).

To change the rotation of a symbol, click on a point feature in the map canvas with the Rotate Point Symbols and
move the mouse around, holding the left button pressed. A red arrow with the rotation value will be visualized (see
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Figure 12.75: Rotit,i Simbolurile Punctelor

Figure_rotate_point). When you release the left mouse button again, the symbol is defined with this new rotation
and the rotation field is updated in the layer’s attribute table.

Tip: Dacă t,inet,i apăsată tasta Ctrl, rotirea se va face în pas, i de 15 grade.

Offset Point Symbols

The Offset Point Symbols allows you to interactively change the rendered position of point symbols in the map

canvas. This tool behaves like the Rotate Point Symbols tool except that it requires you to connect a field to the
data-defined Offset (X,Y) property of the symbol, field which will then be populated with the offset coordinates
while moving the symbol in the map canvas.

Note: The Offset Point Symbols tool doesn’t move the point feature itself; you should use the Node Tool or
Move Feature tool for this purpose.

Warning: Ensure to assign the same field to all symbol layers
If at least two layers of the symbol have different fields assigned to their data-defined property (e.g. rotation),
the corresponding tool will consider that no field is assigned to the symbol property and won’t perform the
action.

Urmărirea Automată

Usually, when using capturing map tools (add feature, add part, add ring, reshape and split), you need to click
each vertex of the feature.

Using the automatic tracing mode you can speed up the digitization process. Enable the Tracing tool by pushing
the icon or pressing t key and snap to a vertex or segment of a feature you want to trace along. Move the mouse
over another vertex or segment you’d like to snap and instead of an usual straight line, the digitizing rubber band
represents a path from the last point you snapped to the current position. QGIS actually uses the underlying
features topology to build the shortest path between the two points. Click and QGIS places the intermediate
vertices following the path. You no longer need to manually place all the vertices during digitization.

Tracing requires snapping to be activated in traceable layers to build the path. You should also snap to an existing
vertex or segment while digitizing and ensure that the two nodes are topologically connectable following existing
features, otherwise QGIS is unable to connect them and thus traces a single straight line.

Note: Adjust map scale or snapping settings for an optimal tracing
If there are too many features in map display, tracing is disabled to avoid potentially long tracing structure prepa-
ration and large memory overhead. After zooming in or disabling some layers the tracing is enabled again.
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Tip: Quickly enable or disable automatic tracing by pressing t key
By pressing t key, tracing can be enabled/disabled anytime even while digitizing one feature, so it is possible to
digitize some parts of the feature with tracing enabled and other parts with tracing disabled. Tools behave as usual
when tracing is disabled.

12.5.5 Panoul de Digitizare Avansată

When capturing, reshaping, splitting new or existing geometries you also have the possibility to use the Advanced
Digitizing panel. You can digitize lines exactly parallel or perpendicular to a particular angle or lock lines to
specific angles. Furthermore, you can enter coordinates directly so that you can make a precise definition of your
new geometry.

Figure 12.76: Panoul de Digitizare Avansată

Note: Instrumentele nu sunt activate dacă vizualizarea hărt,ii este în coordonate geografice.

The Advanced Digitizing panel can be open either with a right-click on the toolbar and choose Advanced Dig-

itizing panel or in View → Panels → Advanced Digitizing Panel. Once the panel is visible, click the
enable advanced digitizing tool button to activate the Advanced Digitizing tool.

Idei generale

The aim of the Advanced Digitizing tool is to lock coordinates, lengths, and angles when moving the mouse during
the digitalizing in the map canvas.

You can also create constraints with relative or absolute reference. Relative reference means that the next vertex
constraints’ values will be relative to the previous vertex or segment.

Setări de Acros, are

Click the button to set the Advanced Digitizing Tool snapping settings. You can make the tool snap to common
angles. The options are:

• Do not snap to common angles

• Snap to 30º angles
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• Snap to 45º angles

• Snap to 90º angles

You can also control the snapping to features. The options are:

• Do not snap to vertices or segments

• Snap according to project configuration

• Snap to all layers

Keyboard shortcuts

To speed up the use of Advanced Digitizing Panel, there are a couple of keyboard shorcuts available:

Cheie Simplu Ctrl + or Alt + Shift +
d Set distance Lock distance
a Set angle Lock angle Toggle relative angle to last segment
x Set x coordinate Lock x coordinate Toggle relative x to last vertex
y Set y coordinate Lock y coordinate Toggle relative y to last vertex
c Toggle construction mode
p Toggle perpendicular and parallel modes

Absolute reference digitizing

When drawing a new geometry from scratch, it is very useful to have the possibility to start digitizing vertexes at
given coordinates.

For example, to add a new feature to a polygonal layer, click the button. You can choose the X and Y
coordinates where you want to start editing the feature, then:

• Click the x text box (or use the x keyboard shortcuts).

• Type the X coordinate value you want and press Enter or click the button to their right to lock the
mouse to the X axis on the map canvas.

• Click the y text box (or use the y keyboard shortcuts).

• Type the Y coordinate value you want and press Enter or click the button to their right to lock the
mouse to the Y axis on the map canvas.

Two blue dotted lines and a green cross identify the exact coordinates you entered. Start digitizing by clicking on
the map canvas; the mouse position is locked at the green cross.

You can continue digitizing by free hand, adding a new pair of coordinates, or you can type the segment’s length
(distance) and angle.

If you want to draw a segment of a given length, click the d (distance) text box (keyboard shortcut d), type the

distance value (in map units) and press Enter or click the button on the right to lock the mouse in the map
canvas to the length of the segment. In the map canvas, the clicked point is surrounded by a circle whose radius is
the value entered in the distance text box.

Finally, you can also choose the angle of the segment. As described before , click the a (angle) text box (keyboard

shortcut a), type the angle value (in degrees), and press Enter or click the buttons on the right to lock it. In
this way the segment will follow the desired angle:

Relative reference digitizing

Instead of using absolute values of angles or coordinates, you can also use values relative to the last digitized
vertex or segment.
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Figure 12.77: Start drawing at given coordinates

Figure 12.78: Fixed length segment

Figure 12.79: Fixed angle segment
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For angles, you can click the button on the left of the a text box (or press Shift + a) to toggle relative
angles to the previous segment. With that option on, angles are measured between the last segment and the mouse
pointer.

For coordinates, click the buttons to the left of the x or y text boxes (or press Shift + x or Shift + y) to
toggle relative coordinates to the previous vertex. With these options on, coordinates measurement will consider
the last vertex to be the x and y axes origin.

Continuous lock

Both in absolute or relative reference digitizing, angle, distance, x and y constraints can be locked continuously by

clicking the Continuous lock buttons. Using continuous lock allows you to digitize several points or vertexes
using the same constraints.

Parallel and perpendiculars line

All the tools described above can be combined with the Perpendicular and Parallel tools. These two tools allow
drawing segments perfectly perpendicular or parallel to another segment.

To draw a perpendicular segment, during the editing click the Perpendicular icon (keyboard shortcut p) to ac-
tivate it. Before drawing the perpendicular line, click on the segment of an existing feature that you want to be
perpendicular to (the line of the existing feature will be colored in light orange); you should see a blue dotted line
where your feature will be snapped:

Figure 12.80: Perpendicular digitizing

To draw a parallel feature, the steps are the same: click on the Parallel icon (keyboard shortcut p twice), click
on the segment you want to use as reference and start drawing your feature:

These two tools just find the right angle of the perpendicular and parallel angle and lock this parameter during
your editing.

Construction mode

You can enable and disable construction mode by clicking on the Construction icon or with the c keyboard
shortcut. While in construction mode, clicking the map canvas won’t add new vertexes, but will capture the
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Figure 12.81: Parallel digitizing

clicks’ positions so that you can use them as reference points to then lock distance, angle or x and y relative
values.

As an example, the construction mode can be used to draw some point at an exact distance from an existing point.

With an existing point in the map canvas and the snapping mode correctly activated, you can easily draw other

points at given distances and angles from it. In addition to the button, you have to activate also the construction

mode by clicking the Construction icon or with the c keyboard shortcut.

Click next to the point from which you want to calculate the distance and click on the d box (d shortcut) type the
desired distance and press Enter to lock the mouse position in the map canvas:

Figure 12.82: Distance from point

Before adding the new point, press c to exit the construction mode. Now, you can click on the map canvas, and
the point will be placed at the distance entered.

You can also use the angle constraint to, for example, create another point at the same distance of the original one,

but at a particular angle from the newly added point. Click the Construction icon or with the c keyboard shortcut
to enter construction mode. Click the recently added point, and then the other one to set a direction segment. Then,
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click on the d text box (d shortcut) type the desired distance and press Enter. Click the a text box (a shortcut)
type the angle you want and press Enter. The mouse position will be locked both in distance and angle.

Figure 12.83: Distance and angle from points

Before adding the new point, press c to exit the construction mode. Now, you can click on the map canvas, and
the point will be placed at the distance and angle entered. Repeating the process, several points can be added.

Figure 12.84: Points at given distance and angle
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CHAPTER 13

Lucrul cu Datele Raster

13.1 Dialogul Proprietăt,ilor Rasterului

To view and set the properties for a raster layer, double click on the layer name in the map legend, or right click on
the layer name and choose Properties from the context menu. This will open the Raster Layer Properties dialog
(see figure_raster_properties).

There are several tabs in the dialog:

• General

• Style

• Transparency

• Pyramids

• Histogram

• Metadata

• Legend

Figure 13.1: Raster Layers Properties Dialog

Tip: Live update rendering
The Layer Styling Panel provides you with some of the common features of the Layer properties dialog and is a
good modeless widget that you can use to speed up the configuration of the layer styles and automatically view
your changes in the map canvas.
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Note: Because properties (symbology, label, actions, default values, forms...) of embedded layers (see Imbricarea
Proiectelor) are pulled from the original project file and to avoid changes that may break this behavior, the layer
properties dialog is made unavailable for these layers.

13.1.1 General Properties

Layer Info

The General tab displays basic information about the selected raster, including the layer source path, the display
name in the legend (which can be modified), and the number of columns, rows and no-data values of the raster.

Coordinate Reference System

Displays the layer’s Coordinate Reference System (CRS) as a PROJ.4 string. You can change the layer’s CRS,

selecting a recently used one in the drop-down list or clicking on Select CRS button (see Coordinate Reference
System Selector). Use this process only if the CRS applied to the layer is a wrong one or if none was applied.
If you wish to reproject your data into another CRS, rather use layer reprojection algorithms from Processing or
Save it into another layer.

13.1.2 Scale dependent visibility

You can set the Maximum (inclusive) and Minimum (exclusive) scale, defining a range of scale in which the layer

will be visible. Out of this range, it’s hidden. The Set to current canvas scale button helps you use the current map
canvas scale as boundary of the range visibility. See Randarea Dependentă de Scară for more information.

13.1.3 Style Properties

Randare bandă

QGIS oferă patru Tipuri de Render diferite. Renderul ales depinde de tipul datelor.

1. Multiband color - if the file comes as a multiband with several bands (e.g., used with a satellite image with
several bands)

2. Paletted - if a single band file comes with an indexed palette (e.g., used with a digital topographic map)

3. Singleband gray - (one band of) the image will be rendered as gray; QGIS will choose this renderer if the
file has neither multibands nor an indexed palette nor a continuous palette (e.g., used with a shaded relief
map)

4. Singleband pseudocolor - this renderer is possible for files with a continuous palette, or color map (e.g.,
used with an elevation map)

Multiband color

With the multiband color renderer, three selected bands from the image will be rendered, each band representing
the red, green or blue component that will be used to create a color image. You can choose several Contrast
enhancement methods: ‘No enhancement’, ‘Stretch to MinMax’, ‘Stretch and clip to MinMax’ and ‘Clip to min
max’.

This selection offers you a wide range of options to modify the appearance of your raster layer. First of all, you
have to get the data range from your image. This can be done by choosing the Extent and pressing [Load]. QGIS
can Estimate (faster) the Min and Max values of the bands or use the Actual (slower) Accuracy.

Now you can scale the colors with the help of the Load min/max values section. A lot of images have a few very
low and high data. These outliers can be eliminated using the Cumulative count cut setting. The standard data
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Figure 13.2: Raster Style - Multiband color rendering

range is set from 2% to 98% of the data values and can be adapted manually. With this setting, the gray character
of the image can disappear. With the scaling option Min/max, QGIS creates a color table with all of the data
included in the original image (e.g., QGIS creates a color table with 256 values, given the fact that you have 8
bit bands). You can also calculate your color table using the Mean +/- standard deviation x . Then,
only the values within the standard deviation or within multiple standard deviations are considered for the color
table. This is useful when you have one or two cells with abnormally high values in a raster grid that are having a
negative impact on the rendering of the raster.

All calculations can also be made for the Current extent.

Tip: Vizualizarea unei singure benzi dintr-un Raster Multibandă
If you want to view a single band of a multiband image (for example, Red), you might think you would set the
Green and Blue bands to “Not Set”. But this is not the correct way. To display the Red band, set the image type to
‘Singleband gray’, then select Red as the band to use for Gray.

Paletted

Aceasta este opt,iunea de randare standard pentru fis, ierele simplă bandă care includ deja un tabel de culori, în care
valoarea fiecărui pixel este atribuită unei anumite culori de randare. În acest caz, paleta este randată automat. Dacă
dorit,i să modificat,i culorile atribuite anumitor valori, doar facet,i dublu-clic pe culoare s, i pe dialogul de Selectare
culoare care apare. De asemenea, în QGIS este posibilă asignarea unei etichete valorilor culorilor. În acel caz,
eticheta va apărea în legenda stratului raster.

Îmbunătăţirea contrastului

Note: Atunci când se adaugă rastere GRASS, opt,iunea de Îmbunătăt,ire a contrastului va fi întotdeauna setată
automat pe întindere la min max, indiferent dacă aceasta este setată la o altă valoare în opt,iunile generale ale
QGIS.
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Figure 13.3: Raster Style - Paletted Rendering

Singleband gray

This renderer allows you to render a single band layer with a Color gradient: ‘Black to white’ or ‘White to black’.
You can define a Min and a Max value by choosing the Extent first and then pressing [Load]. QGIS can
Estimate (faster) the Min and Max values of the bands or use the Actual (slower) Accuracy.

Figure 13.4: Raster Style - Singleband gray rendering

With the Load min/max values section, scaling of the color table is possible. Outliers can be eliminated using the
Cumulative count cut setting. The standard data range is set from 2% to 98% of the data values and can be

adapted manually. With this setting, the gray character of the image can disappear. Further settings can be made
with Min/max and Mean +/- standard deviation x . While the first one creates a color table with
all of the data included in the original image, the second creates a color table that only considers values within
the standard deviation or within multiple standard deviations. This is useful when you have one or two cells with
abnormally high values in a raster grid that are having a negative impact on the rendering of the raster.

Singleband pseudocolor

Aceasta este o opt,iune de randare pentru fis, ierele simplă bandă, incluzând o paletă continuă. Putet,i crea aici, de
asemenea, hărt,i individuale de culoare pentru benzile unice.

Three types of color interpolation are available:

1. Discrete

2. Liniar

3. Exact
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Figure 13.5: Raster Style - Singleband pseudocolor rendering
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In the left block, the button Add values manually adds a value to the individual color table. The button
Remove selected row deletes a value from the individual color table, and the Sort colormap items button sorts the color
table according to the pixel values in the value column. Double clicking on the value column lets you insert a
specific value. Double clicking on the color column opens the dialog Change color, where you can select a color
to apply on that value. Further, you can also add labels for each color, but this value won’t be displayed when you

use the identify feature tool. You can also click on the button Load color map from band, which tries to load the table

from the band (if it has any). And you can use the buttons Load color map from file or Export color map to file to load
an existing color table or to save the defined color table for other sessions.

In the right block, Generate new color map allows you to create newly categorized color maps. For the Classi-

fication mode ‘Equal interval’, you only need to select the number of classes and press the button

Classify. You can invert the colors of the color map by clicking the Invert checkbox. In the case of the Mode

‘Continuous’, QGIS creates classes automatically depending on the Min and Max. Defining Min/Max val-
ues can be done with the help of the Load min/max values section. A lot of images have a few very low and high
data. These outliers can be eliminated using the Cumulative count cut setting. The standard data range is set
from 2% to 98% of the data values and can be adapted manually. With this setting, the gray character of the image
can disappear. With the scaling option Min/max, QGIS creates a color table with all of the data included in the
original image (e.g., QGIS creates a color table with 256 values, given the fact that you have 8 bit bands). You can
also calculate your color table using the Mean +/- standard deviation x . Then, only the values within
the standard deviation or within multiple standard deviations are considered for the color table.

Randarea culorii

Pentru fiecare Randare de bandă, este posibilă o Randare de culoare.

You can also achieve special rendering effects for your raster file(s) using one of the blending modes (see Modurile
de Fuziune).

Mai multe setări pot fi făcute prin modificarea Strălucirii, a Saturat,iei s, i a Contrastului. Putet,i utiliza, de aseme-
nea, o opt,iune Grayscale, în care putet,i alege între ‘By lightness’, ‘By luminosity’ s, i ‘By average’. Pentru o
nuant,ă din tabelul de culori, putet,i modifica ‘Strength’.

Reeşantionare

Opt,iunea Rees, antionare îs, i face aparit,ia atunci când mărit,i s, i mics, orat,i o imagine. Modurile de rees, antionare pot
optimiza aspectul hărt,ii. Eie calculează o nouă matrice cu valori de gri, printr-o transformare geometrică.

Figure 13.6: Raster Style - Color rendering and Resampling settings

Atunci când se aplică metoda ‘Celui mai apropiat vecin ‘, harta poate avea o structură pixelată, la efectuarea
unei transfocări. Aceasta aspect poate fi îmbunătăt,it prin utilizarea metodei ‘Biliniară’ sau ‘Cubică’, care poate
determina ca entităt,ile ascut,ite să fie neclare. Efectul constă într-o imagine mai fină. Această metodă poate fi
aplicată, de exemplu, pentru hărt,i raster, topografice, digitale.
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At the bottom of the Style tab, you can see a thumbnail of the layer, its legend symbol, and the palette.

13.1.4 Transparency Properties

QGIS has the ability to display each raster layer at a different transparency level. Use the transparency slider

to indicate to what extent the underlying layers (if any) should be visible though the current
raster layer. This is very useful if you like to overlay more than one raster layer (e.g., a shaded relief map overlayed
by a classified raster map). This will make the look of the map more three dimensional.

Additionally, you can enter a raster value that should be treated as NODATA in the Additional no data value option.

An even more flexible way to customize the transparency can be done in the Custom transparency options section.
The transparency of every pixel can be set here.

As an example, we want to set the water of our example raster file landcover.tif to a transparency of 20%.
The following steps are necessary:

1. Load the raster file landcover.tif.

2. Open the Properties dialog by double-clicking on the raster name in the legend, or by right-clicking and
choosing Properties from the pop-up menu.

3. Select the Transparency tab.

4. From the Transparency band drop-down menu, choose ‘None’.

5. Clic pe butonul Add values manually. Un nou rând va apărea în lista pixelilor.

6. Enter the raster value in the ‘From’ and ‘To’ column (we use 0 here), and adjust the transparency to 20%.

7. Press the [Apply] button and have a look at the map.

You can repeat steps 5 and 6 to adjust more values with custom transparency.

După cum se poate vedea, des, i este destul de us, or de stabilit transparent,a după dorint,ă, trebuie parcurs, i o mult,ime

de pas, i. Prin urmare, putet,i utiliza butonul Export în fis, ier pentru a salva setările de transparent,ă într-un fis, ier.

Butonul de Import din fis, ier încarcă setările de transparent,ă s, i le aplică stratului raster curent.

13.1.5 Proprietăt,ile Piramidelor

Straturile raster cu rezolut,ie mare pot încetini navigarea în QGIS. Prin crearea unor copii de rezolut,ie scăzută a
datelor (piramide), performant,a poate cres, te considerabil, întrucât QGIS utilizează cea mai potrivită rezolut,ie, în
funct,ie de nivelul de transfocare.

Trebuie să avet,i acces de scriere în directorul în care sunt stocate datele originale, pentru a construi piramide.

From the Resolutions list, select resolutions for which you want to create pyramid by clicking on them.

If you choose Internal (if possible) from the Overview format drop-down menu, QGIS tries to build pyramids
internally.

Note: Ret,inet,i că realizarea piramidelor interne poate modifica fis, ierul de date original, iar o dată create ele nu
mai pot fi eliminate! Dacă dorit,i să păstrat,i o versiune ‘fără-piramide’ a rasterului dvs., facet,i o copie de rezervă
înainte de construirea piramidelor.

If you choose External and External (Erdas Imagine) the pyramids will be created in a file next to the original
raster with the same name and a .ovr extension.

Several Resampling methods can be used to calculate the pyramids:

• cel mai apropiat vecin

• Medie
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• Gauss

• Cubic

• Mod

• Niciuna

Finally, click [Build pyramids] to start the process.

Figure 13.7: Raster Pyramids

13.1.6 Histogram Properties

The Histogram tab allows you to view the distribution of the bands or colors in your raster. The histogram is
generated automatically when you open the Histogram tab. All existing bands will be displayed together. You

can save the histogram as an image with the button. With the Visibility option in the Prefs/Actions menu,
you can display histograms of the individual bands. You will need to select the option Show selected band.
The Min/max options allow you to ‘Always show min/max markers’, to ‘Zoom to min/max’ and to ‘Update style
to min/max’. With the Actions option, you can ‘Reset’ and ‘Recompute histogram’ after you have chosen the
Min/max options.

13.1.7 Metadata Properties

The Metadata tab displays a wealth of information about the raster layer, including statistics about each band in
the current raster layer. From this tab, entries may be made for the Description, Attribution, MetadataUrl and
Properties. In Properties, statistics are gathered on a ‘need to know’ basis, so it may well be that a given layer’s
statistics have not yet been collected.

13.1.8 Legend Properties

The Legend tab provides you with a list of widgets you can embed within the layer tree in the Layers panel. The
idea is to have a way to quickly access some actions that are often used with the layer (setup transparency, filtering,
selection, style or other stuff...).
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Figure 13.8: Histograma Raster

Figure 13.9: Raster Metadata
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By default, QGIS provides transparency widget but this can be extended by plugins registering their own widgets
and assign custom actions to layers they manage.

13.2 Analiza Raster

13.2.1 Calculatorul Raster

Calculatorul Raster din meniul Raster permite efectuarea calculelor pe baza valorilor raster ale pixelilor existent,i
(a se vedea figure_raster_calculator). Rezultatele sunt scrise într-un nou strat raster, într-un format acceptat de
GDAL.

Figure 13.10: Calculatorul Raster

The Raster bands list contains all loaded raster layers that can be used. To add a raster to the raster calculator
expression field, double click its name in the Fields list. You can then use the operators to construct calculation
expressions, or you can just type them into the box.

În sect,iunea Stratului rezultat trebuie să definit,i un strat de ies, ire. Putet,i defini extinderea suprafet,ei calculate pe
baza unui strat de intrare raster, sau în funct,ie de coordonatele X,Y s, i de coloane s, i rânduri, pentru a seta rezolut,ia
stratului de ies, ire. În cazul în care stratul de intrare are o altă rezolut,ie, valorile vor fi rees, antionate cu algoritmul
celui mai apropiat vecin.

Sect,iunea Operatorilor cont,ine tot,i operatorii utilizabili. Pentru a adăuga un operator în caseta de expresii a
calculatorului raster, facet,i clic pe butonul corespunzător. Sunt disponibile operat,iile matematice (+, -, *, ... ) s, i
trigonometrice (sin, cos, tan, ... ). Expresiile condit,ionale (=, !=, <, >=, ... ) returnează fie 0 pentru fals, fie
1 pentru adevărat s, i, de aceea, pot fi folosite cu alt,i operatori s, i funct,ii. Cu timpul, vor fi disponibili mai mult,i
operatori!

232 Chapter 13. Lucrul cu Datele Raster



QGIS User Guide, Release 2.18

Cu ajutorul casetei de Adăugare a rezultatelor la proiect, stratul rezultatelor va fi automat încărcat legendă,
pentru a putea fi vizualizat.

Exemple

Conversia valorilor de elevat,ie de la metri la picioare

Pentru crearea unui raster de elevat,ie în feet dintr-un raster în metri, trebuie să utilizat,i factorul de conversie de la
metri la picioare: 3.28. Expresia este:

"elevation@1" * 3.28

Folosirea unei măs, ti

Dacă dorit,i să mascat,i unele părt,i dintr-un raster - să zicem, de exemplu, pentru că vă interesează doar altitudinile
de peste 0 metri - putet,i utiliza următoarea expresie pentru a crea o mască s, i pentru a aplica rezultatul unui raster,
într-un singur pas.

("elevation@1" >= 0) * "elevation@1"

In other words, for every cell greater than or equal to 0 the conditional expression evaluates to 1, which keeps the
original value by multiplying it by 1. Otherwise the conditional expression evaluates to 0, which sets the raster
value to 0. This creates the mask on the fly.

În cazul în care dorit,i să clasificat,i un raster - să zicem, de exemplu, în două clase de altitudine, putet,i utiliza
următoarea expresie pentru a crea un raster cu două valori, 1 s, i 2, într-un singur pas.

("elevation@1" < 50) * 1 + ("elevation@1" >= 50) * 2

Cu alte cuvinte, pentru fiecare celulă mai mică de 50, valoarea sa va fi setată la 1. Pentru fiecare celulă mai mare
sau egală cu 50 valoarea sa va fi setată la 2.

13.2.2 Alinierea Rasterelor

Acest instrument poate prelua mai multe rastere, pentru a le alinia perfect, ceea ce presupune:

• reproiectarea aceluias, i CRS,

• rees, antionarea la aceeas, i dimensiune de celulă s, i offset de grilă,

• decuparea regiunii de interes,

• redimensionarea valorilor, atunci când este necesar.

All rasters will be saved in another files.

First, open the tools from Raster → Align Raster... and click on the Add new raster button to choose one existing
raster in QGIS. Select an output file to save the raster after the alignment, the resampling method and if the tools
need to Rescale values according to the cell size. The resampling method can be (see figure_raster_align_edit):

• Nearest Neighbor

• Bilinear (2x2 kernel)

• Cubic (4x4 kernel): Cubic Convolution Approximation

• Cubic B-Spline (4x4 kernel): Cubic B-Spline Approximation

• Lanczos (6x6 kernel): Lanczos windowed sinc interpolation

• Average: computes the average of all non-NODATA contributing pixels

• Mode: selects the value which appears most often of all the sampled points

• Maximum, Minimum, Mediane, First Quartile (Q1) or Third Quartile (Q3) of all non-NODATA con-
tributing pixels
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Note: Methods like maximum, minimum, mediane, first and third quartiles are available only if QGIS is built
with GDAL >= 2.0.

Figure 13.11: Select Raster Resampling Options

In the main Align raster dialog, you can still Edit file settings or Remove an existing file from the list of raster layers.
You can also choose one or more other options (see figure_raster_align):

• Select the Reference Layer,

• Transform into a new CRS,

• Setup a different Cell size,

• Setup a different Grid Offset,

• Clip to Extent: it can be user-defined or based on a layer or the map view

• Output Size,

• Add aligned raster to the map canvas.
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Figure 13.12: Alinierea Rasterelor
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CHAPTER 14

Print Composer

With the Print Composer you can create nice maps and atlasses that can be printed or saved as PDF-file, an image
or an SVG-file. This is a powerful way to share geographical information produced with QGIS that can be included
in reports or published.

14.1 Overview of the Print Composer

The Print Composer provides growing layout and printing capabilities. It allows you to add elements such as
the QGIS map canvas, text labels, images, legends, scale bars, basic shapes, arrows, attribute tables and HTML
frames. You can size, group, align, position and rotate each element and adjust their properties to create your
layout. The layout can be printed or exported to image formats, PostScript, PDF or to SVG (export to SVG is
not working properly with some recent Qt4 versions; you should try and check individually on your system). You
can save the layout as a template and load it again in another session. Finally, generating several maps based on a
template can be done through the atlas generator.

14.1.1 Sesiune de Probă

Before you start to work with the Print Composer, you need to load some raster or vector layers in the QGIS map
canvas and adapt their properties to suit your own convenience. After everything is rendered and symbolized to

your liking, click the New Print Composer icon in the toolbar or choose File → New Print Composer. You will be
prompted to choose a title for the new Composer.

Pentru a demonstra cum se poate crea o hartă folosit,i următoarele instruct,iuni.

1. On the left side, select the Add new map toolbar button and draw a rectangle on the canvas holding down
the left mouse button. Inside the drawn rectangle the QGIS map view to the canvas.

2. Select the Add new scalebar toolbar button and click with the left mouse button on the Print Composer
canvas. A scalebar will be added to the canvas.

3. Select the Add new legend toolbar button and draw a rectangle on the canvas holding down the left mouse
button. Inside the drawn rectangle the legend will be drawn.

4. Selectat,i pictograma Select/Move item pentru a selecta harta de pe canevas s, i pentru a o muta un pic.

5. While the map item is still selected you can also change the size of the map item. Click while holding down
the left mouse button, in a white little rectangle in one of the corners of the map item and drag it to a new
location to change its size.

6. Click the Item Properties panel on the left down side and find the setting for the orientation. Change the
value of the setting Map orientation to ‘15.00° ‘. You should see the orientation of the map item change.

7. Now, you can print or export your print composition to image formats, PDF or to SVG with the export tools
in Composer menu.
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8. Finally, you can save your print composition within the project file with the Save Project button.

You can add multiple elements to the Composer. It is also possible to have more than one map view or legend or
scale bar in the Print Composer canvas, on one or several pages. Each element has its own properties and, in the
case of the map, its own extent. If you want to remove any elements from the Composer canvas you can do that
with the Delete or the Backspace key.

14.1.2 The Composer Manager

The Composer Manager is the main window to manage print composers in the project. It helps you add new print

composer, duplicate an existing one, rename or delete it. To open the composer manager dialog, click on the
Composer Manager button in the toolbar or choose Composer → Composer Manager. It can also be reached from the
main window of QGIS with Project → Composer Manager.

Figure 14.1: The Print Composer Manager

The composer manager lists in its upper part all the available print composers in the project. The bottom part
shows tools that help to:

• show the selected composer(s): you can open multiple print composers in one-click

• duplicate the selected composer (available only if one print composer is selected): it creates a new composer
using the selected composer as template. You’ll be prompted to choose a new title for the new composer

• rename the composer (also available only if one print composer is selected): You’ll be prompted to choose
a new title for the composer. Note that you can also rename the composer by double-clicking on its title in
the upper part

• remove the composer: the selected print composer(s) will be deleted from the project.

With the Composer Manager, it’s also possible to create new print composers as an
empty composer or from a saved template. By default, QGIS will look for tem-
plates in user directory (~/.qgis2/composer_templates) or application’s one
(ApplicationFolder/composer_templates). QGIS will retrieve all the available templates and
propose them in the combobox. The selected template will be used to create a new composer when clicking Add
button. You can also save composer templates in another folder. Choosing specific in the template list offers the
ability to select such template and use it to create a new print composer.

14.1.3 Menus, tools and panels of the print composer

Opening the Print Composer provides you with a blank canvas that represents the paper surface when using the
print option. Initially you find buttons on the left beside the canvas to add map composer items: the current QGIS
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map canvas, text labels, images, legends, scale bars, basic shapes, arrows, attribute tables and HTML frames. In
this toolbar you also find toolbar buttons to navigate, zoom in on an area and pan the view on the composer and
toolbar buttons to select a map composer item and to move the contents of the map item.

Figure_composer_overview shows the initial view of the Print Composer before any elements are added.

Figure 14.2: Print Composer

On the right beside the canvas you find two set of panels. The upper one holds the panels Items and Command
History and the lower holds the panels Composition, Item properties and Atlas generation.

• The Items panel provides a list of all map composer items added to the canvas.

• The Command history panel displays a history of all changes applied to the Print Composer layout. With a
mouse click, it is possible to undo and redo layout steps back and forth to a certain status.

• The Composition panel allows you to set paper size, orientation, the page background, number of pages and

print quality for the output file in dpi. Furthermore, you can also activate the Print as raster checkbox.
This means all items will be converted to raster before printing or saving as PostScript or PDF. In this panel,
you can also customize settings for grid and smart guides.

• The Item Properties panel displays the properties for the selected item. Click the Select/Move item icon
to select an item (e.g., legend, scale bar or label) on the canvas. Then click the Item Properties panel and
customize the settings for the selected item (see Composer Items for detailed information on each item
settings).
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• The Atlas generation panel allows you to enable the generation of an atlas for the current Composer and
gives access to its parameters (see Generarea unui Atlas for detailed information on atlas generation usage).

In the bottom part of the Print Composer window, you can find a status bar with mouse position, current page
number, a combo box to set the zoom level, the number of selected items if applicable and, in the case of atlas
generation, the number of features.

In the upper part of the Print composer window, you can find menus and other toolbars. All Print Composer tools
are available in menus and as icons in a toolbar. See a list of tools in table_composer_tools.

The toolbars and the panels can be switched off and on using the right mouse button over any toolbar or through
View → Toolbars or View → Panels.

240 Chapter 14. Print Composer



QGIS User Guide, Release 2.18

Tools

Icon Purpose Icon Purpose

Save Project New Composer

Duplicate Composer Composer Manager

Load from template Save as template

Print or export as PostScript Export to an image format

Export print composition to SVG Export as PDF

Revert last change Restore last change

Zoom to full extent Zoom to 100%

Zoom in Zoom out

Refresh View

Pan Zoom to specific region

Select/Move item in print composition Move content within an item

Add new map from QGIS map canvas Add image to print composition

Add label to print composition Add new legend to print composition

Add scale bar to print composition Add basic shape to print composition

Add arrow to print composition Add attribute table to print composition

Add an HTML frame Add nodes shape to print composition

Edit a nodes shape

Group items of print composition Ungroup items of print composition

Lock Selected Items Unlock All items

Raise selected items Lower selected items

Move selected items to top Move selected items to bottom

Align selected items left Align selected items right

Align selected items center Align selected items center vertical

Align selected items top Align selected items bottom

Preview Atlas First Feature

Previous Feature Next Feature

Last feature Print Atlas

Export Atlas as Image Atlas Settings

Table Composer 1: Print Composer Tools

Composer Menu

With the Composer → Save Project action, you can save the project file directly from the print composer window.
The Composer menu also provides actions to:

• Create a new and blank print composer with New Composer...

• Duplicate Composer... : Create a new print composer by duplicating the current one
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• Open the Composer Manager...

• Print Composers... : Open an existing print composer

Once the layout is designed, with Save as template and Add items from template icons, you can save the current state
of a Print Composer session as a .qpt template and load its item again in another session.

In the Composer menu, there are also powerful ways to share geographical information produced with QGIS that

can be included in reports or published. These tools are Export as Image..., Export as PDF..., Export as SVG... and
Print....

Meniul Setărilor

From Settings → Composer Options you can set some options that will be used as default on any composer during
your work.

• Compositions defaults let you specify the default font to use.

• With Grid appearance, you can set the grid style and its color. There are three types of grid: Dots, Solid
lines and Crosses.

• Grid and guide defaults defines spacing, offset and tolerance of the grid.

Edit Menu

Copy/Cut and Paste Items

The print composer includes actions to use the common Copy/Cut/Paste functionality for the items in the layout.
As usual first you need to select the items using one of the options seen above; at this point the actions can be
found in the Edit menu. When using the Paste action, the elements will be pasted according to the current mouse
position. Using the Edit → Paste in Place action or pressing Ctrl+Shift+V will paste the items into the current
page, at the same position they were in their initial page. It ensures to copy/paste items at the same place, from
page to page.

Note: HTML items can not be copied in this way. As a workaround, use the [Add Frame] button in the Item
Properties panel.

View Menu

Navigation Tools

To navigate in the canvas layout, the Print Composer provides some general tools:

• Zoom In

• Zoom Out

• Zoom Full

• Zoom to 100%

• Refresh view (if you find the view in an inconsistent state)

• Show Grid behind items.

• Snap Grid to snap items on the grid.
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• Show Guides to help user to align items. These are red line that you can click in the rule (above or at the
left side of the layout) and drag and drop to the desired location.

• Snap Guides: allows user to snap items to the guides,

• Smart Guides: uses other composer items as guides to dynamically snap to as user moves or reshapes an
item.

• Clear Guides to remove all current guides.

• Show Bounding box around the items.

• Show Rules around the layout.

• Show Pages or set up pages to transparent. Often composer is used to create non-print layouts, e.g. for
inclusion in presentations or other documents, and it’s desirable to export the composition using a totally
transparent background. It’s sometimes referred to as “infinite canvas” in other editing packages.

• Toggle Full Screen makes the composer window to full screen.

• Hide Panels hides/shows the right panel

• Panels lists all panels available to hide/show them.

• Toolbars same as above for toolbars.

You can change the zoom level also using the mouse wheel or the combo box in the status bar. If you need
to switch to pan mode while working in the Composer area, you can hold the Spacebar or the mouse wheel.
With Ctrl+Spacebar, you can temporarily switch to Zoom In mode, and with Ctrl+Shift+Spacebar, to
Zoom Out mode.

Hide and Show Panels

To maximise the space available to interact with a composition you can use View → Hide panels or press F10.

Note: It’s also possible to switch to a full screen mode to have more space to interact by pressing F11 or using
View → Toggle full screen.

Composition Panel

Page size and settings

In the Composition panel, you can define the global settings of the current composition.

You can choose one of the Presets formats for your paper sheet, or enter your custom width, height and units. You
can also choose the page Orientation to use.

Composition can be divided into several pages. For instance, a first page can show a map canvas, and a second
page can show the attribute table associated with a layer, while a third one shows an HTML frame linking to your
organization website. Set the Number of pages to the desired value. you can also custom the Page Background
with the color or the symbol you want.

The Page size options apply to all the pages in the composition. However, you can modify the values using the
data defined override options (see Data Defined Override Buttons).

A custom page size can also be set, using the Resize page tool. This creates an unique page composition, resizes
the page to fit the current contents of the composition (with optional margins).
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Figure 14.3: Composition settings in the Print Composer

Setări de export

You can define a resolution to use for all exported maps in Export resolution. This setting can, however, be

overridden each time you are exporting a map. When checked, print as raster means all elements will be
rasterized before printing or saving as PostScript or PDF.

While exporting to an image file format, you can choose to generate a world file by checking Save world file

and select a map item in Reference map. The world file is created beside the exported map, has the same
name and contains information to georeference it easily.

Figure 14.4: Export Settings in the Print Composer

Grid and guides

You can put some reference marks on your composition paper sheet to help you place some items. These marks
can be:

• simple lines (called Guides) put at the position you want. To do that, ensure that Show Rulers and Show
Guides in View menu are checked. Then, click and drag from within the ruler to the paper sheet. A vertical

244 Chapter 14. Print Composer



QGIS User Guide, Release 2.18

or horizontal line is added to the paper and you can set its position following the coordinates displayed at
the left bottom of the composer dialog.

• or regular Grid.

Whether grids or guides should be shown is set in View menu. There, you can also decide if they might be used to
snap composer items. The Grid and guides section lets you customize grid settings like Grid spacing, Grid offset
and Snap tolerance to your need. The tolerance is the maximum distance below which an item is snapped to a
grid or a guide.

Figure 14.5: Snapping to grids in the Print Composer

In the Options → Composer menu in QGIS main canvas, you can also set the spacing, offset and snap tolerance
of the grid as much as its style and color. These options are applied by default to any new print composer.

Variabile

The Variables lists all the variables available at the composition’s level (which includes all global and project’s
variables).

It also allows the user to manage composition-level variables. Click the button to add a new custom

composition-level variable. Likewise, select a custom composition-level variable from the list and click the
button to remove it.

More information on variables usage in the General Tools Variables section.

Figure 14.6: Variables editor in the Print Composer

Command History Panel: Revert and Restore actions

During the layout process, it is possible to revert and restore changes. This can be done with the revert and restore
tools:

• Anulează ultima modificare

• Restaurează ultima modificare
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This can also be done by mouse click within the Command history panel (see figure_composer). The History
panel lists the last actions done within the composer. Just select the point you want to revert to and once you do
new action all the actions done after the selected one will be removed.

Figure 14.7: Command history in the Print Composer

Items Panel

The Items panel offers some options to manage selection and visibility of items. All the items added to the print
composer canvas are shown in a list and selecting an item makes the corresponding row selected in the list as well
as selecting a row does select the corresponding item in the print composer canvas. This is thus a handy way to
select an item placed behind another one. Note that a selected row is shown as bold.

Oricărui element selectat, îi putet,i:

• set it visible or not,

• lock or unlock its position,

• order its Z position. You can move up and down each item in the list with a click and drag. The upper item
in the list will be brought to the foreground in the print composer canvas. By default, a newly created item
is placed in the foreground.

• change the name by double-clicking the text.

Once you have found the correct position for an item, you can lock it by ticking the box in column. Locked
items are not selectable on the canvas. Locked items can be unlocked by selecting the item in the Items panel and
unchecking the tickbox or you can use the icons on the toolbar.

14.2 Composer Items

14.2.1 Composer Items Common Options

Composer items have a set of common properties you will find at the bottom of the Item Properties panel: Position
and size, Rotation, Frame, Background, Item ID, Variables and Rendering (See figure_composer_common).

• The Position and size dialog lets you define the size and position of the frame which contains the item. You
can also choose which Reference point will be set at the X and Y coordinates previously defined.

• Rotirea stabiles, te rotat,ia elementului (în grade).

• The Frame shows or hides the frame around the item. Click on the [Color] and [Thickness] buttons to
adjust those properties.

• Use the Background color menu for setting a background color. Click on the [Color...] button to display a
dialog where you can pick a color or choose from a custom setting. Transparency can be adjusted through
atlering the alpha field settings.
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Figure 14.8: Common Item Properties Dialogs
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• Use the Item ID to create a relationship to other Print Composer items. This is used with QGIS server and
other potential web clients. You can set an ID on an item (for example, a map or a label), and then the
web client can send data to set a property (e.g., label text) for that specific item. The GetProjectSettings
command will list the items and IDs which are available in a layout.

• Rendering mode helps you set whether and how the item can be displayed.

Note:

• If you checked Use live-updating color chooser dialogs in the QGIS general options, the color button
will update as soon as you choose a new color from Color Dialog windows. If not, you need to close the
Color Dialog.

• The Data defined override icon next to a field means that you can associate the field with data in the map
item or use expressions. These are particularly helpful with atlas generation (See Data Defined Override
Buttons).

Modul de randare

QGIS now allows advanced rendering for Composer items just like vector and raster layers.

Figure 14.9: Modul de randare

• Blending mode: With this tool you can achieve effects which would otherwise only be achieved using
graphic rendering software. The pixels of your overlaying and underlaying items can be mixed according
to the mode set (see Modurile de Fuziune for description of each effect).

• Transparency : You can make the underlying item in the Composer visible with this
tool. Use the slider to adapt the visibility of your item to your needs. You can also make a precise definition
of the percentage of visibility in the menu beside the slider.

• Exclude item from exports: You can decide to make an item invisible in all exports. After activating this
checkbox, the item will not be included in export to PDF, print etc..

Size and position

Each item inside the Composer can be moved and resized to create a perfect layout.For both operations the first

step is to activate the Select/Move item tool and to click on the item; you can then move it using the mouse while
holding the left button. If you need to constrain the movements to the horizontal or the vertical axis, just hold the
Shift button on the keyboard while moving the mouse. If you need better precision, you can move a selected
item using the Arrow keys on the keyboard; if the movement is too slow, you can speed up it by holding
Shift.

A selected item will show squares on its boundaries; moving one of them with the mouse, will resize the item
in the corresponding direction. While resizing, holding Shift will maintain the aspect ratio. Holding Alt will
resize from the item center.

The correct position for an item can be obtained using the grid snapping or smart guides. Guides are set by clicking
and dragging within the ruler area. To move a guide, click on the ruler, level with the guide and drag it to a new
position. To delete a guide move it off the canvas. If you need to disable the snap on the fly, hold Ctrl while
moving the mouse.
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You can choose multiple items with the Select/Move item button. Just hold the Shift button and click on all the
items you need. You can then resize/move this group like a single item.

Once you have found the correct position for an item, you can lock it by using the items on the toolbar or ticking
the box next to the item in the Items panel. Locked items are not selectable on the canvas.

Locked items can be unlocked by selecting the item in the Items panel and unchecking the tickbox or you can use
the icons on the toolbar.

To unselect an item, just click on it holding the Shift button.

Inside the Edit menu, you can find actions to select all the items, to clear all selections or to invert the current
selection.

Alinierea

Raising or lowering the visual hierarchy for elements are inside the Raise selected items pull-down menu. Choose
an element on the Print Composer canvas and select the matching functionality to raise or lower the selected
element compared to the other elements. This order is shown in the Items panel. You can also raise or lower
objects in the Items panel by clicking and dragging an object’s label in this list.

Figure 14.10: Alignment helper lines in the Print Composer

There are several alignment options available within the Align selected items pull-down menu (see fig-
ure_composer_common_align). To use an alignment function, you first select the elements then click on the
matching alignment icon. All selected elements will then be aligned to their common bounding box. When mov-
ing items on the Composer canvas, alignment helper lines appear when borders, centers or corners are aligned.

Variables

The Variables lists all the variables available at the composer item’s level (which includes all global, project and
composition’s variables). Map items also include Map settings variables that provide easy access to values like
the map’s scale, extent, and so on.
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In Variables, it’s also possible to manage item-level variables. Click the button to add a new custom variable.

Likewise, select any custom item-level variable from the list and click the button to remove it.

More information on variables usage in the General Tools Variables section.

14.2.2 Elementul Hartă

Click on the Add new map toolbar button in the Print Composer toolbar to add the QGIS map canvas. Now, drag
a rectangle onto the Composer canvas with the left mouse button to add the map. To display the current map, you
can choose between three different modes in the map Item Properties panel:

• Rectangle is the default setting. It only displays an empty box with a message ‘Map will be printed here’.

• Cache renders the map in the current screen resolution. If you zoom the Composer window in or out, the
map is not rendered again but the image will be scaled.

• Render means that if you zoom the Composer window in or out, the map will be rendered again, but for
space reasons, only up to a maximum resolution.

Cache is the default preview mode for newly added Print Composer maps.

You can resize the map item by clicking on the Select/Move item button, selecting the element, and dragging one
of the blue handles in the corner of the map. This button also helps to move the map to another place. Select the
item and while holding the left mouse button, move to the new place and release the mouse button. After you
have found the right place for an item, you can lock the item position within the Print Composer canvas. Select

the map item and use the toolbar Lock Selected Items or the Items panel to Lock the item. A locked item can only
be selected using the Items panel. Once selected you can use the Items panel to unlock individual items. The

Unlock All Items icon will unlock all locked composer items. With the map selected, you can now adapt more
properties in the map Item Properties panel.

To move layers within the map element, select the map element, click the Move item content icon and move the
layers within the map item frame with the left mouse button.

Proprietăt,i principale

The Main properties dialog of the map Item Properties panel provides the following functionalities (see fig-
ure_composer_map):

• The Preview drop-down menu allows you to select one of the preview modes ‘Rectangle’, ‘Cache’ and
‘Render’, as described above. If you change the view on the QGIS map canvas by changing vector or raster
properties, you can update the Print Composer view by selecting the map element and clicking the [Update
preview] button.

• The field Scale manually sets the map item scale.

• The field Map rotation allows you to rotate the map element content clockwise in degrees. The
rotation of the map canvas can be imitated here.

• Draw map canvas items lets you show annotations that may be placed on the map canvas in the main
QGIS window.

Straturi

The Layers dialog of the map item panel provides the following functionality (see figure_composer_map_layers):
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Figure 14.11: Panoul Proprietăt,ilor pentru Elementul de tip Hartă

Figure 14.12: Map Layers Dialog
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• If you want to keep the map item constantly updated with a visibility preset, use the Follow visibility
preset and set the preset you want. Any changes applied to the preset in QGIS’s main window (using the
replace preset) will also show in the map item. In this case, the Lock styles for layers option will be disabled
because Follow visibility preset also updates the style (symbology, label, diagram) of the visibility preset
layers.

• To lock the layers shown on a map item to the current map canvas check Lock layers. After this option is
enabled, any changes on the layers visibility in the QGIS’s main window won’t affect the Composer’s map
item. Nevertheless, style and labels of locked layers are still refreshed according to QGIS’s main window.
You can prevent this by using Lock styles for layers.

Using the button, you can lock the map item’s layers to one of the visibility presets you have prepared
in QGIS (see Panoul Straturilor to find out how to create visibility presets). Clicking the button will
show the list of all the preset views. Select the preset you want to display. The map canvas will lock the

preset layers automatically by enabling the Lock layers. You can release the preset by unchecking the

Lock layers and press the button in the map composer’s Navigation toolbar.

Note that, unlike the Follow visibility preset, using the Lock layers option enabled and set to a preset, the
map item layers won’t be updated if the preset is changed (using the replace preset option) in QGIS’s main
window.

Locked layers in the map can also be data-defined, using the icon beside the option. When used, this
overrides the selection set in the drop-down list. You need to pass a list of layers separated by | character.
The following example locks the map item to use only layers layer 1 and layer 2:

concat (’layer 1’, ’|’, ’layer 2’)

Extinderi

The Extents dialog of the map item panel provides the following functionalities (see fig-
ure_composer_map_extents):

Figure 14.13: Map Extents Dialog

The Map extents area allows you to specify the map extent using X and Y min/max values and by clicking the
[Set to map canvas extent] button. This button sets the map extent of the composer map item to the extent of
the current map view in the main QGIS application. The button [View extent in map canvas] does exactly the
opposite; it updates the extent of the map view in the QGIS application to the extent of the composer map item.

If you change the view on the QGIS map canvas by changing vector or raster properties, you can update the Print
Composer view by selecting the map element in the Print Composer and clicking the [Update preview] button in
the map Item Properties panel (see figure_composer_map).

Grile

The Grids dialog of the map Item Properties panel provides the possibility to add several grids to a map item.
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• With the and buttons you can add or remove a selected grid.

• With the and buttons you can move a grid in the list and set the drawing priority.

When you double-click the added grid you can give it another name.

Figure 14.14: Dialogul Grilelor Hărt,ii

After you have added a grid, you can activate the checkbox Draw grid to overlay a grid onto the map element.
Expand this option to provide a lot of configuration options, see Figure_composer_map_grid_draw.

Figure 14.15: Dialogul de Desenare a Grilei

As grid type, you can specify to use a ‘Solid’, ‘Cross’, ‘Markers’ or ‘Frame and annotations only’. ‘Frame and
annotations only’ is especially useful when working with rotated maps or reprojected grids. In the divisions section
of the Grid Frame Dialog mentioned below you then have a corresponding setting. Symbology of the grid and its
rendering mode can be chosen. See Modul de randare. Furthermore, you can define an interval in the X and Y
directions, an X and Y offset, and the width used for the cross or line grid type.

• There are different options to style the frame that holds the map. Following options are available: No Frame,
Zebra, Interior ticks, Exterior ticks, Interior and Exterior ticks and Lineborder.

• With ‘Latitude/Y only’ and ‘Longitude/X only’ setting in the divisions section you have the possibility to
prevent a mix of latitude/y and longitude/x coordinates showing on a side when working with rotated maps
or reprojected grids.

• Advanced rendering mode is also available for grids.

• The Draw coordinates checkbox allows you to add coordinates to the map frame. You can choose the
annotation numeric format, the options range from decimal to degrees, minute and seconds, with or without
suffix, aligned or not and a custom format using the expression dialog. You can choose which annotation
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Figure 14.16: Dialogul Cadrului Grilei

to show. The options are: show all, latitude only, longitude only, or disable(none). This is useful when the
map is rotated. The annotation can be drawn inside or outside the map frame. The annotation direction can
be defined as horizontal, vertical ascending or vertical descending. Finally, you can define the annotation
font, the annotation font color, the annotation distance from the map frame and the precision of the drawn
coordinates.

Prezentare generală

The Overviews dialog of the map Item Properties panel provides the following functionalities:

You can choose to create an overview map, which shows the extents of the other map(s) that are available in the
composer. First you need to create the map(s) you want to include in the overview map and the map you want to
use as the overview map, just like a normal map.

Then expand Overviews option and press the green plus icon-button to add an overview. Initially this overview is
named ‘Overview 1’ (see Figure_composer_map_overview). You can change the name when you double-click on
the overview item in the list named ‘Overview 1’ and change it to another name.

• With the plus and minus button you can add or remove an overview.

• With the up and down button you can move an overview in the list and set the drawing priority.

When you select the overview item in the list you can customize it.

• The Draw “<name_overview>” overview needs to be activated to draw the extent of selected map
frame.

• The Map frame combo list can be used to select the map item whose extents will be drawn on the present
map item.

• Stilul Cadrului vă permite să schimbat,i stilul cadrului pentru imaginea de ansamblu.

• The Blending mode allows you to set different transparency blend modes.

• The Invert overview creates a mask around the extents when activated: the referenced map extents are
shown clearly, whereas everything else is blended with the frame color.

• The Center on overview puts the extent of the overview frame in the center of the overview map. You
can only activate one overview item to center, when you have added several overviews.
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Figure 14.17: Dialogul de Desenare a Coordonatelor Grilei

Figure 14.18: Map Overviews Dialog
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14.2.3 Elementul Etichetă

To add a label, click the Add label icon, place the element with the left mouse button on the Print Composer
canvas and position and customize its appearance in the label Item Properties panel.

The Item Properties panel of a label item provides the following functionality for the label item (see Fig-
ure_composer_label):

Figure 14.19: Panoul Proprietăt,ilor Elementului Etichetă

Proprietăt,i principale

• The main properties dialog is where the text (HTML or not) or the expression needed to fill the label is
added to the Composer canvas.

• Labels can be interpreted as HTML code: check Render as HTML. You can now insert a URL, a
clickable image that links to a web page or something more complex.

• You can also insert an expression. Click on [Insert an expression] to open a new dialog. Build an ex-
pression by clicking the functions available in the left side of the panel. Two special categories can be
useful, particularly associated with the atlas functionality: geometry and records functions. At the bottom,
a preview of the expression is shown.

Aspectul

• Define Font by clicking on the [Font...] button or a Font color selecting a color using the color selection
tool.

• You can specify different horizontal and vertical margins in mm. This is the margin from the edge of the
composer item. The label can be positioned outside the bounds of the label e.g. to align label items with
other items. In this case you have to use negative values for the margin.

• Using the Alignment is another way to position your label. Note that when e.g. using the Horizontal
alignment in Center Position the Horizontal margin feature is disabled.
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14.2.4 Elementul Legendă

To add a map legend, click the Add new legend icon, place the element with the left mouse button on the Print
Composer canvas and position and customize the appearance in the legend Item Properties panel.

The Item properties panel of a legend item provides the following functionalities (see figure_composer_legend):

Figure 14.20: Panoul Proprietăt,ilor Elementului Legendă

Proprietăt,i principale

The Main properties dialog of the legend Item Properties panel provides the following functionalities (see fig-
ure_composer_legend_ppt):

Figure 14.21: Legend Main properties Dialog

În proprietăt,ile principale putet,i:

• change the title of the legend;

• set the title alignment to Left, Center or Right;

• choose which Map item the current legend will refer to in the select list;

• wrap the text of the legend title on a given character;

• use Resize to fit contents to control whether or not a legend should be automatically resized to fit its
contents. If unchecked, then the legend will never resize and instead just stick to whatever size the user has
set. Any content which doesn’t fit the size is cropped out.
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Elementele legendei

The Legend items dialog of the legend Item Properties panel provides the following functionalities (see fig-
ure_composer_legend_items):

Figure 14.22: Legend Items Dialog

• The legend will be updated automatically if Auto-update is checked. When Auto-update is unchecked
this will give you more control over the legend items. The icons below the legend items list will be activated.

• The legend items window lists all legend items and allows you to change item order, group layers, remove
and restore items in the list, edit layer names and add a filter.

– The item order can be changed using the and buttons or with ‘drag-and-drop’ functionality.
The order can not be changed for WMS legend graphics.

– Use the button to add a legend group.

– Use the button to add layers and button to remove groups, layers or symbol classes.

– The button is used to edit the layer, group name or title. First you need to select the legend item.
Double-clicking the item also opens the text box to rename it.

– The button adds a feature count for each class of vector layer.

– With the Filter legend by map content button, only the legend items visible in the map will be listed in the

legend. This tool remains available when Auto-update is active.

– The Filter legend by expression helps you filter which of the legend items of a layer will be displayed, i.e.
using a layer that has different legend items (e.g., from a rule-based or categorized symbology), you
can specify a boolean expression to remove from the legend tree, styles that have no feature satisfying
a condition. Note that the features are nevertheless kept and shown in the composer map item.

While the default behavior of the legend item is to mimic the Layers panel tree, displaying the same groups,
layers and classes of symbology, right-click any item offers you options to hide layer’s name or raise it as a
group or subgroup. In case you have made some changes to a layer, you can revert them by choosing Reset
to defaults from the contextual menu.

After changing the symbology in the QGIS main window, you can click on [Update All] to adapt the
changes in the legend element of the Print Composer.
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• While generating an atlas with polygon features, you can filter out legend items that lie outside the current

atlas feature. To do that, check the Only show items inside current atlas feature option.

Fonturi, Coloane, Simboluri

The Fonts, Columns and Symbol dialogs of the legend Item Properties panel provide the following functionalities
(see figure_composer_legend_fonts):

Figure 14.23: Legend Fonts, Columns and Symbol Dialogs

• You can change the font of the legend title, group, subgroup and item (layer) in the legend item. Click on a
category button to open a Select font dialog.

• You provide the labels with a Color using the advanced color picker, however the selected color will be
given to all font items in the legend..

• Legend items can be arranged over several columns. Set the number of columns in the Count field.

– Equal column widths stabiles, te modul în care ar trebui să fie ajustate coloanele legendei.

– The Split layers option allows a categorized or a graduated layer legend to be divided between
columns.

• You can also change the width and height of the legend symbol, set a color and a thickness in case of raster
layer symbol.

WMS LegendGraphic s, i Spat,ierea

The WMS LegendGraphic and Spacing dialogs of the legend Item Properties panel provide the following func-
tionalities (see figure_composer_legend_wms):

When you have added a WMS layer and you insert a legend composer item, a request will be sent to the WMS
server to provide a WMS legend. This Legend will only be shown if the WMS server provides the GetLegend-
Graphic capability. The WMS legend content will be provided as a raster image.
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Figure 14.24: WMS LegendGraphic and Spacing Dialogs

WMS LegendGraphic is used to be able to adjust the Legend width and the Legend height of the WMS legend
raster image.

Spacing around title, group, subgroup, symbol, icon label, box space or column space can be customized through
this dialog.

14.2.5 Elementul Scării Grafice

To add a scale bar, click the Add new scalebar icon, place the element with the left mouse button on the Print
Composer canvas and position and customize the appearance in the scale bar Item Properties panel.

The Item properties of a scale bar item tab provides the following functionalities (see figure_composer_scalebar):

Figure 14.25: Panoul Proprietăt,ilor pentru Elementul de tip Scară Grafică
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Proprietăt,i principale

The Main properties dialog of the scale bar Item Properties panel provides the following functionalities (see
figure_composer_scalebar_ppt):

Figure 14.26: Scale Bar Main properties Dialog

• În primul rând, aleget,i scara grafică, pentru a o atas, a hărt,ii.

• Apoi, aleget,i stilul scării grafice. Sunt disponibile s, ase stiluri :

– Single box and Double box styles, which contain one or two lines of boxes alternating colors.

– Middle, Up or Down line ticks.

– Numeric, în care este imprimat raportul scării (ex.: 1:50000).

Unităt,i s, i Segmente

The Units and Segments dialogs of the scale bar Item Properties panel provide the following functionalities (see
figure_composer_scalebar_units):

Figure 14.27: Scale Bar Units and Segments Dialogs

In these two dialogs, you can set how the scale bar will be represented.

• Select the units you want to use with Scalebar units. There are four possible choices: Map Units, the
default one and Meters, Feet or Nautical Miles which may force unit conversions.

• The Label unit multiplier specifies how many scalebar units per labeled unit. Eg, if your scalebar units are
set to “meters”, a multiplier of 1000 will result in the scale bar labels in “kilometers”.

• The Label for units field defines the text used to describe the units of the scale bar, eg “m” or “km”. This
should be matched to reflect the multiplier above.

• You can define how many Segments will be drawn on the left and on the right side of the scale bar.
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• You can set how long each segment will be (fixed width), or limit the scale bar size in mm with Fit segment
width option. In the latter case, each time the map scale changes, the scale bar is resized (and its label
updated) to fit the range set.

• Height is used to define the height of the bar.

Afis, area

The Display dialog of the scale bar Item Properties panel provides the following functionalities (see fig-
ure_composer_scalebar_display):

Figure 14.28: Scale Bar Display

Putet,i defini modul în care va fi afis, ată scara grafică în cadrul său.

• Box margin : spat,iul dintre bordurile textului s, i ale cadrului

• Labels margin : space between text and scale bar drawing

• Lăt,imea Liniei : lăt,imea liniei de desenare a scării grafice

• Join style : Corners at the end of scalebar in style Bevel, Rounded or Square (only available for Scale bar
style Single Box & Double Box)

• Cap style : End of all lines in style Square, Round or Flat (only available for Scale bar style Line Ticks Up,
Down and Middle)

• Alignment : Puts text on the left, middle or right side of the frame (works only for Scale bar style Numeric)

Fonturi s, i culori

The Fonts and colors dialog of the scale bar Item Properties panel provides the following functionalities (see
figure_composer_scalebar_fonts):

Figure 14.29: Scale Bar Fonts and colors Dialogs

You can define the fonts and colors used for the scale bar.
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• Use the [Font] button to set the font of scale bar label

• Font color: setează culoarea fontului

• Fill color: setează prima culoare de umplere

• Secondary fill color: setează a doua culoare de umplere

• Stroke color: set the color of the lines of the Scale Bar

Fill colors are only used for scale box styles Single Box and Double Box. To select a color you can use the list
option using the dropdown arrow to open a simple color selection option or the more advanced color selection
option, that is started when you click in the colored box in the dialog.

14.2.6 Elementul de tip Tabelă de Atribute

It is possible to add parts of a vector attribute table to the Print Composer canvas: Click the Add attribute table

icon, click and drag with the left mouse button on the Print Composer canvas to place and size the item. You can
better position and customize its appearance in the Item Properties panel.

The Item properties panel of an attribute table provides the following functionalities (see figure_composer_table):

Figure 14.30: Panoul Proprietăt,ilor pentru Elementul de tip Tabelă de Atribute

Proprietăt,i principale

The Main properties dialog of the attribute table provides the following functionalities (see fig-
ure_composer_table_ppt):

• For Source you can normally select only Layer features.

• With Layer you can choose from the vector layers loaded in the project.

• In case you activated the Generate an atlas option in the Atlas generation panel, there are two additional
Source possible:

– Current atlas feature (see figure_composer_table_atlas): you won’t see any option to choose the
layer, and the table item will only show a row with the attributes from the current feature of the atlas
coverage layer.
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Figure 14.31: Attribute table Main properties Dialog

– and Relation children (see figure_composer_table_relation): an option with the relation names will
show up. This feature can only be used if you have defined a relation using your atlas coverage layer
as parent, and the table will show the children rows of the atlas coverage layer’s current feature (for
further information about the atlas generation, see Generarea unui Atlas).

• The button [Refresh table data] can be used to refresh the table when the actual contents of the table has
changed.

Figure 14.32: Attribute table Main properties for ‘Current atlas feature’

Figure 14.33: Attribute table Main properties for ‘Relation children’

• The button [Attributes...] starts the Select attributes menu, see figure_composer_table_select, that can be
used to change the visible contents of the table. After making changes use the [OK] button to apply changes
to the table. The upper part of the window shows the list of the attributes to display and the lower part helps
to set the way the data is sorted.

În sect,iunea Coloanelor putet,i:

– Remove an attribute, just select an attribute row by clicking anywhere in the row and press the minus
button to remove the selected attribute.

– Add a new attribute use the plus button. At the end a new empty row appears and you can select empty
cell of the column Attribute. You can select a field attribute from the list or you can select to build a

new attribute using a regular expression ( button). Of course you can modify every already existing
attribute by means of a regular expression.

– Use the up and down arrows to change the order of the attributes in the table.

– Select a cell in the Headings column and, to change the heading, just type in a new name.

– set a precise Alignment (mixing vertical and horizontal alignment options) for each column.

– Select a cell in the Width column and change it from Automatic to a width in mm, just type a number.
When you want to change it back to Automatic, use the cross.
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Figure 14.34: Attribute table Select attributes Dialog

– The [Reset] button can always be used to restore it to the original attribute settings.

În sect,iunea de Sortare putet,i:

– Add an attribute to sort the table with. Select an attribute and set the sorting order to ‘Ascending’ or
‘Descending’ and press the plus button. A new line is added to the sort order list.

– select a row in the list and use the up and down button to change the sort priority on attribute level.
Selecting a cell in the Sort Order column helps you change the sorting order of the attribute field.

– use the minus button to remove an attribute from the sort order list.

Filtrarea entităt,ilor

The Feature filtering dialog of the attribute table provides the following functionalities (see fig-
ure_composer_table_filter):

Figure 14.35: Attribute table Feature filtering Dialog

Putet,i:

• Defini Numărul maxim de rânduri care vor fi afis, ate.

• Activate Remove duplicate rows from table to show unique records only.
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• Activate Show only visible features within a map and select the corresponding Composer map to display
the attributes of features only visible on selected map.

• Activate Show only features intersecting Atlas feature is only available when Generate an atlas is
activated. When activated it will show a table with only the features which intersect the current atlas feature.

• Activate Filter with and provide a filter by typing in the input line or insert a regular expression using

the given expression button. A few examples of filtering statements you can use when you have loaded
the airports layer from the Sample dataset:

– ELEV > 500

– NAME = ’ANIAK’

– NAME NOT LIKE ’AN%’

– regexp_match( attribute( $currentfeature, ’USE’ ) , ’[i]’)

The last regular expression will include only the airports that have a letter ‘i’ in the attribute field ‘USE’.

Aspectul

The Appearance dialog of the attribute table provides the following functionalities (see fig-
ure_composer_table_appearance):

Figure 14.36: Attribute table appearance Dialog

• Click Show empty rows to fill the attribute table with empty cells. This option can also be used to provide
additional empty cells when you have a result to show!

• With Cell margins you can define the margin around text in each cell of the table.

• With Display header you can select from a list one of ‘On first frame’, ‘On all frames’ default option, or
‘No header’.

• The option Empty table controls what will be displayed when the result selection is empty.

– Draw headers only, will only draw the header except if you have chosen ‘No header’ for Display
header.

– Hide entire table, will only draw the background of the table. You can activate Don’t draw
background if frame is empty in Frames to completely hide the table.

– Show set message, will draw the header and adds a cell spanning all columns and display a message
like ‘No result’ that can be provided in the option Message to display
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• The option Message to display is only activated when you have selected Show set message for Empty table.
The message provided will be shown in the table in the first row, when the result is an empty table.

• With Background color you can set the background color of the table. The Advanced customization option
helps you define different background colors for each cell (see figure_composer_table_background)

Figure 14.37: Attribute table Advanced Background Dialog

• With the Wrap text on option, you can define a character on which the cell content will be wraped each time
it is met

• With Oversized text you define the behaviour when the width set for a column is smaller than its content’s
length. It can be Wrap text or Truncate text.

Afis, area grilei

The Show grid dialog of the attribute table provides the following functionalities (see fig-
ure_composer_table_grid):

Figure 14.38: Attribute table Show grid Dialog

• Activate Show grid when you want to display the grid, the outlines of the table cells.

• With Line width you can set the thickness of the lines used in the grid.

• The Color of the grid can be set using the color selection dialog.
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Stilizarea fonturilor s, i a textelor

The Fonts and text styling dialog of the attribute table provides the following functionalities (see fig-
ure_composer_table_fonts):

Figure 14.39: Attribute table Fonts and text styling Dialog

• You can define Font and Color for Table heading and Table contents.

• For Table heading you can additionally set the Alignment to Follow column alignment or override this
setting by choosing Left, Center or Right. The column alignment is set using the Select Attributes dialog
(see Figure_composer_table_select ).

Cadrele

The Frames dialog of the attribute table provides the following functionalities (see fig-
ure_composer_table_frames):

Figure 14.40: Attribute table Frames Dialog

• With Resize mode you can select how to render the attribute table contents:

– Use existing frames displays the result in the first frame and added frames only.

– Extend to next page will create as many frames (and corresponding pages) as necessary to display the
full selection of attribute table. Each frame can be moved around on the layout. If you resize a frame,
the resulting table will be divided up between the other frames. The last frame will be trimmed to fit
the table.

– Repeat until finished will also create as many frames as the Extend to next page option, except all
frames will have the same size.

• Use the [Add Frame] button to add another frame with the same size as selected frame. The result of the
table that will not fit in the first frame will continue in the next frame when you use the Resize mode Use
existing frames.

• Activate Don’t export page if frame is empty prevents the page to be exported when the table frame has
no contents. This means all other composer items, maps, scalebars, legends etc. will not be visible in the
result.
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• Activate Don’t draw background if frame is empty prevents the background to be drawn when the table
frame has no contents.

14.2.7 The Image Item

To add an image, click the Add image icon and drag a rectangle onto the Composer canvas with the left mouse
button. You can then position and customize its appearance in the image Item Properties panel.

The image Item Properties tab provides the following functionalities (see figure_composer_image):

Figure 14.41: Image Item Properties panel

You first have to select the image you want to display. There are several ways to set the image source in the Main
properties area.

1. Use the browse button of image source to select a file on your computer using the browse dialog. The
browser will start in the SVG-libraries provided with QGIS. Besides SVG, you can also select other image
formats like .png or .jpg.

2. You can enter the source directly in the image source text field. You can even provide a remote URL-address
to an image.

3. From the Search directories area you can also select an image from loading previews ... to set the image
source.

4. Use the data defined button to set the image source from a record or using a regular expression.

With the Resize mode option, you can set how the image is displayed when the frame is changed, or choose to
resize the frame of the image item so it matches the original size of the image.

You can select one of the following modes:

• Zoom: Enlarges the image to the frame while maintaining aspect ratio of picture.
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• Stretch: Stretches image to fit inside the frame, ignores aspect ratio.

• Clip: Use this mode for raster images only, it sets the size of the image to original image size without scaling
and the frame is used to clip the image, so only the part of the image inside the frame is visible.

• Zoom and resize frame: Enlarges image to fit frame, then resizes frame to fit resultant image.

• Resize frame to image size: Sets size of frame to match original size of image without scaling.

Selected resize mode can disable the item options ‘Placement’ and ‘Image rotation’. The Image rotation is active
for the resize mode ‘Zoom’ and ‘Clip’.

With Placement you can select the position of the image inside its frame. The Search directories area allows you
to add and remove directories with images in SVG format to the picture database. A preview of the pictures found
in the selected directories is shown in a pane and can be used to select and set the image source. It is possible to
change SVG fill/outline color and outline width when using parameterized SVG files such as those included with
QGIS. If you add a SVG file you should add the following tags in order to add support for transparency:

• fill-opacity=”param(fill-opacity)”

• stroke-opacity=”param(outline-opacity)”

You can read this blog post to see an example.

Images can be rotated with the Image rotation field. Activating the Sync with map checkbox synchronizes the
rotation of the image (i.e., a rotated north arrow) with the rotation applied to the selected map item.

It is also possible to select a north arrow directly. If you first select a north arrow image from Search directories

and then use the browse button of the field Image source, you can now select one of the north arrow from
the list as displayed in figure_composer_image_north.

Note: Many of the north arrows do not have an ‘N’ added in the north arrow, this is done on purpose for languages
that do not use an ‘N’ for North, so they can use another letter.

Figure 14.42: Săget,ile Nordului disponibile pentru select,ie în Biblioteca SVG
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14.2.8 Elementul HTML de tip cadru

It is possible to add a frame that displays the contents of a website or even create and style your own HTML page
and display it!

Click the Add HTML frame icon, place the element by dragging a rectangle holding down the left mouse but-
ton on the Print Composer canvas and position and customize the appearance in the Item Properties panel (see
figure_composer_html).

Figure 14.43: Cadrul HTML, Panoul Proprietăt,ilor Elementului

Sursa HTML

As an HTML source, you can either set a URL and activate the URL radiobutton or enter the HTML source
directly in the textbox provided and activate the Source radiobutton.

The HTML Source dialog of the HTML frame Item Properties panel provides the following functionalities (see
figure_composer_html_ppt):

Figure 14.44: Cadrul HTML, Proprietăt,ile Sursei HTML

• In URL you can enter the URL of a webpage you copied from your Internet browser or select an HTML file

using the browse button . There is also the option to use the Data defined override button, to provide
an URL from the contents of an attribute field of a table or using a regular expression.

• În cadrul casetei de text Sursă se poate introduce un text , însot,it de etichete HTML, sau să furnizat,i o pagină
HTML completă.
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• The [insert an expression] button can be used to insert an expression like [%Year($now)%] in the
Source textbox to display the current year. This button is only activated when radiobutton Source is selected.
After inserting the expression click somewhere in the textbox before refreshing the HTML frame, otherwise
you will lose the expression.

• Activat,i Evaluarea expresiilor QGIS din codul HTML pentru a vedea rezultatul expresiei pe care at,i
inclus-o, în caz contrar, vet,i vedea expresia originală.

• Use the [Refresh HTML] button to refresh the HTML frame(s) to see the result of changes.

Cadrele

The Frames dialog of the HTML frame Item Properties panel provides the following functionalities (see fig-
ure_composer_html_frames):

Figure 14.45: HTML frame, the Frames properties

• Cu ajutorul Modului de redimensionare putet,i selecta randarea cont,inutului HTML:

– Use existing frames displays the result in the first frame and added frames only.

– Extend to next page will create as many frames (and corresponding pages) as necessary to render the
height of the web page. Each frame can be moved around on the layout. If you resize a frame, the
webpage will be divided up between the other frames. The last frame will be trimmed to fit the web
page.

– Repeat on every page will repeat the upper left of the web page on every page in frames of the same
size.

– Repeat until finished will also create as many frames as the Extend to next page option, except all
frames will have the same size.

• Use the [Add Frame] button to add another frame with the same size as selected frame. If the HTML page
that will not fit in the first frame it will continue in the next frame when you use Resize mode or Use existing
frames.

• Activate Don’t export page if frame is empty prevents the map layout from being exported when the
frame has no HTML contents. This means all other composer items, maps, scalebars, legends etc. will not
be visible in the result.

• Activarea opt,iunii de Nedesenare a fundalului în cazul unui cadru vid previne desenarea cadrului HTML
atunci când cadrul nu cont,ine nimic.

Folosirea salturilor de pagină inteligente s, i a paginii de stil a Utilizatorului

The Use smart page breaks dialog and Use style sheet dialog of the HTML frame Item Properties panel provides
the following functionalities (see figure_composer_html_breaks):

• Activat,i Folosirea întreruperilor de pagină inteligente pentru a preveni ruperea liniilor de text la jumătate
din cadrele cu cont,inut html, astfel încât ele să continue frumos s, i neted în cadrul următor.
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Figure 14.46: HTML frame, Use smart page breaks and User stylesheet properties

• Set the Maximum distance allowed when calculating where to place page breaks in the html. This distance
is the maximum amount of empty space allowed at the bottom of a frame after calculating the optimum
break location. Setting a larger value will result in better choice of page break location, but more wasted
space at the bottom of frames. This is only used when Use smart page breaks is activated.

• Activate User stylesheet to apply HTML styles that often is provided in cascading style sheets. An
example of style code is provide below to set the color of <h1> header tag to green and set the font and
fontsize of text included in paragraph tags <p>.

h1 {color: #00ff00;
}
p {font-family: "Times New Roman", Times, serif;

font-size: 20px;
}

• Use the [Update HTML] button to see the result of the stylesheet settings.

14.2.9 Elementele de tip Formă

Elementul Săgeată

To add an arrow, click the Add Arrow icon, place the element holding down the left mouse button and drag a line
to draw the arrow on the Print Composer canvas and position and customize the appearance in the scale bar Item
Properties panel.

When you also hold down the Shift key while placing the arrow, it is placed in an angle of exactly 45° .

The arrow item can be used to add a line or a simple arrow that can be used, for example, to show the relation
between other print composer items. To create a north arrow, the image item should be considered first. QGIS
has a set of North arrows in SVG format. Furthermore you can connect an image item with a map so it can rotate
automatically with the map (see The Image Item).

Item Properties

The Arrow item properties panel allows you to configure an arrow item.

The [Line style...] button can be used to set the line style using the line style symbol editor.

In Arrows markers you can select one of three radio buttons.

• Default: To draw a regular arrow, gives you options to style the arrow head

• None: To draw a line without arrow head

• SVG Marker: To draw a line with an SVG Start marker and/or End marker

For Default Arrow marker you can use following options to style the arrow head.
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Figure 14.47: Arrow Item Properties Panel

• Arrow outline color: Set the outline color of the arrow head

• Arrow fill color: Set the fill color of the arrow head

• Arrow outline width: Set the outline width of the arrow head

• Arrow head width: Set the size of the arrow head

For SVG Marker you can use following options.

• Start marker: Choose an SVG image to draw at the beginning of the line

• End marker: Choose an SVG image to draw at the end of the line

• Arrow head width: Set the size of Start and/or End marker

SVG images are automatically rotated with the line. Outline and fill colors of QGIS predefined SVG images can
be changed using the corresponding options. Custom SVG may require some tags following this instruction.

The Basic Shape Items

To add a basic shape (ellipse, rectangle, triangle), click the Add basic shape icon, place the element holding down
the left mouse. Customize the appearance in the Item Properties panel.

When you also hold down the Shift key while placing the basic shape you can create a perfect square, circle or
triangle.

The Shape item properties panel allows you to select if you want to draw an ellipse, rectangle or triangle inside
the given frame.

You can set the style of the shape using the advanced symbol style dialog with which you can define its outline
and fill color, fill pattern, use markers...

For the rectangle shape, you can set the value of the corner radius to round of the corners.
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Figure 14.48: Panoul Proprietăt,ilor pentru Elementul de tip Formă

Note: Unlike other items, you can not style the frame or the background color of the frame.

The Node-Based Shape Items

While arrow and basic shape items offer you simple and predefined geometric item to use, a node-based shape
(polygon or polyline) helps you create a custom and more advanced geometric item. You can add as many lines
or sides as you want to the item and independently and directly interact with each of its vertices.

To add a node-based shape, click the Add nodes item icon. Then perform left clicks to add nodes to your current
shape. When you’re done, a simple right click terminates the shape. Customize the appearance in the Item
Properties panel.

Figure 14.49: Nodes Shape Item Properties Panel

You can set the style of the shape using the advanced symbol style dialog available thanks to the [Change...]
button in Main properties.

A specific tool is provided to edit node-based shapes through Edit Nodes Item. Within this mode, you can select
a node by clicking on it (a marker is displayed on the selected node). A selected node can be moved either by
dragging it or by using the arrow keys. Moreover, in this mode, you are able to add nodes to an existing shape.
You just have to do a left click near a segment and if you are not too far from the shape, a node is added. Finally,
you can remove the currently selected node by hitting the DEL key.
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14.3 Generarea unui Rezultat

Figure_composer_output shows the Print Composer with an example print layout, including each type of map
item described in the previous section.

Figure 14.50: Print Composer with map view, legend, image, scale bar, coordinates, text and HTML frame added

Before printing a layout you have the possibility to view your composition without bounding boxes. This can be

enabled by deactivating View → Show bounding boxes or pressing the shortcut Ctrl+Shift+B.

The Print Composer allows you to create several output formats, and it is possible to define the resolution (print
quality) and paper size:

• The Print icon allows you to print the layout to a connected printer or a PostScript file, depending on
installed printer drivers.

• The Export as image icon exports the Composer canvas in several image formats, such as PNG, BPM, TIF,
JPG,...

• The Export as SVG icon saves the Print Composer canvas as an SVG (Scalable Vector Graphic).

• The Export as PDF icon saves the defined Print Composer canvas directly as a PDF.

14.3.1 Exportare ca imagine

Clicking the Export as image icon will ask you to enter the filename to use to export composition: in the case of
multi-page composition, each page will be exported to a file with the given name appended with the page number.

You can then override the print resolution and the exported image dimensions (set in Composition panel).
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By checking Crop to content option, the image output by the composer includes the minimal area enclosing
all the items (map, legend, scale bar, shapes, label, image...) of each page of the composition:

• If the composition includes a single page, then the output is resized to include EVERYTHING on the
composition. The page can then be reduced or extended to all items depending on their position (on, above,
below, left or right of the page).

• In case of a multi-page composition, each page will be resized to include items in its area (left and right
sides for all pages, plus top for the first page and bottom for the last page). Each resized page is exported to
a separate file.

The Crop to content dialog also allows to add some margins around the cropped bounds.

Figure 14.51: Image Export Options, output is resized to items extent

If you need to export your layout as a georeferenced image (e.g., to share with other projects), you need to enable
this feature under the Composition Panel.

If the output format is a TIFF format, all you need to do is making sure to select the correct map item to use in

Reference map, and the output will always be a GeoTIFF. For other image formats, you also need to check

the Save world file option. With this option, the ‘Export as image’ action will create a world file along with
the exported image.

Note: Exporting large rasters can sometimes fail, even if there seems to be enough memory. This is a problem
with the underlying Qt management of rasters.

14.3.2 Exportare ca SVG

With Export as SVG, you also need to fill the filename (used as a basename for all files in case of multi-page

composition) and then can apply Crop to content option.

The SVG export options dialog also allows to:

• export map layers as svg groups:

• render map labels as outlines

Note: În prezent, producerea SVG-ului este foarte simplă. Aceasta nu t,ine de QGIS, ci de biblioteca Qt de la
bază. Acest lucru se va schimba, sperăm, în versiunile viitoare.
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Figure 14.52: Opt,iuni de Export SVG

14.3.3 Exportare ca PDF

The Export as PDF exports all the composition into a single PDF file.

If you applied to your composition or any shown layer an advanced effect such as blend modes, transparency or
symbol effects, these cannot be printed as vectors, and the effects may be lost. Checking Print as a raster in the
Composition Panel helps to keep the effects but rasterize the composition. Note that the Force layer to render as
raster in the Rendering tab of Layer Properties dialog is a layer-level alternative that avoids global composition
rasterization.

If you need to export your layout as a georeferenced PDF, in the Composition Panel, make sure to select the

correct map item to use in Reference map.

14.3.4 Generarea unui Atlas

The Print Composer includes generation functions that allow you to create map books in an automated way. The
concept is to use a coverage layer, which contains geometries and fields. For each geometry in the coverage layer,
a new output will be generated where the content of some canvas maps will be moved to highlight the current
geometry. Fields associated with this geometry can be used within text labels.

Every page will be generated with each feature. To enable the generation of an atlas and access generation param-
eters, refer to the Atlas generation panel.This panel contains the following widgets (see figure_composer_atlas):

• Generate an atlas, which enables or disables the atlas generation.

• A Coverage layer combo box that allows you to choose the (vector) layer containing the features on
which to iterate over.

• An optional Hidden coverage layer that, if checked, will hide the coverage layer (but not the other ones)
during the generation.

• An optional Page name combo box to give a more explicit name to each feature page(s) when previewing
atlas. You can select an attribute of the coverage layer or set an expression. If this option is empty, QGIS
will use an internal ID, according to the filter and/or the sort order applied to the layer.

• An optional Filter with text area that allows you to specify an expression for filtering features from the
coverage layer. If the expression is not empty, only features that evaluate to True will be selected. The
button on the right allows you to display the expression builder.

• An optional Sort by that, if checked, allows you to sort features of the coverage layer. The associated
combo box allows you to choose which column will be used as the sorting key. Sort order (either ascending
or descending) is set by a two-state button that displays an up or a down arrow.
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Figure 14.53: Atlas Generation Panel

De asemenea, avet,i opt,iuni de setare a ies, irii atlasului:

• An Output filename expression textbox that is used to generate a filename for each geometry if needed. It is
based on expressions. This field is meaningful only for rendering to multiple files.

• A Single file export when possible that allows you to force the generation of a single file if this is possible
with the chosen output format (PDF, for instance). If this field is checked, the value of the Output filename
expression field is meaningless.

You can use multiple map items with the atlas generation; each map will be rendered according to the coverage

features. To enable atlas generation for a specific map item, you need to check Controlled by Atlas under the
item properties of the map item. Once checked, you can set:

• A Margin around feature that allows you to select the amount of space added around each geometry
within the allocated map. Its value is meaningful only when using the auto-scaling mode.

• A Predefined scale (best fit). It will use the best fitting option from the list of predefined scales in your
project properties settings (see Project → Project Properties → General → Project Scales to configure
these predefined scales).

• A Fixed scale that allows you to toggle between auto-scale and fixed-scale mode. In fixed-scale mode,
the map will only be translated for each geometry to be centered. In auto-scale mode, the map’s extents are
computed in such a way that each geometry will appear in its entirety.

Labels

In order to adapt labels to the feature the atlas plugin iterates over, you can include expressions. What you should
take care of is to place expression part (including functions, fields or variables) between [% and %]. For example,
for a city layer with fields CITY_NAME and ZIPCODE, you could insert this:

The area of [% upper(CITY_NAME) || ’,’ || ZIPCODE || ’ is ’
format_number($area/1000000,2) %] km2

sau, o altă combinat,ie:

The area of [% upper(CITY_NAME)%],[%ZIPCODE%] is
[%format_number($area/1000000,2) %] km2

The information [% upper(CITY_NAME) || ’,’ || ZIPCODE || ’ is ’
format_number($area/1000000,2) %] is an expression used inside the label. Both expressions
would result in the generated atlas as:
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The area of PARIS,75001 is 1.94 km2

Data Defined Override Buttons

There are several places where you can use a Data Defined Override button to override the selected setting. These
options are particularly useful with Atlas Generation.

For the following examples the Regions layer of the QGIS sample dataset is used and selected for Atlas Generation.
We also assume the paper format A4 (210X297) is selected in the Composition panel for field Presets.

With a Data Defined Override button you can dynamically set the paper orientation. When the height (north-
south) of the extents of a region is greater than its width (east-west), you rather want to use portrait instead of
landscape orientation to optimize the use of paper.

In the Composition you can set the field Orientation and select Landscape or Portrait. We want to set the orienta-

tion dynamically using an expression depending on the region geometry. Press the button of field Orientation,
select Edit... so the Expression string builder dialog opens. Enter the following expression:

CASE WHEN bounds_width($atlasgeometry) > bounds_height($atlasgeometry)
THEN ’Landscape’ ELSE ’Portrait’ END

Now the paper orients itself automatically. For each Region you need to reposition the location of the composer

item as well. For the map item you can use the button of field Width to set it dynamically using following
expression:

(CASE WHEN bounds_width($atlasgeometry) > bounds_height($atlasgeometry)
THEN 297 ELSE 210 END) - 20

Use the button of field Height to provide following expression:

(CASE WHEN bounds_width($atlasgeometry) > bounds_height($atlasgeometry)
THEN 210 ELSE 297 END) - 20

When you want to give a title above the map in the center of the page, insert a label item above the map. First use
the item properties of the label item to set the horizontal alignment to Center. Next activate from Reference
point the upper middle checkbox. You can provide the following expression for field X :

(CASE WHEN bounds_width($atlasgeometry) > bounds_height($atlasgeometry)
THEN 297 ELSE 210 END) / 2

For all other composer items you can set the position in a similar way so they are correctly positioned when the
page is automatically rotated in portrait or landscape.

Information provided is derived from the excellent blog (in English and Portuguese) on the Data Defined Override
options Multiple_format_map_series_using_QGIS_2.6 .

This is just one example of how you can use the Data Defined Override option.

Preview and generate

Figure 14.54: Bara instrumentelor de previzualizare a atlasului

Once the atlas settings have been configured and composer items (map, table, image...) linked to it, you can create

a preview of all the pages by clicking Atlas → Preview Atlas or Preview Atlas icon. You can then use the arrows
in the same toolbar to navigate through all the features:

280 Chapter 14. Print Composer

http://sigsemgrilhetas.wordpress.com/2014/11/09/series-de-mapas-com-formatos-multiplos-em-qgis-2-6-parte-1-multiple-format-map-series-using-qgis-2-6-part-1


QGIS User Guide, Release 2.18

• Prima entitate

• Entitatea anterioară

• Următoarea entitate

• Ultima entitate

You can also use the combo box to directly select and preview a specific feature. The combo box shows atlas
features name according to the expression set in the atlas Page name option.

As for simple compositions, an atlas can be generated in different ways (see Generarea unui Rezultat for more
information). Instead of Composer menu, rather use tools from Atlas menu or Atlas toolbar.

This means that you can directly print your compositions with Atlas → Print Atlas. You can also create a PDF
using Atlas → Export Atlas as PDF...: The user will be asked for a directory to save all the generated PDF files,

except if the Single file export when possible has been selected. In that case, you’ll be prompted to give a
filename.

With Atlas → Export Atlas as Images... or Atlas → Export Atlas as SVG... tool, you’re also prompted to select a
folder. Each page of each atlas feature composition is exported to an image or SVG file.

Tip: Imprimă o entitate specifică a atlasului
If you want to print or export the composition of only one feature of the atlas, simply start the preview, select the
desired feature in the drop-down list and click on Composer → Print (or export... to any supported file format).
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CHAPTER 15

Lucrul cu date OGC

15.1 QGIS ca s, i Client de Date OGC

Open Geospatial Consortium (OGC) este o organizatie internat,ională, având ca membri mai mult de 300 de
organizat,ii comerciale, guvernamentale, non-profit s, i de cercetare din întreaga lume. Membrii săi dezvoltă s, i
implementează standarde s, i servicii pentru cont,inut geospat,ial, de prelucrare s, i de schimb a datelor GIS.

Describing a basic data model for geographic features, an increasing number of specifications are developed
by OGC to serve specific needs for interoperable location and geospatial technology, including GIS. Further
information can be found at http://www.opengeospatial.org/.

Specificat,iile OGC importante, acceptate de către QGIS sunt:

• WMS — Web Map Service (Client WMS/WMTS)

• WMTS — Web Map Tile Service (Client WMS/WMTS)

• WFS — Web Feature Service (Client WFS s, i WFS-T)

• WFS-T — Web Feature Service - Transactional (Client WFS s, i WFS-T)

• WCS — Web Coverage Service (Client WCS)

• WPS — Web Processing Service

• CSW — Serviciu de Catalogare pentru Web

• SFS — Simple Features for SQL (Straturi PostGIS)

• GML — Limbaj cu Marcaje Geografice

Serviciile OGC sunt tot mai mult utilizate pentru a interschimba datele geospat,iale între diferitele implementări
GIS, sau între depozitele de date. QGIS are de-a face cu specificat,iile de mai sus din punctul de vedere al unui
client, fiind SFS (prin sprijinirea furnizorului de date PostgreSQL / PostGIS, v. sect,iunea Straturi PostGIS).

15.1.1 Client WMS/WMTS

Privire de ansamblu asupra suportului WMS

În prezent, QGIS poate act,iona ca un client WMS care înt,elege serverele WMS 1.1, 1.1.1 s, i 1.3. În special, acesta
a fost testat cu servere accesibile publicului, cum ar fi DEMIS.

Un server WMS act,ionează asupra cererilor din partea clientului (cum ar fi QGIS) pentru o hartă raster cu o
anumită extindere, set de straturi, stil de simbolizare, s, i transparent,ă. Serverul WMS îs, i consultă apoi sursele de
date locale, rasterizează harta, s, i o trimite înapoi la client, într-un format raster. Pentru QGIS, acest format va fi,
de obicei, JPEG sau PNG.

WMS este mai degrabă un serviciu generic REST (Transfer de Stare de Reprezentare), decât un serviciu Web
matur. De fapt, putet,i lua ca atare adresele URL generate de QGIS s, i să le utilizat,i într-un browser web, pentru a
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obt,ine aceleas, i imagini pe care QGIS le foloses, te intern. Acest lucru poate fi util pentru depanare, deoarece există
mai multe mărci de servere WMS pe piat,ă, s, i toate au propria interpretare a standardului WMS.

Straturile WMS pot fi adăugate pur s, i simplu, atât timp cât: s, tit,i URL-ul de acces la serverul WMS, at,i stabilit o
conexiune validă la acel server, iar serverul înt,elege ptotocolul HTTP, ca mecanism de transport al datelor.

Additionally, QGIS will cache your WMS responses (i.e. images) for 24h as long as the GetCapabilities request is
not triggered. The GetCapabilities request is triggered everytime the [Connect] button in the [Add layer(s) from
WMS(T)S Server] dialog is used to retrieve the WMS server capabilities. This is an automatic feature meant to
optimize project loading time. If a project is saved with a WMS layer, the corresponding WMS tiles will be loaded
from the cache the next time the project is opened as long as they are no older than 24H.

Privire de ansamblu asupra suportului WMTS

QGIS poate act,iona, de asemenea, ca un client WMTS. WMTS reprezintă un standard OGC pentru distribuirea
de seturi de plăcut,e ale datelor geospat,iale. Acesta constituie un mod mai rapid s, i mai eficient de a distribui date,
comparativ cu WMS, deoarece în cazul WMTS seturile de plăcut,e sunt pre-generate, iar clientul solicită numai
transmiterea lor, nu s, i producerea acestora. O cerere WMS implică, de regulă, atât generarea cât s, i transmiterea
datelor. Un exemplu bine-cunoscut al unui standard de bază non-OGC, pentru vizualizarea de date geospat,iale cu
ajutorul plăcut,elor, este Google Maps.

Pentru a afis, a datele la o varietate de scări, apropiate de ceea ce s, i-ar putea dori utilizatorul, seturile de plăcut,e
WMTS sunt produse la mai multe niveluri de scări diferite, s, i sunt puse la dispozit,ia clientului GIS pentru a le
apela.

Această diagramă ilustrează conceptul seturilor de plăcut,e:

Figure 15.1: Conceptul seturilor de plăcut,e WMTS:

Cele două tipuri de interfet,e WMTS, pe care QGIS le acceptă, sunt Key-Value-Pairs (KVP) s, i REST. Aceste două
interfet,e sunt diferite, s, i trebuie să le specificat,i în QGIS în mod diferit.

1. Pentru a avea acces la un serviciu WMTS KVP, un utilizator QGIS trebuie să deschidă interfat,a
WMS/WMTS s, i să adăuge următorul s, ir la adresa URL a serviciului de plăcut,e WMTS:

"?SERVICE=WMTS&REQUEST=GetCapabilities"

Un exemplu al acestui tip de adresă este

http://opencache.statkart.no/gatekeeper/gk/gk.open_wmts?\
service=WMTS&request=GetCapabilities

Pentru testare, stratul topo2 din acest WMTS funct,ionează bine. Adăugarea acestui s, ir indică faptul că se
va utiliza un serviciu web WMTS în locul unui serviciu WMS.

2. Serviciul RESTful WMTS are o formă diferită de adresă URL, simplă. Formatul recomandat de OGC este:
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{WMTSBaseURL}/1.0.0/WMTSCapabilities.xml

This format helps you to recognize that it is a RESTful address. A RESTful WMTS is accessed in QGIS by
simply adding its address in the WMS setup in the URL field of the form. An example of this type of address
for the case of an Austrian basemap is http://maps.wien.gv.at/basemap/1.0.0/WMTSCapabilities.xml.

Note: You can still find some old services called WMS-C. These services are quite similar to WMTS (i.e., same
purpose but working a little bit differently). You can manage them the same as you do WMTS services. Just add
?tiled=true at the end of the url. See http://wiki.osgeo.org/wiki/Tile_Map_Service_Specification for more
information about this specification.

Când citit,i WMTS, vă putet,i gândi adesea s, i la WMS-C.

Selectarea serverelor WMS/WMTS

Prima dată când utilizat,i funct,iunea WMS din QGIS nu există servere definite.

Începet,i printr-un clic pe butonul Add WMS layer din bara de instrumente, sau prin selectarea elementului de
meniu Strat → Adăugare Strat WMS....

The dialog Add Layer(s) from a Server for adding layers from the WMS server appears. You can add some
servers to play with by clicking the [Add default servers] button. This will add two WMS demo servers for
you to use: the WMS servers of the DM Solutions Group and Lizardtech. To define a new WMS server in the
Layers tab, select the [New] button. Then enter the parameters to connect to your desired WMS server, as listed
in table_OGC_wms:

Nume Un nume pentru această conexiune. Acest nume va fi folosit în lista Conexiunilor la Server,
astfel încât să o putet,i distinge de alte servere WMS.

URL URL-ul serverului care furnizează datele. Acesta trebuie să fie un nume de gazdă solubil -
acelas, i format pe care l-at,i folosi pentru a deschide o conexiune telnet, sau pentru a efectua
ping către un calculator.

Nume utilizator Numele de utilizator pentru a accesa un server WMS securizat. Acest parametru este
opt,ional.

Parolă Parola pentru autentificarea de bază la un server WMS. Acest parametru este opt,ional.

Ignorare
GetMap URI

Ignoră GetMap URI raportat în capabilităt,i. Foloses, te URI-ul dat din câmpul URL de
mai sus.

Ignorare
GetFeatureInfo
URI

Ignoră GetFeatureInfo URI raportat în capabilităt,i. Foloses, te URI-ul dat din câmpul
URL de mai sus.

Tabelul OGC 1: Parametri de conectare WMS

If you need to set up a proxy server to be able to receive WMS services from the internet, you can add your proxy
server in the options. Choose Settings → Options and click on the Network & Proxy tab. There, you can add your

proxy settings and enable them by setting Use proxy for web access. Make sure that you select the correct

proxy type from the Proxy type drop-down menu.

O dată ce noua conexiune de server WMS a fost creată, aceasta va fi păstrată pentru viitoarele sesiuni QGIS.

Tip: Despre URL-urile Server-ului WMS
Be sure, when entering the WMS server URL, that you have the base URL only. For example, you shouldn’t have
fragments such as request=GetCapabilities or version=1.0.0 in your URL.

Warning: Entering username and password in the Authentication tab will keep unprotected credentials in
the connection configuration. Those credentials will be visible if, for instance, you shared the project file
with someone. Therefore, it’s advisable to save your credentials in a Authentication configuration instead
(configurations tab). See Sistem de Autentificare for more details.
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Încărcarea Straturilor WMS/WMTS

Once you have successfully filled in your parameters, you can use the [Connect] button to retrieve the capabilities
of the selected server. This includes the image encoding, layers, layer styles and projections. Since this is a
network operation, the speed of the response depends on the quality of your network connection to the WMS
server. While downloading data from the WMS server, the download progress is visualized in the lower left of the
WMS dialog.

Your screen should now look a bit like figure_OGC_add_wms, which shows the response provided by the Euro-
pean Soil Portal WMS server.

Figure 15.2: Dialogul pentru adăugarea unui server WMS, arătând straturile sale disponibile

Codificare Imagine

The Image encoding section lists the formats that are supported by both the client and server. Choose one depend-
ing on your image accuracy requirements.

Tip: Codificare Imagine
Vet,i descoperi că, de obicei, un server WMS vă oferă posibilitatea de a alege codificarea imaginii sub formă de
JPEG sau PNG. JPEG este un format de compresie cu pierderi, în timp ce PNG reproduce fidel datele raster
originale.

Use JPEG if you expect the WMS data to be photographic in nature and/or you don’t mind some loss in picture
quality. This trade-off typically reduces by five times the data transfer requirement compared with PNG.

Utilizat,i PNG dacă dorit,i reprezentări precise ale datelor originale, s, i nu vă deranjează cerint,ele crescute de transfer
de date.
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Opt,iuni

The Options area of the dialog provides a text field where you can add a Layer name for the WMS layer. This
name will appear in the legend after loading the layer.

Mai jos de numele stratului, putet,i defini Dimensiunea plăcut,ei, în ncazul în care dorit,i să setat,i mărimea plăcut,elor
(ex.: 256x256), pentru divizarea cererii WMS.

Limitarea entităt,ilor pentru GetFeatureInfo defines, te ce entităt,i de pe server vor fi interogate.

If you select a WMS from the list, a field with the default projection provided by the mapserver appears. If the
[Change...] button is active, you can click on it and change the default projection of the WMS to another CRS
provided by the WMS server.

Finally you can activate Use contextual WMS-Legend if the WMS Server supports this feature. Then only the
relevant legend for your current map view extent will be shown and thus will not include legend items for things
you can’t see in the current map.

Ordinea straturilor

The Layer Order tab lists the selected layers available from the current connected WMS server. You may notice
that some layers are expandable; this means that the layer can be displayed in a choice of image styles.

Putet,i selecta mai multe straturi simultan, dar numai un singur stil pentru fiecare strat. Atunci când sunt selectate
mai multe straturi, acestea vor fi combinate în serverul WMS, după care vor fi transmise către QGIS toate o dată.

Tip: Ordinea straturilor WMS
WMS layers rendered by a server are overlaid in the order listed in the Layers section, from top to bottom of the
list. If you want to change the overlay order, you can use the Layer Order tab.

Transparenţă

In this version of QGIS, the Global transparency setting from the Layer Properties is hard coded to be always on,
where available.

Tip: Transparenţa stratului WMS
Disponibilitatea transparent,ei pentru imaginile WMS depinde de codificarea folosită pentru imagini: formatele
PNG s, i GIF acceptă transparent,a, în timp ce pentru JPEG acest lucru nu este posibil.

Sistemul de Coordonate de Referint, ă

Un sistem de referint,ă de coordonate (CRS) este o terminologie OGC pentru o proiect,ie QGIS.

Fiecare strat WMS poate fi prezentat în mai multe CRS-uri, în funct,ie de capacitatea serverului WMS.

To choose a CRS, select [Change...] and a dialog similar to Dialogul CRS-urilor Personalizate will appear. The
main difference with the WMS version of the dialog is that only those CRSs supported by the WMS server will
be shown.

Căutare server

Within QGIS, you can search for WMS servers. Figure_OGC_search shows the Server Search tab with the Add
Layer(s) from a Server dialog.

As you can see, it is possible to enter a search string in the text field and hit the [Search] button. After a short
while, the search result will be populated into the list below the text field. Browse the result list and inspect your
search results within the table. To visualize the results, select a table entry, press the [Add selected row to WMS
list] button and change back to the Layers tab. QGIS has automatically updated your server list, and the selected
search result is already enabled in the list of saved WMS servers in the Layers tab. You only need to request the list
of layers by clicking the [Connect] button. This option is quite handy when you want to search maps by specific
keywords.
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Figure 15.3: Dialogul pentru căutarea, după unele cuvinte cheie, a serverelor WMS

Practic, această opt,iune este un front-end pentru API-ul de la http://geopole.org.

Seturi de plăcut,e

Atunci când se utilizează servicii WMTS (Cached WMS), cum ar fi

http://opencache.statkart.no/gatekeeper/gk/gk.open_wmts?\
service=WMTS&request=GetCapabilities

you are able to browse through the Tilesets tab given by the server. Additional information like tile size, formats
and supported CRS are listed in this table. In combination with this feature, you can use the tile scale slider by

selecting View → Panels ( or Settings → Panels), then choosing Tile Scale Panel. This gives you the available
scales from the tile server with a nice slider docked in.

Folosirea instrumentului de identificare

După ce at,i adăugat un server WMS, în cazul în care orice strat primit de la serverul WMS este interogabil, putet,i

folosi instrumentul Identificare pentru a selecta un pixel de pe canevasul hărt,ii. O interogare a serverului WMS
are loc pentru fiecare select,ie efectuată. Rezultatele interogării sunt returnate sub formă de text simplu. Formatarea
acestui text depinde de particularităt,ile serverului WMS folosit. Select,ia Formatului

If multiple output formats are supported by the server, a combo box with supported formats is automatically added
to the identify results dialog and the selected format may be stored in the project for the layer. Suport pentru
formatul GML

The Identify tool supports WMS server response (GetFeatureInfo) in GML format (it is called Feature in the
QGIS GUI in this context). If “Feature” format is supported by the server and selected, results of the Identify tool
are vector features, as from a regular vector layer. When a single feature is selected in the tree, it is highlighted
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in the map and it can be copied to the clipboard and pasted to another vector layer. See the example setup of the
UMN Mapserver below to support GetFeatureInfo in GML format.

# in layer METADATA add which fields should be included and define geometry (example):

"gml_include_items" "all"
"ows_geometries" "mygeom"
"ows_mygeom_type" "polygon"

# Then there are two possibilities/formats available, see a) and b):

# a) basic (output is generated by Mapserver and does not contain XSD)
# in WEB METADATA define formats (example):
"wms_getfeatureinfo_formatlist" "application/vnd.ogc.gml,text/html"

# b) using OGR (output is generated by OGR, it is send as multipart and contains XSD)
# in MAP define OUTPUTFORMAT (example):
OUTPUTFORMAT

NAME "OGRGML"
MIMETYPE "ogr/gml"
DRIVER "OGR/GML"
FORMATOPTION "FORM=multipart"

END

# in WEB METADATA define formats (example):
"wms_getfeatureinfo_formatlist" "OGRGML,text/html"

Vizualizarea Proprietăţilor

După ce at,i adăugat un server WMS, îi putet,i vizualiza proprietăt,ile printr-un clic-dreapta pe el, în legendă, s, i prin
selectarea Proprietăt,ilor. Fila Metadatelor

The tab Metadata displays a wealth of information about the WMS server, generally collected from the capabilities
statement returned from that server. Many definitions can be gleaned by reading the WMS standards (see OPEN-
GEOSPATIAL-CONSORTIUM in Literatură s, i Referint,e Web), but here are a few handy definitions:

• Proprietăţile serverului

– Versiunea WMS — Versiunea WMS acceptată de server.

– Formatele de Imagine — Lista tipurilor MIME pentru care serverul poate răspunde la momentul
desenării hărt,ii. QGIS acceptă oricare dintre formatele recunoscute de bibliotecile Qt, acestea fiind de
obicei image/png s, i image/jpeg.

– Identity Formats — The list of MIME-types the server can respond with when you use the Identify
tool. Currently, QGIS supports the text-plain type.

• Proprietăţile stratului

– Selectat — Indiferent dacă acest strat a fost sau nu selectat, atunci când serverul său a fost adăugat în
acest proiect.

– Vizibil — Indiferent dacă acest strat este selectat ca vizibil în legendă (nu este utilizat încă în această
versiune de QGIS).

– Poate Identifica — Dacă acest strat va returna un rezultat, sau nu, atunci când este folosit instrumentul
Identificare asupra lui.

– Poate fi Transparent — Dacă sau nu, un strat poate fi randat cu transparent,ă. Această versiune de
QGIS va folosi întotdeauna transparent,a dacă această setare este Yes, s, i dacă codificarea imaginii
acceptă transparent,ă.

– Se Poate Mări — Dacă acest strat poate fi, sau nu, mărit de către server. Această versiune de QGIS
presupune că toate straturile WMS au această opt,iune setată pe Yes. Straturile cu deficient,e pot fi
randate în mod eronat.
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– Numărare în Cascadă — Serverele WMS pot act,iona ca un proxy pentru alte servere WMS, pentru a
obt,ine datele raster ale unui strat. Această intrare arată de câte ori este transmisă cererea pentru acest
strat către alte servere WMS, pentru obt,inerea unui rezultat.

– Lăt,ime fixă, Înălt,ime Fixă — Dacă acest strat are, sau nu, dimensiuni fixe. Această versiune de
QGIS presupune că toate straturile WMS nu au această opt,iune setată. Straturile cu deficient,e pot fi
randate în mod eronat.

– WGS 84 Bounding Box — The bounding box of the layer, in WGS 84 coordinates. Some WMS
servers do not set this correctly (e.g., UTM coordinates are used instead). If this is the case, then
the initial view of this layer may be rendered with a very ‘zoomed-out’ appearance by QGIS. The
WMS webmaster should be informed of this error, which they may know as the WMS XML elements
LatLonBoundingBox, EX_GeographicBoundingBox or the CRS:84 BoundingBox.

– Disponibil în CRS — Proiect,iile în care poate fi randat acest strat de către serverul WMS. Acestea
sunt prezentate în format nativ WMS.

– Disponibil în stil — Stilurile de imagine în care poate fi randat acest strat de către serverul WMS.

Show WMS legend graphic in table of contents and composer

The QGIS WMS data provider is able to display a legend graphic in the table of contents’ layer list and in the
map composer. The WMS legend will be shown only if the WMS server has GetLegendGraphic capability and
the layer has getCapability url specified, so you additionally have to select a styling for the layer.

If a legendGraphic is available, it is shown below the layer. It is little and you have to click on it to open it in real
dimension (due to QgsLegendInterface architectural limitation). Clicking on the layer’s legend will open a frame
with the legend at full resolution.

In the print composer, the legend will be integrated at it’s original (downloaded) dimension. Resolution of the
legend graphic can be set in the item properties under Legend –> WMS LegendGraphic to match your printing
requirements

The legend will display contextual information based on your current scale. The WMS legend will be shown only
if the WMS server has GetLegendGraphic capability and the layer has getCapability url specified, so you have to
select a styling.

Limitările clientului WMS

În această versiune de QGIS, clientul WMS nu include orice funct,ionalitate posibilă. Unele dintre cele mai
notabile except,ii sunt prezentate în continuare.

Editarea Setărilor Stratului WMS

Once you’ve completed the Add WMS layer procedure, there is no way to change the settings. A work-around is
to delete the layer completely and start again.

Cerint,ele de autentificare ale Serverelor WMS

Currently, publicly accessible and secured WMS services are supported. The secured WMS servers can be ac-
cessed by public authentication. You can add the (optional) credentials when you add a WMS server. See section
Selectarea serverelor WMS/WMTS for details.

Tip: Accesarea straturilor OGC securizate
If you need to access secured layers with secured methods other than basic authentication, you can use InteProxy
as a transparent proxy, which does support several authentication methods. More information can be found in the
InteProxy manual at http://inteproxy.wald.intevation.org.

Tip: QGIS WMS Mapserver
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Începând cu versiunea 1.7.0, QGIS include propria implementare de Mapserver WMS 1.3.0. Citit,i mai multe
despre acest lucru în capitolul QGIS ca s, i Server de Date OGC.

15.1.2 Client WCS

Un Serviciu de Acoperire Web (WCS) oferă acces la datele raster, în forme care sunt utile pentru randarea pe
partea clientului, ca date de intrare în modelele s, tiint,ifice, precum s, i pentru alt,i client,i. WCS poate fi comparat cu
WFS s, i WMS. La fel ca s, i instant,ele serviciilor WMS s, i WFS, un WCS permite client,ilor să aleagă port,iuni din
informat,iile serverelor, bazate pe constrângeri spat,iale s, i pe alte criterii de interogare.

QGIS has a native WCS provider and supports both version 1.0 and 1.1 (which are significantly different), but
currently it prefers 1.0, because 1.1 has many issues (i.e., each server implements it in a different way with various
particularities).

Furnizorul nativ WCS se ocupă de toate cererile de ret,ea, utilizând toate setările de ret,ea standard ale QGIS
(în special proxy). Este, de asemenea, posibil de selectat modul cache (‘întotdeauna cache’, ‘se preferă cache’,
‘se preferă ret,eaua’, ‘mereu ret,ea’), furnizorul acceptând, de asemenea, select,ia pozit,iei în timp, dacă domeniul
temporal este oferit de server.

Warning: Entering username and password in the Authentication tab will keep unprotected credentials in
the connection configuration. Those credentials will be visible if, for instance, you shared the project file
with someone. Therefore, it’s advisable to save your credentials in a Authentication configuration instead
(configurations tab). See Sistem de Autentificare for more details.

15.1.3 Client WFS s, i WFS-T

În QGIS, un strat WFS se comportă destul de mult ca oricare alt strat vectorial. Putet,i identifica s, i selecta entităt,ile,
pentru a le vizualiza în tabelul de atribute. Începând cu versiunea QGIS 1.6, editarea WFS-T este, de asemenea,
acceptată.

În general, adăugarea unui strat WFS este foarte similară cu procedura utilizată pentru WMS. Diferent,a este că nu
există servere standard definite, as, a că trebuie să-l adăugăm pe al nostru.

Încărcarea unui strat WFS

Ca exemplu, vom folosi serverul WFS de la DM Solutions pentru a afis, a un strat. URL-ul este:
http://www2.dmsolutions.ca/cgi-bin/mswfs_gmap

1. Clic pe instrumentul Add WFS Layer din bara de instrumente a Straturilor. Va apărea dialogul Add WFS
Layer from a Server.

2. Click on [New].

3. Introducet,i ‘DM Solutions’ ca nume.

4. Introducet,i URL-ul (a se vedea mai sus).

5. Click [OK].

6. Aleget,i ‘Solut,ii DM’ din lista cu derulare verticală a Conexiunilor la Server .

7. Click [Connect].

8. As, teptat,i ca lista de straturi să fie populată.

9. Selectat,i stratul Parks din listă.

10. Click [Apply] to add the layer to the map.
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Ret,inet,i că orice setări proxy stabilite în preferint,e sunt, de asemenea, recunoscute.

In the WFS settings dialog, you can define the maximal number of features downloaded, set up the version, force
to Ignore axis orientation (WFS 1.1/WFS 2.0) and force Inverse axis orientation.

Warning: Entering username and password in the Authentication tab will keep unprotected credentials in
the connection configuration. Those credentials will be visible if, for instance, you shared the project file
with someone. Therefore, it’s advisable to save your credentials in a Authentication configuration instead
(configurations tab). See Sistem de Autentificare for more details.

Figure 15.4: Adăugarea unui strat WFS

Ret,inet,i că progresul descărcării este vizualizat în partea din stânga jos a ferestrei principale QGIS. O dată ce
stratul este încărcat, putet,i identifica s, i selecta o provincie sau două, apoi să le vedet,i în tabelul de atribute.

Note: About differences between WFS versions
WFS 1.0.0, 1.1.0 and 2.0 are supported. Background download and progressive rendering, on-disk caching of
downloaded features and version autodetection are now supported.

Only WFS 2.0 service supports GetFeature paging.

Tip: Găsirea Serverelor WFS
Putet,i găsi servere suplimentare WFS cu ajutorul Google, sau a motorului de căutare preferat. Există o serie de
liste cu URL-uri publice, unele dintre ele întret,inute, altele nu.

15.2 QGIS ca s, i Server de Date OGC

QGIS Server is an open source WMS 1.3, WFS 1.0.0 and WCS 1 1.1.1 implementation that, in addition, imple-
ments advanced cartographic features for thematic mapping. QGIS Server is a FastCGI/CGI (Common Gateway
Interface) application written in C++ that works together with a web server (e.g., Apache, Lighttpd). It has Python
plugin support allowing for fast and efficient development and deployment of new features. The original develop-
ment of QGIS Server was funded by the EU projects Orchestra, Sany and the city of Uster in Switzerland.

Pentru logica GIS s, i pentru redarea hărt,ilor, serverul QGIS utilizează în fundal aplicat,ia QGIS. În plus, grafica s, i
programarea în C++ fac uz de biblioteca independentă de platformă Qt. Spre deosebire de alte aplicat,ii WMS,
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serverul QGIS utilizează ca limbaj de configurare regulile cartografice, atât pentru configurat,ia serverului, cât s, i
pentru regulile definite de utilizator.

Atât timp cât QGIS desktop s, i QGIS Server folosesc aceleas, i biblioteci de vizualizare, hărt,ile care sunt publicate
pe web arată la fel ca s, i în GIS desktop.

In the following sections, we will provide a sample configuration to set up a QGIS Server on Debian/Ubuntu
Linux. For more detailed installation instructions on other platforms or distributions and more information on
working with QGIS Server, we recommend reading the QGIS Server Training Manual or server_plugins.

15.2.1 Not,iuni de bază

Installation

At this point, we will give a short and simple sample installation how-to for a minimal working configuration
using Apache2 on Debian/Ubuntu. The first step is QGIS Server installation whose instructions are provided in
QGIS installers page.

Configurarea serverului HTTP

Apache

Install the Apache server in a separate virtual host listening on port 80. Enable the rewrite module to pass HTTP
BASIC auth headers:

$ sudo a2enmod rewrite
$ cat /etc/apache2/conf-available/qgis-server-port.conf
Listen 80
$ sudo a2enconf qgis-server-port

This is the virtual host configuration, stored in /etc/apache2/sites-available/001-qgis-server.conf:

<VirtualHost *:80>
ServerAdmin webmaster@localhost
DocumentRoot /var/www/html

ErrorLog ${APACHE_LOG_DIR}/qgis-server-error.log
CustomLog ${APACHE_LOG_DIR}/qgis-server-access.log combined

# Longer timeout for WPS... default = 40
FcgidIOTimeout 120
FcgidInitialEnv LC_ALL "en_US.UTF-8"
FcgidInitialEnv PYTHONIOENCODING UTF-8
FcgidInitialEnv LANG "en_US.UTF-8"
FcgidInitialEnv QGIS_DEBUG 1
FcgidInitialEnv QGIS_SERVER_LOG_FILE /tmp/qgis-000.log
FcgidInitialEnv QGIS_SERVER_LOG_LEVEL 0

ScriptAlias /cgi-bin/ /usr/lib/cgi-bin/
<Directory "/usr/lib/cgi-bin">

AllowOverride All
Options +ExecCGI -MultiViews +FollowSymLinks
# for apache2 > 2.4
Require all granted
#Allow from all

</Directory>
</VirtualHost>

Acum activat,i gazda virtuală s, i repornit,i Apache:
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$ sudo a2ensite 001-qgis-server
$ sudo service apache2 restart

NGINX

You can use QGIS Server with nginx.

On Debian based systems:

apt-get install nginx fcgiwrap

Introduce the following in your nginx server block configuration:

1 location ~ ^/cgi-bin/.*\.fcgi$ {
2 gzip off;
3 include fastcgi_params;
4 fastcgi_pass unix:/var/run/fcgiwrap.socket;
5

6 fastcgi_param SCRIPT_FILENAME /usr/lib/cgi-bin/qgis_mapserv.fcgi;
7 fastcgi_param QGIS_SERVER_LOG_FILE /logs/qgisserver.log;
8 fastcgi_param QGIS_SERVER_LOG_LEVEL 0;
9 fastcgi_param QGIS_DEBUG 1;

10 }

As you can see from lines 6-9 you can add parameters in your location block in the form of fastcgi_param
param_name param_value, e.g. fastcgi_param DISPLAY ":99";.

The include fastcgi_params; is important as it adds the parameters from
/etc/nginx/fastcgi_params:

fastcgi_param QUERY_STRING $query_string;
fastcgi_param REQUEST_METHOD $request_method;
fastcgi_param CONTENT_TYPE $content_type;
fastcgi_param CONTENT_LENGTH $content_length;

fastcgi_param SCRIPT_NAME $fastcgi_script_name;
fastcgi_param REQUEST_URI $request_uri;
fastcgi_param DOCUMENT_URI $document_uri;
fastcgi_param DOCUMENT_ROOT $document_root;
fastcgi_param SERVER_PROTOCOL $server_protocol;
fastcgi_param REQUEST_SCHEME $scheme;
fastcgi_param HTTPS $https if_not_empty;

fastcgi_param GATEWAY_INTERFACE CGI/1.1;
fastcgi_param SERVER_SOFTWARE nginx/$nginx_version;

fastcgi_param REMOTE_ADDR $remote_addr;
fastcgi_param REMOTE_PORT $remote_port;
fastcgi_param SERVER_ADDR $server_addr;
fastcgi_param SERVER_PORT $server_port;
fastcgi_param SERVER_NAME $server_name;

# PHP only, required if PHP was built with --enable-force-cgi-redirect
fastcgi_param REDIRECT_STATUS 200;

Prepare a project to serve

To provide a new QGIS Server WMS, WFS or WCS, we have to create a QGIS project file with some data. Here,
we use the ‘Alaska’ shapefile from the QGIS sample dataset. Define the colors and styles of the layers in QGIS
and the project CRS, if not already defined.
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Figure 15.5: Definitions for a QGIS Server WMS/WFS/WCS project
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Then, go to the OWS Server menu of the Project → Project Properties dialog and provide some information about
the OWS in the fields under Service Capabilities. This will appear in the GetCapabilities response of the WMS,

WFS or WCS. If you don’t check Service capabilities, QGIS Server will use the information given in the
wms_metadata.xml file located in the cgi-bin folder.

Warning: If you’re using the QGIS project with styling based on SVG files using relative paths then you
should know that the server considers the path relative to its qgis_mapserv.fcgi file (not to the qgs
file). So, if you deploy a project on the server and the SVG files are not placed accordingly, the output images
may not respect the Desktop styling. To ensure this doesn’t happen, you can simply copy the SVG files relative
to the qgis_mapserv.fcgi. You can also create a symbolic link in the directory where the fcgi file resides
that points to the directory containing the SVG files (on Linux/Unix).

WMS capabilities

In the WMS capabilities section, you can define the extent advertised in the WMS GetCapabilities response by
entering the minimum and maximum X and Y values in the fields under Advertised extent. Clicking Use Current

Canvas Extent sets these values to the extent currently displayed in the QGIS map canvas. By checking CRS
restrictions, you can restrict in which coordinate reference systems (CRS) QGIS Server will offer to render maps.

Use the button below to select those CRSs from the Coordinate Reference System Selector, or click Used to
add the CRSs used in the QGIS project to the list.

If you have print composers defined in your project, they will be listed in the GetProjectSettings response, and
they can be used by the GetPrint request to create prints, using one of the print composer layouts as a template.
This is a QGIS-specific extension to the WMS 1.3.0 specification. If you want to exclude any print composer from

being published by the WMS, check Exclude composers and click the button below. Then, select a print
composer from the Select print composer dialog in order to add it to the excluded composers list.

If you want to exclude any layer or layer group from being published by the WMS, check Exclude Layers and

click the button below. This opens the Select restricted layers and groups dialog, which allows you to choose
the layers and groups that you don’t want to be published. Use the Shift or Ctrl key if you want to select
multiple entries.

You can receive requested GetFeatureInfo as plain text, XML and GML. Default is XML, text or GML format
depends the output format chosen for the GetFeatureInfo request.

If you wish, you can check Add geometry to feature response. This will include in the GetFeatureInfo response
the geometries of the features in a text format. If you want QGIS Server to advertise specific request URLs in the
WMS GetCapabilities response, enter the corresponding URL in the Advertised URL field. Furthermore, you can
restrict the maximum size of the maps returned by the GetMap request by entering the maximum width and height
into the respective fields under Maximums for GetMap request.

If one of your layers uses the Map Tip display (i.e. to show text using expressions) this will be listed inside the
GetFeatureInfo output. If the layer uses a Value Map for one of its attributes, this information will also be shown
in the GetFeatureInfo output.

WFS capabilities

In the WFS capabilities area you can select the layers you want to publish as WFS, and specify if they will allow
update, insert and delete operations. If you enter a URL in the Advertised URL field of the WFS capabilities
section, QGIS Server will advertise this specific URL in the WFS GetCapabilities response.
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WCS capabilities

In the WCS capabilities area, you can select the layers that you want to publish as WCS. If you enter a URL in the
Advertised URL field of the WCS capabilities section, QGIS Server will advertise this specific URL in the WCS
GetCapabilities response.

Reglarea fină a OWS-ului dvs.

For vector layers, the Fields menu of the Layer → Properties dialog allows you to define for each attribute if it
will be published or not. By default, all the attributes are published by your WMS and WFS. If you don’t want a
specific attribute to be published, uncheck the corresponding checkbox in the WMS or WFS column.

You can overlay watermarks over the maps produced by your WMS by adding text annotations or SVG anno-
tations to the project file. See the Instrumente de Adnotare section for instructions on creating annotations. For
annotations to be displayed as watermarks on the WMS output, the Fixed map position checkbox in the Annotation
text dialog must be unchecked. This can be accessed by double clicking the annotation while one of the annotation
tools is active. For SVG annotations, you will need either to set the project to save absolute paths (in the General
menu of the Project → Project Properties dialog) or to manually modify the path to the SVG image so that it
represents a valid relative path.

Serve the project

Now, save the session in a project file alaska.qgs. To provide the project as a WMS/WFS, create a new folder
/usr/lib/cgi-bin/project with admin privileges and add the project file alaska.qgs and a copy of
the qgis_mapserv.fcgi file - that’s all.

Now test your project WMS, WFS and WCS. Add the WMS, WFS and WCS as described in Încărcarea Straturilor
WMS/WMTS, Client WFS s, i WFS-T and Client WCS to QGIS and load the data. The URL is:

http://localhost/cgi-bin/project/qgis_mapserv.fcgi

Cascading OGC layers

A QGIS project can of course contain layers coming from remote OGC servers (regardless of the underlying OGC
server software used). This way QGIS will effectively cascade those layers through its OGC (QGIS Server based)
services.

If the external OGC layers are coming from services that make use of the HTTPS protocol you must take care of
some extra QGIS Server configuration. Example for the Apache web server:

$ mkdir /srv/qgis/.qgis2
$ chown www-data:www-data /srv/qgis/.qgis2
$ chmod 774 /srv/qgis/.qgis2

This ensures that the web server is able to write in some user defined folder. Then add the following line to the
Apache virtual host file to ensure that Apache will use such folder:

FcgidInitialEnv HOME "/srv/qgis"

Restart Apache.

15.2.2 Servicii

QGIS Server supports some vendor parameters and requests that greatly enhance the possibilities of customising
its behavior. The following paragraphs list the vendor parameters and the environment variables supported by the
server.
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Web Map Service (WMS)

GetMap

In the WMS GetMap request, QGIS Server accepts a couple of extra parameters in addition to the standard
parameters according to the OGC WMS 1.3.0 specification:

• DPI parameter: The DPI parameter can be used to specify the requested output resolution.

Exemplu:

http://localhost/cgi-bin/qgis_mapserv.fcgi?REQUEST=GetMap&DPI=300&...

• IMAGE_QUALITY parameter is only used for JPEG images. By default, the JPEG compression is -1.
You can change the default per QGIS project in the OWS Server → WMS capabilities menu of the Project
→ Project Properties dialog. If you want to override it in a GetMap request you can do it using the
IMAGE_QUALITY parameter:

http://localhost/cgi-bin/qgis_mapserv.fcgi?\
REQUEST=GetMap&FORMAT=image/jpeg&IMAGE_QUALITY=65&...

• image/png; mode= can be used to override the png format. You can choose between image/png;
mode=16bit, image/png; mode=8bit and image/png; mode=1bit. This can shrink the out-
put image size quite a bit. Example:

http://localhost/cgi-bin/qgis_mapserv.fcgi?\
REQUEST=GetMap&FORMAT=image/png; mode=8bit&...

• OPACITIES parameter: Opacity can be set on layer or group level. Allowed values range from 0 (fully
transparent) to 255 (fully opaque).

Exemplu:

http://localhost/cgi-bin/qgis_mapserv.fcgi?\
REQUEST=GetMap&LAYERS=mylayer1,mylayer2&OPACITIES=125,200&...

• FILTER parameter: Subsets of layers can be selected with the FILTER parameter. Syntax is basically
the same as for the QGIS subset string. However, there are some restrictions to avoid SQL injections into
databases via QGIS server:

Text strings need to be enclosed with quotes (single quotes for strings, double quotes for attributes) A
space between each word / special character is mandatory. Allowed Keywords and special characters are
‘AND’,’OR’,’IN’,’=’,’<’,’>=’, ‘>’,’>=’,’!=*,’(‘,’)’. Semicolons in string expressions are not allowed

Exemplu:

http://myserver.com/cgi/qgis_mapserv.fcgi?REQUEST=GetMap&LAYERS=mylayer1,mylayer2&FILTER=mylayer1:"OBJECTID" = 3;mylayer2:’text’ = ’blabla’&....

Note: It is possible to make attribute searches via GetFeatureInfo and omit the X/Y parameter if a FILTER is
there. QGIS server then returns info about the matching features and generates a combined bounding box in the
xml output.

• SELECTION parameter: The SELECTION parameter can highlight features from one or more layers. Vec-
tor features can be selected by passing comma separated lists with feature ids in GetMap and GetPrint.

Exemplu:

http://myserver.com/cgi/qgis_mapserv.fcgi?REQUEST=GetMap&LAYERS=mylayer1,mylayer2&SELECTION=mylayer1:3,6,9;mylayer2:1,5,6&...

The following image presents the response from a GetMap request using the SELECTION option e.g.
http://myserver.com/...&SELECTION=countries:171,65. As those features id’s corre-
spond in the source dataset to France and Romania they’re highlighted in yellow.
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Figure 15.6: Server response to a GetMap request with SELECTION parameter
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It is possible to export layers in the DXF format using the GetMap Request. Only layers that have read access in
the WFS service are exported in the DXF format. Here is a valid REQUEST and a documentation of the available
parameters:

http://your.server.address/wms/liegenschaftsentwaesserung/abwasser_werkplan?SERVICE=WMS&VERSION=1.3.0&REQUEST=GetMap&LAYERS=Haltungen,Normschacht,Spezialbauwerke&STYLES=&CRS=EPSG%3A21781&BBOX=696136.28844801,245797.12108743,696318.91114315,245939.25832905&WIDTH=1042&HEIGHT=811&FORMAT=application/dxf&FORMAT_OPTIONS=MODE:SYMBOLLAYERSYMBOLOGY;SCALE:250&FILE_NAME=werkplan_abwasser.dxf

Parameters:

• FORMAT=application/dxf

• FILE_NAME=yoursuggested_file_name_for_download.dxf

• FORMAT_OPTIONS=see options below, key:value pairs separated by Semicolon

FORMAT_OPTIONS Parameters:

• SCALE:scale to be used for symbology rules, filters and styles (not an actual scaling of the data - data
remains in the original scale).

• MODE:NOSYMBOLOGY|FEATURESYMBOLOGY|SYMBOLLAYERSYMBOLOGY corresponds
to the three export options offered in the QGIS Desktop DXF export dialog.

• LAYERSATTRIBUTES:yourcolumn_with_values_to_be_used_for_dxf_layernames - if not specified,
the original QGIS layer names are used.

• USE_TITLE_AS_LAYERNAME if enabled, the title of the layer will be used as layer name.

GetFeatureInfo

QGIS Server WMS GetFeatureInfo requests supports the following extra optional parameters to define the toler-
ance for point, line and polygon layers:

• FI_POINT_TOLERANCE parameter: Tolerance for point layers GetFeatureInfo request, in pixels.

• FI_LINE_TOLERANCE parameter: Tolerance for linestring layers GetFeatureInfo request, in pixels.

• FI_POLYGON_TOLERANCE parameter: Tolerance for polygon layers GetFeatureInfo request, in pixels.

GetPrint

QGIS server has the capability to create print composer output in pdf or pixel format. Print composer windows
in the published project are used as templates. In the GetPrint request, the client has the possibility to specify
parameters of the contained composer maps and labels.

Example:

The published project has two composer maps. In the GetProjectSettings response, they are listed as possible print
templates:

<WMS_Capabilities>
...
<ComposerTemplates xsi:type="wms:_ExtendedCapabilities">
<ComposerTemplate width="297" height="210" name="Druckzusammenstellung 1">
<ComposerMap width="171" height="133" name="map0"/>
<ComposerMap width="49" height="46" name="map1"/></ComposerTemplate>
</ComposerTemplates>
...
</WMS_Capabilities>

The client has now the information to request a print output:

http://myserver.com/cgi/qgis_mapserv.fcgi?...&REQUEST=GetPrint&TEMPLATE=Druckzusammenstellung 1&map0:EXTENT=xmin,ymin,xmax,ymax&map0:ROTATION=45&FORMAT=pdf&DPI=300

Parameters in the GetPrint request are:

• <map_id>:EXTENT gives the extent for a composer map as xmin,ymin,xmax,ymax.
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• <map_id>:ROTATION map rotation in degrees

• <map_id>:GRID_INTERVAL_X, <map_id>:GRID_INTERVAL_Y Grid line density for a composer
map in x- and y-direction

• <map_id>:SCALE Sets a mapscale to a composer map. This is useful to ensure scale based visibility of
layers and labels even if client and server may have different algorithms to calculate the scale denominator

• <map_id>:LAYERS, <map_id>:STYLES possibility to give layer and styles list for composer map (use-
ful in case of overview maps which should have only a subset of layers)

GetLegendGraphics

Several additional parameters are available to change the size of the legend elements:

• BOXSPACE space between legend frame and content (mm)

• LAYERSPACE versical space between layers (mm)

• LAYERTITLESPACE vertical space between layer title and items following (mm)

• SYMBOLSPACE vertical space between symbol and item following (mm)

• ICONLABELSPACE horizontal space between symbol and label text (mm)

• SYMBOLWIDTH width of the symbol preview (mm)

• SYMBOLHEIGHT height of the symbol preview (mm)

These parameters change the font properties for layer titles and item labels:

• LAYERFONTFAMILY / ITEMFONTFAMILY font family for layer title / item text

• LAYERFONTBOLD / ITEMFONTBOLD ‘TRUE’ to use a bold font

• LAYERFONTSIZE / ITEMFONTSIZE Font size in point

• LAYERFONTITALIC / ITEMFONTITALIC ‘TRUE’ to use italic font

• LAYERFONTCOLOR / ITEMFONTCOLOR Hex color code (e.g. #FF0000 for red)

• LAYERTITLE / RULELABEL (from QGIS 2.4) set them to ‘FALSE’ to get only the legend graphics
without labels

Contest based legend. These parameters let the client request a legend showing only the symbols for the features
falling into the requested area:

• BBOX the geographical area for which the legend should be built

• CRS / SRS the coordinate reference system adopted to define the BBOX coordinates

• WIDTH / HEIGHT if set these should match those defined for the GetMap request, to let QGIS Server
scale symbols according to the map view image size.

Contest based legend features are based on the UMN MapServer implementation:

GetProjectSettings

This request type works similar to GetCapabilities, but it is more specific to QGIS Server and allows a client to
read additional information which is not available in the GetCapabilities output:

• initial visibility of layers

• information about vector attributes and their edit types

• information about layer order and drawing order

• list of layers published in WFS
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Web Feature Service (WFS)

GetFeature

In the WFS GetFeature request, QGIS Server accepts two extra parameters in addition to the standard parameters
according to the OGC WFS 1.0.0 specification:

• GeometryName parameter: this parameter can be used to get the extent or the centroid as the geometry or
no geometry if none if used (ie attribute only). Allowed values are extent, centroid or none.

• StartIndex parameter: STARTINDEX is standard in WFS 2.0, but it’s an extension for WFS 1.0.0 which
is the only version implemented in QGIS Server. STARTINDEX can be used to skip some features in the
result set and in combination with MAXFEATURES will provide for the ability to use WFS GetFeature to
page through results. Note that STARTINDEX=0 means start with

Extra parameters supported by all request types

• FILE_NAME parameter: if set, the server response will be sent to the client as a file attachment with the
specified file name.

• MAP parameter: Similar to MapServer, the MAP parameter can be used to specify the path to the QGIS
project file. You can specify an absolute path or a path relative to the location of the server executable
(qgis_mapserv.fcgi). If not specified, QGIS Server searches for .qgs files in the directory where the
server executable is located.

Exemplu:

http://localhost/cgi-bin/qgis_mapserv.fcgi?\
REQUEST=GetMap&MAP=/home/qgis/mymap.qgs&...

Note:
You can define a QGIS_PROJECT_FILE as an environment variable to tell the server executable
where to find the QGIS project file. This variable will be the location where QGIS will look for the
project file. If not defined it will use the MAP parameter in the request and finally look at the server
executable directory.

the first feature, skipping none.

REDLINING

This feature is available and can be used with GetMap and GetPrint requests.

The redlining feature can be used to pass geometries and labels in the request which are overlapped by the server
over the standard returned image (map). This permits the user to put emphasis or maybe add some comments
(labels) to some areas, locations etc. that are not in the standard map.

The request is in the format:

http://qgisplatform.demo/cgi-bin/qgis_mapserv.fcgi?map=/world.qgs&SERVICE=WMS&VERSION=1.3.0&
REQUEST=GetMap
...
&HIGHLIGHT_GEOM=POLYGON((590000 5647000, 590000 6110620, 2500000 6110620, 2500000 5647000, 590000 5647000))
&HIGHLIGHT_SYMBOL=<StyledLayerDescriptor><UserStyle><Name>Highlight</Name><FeatureTypeStyle><Rule><Name>Symbol</Name><LineSymbolizer><Stroke><SvgParameter name="stroke">%23ea1173</SvgParameter><SvgParameter name="stroke-opacity">1</SvgParameter><SvgParameter name="stroke-width">1.6</SvgParameter></Stroke></LineSymbolizer></Rule></FeatureTypeStyle></UserStyle></StyledLayerDescriptor>
&HIGHLIGHT_LABELSTRING=Write label here
&HIGHLIGHT_LABELSIZE=16
&HIGHLIGHT_LABELCOLOR=%23000000
&HIGHLIGHT_LABELBUFFERCOLOR=%23FFFFFF
&HIGHLIGHT_LABELBUFFERSIZE=1.5
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Here is the image outputed by the above request in which a polygon and a label are drawn on top of the normal
map:

Figure 15.7: Server response to a GetMap request with redlining parameters

You can see there are several parameters in this request:

• HIGHLIGHT_GEOM: You can add POINT, MULTILINESTRING, POLYGON etc. It supports multipart
geometries. Here is an example: HIGHLIGHT_GEOM=MULTILINESTRING((0 0, 0 1, 1 1)).
The coordinates should be in the CRS of the GetMap/GetPrint request.

• HIGHLIGHT_SYMBOL: This controls how the geometry is outlined and you can change the stroke width,
color and opacity.

• HIGHLIGHT_LABELSTRING: You can pass your labeling text to this parameter.

• HIGHLIGHT_LABELSIZE: This parameter controls the size of the label.

• HIGHLIGHT_LABELCOLOR: This parameter controls the label color.

• HIGHLIGHT_LABELBUFFERCOLOR: This parameter controls the label buffer color.

• HIGHLIGHT_LABELBUFFERSIZE: This parameter controls the label buffer size.
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15.2.3 Plugin-uri

Instalarea

Pentru a instala pluginul HelloWorld, în scopul testării serverelor, mai întâi trebuie să creat,i un director de stocare
a plugin-urilor. Acesta va fi specificat în configurat,ia gazdei virtuale s, i va fi transmis serverului printr-o variabilă
de mediu:

$ sudo mkdir -p /opt/qgis-server/plugins
$ cd /opt/qgis-server/plugins
$ sudo wget https://github.com/elpaso/qgis-helloserver/archive/master.zip
# In case unzip was not installed before:
$ sudo apt-get install unzip
$ sudo unzip master.zip
$ sudo mv qgis-helloserver-master HelloServer

Configurarea Serverului HTTP

Apache

To be able to use server plugins, FastCGI needs to know where to look. So, we have to modify the Apache
configuration file to indicate the QGIS_PLUGINPATH environment variable to FastCGI:

FcgidInitialEnv QGIS_SERVER_LOG_FILE /tmp/qgis-000.log
FcgidInitialEnv QGIS_SERVER_LOG_LEVEL 0
FcgidInitialEnv QGIS_PLUGINPATH "/opt/qgis-server/plugins"

Moreover, a basic HTTP authorization is necessary to play with the HelloWorld plugin previously introduced. So
we have to update the Apache configuration file a last time:

# Needed for QGIS HelloServer plugin HTTP BASIC auth
<IfModule mod_fcgid.c>

RewriteEngine on
RewriteCond %{HTTP:Authorization} .
RewriteRule .* - [E=HTTP_AUTHORIZATION:%{HTTP:Authorization}]

</IfModule>

Apoi, restartat,i Apache:

$ sudo a2ensite 001-qgis-server
$ sudo service apache2 restart

Tip: If you work with a feature that has many nodes then modifying and adding a new feature will fail. In this
case it is possible to insert the following code into the 001-qgis-server.conf file:

<IfModule mod_fcgid.c>
FcgidMaxRequestLen 26214400
FcgidConnectTimeout 60
</IfModule>

Cum se utilizează un plugin

Testat,i serverul cu plugin-ul HelloWorld:

$ wget -q -O - "http://localhost/cgi-bin/qgis_mapserv.fcgi?SERVICE=HELLO"
HelloServer!

You can have a look at the default GetCapabilities of the QGIS server at:
http://localhost/cgi-bin/qgis_mapserv.fcgi?SERVICE=WMS&VERSION=1.3.0&REQUEST=GetCapabilities
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15.2.4 Configurare avansată

Jurnalizarea

To log requests sent to the server, set the following environment variables:

• QGIS_SERVER_LOG_FILE: Specify path and filename. Make sure that the server has proper permis-
sions for writing to file. File should be created automatically, just send some requests to server. If it’s not
there, check permissions.

• QGIS_SERVER_LOG_LEVEL: Specify desired log level. Available values are:

– 0 INFO (log all requests),

– 1 WARNING,

– 2 CRITICAL (log just critical errors, suitable for production purposes).

Example:

SetEnv QGIS_SERVER_LOG_FILE /var/tmp/qgislog.txt
SetEnv QGIS_SERVER_LOG_LEVEL 0

Note:
• When using Fcgid module use FcgidInitialEnv instead of SetEnv!

• Server logging is also enabled if executable is compiled in release mode.

Variabile de mediu

You can configure some aspects of QGIS server by setting environment variables. For example, to set QGIS
server on Apache to use /path/to/config/QGIS/QGIS2.ini settings file, add to Apache config:

SetEnv QGIS_OPTIONS_PATH "/path/to/config/"

or, if using fcgi:

FcgidInitialEnv QGIS_OPTIONS_PATH "/path/to/config/"

This is a list of the variables supported by QGIS server:

• QGIS_OPTIONS_PATH: Specifies the path to the directory with settings. It works the
same way as QGIS application –optionspath option. It is looking for settings file in
<QGIS_OPTIONS_PATH>/QGIS/QGIS2.ini.

• QUERY_STRING: The query string, normally passed by the web server. This variable can be useful while
testing QGIS server binary from the command line.

• QGIS_PROJECT_FILE: the .qgs project file, normally passed as a parameter in the query string, you can
also set it as an environment variable (for example by using mod_rewrite Apache module).

• QGIS_SERVER_LOG_FILE: Specify path and filename. Make sure that server has proper permissions
for writing to file. File should be created automatically, just send some requests to server. If it’s not there,
check permissions.

• QGIS_SERVER_LOG_LEVEL: Specify desired log level. See Jurnalizarea

• MAX_CACHE_LAYERS: Specify the maximum number of cached layers (default: 100).

• DISPLAY: This is used to pass (fake) X server display number (needed on Unix-like systems).

• QGIS_PLUGINPATH: Useful if you are using Python plugins for the server, this sets the folder that is
searched for Python plugins.
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• DEFAULT_DATUM_TRANSFORM: Define datum transformations between two projections, e.g.
EPSG:21781/EPSG:2056/100001/-1;EPSG:2056/EPSG:21781/-1/100001 sets the trans-
formation between CH1903 LV03 (EPSG:21781) and CH1903 LV95 (EPSG:2056) and vice versa. You
also need to place grid shift .gsb files in the directory where proj4 stores the grid shift files, e.g. in
/usr/share/proj. You need to run crssync after you added new .gsb files and look up the ID
in the srs.db. Look at attribute coord_op_code of table tbl_datum_transform in srs.db to find the
correct entry.

Short name for layers, groups and project

A number of elements have both a <Name> and a <Title>. The Name is a text string used for machine-to-
machine communication while the Title is for the benefit of humans.

For example, a dataset might have the descriptive Title “Maximum Atmospheric Temperature” and be requested
using the abbreviated Name “ATMAX”. User can already set title for layers, groups and project.

OWS name is based on the name used in layer tree. This name is more a label for humans than a name for
machine-to-machine communication.

QGIS Server supports:

• short name line edits to layers properties You can change this by right clicking on a layer, choose Properties
→ Metadata tab → Description → Short name.

• WMS data dialog to layer tree group (short name, title, abstract)

By right clicking on a layer group and selecting the Set Group WMS data option you will get:

Figure 15.8: Set group WMS data dialog

• short name line edits to project properties - add a regexp validator "^[A-Za-z][A-Za-z0-9\._-]*"
to short name line edit accessible through a static method

• add a regexp validator "^[A-Za-z][A-Za-z0-9\._-]*" to short name line edit accessible through a
static method

You can choose a short name for the project root by going to Project properties → OWS Server → Service
capabilities → Short name.

• add a TreeName element in the fullProjectSettings

If a short name has been set for layers, groups or project it is used by QGIS Sever as the layer name.

Connection to service file

In order to make apache aware of the PostgreSQL service file (see the PostgreSQL Service connection file section)
you need to make your *.conf file look like:

SetEnv PGSERVICEFILE /home/web/.pg_service.conf

<Directory "/home/web/apps2/bin/">
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AllowOverride None
.....

Add fonts to your linux server

Keep in mind that you may use QGIS projects that point to fonts that may not exist by default on other machines.
This means that if you share the project, it may look different on other machines (if the fonts don’t exist on the
target machine).

In order to ensure this does not happen you just need to install the missing fonts on the target machine. Doing this
on desktop systems is usually trivial (double clicking the fonts).

For linux, if you don’t have a desktop environment installed (or you prefer the command line) you need to:

• On Debian based systems:

$ sudo su
$ mkdir -p /usr/local/share/fonts/truetype/myfonts && cd /usr/local/share/fonts/truetype/myfonts

# copy the fonts from their location
$ cp /fonts_location/* .

$ chown root *
$ cd .. && fc-cache -f -v

• On Fedora based systems:

$ sudo su
$ mkdir /usr/share/fonts/myfonts && cd /usr/share/fonts/myfonts

# copy the fonts from their location
$ cp /fonts_location/* .

$ chown root *
$ cd .. && fc-cache -f -v
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CHAPTER 16

Lucrul cu datele GPS

16.1 Plugin-ul GPS

16.1.1 Ce este GPS?

GPS, the Global Positioning System, is a satellite-based system that allows anyone with a GPS receiver to find their
exact position anywhere in the world. GPS is used as an aid in navigation, for example in airplanes, in boats and
by hikers. The GPS receiver uses the signals from the satellites to calculate its latitude, longitude and (sometimes)
elevation. Most receivers also have the capability to store locations (known as waypoints), sequences of locations
that make up a planned route and a tracklog or track of the receiver’s movement over time. Waypoints, routes
and tracks are the three basic feature types in GPS data. QGIS displays waypoints in point layers, while routes
and tracks are displayed in linestring layers.

Note: QGIS supports also GNSS receivers. But we keep using the term GPS in this documentation.

16.1.2 Încărcarea datelor GPS dintr-un fis, ier

There are dozens of different file formats for storing GPS data. The format that QGIS uses is called GPX (GPS
eXchange format), which is a standard interchange format that can contain any number of waypoints, routes and
tracks in the same file.

To load a GPX file, you first need to load the plugin. Plugins → Plugin Manager... opens the Plugin Manager

Dialog. Activate the GPS Tools checkbox. When this plugin is loaded, a button with a small handheld GPS
device will show up in the toolbar and in Layer → Create Layer → :

• Instrumente GPS

• Crearea unui nou Strat GPX

For working with GPS data, we provide an example GPX file available in the QGIS sample dataset:
qgis_sample_data/gps/national_monuments.gpx. See section Sample Data for more information
about the sample data.

1. Select Vector → GPS → GPS Tools or click the GPS Tools icon in the toolbar and open the Load GPX file
tab (see figure_GPS).

2. Browse to the folder qgis_sample_data/gps/, select the GPX file national_monuments.gpx
and click [Open].

Use the [Browse...] button to select the GPX file, then use the checkboxes to select the feature types you want
to load from that GPX file. Each feature type will be loaded in a separate layer when you click [OK]. The file
national_monuments.gpx only includes waypoints.
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Figure 16.1: Fereastra de dialog a Instrumentelor GPS

Note: GPS units allow you to store data in different coordinate systems. When downloading a GPX file
(from your GPS unit or a web site) and then loading it in QGIS, be sure that the data stored in the GPX
file uses WGS 84 (latitude/longitude). QGIS expects this, and it is the official GPX specification. See
http://www.topografix.com/GPX/1/1/.

16.1.3 GPSBabel

Since QGIS uses GPX files, you need a way to convert other GPS file formats to GPX. This can be done for many
formats using the free program GPSBabel, which is available at http://www.gpsbabel.org. This program can also
transfer GPS data between your computer and a GPS device. QGIS uses GPSBabel to do these things, so it is
recommended that you install it. However, if you just want to load GPS data from GPX files you will not need it.
Version 1.2.3 of GPSBabel is known to work with QGIS, but you should be able to use later versions without any
problems.

16.1.4 Importarea datelor GPS

To import GPS data from a file that is not a GPX file, you use the tool Import other file in the GPS Tools dialog.
Here, you select the file that you want to import (and the file type), which feature type you want to import from it,
where you want to store the converted GPX file and what the name of the new layer should be. Note that not all
GPS data formats will support all three feature types, so for many formats you will only be able to choose between
one or two types.

16.1.5 Descărcarea datelor GPS de pe un dispozitiv

QGIS can use GPSBabel to download data from a GPS device directly as new vector layers. For this we use
the Download from GPS tab of the GPS Tools dialog (see Figure_GPS_download). Here, we select the type of
GPS device, the port that it is connected to (or USB if your GPS supports this), the feature type that you want to
download, the GPX file where the data should be stored, and the name of the new layer.

The device type you select in the GPS device menu determines how GPSBabel tries to communicate with your
GPS device. If none of the available types work with your GPS device, you can create a new type (see section
Definirea noilor tipuri de dispozitive).

The port may be a file name or some other name that your operating system uses as a reference to the physical port
in your computer that the GPS device is connected to. It may also be simply USB, for USB-enabled GPS units.

• Pe Linux, este ceva de genul /dev/ttyS0 sau /dev/ttyS1.

• Pe Windows, este COM1 sau COM2.
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Figure 16.2: Instrumentul de descărcare

When you click [OK], the data will be downloaded from the device and appear as a layer in QGIS.

16.1.6 Încărcarea datelor GPS pe un dispozitiv

You can also upload data directly from a vector layer in QGIS to a GPS device using the Upload to GPS tab of
the GPS Tools dialog. To do this, you simply select the layer that you want to upload (which must be a GPX
layer), your GPS device type, and the port (or USB) that it is connected to. Just as with the download tool, you
can specify new device types if your device isn’t in the list.

This tool is very useful in combination with the vector-editing capabilities of QGIS. It allows you to load a map,
create waypoints and routes, and then upload them and use them on your GPS device.

16.1.7 Definirea noilor tipuri de dispozitive

There are lots of different types of GPS devices. The QGIS developers can’t test all of them, so if you have one
that does not work with any of the device types listed in the Download from GPS and Upload to GPS tools, you
can define your own device type for it. You do this by using the GPS device editor, which you start by clicking
the [Edit devices] button in the download or the upload tab.

To define a new device, you simply click the [New device] button, enter a name, enter download and upload
commands for your device, and click the [Update device] button. The name will be listed in the device menus in
the upload and download windows – it can be any string. The download command is the command that is used to
download data from the device to a GPX file. This will probably be a GPSBabel command, but you can use any
other command line program that can create a GPX file. QGIS will replace the keywords %type, %in, and %out
when it runs the command.

%type will be replaced by -w if you are downloading waypoints, -r if you are downloading routes and -t if
you are downloading tracks. These are command-line options that tell GPSBabel which feature type to download.

%in will be replaced by the port name that you choose in the download window and %out will be replaced by
the name you choose for the GPX file that the downloaded data should be stored in. So, if you create a device
type with the download command gpsbabel %type -i garmin -o gpx %in %out (this is actually the
download command for the predefined device type ‘Garmin serial’) and then use it to download waypoints from
port /dev/ttyS0 to the file output.gpx, QGIS will replace the keywords and run the command gpsbabel
-w -i garmin -o gpx /dev/ttyS0 output.gpx.

The upload command is the command that is used to upload data to the device. The same keywords are used, but
%in is now replaced by the name of the GPX file for the layer that is being uploaded, and %out is replaced by
the port name.

You can learn more about GPSBabel and its available command line options at http://www.gpsbabel.org.
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După ce at,i creat un nou tip de dispozitiv, acesta va apărea în listele dispozitivelor, pentru instrumentele de down-
load s, i de upload.

16.1.8 Descărcat,i punctele/traseele de pe unităt,ile GPS

As described in previous sections QGIS uses GPSBabel to download points/tracks directly in the project. QGIS
comes out of the box with a pre-defined profile to download from Garmin devices. Unfortunately there is a bug
#6318 that does not allow create other profiles, so downloading directly in QGIS using the GPS Tools is at the
moment limited to Garmin USB units.

Garmin GPSMAP 60cs

MS Windows

Install the Garmin USB drivers from http://www8.garmin.com/support/download_details.jsp?id=591

Connect the unit. Open GPS Tools and use type=garmin serial and port=usb: Fill the fields Layer
name and Output file. Sometimes it seems to have problems saving in a certain folder, using something like
c:\temp usually works.

Ubuntu/Mint GNU/Linux

It is first needed an issue about the permissions of the device, as described at
https://wiki.openstreetmap.org/wiki/USB_Garmin_on_GNU/Linux. You can try to create a file
/etc/udev/rules.d/51-garmin.rules containing this rule

ATTRS{idVendor}=="091e", ATTRS{idProduct}=="0003", MODE="666"

După aceea este necesar să vă asigurat,i că modulul de kernel garmin_gps nu este încărcat

rmmod garmin_gps

and then you can use the GPS Tools. Unfortunately there seems to be a bug #7182 and usually QGIS freezes
several times before the operation work fine.

BTGP-38KM datalogger (doar Bluetooth)

MS Windows

The already referred bug does not allow to download the data from within QGIS, so it is needed to use GPSBabel
from the command line or using its interface. The working command is

gpsbabel -t -i skytraq,baud=9600,initbaud=9600 -f COM9 -o gpx -F C:/GPX/aaa.gpx

Ubuntu/Mint GNU/Linux

Utilizat,i aceeas, i comandă (sau setări, dacă utilizat,i GPSBabel GUI) ca în Windows. În Linux, întrucâtva este
normal să obt,inet,i un mesaj de genul

skytraq: Too many read errors on serial port

este doar o chestiune de oprire s, i repornire a înregistratorului de date, apoi încercat,i din nou.

BlueMax GPS-4044 datalogger (atât BT cât s, i USB)

MS Windows

Note: Este nevoie de instalarea driver-elor sale înainte de utilizarea pe Windows 7. Vizitat,i site-ul producătorului
pentru descărcarea corectă.
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La descărcarea cu GPSBabel, atât cel cu USB cât s, i cel cu BT returnează întotdeauna o eroare de genul

gpsbabel -t -i mtk -f COM12 -o gpx -F C:/temp/test.gpx
mtk_logger: Can’t create temporary file data.bin
Error running gpsbabel: Process exited unsuccessfully with code 1

Ubuntu/Mint GNU/Linux

Cu USB

After having connected the cable use the dmesg command to understand what port is being used, for example
/dev/ttyACM3. Then as usual use GPSBabel from the CLI or GUI

gpsbabel -t -i mtk -f /dev/ttyACM3 -o gpx -F /home/user/bluemax.gpx

Cu Bluetooth

Use Blueman Device Manager to pair the device and make it available through a system port, then run GPSBabel

gpsbabel -t -i mtk -f /dev/rfcomm0 -o gpx -F /home/user/bluemax_bt.gpx

16.2 Urmărirea live a GPS-ului

To activate live GPS tracking in QGIS, you need to select Settings → Panels GPS information. You will get a
new docked window on the left side of the canvas.

Există patru ecrane posibile în această fereastră de urmărire GPS:

• GPS position coordinates and an interface for manually entering vertices and features

• Puterea semnalului GPS al conexiunilor prin satelit

• GPS polar screen showing number and polar position of satellites

• Opt,iunile ecranului GPS (a se vedea figure_gps_options)

With a plugged-in GPS receiver (has to be supported by your operating system), a simple click on [Connect] con-
nects the GPS to QGIS. A second click (now on [Disconnect]) disconnects the GPS receiver from your computer.
For GNU/Linux, gpsd support is integrated to support connection to most GPS receivers. Therefore, you first have
to configure gpsd properly to connect QGIS to it.

Warning: If you want to record your position to the canvas, you have to create a new vector layer first and
switch it to editable status to be able to record your track.

16.2.1 Pozit,ia s, i atributele suplimentare

If the GPS is receiving signals from satellites, you will see your position in latitude, longitude and altitude
together with additional attributes.

16.2.2 Puterea semnalului GPS

Aici se poate vedea puterea semnalului pe care îl primit,i de la satelit,i.
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Figure 16.3: Urmărirea pozit,iei GPS s, i atributele suplimentare

Figure 16.4: Puterea de urmărire a semnalului GPS
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16.2.3 GPS polar window

If you want to know where in the sky all the connected satellites are, you have to switch to the polar screen.
You can also see the ID numbers of the satellites you are receiving signals from.

Figure 16.5: GPS tracking polar window

16.2.4 Opt,iunile GPS

În cazul unor probleme de conectare, putet,i comuta între:

• Autodetectare

• Intern

• Dispozitiv serial

• gpsd (se alege Gazda, Portul s, i Dispozitivul la care este conectat GPSul dvs.)

A click on [Connect] again initiates the connection to the GPS receiver.

You can activate Automatically save added features when you are in editing mode. Or you can activate
Automatically add points to the map canvas with a certain width and color.

Activating Cursor, you can use a slider to shrink and grow the position cursor on the
canvas.

Activating Map centering allows you to decide in which way the canvas will be updated. This includes
‘always’, ‘when leaving’, if your recorded coordinates start to move out of the canvas, or ‘never’, to keep map
extent.

Finally, you can activate Log file and define a path and a file where log messages about the GPS tracking are
logged.

If you want to set a feature manually, you have to go back to Position and click on [Add Point] or [Add track
point].

16.2.5 Conectaare la un GPS Bluetooth pentru urmărirea în direct a pozit,iei

With QGIS you can connect a Bluetooth GPS for field data collection. To perform this task you need a GPS
Bluetooth device and a Bluetooth receiver on your computer.

At first you must let your GPS device be recognized and paired to the computer. Turn on the GPS, go to the
Bluetooth icon on your notification area and search for a New Device.
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Figure 16.6: Fereastra opt,iunilor de urmărire GPS
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On the right side of the Device selection mask make sure that all devices are selected so your GPS unit will
probably appear among those available. In the next step a serial connection service should be available, select it
and click on [Configure] button.

Ret,inet,i numărul portului COM atribuit conexiunii GPS, după cum rezultă din proprietăt,ile Bluetooth.

După ce GPS-ul a fost recunoscut, creat,i asocierea pentru conexiune. De obicei, codul de autorizare este 0000.

Now open GPS information panel and switch to GPS options screen. Select the COM port assigned to the GPS
connection and click the [Connect]. After a while a cursor indicating your position should appear.

If QGIS can’t receive GPS data, then you should restart your GPS device, wait 5-10 seconds then try to connect
again. Usually this solution work. If you receive again a connection error make sure you don’t have another
Bluetooth receiver near you, paired with the same GPS unit.

16.2.6 Folosirea GPSMAP 60cs

MS Windows

Easiest way to make it work is to use a middleware (freeware, not open) called GPSGate.

Launch the program, make it scan for GPS devices (works for both USB and BT ones) and then in QGIS just click
[Connect] in the Live tracking panel using the Autodetect mode.

Ubuntu/Mint GNU/Linux

As for Windows the easiest way is to use a server in the middle, in this case GPSD, so

sudo apt-get install gpsd

Apoi, încărcat,i nucleul garmin_gps

sudo modprobe garmin_gps

And then connect the unit. Then check with dmesg the actual device being used bu the unit, for example
/dev/ttyUSB0. Now you can launch gpsd

gpsd /dev/ttyUSB0

S, i, la final, conectat,i-va la instrumentul de urmărire în direct din QGIS.

16.2.7 Folosirea datalogger-ului BTGP-38KM (doar Bluetooth)

Folosirea GPSD (în Linux) sau GPSGate (în Windows) se face fâră efort.

16.2.8 Folosirea datalogger-ului BlueMax GPS-4044 (atât BT cât s, i USB)

MS Windows

The live tracking works for both USB and BT modes, by using GPSGate or even without it, just use the
Autodetect mode, or point the tool the right port.

Ubuntu/Mint GNU/Linux

Pentru USB

The live tracking works both with GPSD
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gpsd /dev/ttyACM3

or without it, by connecting the QGIS live tracking tool directly to the device (for example /dev/ttyACM3).

Pentru Bluetooth

The live tracking works both with GPSD

gpsd /dev/rfcomm0

or without it, by connecting the QGIS live tracking tool directly to the device (for example /dev/rfcomm0).
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CHAPTER 17

Sistem de Autentificare

17.1 Prezentare Generală a Sistemului de Autentificare

Figure 17.1: Anatomia Sistemului de Autentificare

17.1.1 Baza de date de autentificare

The new authentication system stores authentication configurations in an SQLite database file located, by default,
at <user home>/.qgis2/qgis-auth.db.

Această bază de date de autentificare poate fi mutată între instalările QGIS, fără afectarea altor preferint,e ale
utilizatorului QGIS curent, deoarece este complet separată de setările normale ale QGIS. Atunci când stocat,i init,ial
o configurat,ie a unei baze de date, este generat un ID de configurare (un s, ir aleatoriu de 7 caractere alfanumerice).
Acesta reprezintă configurat,ia, fiind posibilă stocarea în clar a ID-ului de către componentele aplicat,iei, (cum ar fi
proiectele, plugin-urile, sau fis, ierele de setare) fără divulgarea credent,ialelor asociate.

Note: Directorul părinte al qgis-auth.db poate fi setat folosind variabila de mediu QGIS_AUTH_DB_DIR_PATH,
sau din linia de comandă, pe durata lansării cu opt,iunea --authdbdirectory.
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17.1.2 Parola master

Pentru a stoca sau pentru a accesa informat,iile sensibile din baza de date, un utilizator trebuie să definească un
parolă master. O nouă parolă master este solicitată s, i verificată, atunci când se stochează init,ial date criptate în
baza de date. Numai atunci când accesează informat,ii sensibile, utilizatorului i se solicită parola master, care
este apoi stocată în memoria tampon, pentru restul sesiunii (până la închiderea aplicat,iei), cu except,ia cazului
în care utilizatorul alege manual act,iunea de a s, terge valoarea salvată. Unele instant,e de utilizare a sistemului
de autentificare nu necesită introducerea parolei principale, cum ar fi la selectarea configurat,iei de autentificare
existentă, sau prin aplicarea unei configurat,ii pentru un serviciu (cum ar fi adăugarea unui strat WMS).

Figure 17.2: Introducerea noii parole master

Note: A path to a file containing the master password can be set using the following environment variable,
QGIS_AUTH_PASSWORD_FILE.

Gestiunea parolei master

Odată stabilită, parola principală poate fi resetată; parola master curentă va fi necesară înainte de resetare. Pe
durata acestui proces, există opt,iunea de a genera o copie de rezervă completă a bazei de date curente.

Figure 17.3: Resetarea parolei master

În cazul în care utilizatorul uită parola principală, nu există nici o modalitate de a o recupera sau de a o suprascrie.
De asemenea, nu există nici un mijloc de recuperare a informat,iilor criptate, fără a cunoas, te parola de master.

Dacă un utilizator introduce incorect, de trei ori, parola, fereastra de dialog se va oferi să s, teargă baza de date.

17.1.3 Configurat,ii de Autentificare

You can manage authentication configurations from Configurations in the Authentication tab of the QGIS Options
dialog (Settings → Options).

Use the button to add a new configuration, the button to remove configurations, and the button to
modify existing ones.
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Figure 17.4: Se va cere parola după trei încercări eronate

Figure 17.5: Editorul de configurat,ii
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Figure 17.6: Adăugarea configurărilor din cadrul Editorului de Configurat,ii

The same type of operations for authentication configuration management (Add, Edit and Remove) can be done
when configuring a given service connection, such as configuring an OWS service connection. For that, there are
action buttons within the configuration selector for fully managing configurations found within the authentication
database. In this case, there is no need to go to the configurations in Authentication tab of QGIS options unless
you need to do more comprehensive configuration management.

When creating or editing an authentication configuration, the info required is a name, an authentication method
and any other info that the authentication method requires (see more about the available authentication types in
Metoda de Autentificare).

17.1.4 Metoda de Autentificare

Available authentications are provided by C++ plugins much in the same way data provider plugins are sup-
ported by QGIS. The method of authentication that can be selected is relative to the access needed for the re-
source/provider, e.g. HTTP(S) or database, and whether there is support in both QGIS code and a plugin. As such,
some authentication method plugins may not be applicable everywhere an authentication configuration selector is
shown. A list of available authentication method plugins and their compatible resource/providers can be accessed
going to Settings → Options and, in the Authentication tab, click the [Installed plugins] button.

Plugins can be created for new authentication methods that do not require QGIS to be recompiled. Since the
support for plugins is currently (since QGIS 2.12) C++-only, QGIS will need to be restarted for the new dropped-
in plugin to become available to the user. Ensure your plugin is compiled against the same target version of QGIS
if you intend to add it to an existing target install.

Note: The Resource URL is currently an unimplemented feature that will eventually allow a particular configu-
ration to be auto-chosen when connecting to resources at a given URL.

17.1.5 Utilitare pentru Parola Master s, i Configurările de Autentificare

Under the Options menu (Settings → Options) in the Authentication tab, there are several utility actions to manage
the authentication database and configurations:

• Input master password:

322 Chapter 17. Sistem de Autentificare



QGIS User Guide, Release 2.18

Figure 17.7: WMS connection dialog showing [Add], [Edit], and [Remove] authentication configuration buttons

Figure 17.8: Available method plugins list

Figure 17.9: Configurări de autentificare HTTP de bază
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Figure 17.10: Configurări de autentificare ale căilor PKI

Figure 17.11: Configurări de autentificare ale căilor către fis, ierele PKI PKCS#12

Figure 17.12: Configurări de autentificare ale Identităt,ilor Stocate
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Figure 17.13: Meniul Utilitarelor

– Opens the master password input dialog, independent of performing any authentication database com-
mand. Clear cached master password

– Unsets the master password if it has been set via input dialog. Reset master password

– Opens a dialog to change the master password (the current password must be known) and optionally
back up the current database.

• Clear cached authentication configurations: Clears the internal lookup cache for configurations used to
speed up network connections. This does not clear QGIS’s core network access manager’s cache, which
requires a relaunch of QGIS.

• Reset master password: Replaces the current master password for a new one. The current master password
will be needed prior to resetting and a backup of database can be done.

• Remove all authentication configurations: Clears the database of all configuration records, without re-
moving other stored records.

• Erase authentication database: Schedules a backup of the current database and complete rebuild of the
database table structure. These actions are scheduled for a later time, so as to ensure other operations like
project loading do not interrupt the operation or cause errors due to a temporarily missing database.

Figure 17.14: Meniul de verificare a s, tergerii DB

17.1.6 Folosirea configurat,iilor de autentificare

În mod tipic, o configurat,ie de autentificare este selectată într-un dialog de configurare, pentru serviciile de ret,ea
(cum ar fi WMS). Cu toate acestea, controlul grafic de selectare poate fi încorporat oriunde este necesară auten-
tificarea, sau într-o funct,ionalitate care nu este de esent,ială, cum ar fi plugin-urile tert,e PyQGIS sau C++.

When using the selector, No authentication is displayed in the pop-up menu control when nothing is selected,
when there are no configurations to choose from, or when a previously assigned configuration can no longer be
found in the database. The Type and Id fields are read-only and provide a description of the authentication method
and the config’s ID respectively.
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Figure 17.15: Authentication configuration selector with no authentication

Figure 17.16: Authentication configuration selector with selected config

17.1.7 Legături Python

All classes and public functions have sip bindings, except QgsAuthCrypto, since management of the master
password hashing and auth database encryption should be handled by the main app, and not via Python. See
Avertismente de Securitate concerning Python access.

17.2 Fluxul de Autentificare a Utilizatorului

Figure 17.17: Fluxul de lucru al utilizatorului generic
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17.2.1 Autentificarea HTTP(S)

Una dintre cele mai comune conectări la resurse are loc prin prin HTTP(S), cum ar fi serverele de cartografiere
web s, i plugin-urile cu metode de autentificare, care adesea lucrează cu aceste tipuri de conexiuni. Plugin-urile
cu metode au acces la obiectul cerere HTTP s, i pot manipula atât cererea cât s, i antetele sale. Acest lucru permite
mai multe forme de autentificare prin internet. Atunci când conectarea are loc prin HTTP(S) cu ajutorul metodei
standard de autentificare nume de utilizator/ parolă, se va încerca autentificarea HTTP de bază a conexiunii.

Figure 17.18: Configurarea unei conexiuni WMS pentru HTTP BASIC

17.2.2 Autentificarea bazei de date

Connections to database resources are generally stored as key=value pairs, which will expose usernames and
(optionally) passwords, if not using an authentication configuration. When configuring with the new auth system,
the key=value will be an abstracted representation of the credentials, e.g. authfg=81t21b9.

17.2.3 Autentificarea PKI

When configuring PKI components within the authentication system, you have the option of importing compo-
nents into the database or referencing component files stored on your filesystem. The latter may be useful if such
components change frequently, or where the components will be replaced by a system administrator. In either
instance you will need to store any passphrase needed to access private keys within the database.

All PKI components can be managed in separate editors within the Certificate Manager, which can be accessed
in the Authentication tab in QGIS Options dialog (Settings → Options) by clicking the [Manage certificates]
button.

In the Certificate Manager, there are editors for Identities, Servers and Authorities. Each of these are contained
in their own tabs, and are described below in the order they are encountered in the workflow chart above. The tab
order is relative to frequently accessed editors once you are accustomed to the workflow.

Note: Because all authentication system edits write immediately to the authentication database, there is no need
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Figure 17.19: Configurarea unei conexiuni Postgres SSL-with-PKI

to click the Options dialog [OK] button for any changes to be saved. This is unlike other settings in the Options
dialog.

Autorităt,i

You can manage available Certificate Authorities (CAs) from the Authorities tab in the Certificate manager from
the Authentication tab of the QGIS Options dialog.

As referenced in the workflow chart above, the first step is to import or reference a file of CAs. This step is
optional, and may be unnecessary if your PKI trust chain originates from root CAs already installed in your
operating system (OS), such as a certificate from a commercial certificate vendor. If your authenticating root CA
is not in the OS’s trusted root CAs, it will need to be imported or have its file system path referenced. (Contact
your system administrator if unsure.)

By default, the root CAs from your OS are available; however, their trust settings are not inherited. You should
review the certificate trust policy settings, especially if your OS root CAs have had their policies adjusted. Any
certificate that is expired will be set to untrusted and will not be used in secure server connections, unless you
specifically override its trust policy. To see the QGIS-discoverable trust chain for any certificate, select it and click

the Show information for certificate.

You can edit the trust policy for any selected certificate within the chain. Any change in trust policy to

a selected certificate will not be saved to the database unless the Save certificate trust policy change to database button is
clicked per selected certification. Closing the dialog will not apply the policy changes.

You can review the filtered CAs, both intermediate and root certificates, that will be trusted for secure connections

or change the default trust policy by clicking the Options button.
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Figure 17.20: Fluxul de lucru pentru configurarea PKI
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Figure 17.21: Deschiderea Managerului de Certificate

Figure 17.22: Editorul de autorităt,i
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Figure 17.23: Dialogul nformat,iilor despre Certificat

Figure 17.24: Salvarea modificărilor aduse politicii de încredere
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Warning: Schimbarea politicii de încredere implicită, poate genera probleme conexiunilor securizate.

Figure 17.25: Meniul opt,iunilor pentru autorităt,i

You can import CAs or save a file system path from a file that contains multiple CAs, or import individual CAs.
The standard PEM format for files that contain multiple CA chain certifications has the root cert at the bottom of
the file and all subsequently signed child certificates above, towards the beginning of the file.

The CA certificate import dialog will find all CA certificates within the file, regardless of order, and also offers the
option to import certificates that are considered invalid (in case you want to override their trust policy). You can
override the trust policy upon import, or do so later within the Authorities editor.

Figure 17.26: Dialogul de importare a certificatelor

Note: If you are pasting certificate information into the PEM text field, note that encrypted certificates are not
supported.

Identităt,i

You can manage available client identity bundles from the Identities tab in the Certificate manager from the
Authentication tab of the QGIS Options dialog. An identity is what authenticates you against a PKI-enabled
service and usually consists of a client certificate and private key, either as separate files or combined into a single
“bundled” file. The bundle or private key is often passphrase-protected.

Once you have any Certificate Authorities (CAs) imported you can optionally import any identity bundles into the
authentication database. If you do not wish to store the identities, you can reference their component file system
paths within an individual authentication configuration.
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Figure 17.27: Editorul de Identităt,i

When importing an identity bundle, it can be passphrase-protected or unprotected, and can contain CA certificates
forming a trust chain. Trust chain certifications will not be imported here; they can be added separately under the
Authorities tab.

Upon import the bundle’s certificate and private key will be stored in the database, with the key’s storage encrypted
using the QGIS master password. Subsequent usage of the stored bundle from the database will only require input
of the master password.

Personal identity bundles consisting of PEM/DER (.pem/.der) and PKCS#12 (.p12/.pfx) components are sup-
ported. If a key or bundle is passphrase-protected, the password will be required to validate the component prior
to import. Likewise, if the client certificate in the bundle is invalid (for example, its effective date has not yet
started or has elapsed) the bundle can not be imported.

Figure 17.28: Import de identitate PEM/DER
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Figure 17.29: Import de identitate PKCS#12

17.2.4 Gestionarea straturilor eronate

Occasionally, the authentication configuration ID that is saved with a project file is no longer valid, possibly
because the current authentication database is different than when the project was last saved, or due to a credentials
mismatch. In such cases the Handle bad layers dialog will be presented upon QGIS launch.

Figure 17.30: Gestionarea straturilor eronate s, i a autentificării

If a data source is found to have an authentication configuration ID associated with it, you will be able to edit it.
Doing so will automatically edit the data source string, much in the same way as opening the project file in a text
editor and editing the string.

17.2.5 Schimbarea ID-ului de configurare a autentificării

Occasionally, you will need to change the authenticationn configuration ID that is associated with accessing a
resource. There are instances where this is useful:

• Resource auth config ID is no longer valid: This can occur when you have switched auth databases add
need to align a new configuration to the ID already associated with a resource.

• Shared project files: If you intended to share projects between users, e.g. via a shared file server, you can
predefine a 7-character (containing a-z and/or 0-9) that is associated with the resource. Then, individual
users change the ID of an authentication configuration that is specific to their credentials of the resource.
When the project is opened, the ID is found in the authentication database, but the credentials are different
per user.

334 Chapter 17. Sistem de Autentificare



QGIS User Guide, Release 2.18

Figure 17.31: Editarea ID-ului de configurare a autentificării, în cazul straturilor eronate

Figure 17.32: Schimbarea ID-ului de configurare pentru autentificarea stratului (câmp de text galben, deblocat)

17.2. Fluxul de Autentificare a Utilizatorului 335



QGIS User Guide, Release 2.18

Warning: Changing the auth config ID is considered an advanced operation and should only be done with
full knowledge as to why it is necessary. This is why there is a lock button that needs clicked, to unlock the
ID’s text field prior to editing the ID.

17.2.6 Suport pentru serverul QGIS

When using a project file, with layers that have authentication configurations, as a basis for a map in QGIS Server,
there are a couple of additional setup steps necessary for QGIS to load the resources:

• Baza de date pentru autentificare trebuie să fie disponibilă

• Parola master a bazei de date pentru autentificare trebuie să fie disponibilă

When instantiating the authentication system, Server will create or use qgis-auth.db in ~/.qgis2/ or the
directory defined by the QGIS_AUTH_DB_DIR_PATH environment variable. It may be that the Server’s user has
no HOME directory, in which case, use the environment variable to define a directory that the Server’s user has
read/write permissions and is not located within the web-accessible directories.

To pass the master password to Server, write it to the first line of file at a path on the file system readable by the
Server processes user and defined using the QGIS_AUTH_PASSWORD_FILE environment variable. Ensure to
limit the file as only readable by the Server’s process user and to not store the file within web-accessible directories.

Note: QGIS_AUTH_PASSWORD_FILE variable will be removed from the Server environment immediately
after accessing.

17.2.7 Except,ii de server SSL

Figure 17.33: Except,ie de server SSL

You can manage SSL server configurations and exceptions from the Servers tab in the Authentication section of
the QGIS Options dialog.

Sometimes, when connecting to an SSL server, there are errors with the SSL “handshake” or the server’s certifi-
cate. You can ignore those errors or create an SSL server configuration as an exception. This is similar to how
web browsers allow you to override SSL errors, but with more granular control.

Warning: You should not create an SSL server configuration unless you have complete knowledge of the
entire SSL setup between the server and client. Instead, report the issue to the server administrator.

Note: Some PKI setups use a completely different CA trust chain to validate client identities than the chain used
to validate the SSL server certificate. In such circumstances, any configuration created for the connecting server
will not necessarily fix an issue with the validation of your client identity, and only your client identity’s issuer or
server administrator can fix the issue.
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You can pre-configure an SSL server configuration by clicking the button. Alternatively, you can add a
configuration when an SSL error occurs during a connection and you are presented with an SSL Error dialog
(where the error can be ignored temporarily or saved to the database and ignored):

Figure 17.34: Adăugarea manuală a configurărilor

O dată ce o configurat,ie SSL este salvată în baza de date, aceasta poate fi editată sau s, tearsă.

If you want to pre-configure an SSL configuration and the import dialog is not working for your server’s con-
nection, you can manually trigger a connection via the Python Console by running the following code (replace
https://bugreports.qt-project.org with the URL of your server):

from PyQt4.QtNetwork import *
req = QNetworkRequest(QUrl(’https://bugreports.qt-project.org’))
reply = QgsNetworkAccessManager.instance().get(req)

This will open an SSL error dialog if any errors occur, where you can choose to save the configuration to the
database.

17.3 Avertismente de Securitate

O dată ce este introdusă parola de master, API-ul este deschis pentru a vă oferi acces la baza datelor de au-
tentificare, similar modului în care funct,ionează Firefox. Cu toate acestea, la implementarea init,ială, nu sunt
definit piedici împotriva accesului PyQGIS. Acest lucru poate conduce la probleme, în cazul în care un utiliza-
tor descarcă/instalează un plugin PyQGIS rău intent,ionat, sau o aplicat,ie de sine stătătoare, care obt,ine acces la
prerogativele de autentificare.

Solut,ia rapidă pentru versiunea init,ială a caracteristicii, este de a nu include doar cele mai multe legături PyQGIS
pentru sistemul de autentificare.
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Figure 17.35: Adăugarea configurărilor pe durata erorii SSL

Figure 17.36: Configurat,iile SSL existente
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Figure 17.37: Editarea unei configurat,ii SSL existente

O altă modalitate simplă, des, i nu robustă, este de a adăuga un ComboBox prin Setări → Opt,iuni → Autentificare
(implicit “niciodată”):

"Allow Python access to authentication system"
Choices: [ confirm once per session | always confirm | always allow | never]

Setarea unei asemenea opt,iuni ar trebui să fie salvată într-o locat,ie de bază inaccesibilă pentru Python, cum ar fi
baza de date de autentificare, s, i să fie criptată cu parola principală.

• O altă opt,iune ar putea consta în urmărirea plugin-urilor specifice utilizatorului

• allowed to access the authentication system, though it may be tricky to deduce which plugin is actually
making the call.

• Sandboxing plugins, possibly in their own virtual environments, would reduce ‘cross-plugin’ hacking of
authentication configs from another plugin that is authorized. This might mean limiting cross-plugin com-
munication as well, but maybe only between third-party plugins.

• Another good solution is to issue code-signing certificates to vetted plugin authors. Then validate the plu-
gin’s certificate upon loading. If need be the user can also directly set an untrusted policy for the certificate
associated with the plugin using existing certificate management dialogs.

• Alternativ, accesat,i din Python datele sensibile de autentificare la sistem

• could never be allowed, and only the use of QGIS core widgets, or duplicating authentication system in-
tegrations, would allow the plugin to work with resources that have an authentication configuration, while
keeping master password and authentication config loading in the realm of the main app.

The same security concerns apply to C++ plugins, though it will be harder to restrict access, since there is no
function binding to simply be removed as with Python.

17.3.1 Restrict,ii

The confusing licensing and exporting issues associated with OpenSSL apply. In order for Qt to work with SSL
certificates, it needs access to the OpenSSL libraries. Depending upon how Qt was compiled, the default is to
dynamically link to the OpenSSL libs at run-time (to avoid the export limitations).

QCA follows a similar tactic, whereby linking to QCA incurs no restrictions, because the qca-ossl (OpenSSL)
plugin is loaded at run-time. The qca-ossl plugin is directly linked to the OpenSSL libs. Packagers would be the
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ones needing to ensure any OpenSSL-linking restrictions are met, if they ship the plugin. Maybe. I don’t really
know. I’m not a lawyer.

The authentication system safely disables itself when qca-ossl is not found at run-time.
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CHAPTER 18

Integrarea GRASS GIS

GRASS integration provides access to GRASS GIS databases and functionalities (see GRASS-PROJECT in Lit-
eratură s, i Referint,e Web). The integration consists of two parts: provider and plugin. The provider allows to
browse, manage and visualize GRASS raster and vector layers. The plugin can be used to create new GRASS
locations and mapsets, change GRASS region, create and edit vector layers and analyze GRASS 2-D and 3-D data
with more than 400 GRASS modules. In this section, we’ll introduce the provider and plugin functionalities and
give some examples of managing and working with GRASS data.

The provider supports GRASS version 6 and 7, the plugin supports GRASS 6 and 7 (starting from QGIS 2.12).
QGIS distribution may contain provider/plugin for either GRASS 6 or GRASS 7 or for both versions at the same
time (binaries have different file names). Only one version of the provider/plugin may be loaded on runtime
however.

18.1 Setul de date demonstrative

As an example, we will use the QGIS Alaska dataset (see section Sample Data). It includes a small sample GRASS
LOCATION with three vector layers and one raster elevation map. Create a new folder called grassdata, down-
load the QGIS ‘Alaska’ dataset qgis_sample_data.zip from http://qgis.org/downloads/data/ and unzip the
file into grassdata.

More sample GRASS LOCATIONs are available at the GRASS website at
http://grass.osgeo.org/download/sample-data/.

18.2 Încărcarea straturilor raster s, i vectoriale GRASS

If the provider is loaded in QGIS, the location item with GRASS icon is added in the browser tree under each
folder item which contains GRASS location. Go to the folder grassdata and expand location alaska and
mapset demo.

You can load GRASS raster and vector layers like any other layer from the browser either by double click on layer
item or by dragging and dropping to map canvas or legend.

Tip: Încărcarea Datelor GRASS
If you don’t see GRASS location item, verify in Help → About → Providers if GRASS vector provider is loaded.

18.3 Importing data into a GRASS LOCATION via drag and drop

This section gives an example of how to import raster and vector data into a GRASS mapset.

1. In QGIS browser navigate to the mapset you want to import data into.
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2. In QGIS browser find a layer you want to import to GRASS, note that you can open another instance of the
browser (Browser Panel (2)) if source data are too far from the mapset in the tree.

3. Drag a layer and drop it on the target mapset. The import may take some time for larger layers, you will see
animated icon in front of new layer item until the import finishes.

When raster data are in different CRS, they can be reprojected using an Approximate (fast) or Exact (precise)
transformation. If a link to the source raster is created (using r.external), the source data are in the same CRS
and the format is known to GDAL, the source data CRS will be used. You can set these options in the Browser tab
in Opt,iuni GRASS.

If a source raster has more bands, a new GRASS map is created for each layer with .<band number> suffix and

group of all maps with icon is created. External rasters have a different icon .

18.4 Managing GRASS data in QGIS Browser

• Copying maps: GRASS maps may be copied between mapsets within the same location using drag and
drop.

• Deleting maps: Right click on a GRASS map and select Delete from context menu.

• Renaming maps: Right click on a GRASS map and select Rename from context menu.

18.5 Opt,iuni GRASS

GRASS options may be set in GRASS Options dialog, which can be opened by right clicking on the location or
mapset item in the browser and then choosing GRASS Options.

18.6 Startarea plugin-ului GRASS

To use GRASS functionalities in QGIS, you must select and load the GRASS plugin using the Plugin Manager.

To do this, go to the menu Plugins → Manage and Install Plugins..., select GRASS and click [OK].

The following main features are provided with the GRASS menu (Plugins → GRASS) when you start the GRASS
plugin:

• Open Mapset

• New Mapset

• Închidere set de hărt,i

• Deschidere Instrumente GRASS

• Afis,area regiunii curente GRASS

• Opt,iuni GRASS

18.7 Deschiderea Setului de hărt,i GRASS

A GRASS mapset must be opened to get access to GRASS Tools in the plugin (the tools are disabled if no mapset
is open). You can open a mapset from the browser: right click on mapset item and then choose Open mapset from
context menu.
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18.8 GRASS LOCATION s, i MAPSET

Datele GRASS sunt stocate într-un director de tip GISDBASE. Acest director, denumit adesea grassdata,
trebuie să existe înainte de a începe lucrul cu plugin-ul GRASS din QGIS. În interiorul acestui director, datele
GRASS GIS sunt organizate în proiecte stocate, la rândul lor, în subdirectoare denumite LOCATIONs. Fiecare
LOCATION este definită prin sistemul de coordonate, proiect,ia hărt,ii s, i limitele geografice. Fiecare LOCATION
poate avea mai multe MAPSETs (subdirectoare ale LOCATION) care sunt utilizate pentru a subdiviza un proiect în
diferite teme sau subregiuni, ori în spat,ii de lucru pentru membrii individuali ai unei echipe (v. Neteler & Mitasova
2008 în Literatură s, i Referint,e Web). Pentru a analiza straturile vectoriale s, i raster cu ajutorul modulelor GRASS,
trebuie să le importat,i într-o LOCATION GRASS. (Acest lucru nu este complet adevărat - cu ajutorul modulelor
GRASS r.external s, i v.external putet,i crea numai link-uri read-only către seturile de date GDAL/OGR
externe acceptate, fără să fie necesar importul lor. Însă, deoarece acesta nu este modul obis, nuit pentru începători
de a lucra cu GRASS, această opt,iune nu va fi descrisă aici.)

Figure 18.1: Datele GRASS din LOCAT, IA alaska

18.9 Importat,i datele într-o LOCAT, IE GRASS

See section Importing data into a GRASS LOCATION via drag and drop to find how data can be easily imported
by dragging and dropping in the browser.

This section gives an example of how to import raster and vector data into the ‘alaska’ GRASS LOCATION
provided by the QGIS ‘Alaska’ dataset in traditional way, using standard GRASS modules. Therefore, we use the
landcover raster map landcover.img and the vector GML file lakes.gml from the QGIS ‘Alaska’ dataset
(see Sample Data).

1. Start QGIS, apoi asigurat,i-vă că plugin-ul GRASS este încărcat.

2. In the GRASS toolbar, click the Open MAPSET icon to bring up the MAPSET wizard.

3. Select as GRASS database the folder grassdata in the QGIS Alaska dataset, as LOCATION ‘alaska’, as
MAPSET ‘demo’ and click [OK].

4. Acum facet,i clic pe pictograma Open GRASS tools. Va apărea bara de instrumente GRASS (v. sect,iunea
Bara de instrumente GRASS).

5. To import the raster map landcover.img, click the module r.in.gdal in the Modules Tree tab. This
GRASS module allows you to import GDAL-supported raster files into a GRASS LOCATION. The module
dialog for r.in.gdal appears.

6. Răsfoit,i folderul raster din setul de date ‘Alaska’ din QGIS, apoi selectat,i fis, ierul landcover.img.
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7. As raster output name, define landcover_grass and click [Run]. In the Output tab, you
see the currently running GRASS command r.in.gdal -o input=/path/to/landcover.img
output=landcover_grass.

8. When it says Successfully finished, click [View output]. The landcover_grass raster layer is now
imported into GRASS and will be visualized in the QGIS canvas.

9. To import the vector GML file lakes.gml, click the module v.in.ogr in the Modules Tree tab. This
GRASS module allows you to import OGR-supported vector files into a GRASS LOCATION. The module
dialog for v.in.ogr appears.

10. Răsfoit,i folderul gml din setul de date ‘Alaska’ din QGIS, apoi selectat,i fis, ierul lakes.gml ca fis, ier OGR.

11. As vector output name, define lakes_grass and click [Run]. You don’t have to care about the other
options in this example. In the Output tab you see the currently running GRASS command v.in.ogr -o
dsn=/path/to/lakes.gml output=lakes\_grass.

12. When it says Succesfully finished, click [View output]. The lakes_grass vector layer is now imported
into GRASS and will be visualized in the QGIS canvas.

18.9.1 Crearea unei noi LOCAT, II GRASS

Ca exemplu, este prezentat es, antionul GRASS LOCATION alaska, care este proiectat în proiect,ia Albers cu
Suprafet,e Egale s, i având feet ca unitate de măsură. Acest es, antion GRASS LOCATION alaska va fi folosit
pentru toate exemplele s, i exercit,iile din următoarele sect,iuni legate de GRASS. Este util să descărcat,i setul de date
pe computerul dvs, apoi să-l instalat,i (v. Sample Data).

1. Start QGIS, apoi asigurat,i-vă că plugin-ul GRASS este încărcat.

2. Visualize the alaska.shp shapefile (see section Încărcarea unui strat dintr-un fis, ier) from the QGIS
Alaska dataset (see Sample Data).

3. In the GRASS toolbar, click on the New mapset icon to bring up the MAPSET wizard.

4. Select an existing GRASS database (GISDBASE) folder grassdata, or create one for the new
LOCATION using a file manager on your computer. Then click [Next].

5. We can use this wizard to create a new MAPSET within an existing LOCATION (see section Adăugarea
unui nou MAPSET) or to create a new LOCATION altogether. Select Create new location (see fig-
ure_grass_new_location).

6. Enter a name for the LOCATION – we used ‘alaska’ – and click [Next].

7. Define the projection by clicking on the radio button Projection to enable the projection list.

8. We are using Albers Equal Area Alaska (feet) projection. Since we happen to know that it is represented
by the EPSG ID 2964, we enter it in the search box. (Note: If you want to repeat this process for another

LOCATION and projection and haven’t memorized the EPSG ID, click on the CRS Status icon in the lower
right-hand corner of the status bar (see section Lucrul cu Proiect,ii)).

9. În Filtrul, inserat,i 2964 pentru a selecta proiect,ia.

10. Click [Next].

11. To define the default region, we have to enter the LOCATION bounds in the north, south, east, and west
directions. Here, we simply click on the button [Set current QGIS extent], to apply the extent of the
loaded layer alaska.shp as the GRASS default region extent.

12. Click [Next].

13. We also need to define a MAPSET within our new LOCATION (this is necessary when creating a new
LOCATION). You can name it whatever you like - we used ‘demo’. GRASS automatically creates a special
MAPSET called PERMANENT, designed to store the core data for the project, its default spatial extent and
coordinate system definitions (see Neteler & Mitasova 2008 in Literatură s, i Referint,e Web).
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14. Check out the summary to make sure it’s correct and click [Finish].

15. Sunt create noua LOCATION, ‘alaska’, s, i două MAPSETs, ‘demo’ s, i ‘PERMANENT’. Setul deschis în mod
curent este ‘demo’, as, a cum l-at,i definit.

16. Observat,i că unele instrumente din bara de instrumente GRASS, dezactivate anterior, sunt acum activate.

Figure 18.2: Crearea unei LOCAT, II GRASS noi, sau a unui nou SET DE HĂRT, I în QGIS

If that seemed like a lot of steps, it’s really not all that bad and a very quick way to create a LOCATION. The
LOCATION ‘alaska’ is now ready for data import (see section Importat,i datele într-o LOCAT, IE GRASS). You can
also use the already-existing vector and raster data in the sample GRASS LOCATION ‘alaska’, included in the
QGIS ‘Alaska’ dataset Sample Data, and move on to section Modelul de date vectoriale GRASS.

18.9.2 Adăugarea unui nou MAPSET

A user has write access only to a GRASS MAPSET which he or she created. This means that besides access to
your own MAPSET, you can read maps in other users’ MAPSETs (and they can read yours), but you can modify
or remove only the maps in your own MAPSET.

All MAPSETs include a WIND file that stores the current boundary coordinate values and the currently selected
raster resolution (see Neteler & Mitasova 2008 in Literatură s, i Referint,e Web, and section Regiunea instrumentelor
GRASS).

1. Start QGIS, apoi asigurat,i-vă că plugin-ul GRASS este încărcat.

2. In the GRASS toolbar, click on the New mapset icon to bring up the MAPSET wizard.

3. Selectat,i folderul grassdata al bazei de date GRASS (GISDBASE) cu locat,ia LOCATION ‘alaska’, în
care dorim să adăugăm un nou MAPSET denumit ‘test’.

4. Click [Next].

5. We can use this wizard to create a new MAPSET within an existing LOCATION or to create a new
LOCATION altogether. Click on the radio button Select location (see figure_grass_new_location) and
click [Next].

6. Introducet,i denumirea text pentru noul MAPSET. În josul controlului grafic se poate vedea lista MAPSETs
existente, precum s, i proprietarii aferent,i.

7. Click [Next], check out the summary to make sure it’s all correct and click [Finish].

18.10 Modelul de date vectoriale GRASS

It is important to understand the GRASS vector data model prior to digitizing. In general, GRASS uses a topolog-
ical vector model. This means that areas are not represented as closed polygons, but by one or more boundaries.
A boundary between two adjacent areas is digitized only once, and it is shared by both areas. Boundaries must be
connected and closed without gaps. An area is identified (and labelled) by the centroid of the area.
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Besides boundaries and centroids, a vector map can also contain points and lines. All these geometry elements
can be mixed in one vector and will be represented in different so-called ‘layers’ inside one GRASS vector map.
So in GRASS, a layer is not a vector or raster map but a level inside a vector layer. This is important to distinguish
carefully. (Although it is possible to mix geometry elements, it is unusual and, even in GRASS, only used in
special cases such as vector network analysis. Normally, you should prefer to store different geometry elements
in different layers.)

It is possible to store several ‘layers’ in one vector dataset. For example, fields, forests and lakes can be stored in
one vector. An adjacent forest and lake can share the same boundary, but they have separate attribute tables. It is
also possible to attach attributes to boundaries. An example might be the case where the boundary between a lake
and a forest is a road, so it can have a different attribute table.

The ‘layer’ of the feature is defined by the ‘layer’ inside GRASS. ‘Layer’ is the number which defines if there is
more than one layer inside the dataset (e.g., if the geometry is forest or lake). For now, it can be only a number. In
the future, GRASS will also support names as fields in the user interface.

Atributele pot fi stocate în interiorul LOCATION GRASS în format dBase sau SQLite3, sau în tabelele bazei de
date externe, cum ar fi PostgreSQL, MySQL, Oracle, etc.

Atributele din tabelele bazei de date sunt legate de elementele geometrice printr-o valoare de ‘categorie’.

‘Categoria’ (key, ID) este un număr întreg atas, at primitivelor geometrice, fiind folosită ca legătură către o coloană
cheie, din tabelul bazei de date.

Tip: Înt,elegerea modelului de date vectoriale GRASS
The best way to learn the GRASS vector model and its capabilities is to download one of the many GRASS
tutorials where the vector model is described more deeply. See http://grass.osgeo.org/documentation/manuals/ for
more information, books and tutorials in several languages.

18.11 Crearea unui nou strat vectorial GRASS

To create a new GRASS vector layer, select one of following items from mapset context menu in the browser:

• Strat Nou, de tip Punct

• Strat Nou, de tip Linie

• Strat Nou, de tip Poligon

and enter a name in the dialog. A new vector map will be created and layer will be added to canvas and editing
started. Selecting type of the layer does not restrict geometry types which can be digitized in the vector map. In
GRASS, it is possible to organize all sorts of geometry types (point, line and polygon) in one vector map. The
type is only used to add the layer to the canvas, because QGIS requires a layer to have a specific type.

It is also possible to add layers to existing vector maps selecting one of the items described above from context
menu of existing vector map.

In GRASS, it is possible to organize all sorts of geometry types (point, line and area) in one layer, because GRASS
uses a topological vector model, so you don’t need to select the geometry type when creating a new GRASS vector.
This is different from shapefile creation with QGIS, because shapefiles use the Simple Feature vector model (see
section Creating new vector layers).

18.12 Digitizarea s, i editarea unui strat vectorial GRASS

GRASS vector layers can be digitized using the standard QGIS digitizing tools. There are however some particu-
larities, which you should know about, due to

• GRASS topological model versus QGIS simple feature

• complexity of GRASS model
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– multiple layers in single maps

– multiple geometry types in single map

– geometry sharing by multiple features from multiple layers

The particularities are discussed in the following sections.

Save, discard changes, undo, redo

Warning: All the changes done during editing are immediately written to vector map and related attribute
tables.

Changes are written after each operation, it is however, possible to do undo/redo or discard all changes when
closing editing. If undo or discard changes is used, original state is rewritten in vector map and attribute tables.

There are two main reasons for this behaviour:

• It is the nature of GRASS vectors coming from conviction that user wants to do what he is doing and it is
better to have data saved when the work is suddenly interrupted (for example, blackout)

• Necessity for effective editing of topological data is visualized information about topological correctness,
such information can only be acquired from GRASS vector map if changes are written to the map.

Bara de Instrumente

The ‘Digitizing Toolbar’ has some specific tools when a GRASS layer is edited:
Pictogramă Instrument Scop

Punct Nou Digitizare punct nou

Linie nouă Digitizare linie nouă

Limită Nouă Digitize new boundary

Centroid Nou Digitizarea unui nou centroid (etichetarea zonei existente)

New Closed Boundary Digitize new closed boundary

Table GRASS Digitizing: GRASS Digitizing Tools

Tip: Digitizarea poligoanelor în GRASS
If you want to create a polygon in GRASS, you first digitize the boundary of the polygon. Then you add a centroid
(label point) into the closed boundary. The reason for this is that a topological vector model links the attribute
information of a polygon always to the centroid and not to the boundary.

Category

Category, often called cat, is sort of ID. The name comes from times when GRASS vectors had only singly
attribute “category”. Category is used as a link between geometry and attributes. A single geometry may have
multiple categories and thus represent multiple features in different layers. Currently it is possible to assign only
one category per layer using QGIS editing tools. New features have automatically assigned new unique category,
except boundaries. Boundaries usually only form areas and do not represent linear features, it is however possible
to define attributes for a boundary later, for example in different layer.

New categories are always created only in currently being edited layer.

It is not possible to assign more categories to geometry using QGIS editing, such data are properly represented as
multiple features, and individual features, even from different layers, may be deleted.

Atribute

Attributes of currently edited layer can only be modified. If the vector map contains more layers, features of other
layers will have all attributes set to ‘<not editable (layer #)>’ to warn you that such attribute is not editable. The
reason is, that other layers may have and usually have different set of fields while QGIS only supports one fixed
set of fields per layer.
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If a geometry primitive does not have a category assigned, a new unique category is automatically assigned and
new record in attribute table is created when an attribute of that geometry is changed.

Tip: If you want to do bulk update of attributes in table, for example using ‘Field Calculator’ (Using the Field
Calculator), and there are features without category which you don’t want to update (typically boundaries), you
can filter them out by setting ‘Advanced Filter’ to cat is not null.

Editing style

The topological symbology is essential for effective editing of topological data. When editing starts, a specialized
‘GRASS Edit’ renderer is set on the layer automatically and original renderer is restored when editing is closed.
The style may be customized in layer properties ‘Style’ tab. The style can also be stored in project file or in
separate file as any other style. If you customize the style, do not change its name, because it is used to reset the
style when editing is started again.

Tip: Do not save project file when the layer is edited, the layer would be stored with ‘Edit Style’ which has no
meaning if layer is not edited.

The style is based on topological information which is temporarily added to attribute table as field ‘topo_symbol’.
The field is automatically removed when editing is closed.

Tip: Do not remove ‘topo_symbol’ field from attribute table, that would make features invisible because the
renderer is based on that column.

Acros, area

To form an area, vertices of connected boundaries must have exactly the same coordinates. This can be achieved
using snapping tool only if canvas and vector map have the same CRS. Otherwise, due conversion from map
coordinates to canvas and back, the coordinate may become slightly different due to representation error and CRS
transformations.

Tip: Canvasul foloses, te CRS-ul stratului s, i la momentul editării.

Limitări

Simultaneous editing of multiple layers within the same vector at the same time is not supported. This is mainly
due to the impossibility of handling multiple undo stacks for a single data source.

On Linux and macOS only one GRASS layer can be edited at time. This is due to a bug in GRASS which
does not allow to close database drivers in random order. This is being solved with GRASS developers.

Tip: Permisiuni de Editare GRASS
Trebuie să fit,i proprietarul MAPSET GRASS, pentru a-l putea edita. Este imposibilă editarea datelor din straturile
MAPSET care nu vă apart,ine, chiar dacă avet,i permisiunea de scriere.

18.13 Regiunea instrumentelor GRASS

The region definition (setting a spatial working window) in GRASS is important for working with raster layers.
Vector analysis is by default not limited to any defined region definitions. But all newly created rasters will have
the spatial extension and resolution of the currently defined GRASS region, regardless of their original extension
and resolution. The current GRASS region is stored in the $LOCATION/$MAPSET/WIND file, and it defines
north, south, east and west bounds, number of columns and rows, horizontal and vertical spatial resolution.

It is possible to switch on and off the visualization of the GRASS region in the QGIS canvas using the
Display current GRASS region button.
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The region can be modified in ‘Region’ tab in ‘GRASS Tolls’ dock widget. Type in the new region bounds and
resolution, and click [Apply]. If you click on [Select the extent by dragging on canvas] you can select a new
region interactively with your mouse on the QGIS canvas dragging a rectangle.

The GRASS module g.region provides a lot more parameters to define an appropriate region extent and reso-
lution for your raster analysis. You can use these parameters with the GRASS Toolbox, described in section Bara
de instrumente GRASS.

18.14 Bara de instrumente GRASS

The Open GRASS Tools box provides GRASS module functionalities to work with data inside a selected GRASS
LOCATION and MAPSET. To use the GRASS Toolbox you need to open a LOCATION and MAPSET that you
have write permission for (usually granted, if you created the MAPSET). This is necessary, because new raster or
vector layers created during analysis need to be written to the currently selected LOCATION and MAPSET.

Figure 18.3: GRASS Toolbox and Module Tree

18.14.1 Lucrul cu modulele GRASS

The GRASS shell inside the GRASS Toolbox provides access to almost all (more than 300) GRASS modules in
a command line interface. To offer a more user-friendly working environment, about 200 of the available GRASS
modules and functionalities are also provided by graphical dialogs within the GRASS plugin Toolbox.

A complete list of GRASS modules available in the graphical Toolbox in QGIS version 2.18 is available in the
GRASS wiki at http://grass.osgeo.org/wiki/GRASS-QGIS_relevant_module_list.

De asemenea, este posibilă personalizarea cont,inutul Instrumentarului GRASS. Această procedură este descrisă
în sect,iunea Personalizarea Barei de Instrumente GRASS.

As shown in figure_grass_toolbox, you can look for the appropriate GRASS module using the thematically
grouped Modules Tree or the searchable Modules List tab.

By clicking on a graphical module icon, a new tab will be added to the Toolbox dialog, providing three new
sub-tabs: Options, Output and Manual.

18.14. Bara de instrumente GRASS 349

http://grass.osgeo.org/wiki/GRASS-QGIS_relevant_module_list


QGIS User Guide, Release 2.18

Opt,iuni

The Options tab provides a simplified module dialog where you can usually select a raster or vector layer visualized
in the QGIS canvas and enter further module-specific parameters to run the module.

Figure 18.4: GRASS Toolbox Module Options

The provided module parameters are often not complete to keep the dialog simple. If you want to use further
module parameters and flags, you need to start the GRASS shell and run the module in the command line.

A new feature since QGIS 1.8 is the support for a Show Advanced Options button below the simplified module
dialog in the Options tab. At the moment, it is only added to the module v.in.ascii as an example of use, but
it will probably be part of more or all modules in the GRASS Toolbox in future versions of QGIS. This allows you
to use the complete GRASS module options without the need to switch to the GRASS shell.

Rezultat

The Output tab provides information about the output status of the module. When you click the [Run] button, the
module switches to the Output tab and you see information about the analysis process. If all works well, you will
finally see a Successfully finished message.

Manual

The Manual tab shows the HTML help page of the GRASS module. You can use it to check further module
parameters and flags or to get a deeper knowledge about the purpose of the module. At the end of each module
manual page, you see further links to the Main Help index, the Thematic index and the Full index.
These links provide the same information as the module g.manual.

Tip: Afis, ează imediat rezultatele
Dacă dorit,i să afis, at,i imediat rezultatele calculelor dvs în canevasul hărt,ii, putet,i folosi butonul ‘Vizualizare Out-
put’, din partea de jos a filei modulului.

18.14.2 Exemple de module GRASS

Următoarele exemple vor demonstra puterea unora dintre modulele GRASS.
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Figure 18.5: GRASS Toolbox Module Output

Figure 18.6: GRASS Toolbox Module Manual
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Crearea curbelor de nivel

The first example creates a vector contour map from an elevation raster (DEM). Here, it is assumed that you have
the Alaska LOCATION set up as explained in section Importat,i datele într-o LOCAT, IE GRASS.

• First, open the location by clicking the Open mapset button and choosing the Alaska location.

• Now open the Toolbox with the Open GRASS tools button.

• În lista de de unelte pentru categorii, facet,i dublu-clic pe Raster → Surface Management → Generate vector
contour lines.

• Now a single click on the tool r.contour will open the tool dialog as explained above (see Lucrul cu modulele
GRASS).

• In the Name of input raster map enter gtopo30.

• Type into the Increment between Contour levels the value 100. (This will create contour lines at
intervals of 100 meters.)

• Introducet,i în Name for output vector map ‘numele ‘‘ctour_100‘.

• Click [Run] to start the process. Wait for several moments until the message Successfully finished
appears in the output window. Then click [View Output] and [Close].

Deoarece aceasta este o regiune mare, va dura ceva timp până la afis, are. După ce se termină randarea, putet,i
deschide fereastra cu proprietăt,ile stratului, pentru a schimba culoarea liniei astfel încât conturul să apară clar pe
rasterul de elevat,ie, la fel ca în Dialogul Proprietăt,ilor Vectoriale.

Next, zoom in to a small, mountainous area in the center of Alaska. Zooming in close, you will notice that the
contours have sharp corners. GRASS offers the v.generalize tool to slightly alter vector maps while keeping
their overall shape. The tool uses several different algorithms with different purposes. Some of the algorithms
(i.e., Douglas Peuker and Vertex Reduction) simplify the line by removing some of the vertices. The resulting
vector will load faster. This process is useful when you have a highly detailed vector, but you are creating a very
small-scale map, so the detail is unnecessary.

Tip: Instrumentul de simplificare
Note that QGIS has a Vector → Geometry Tools → Simplify geometries tool that works just like the GRASS
v.generalize Douglas-Peuker algorithm.

However, the purpose of this example is different. The contour lines created by r.contour have sharp angles
that should be smoothed. Among the v.generalize algorithms, there is Chaiken’s, which does just that (also
Hermite splines). Be aware that these algorithms can add additional vertices to the vector, causing it to load even
more slowly.

• Open the GRASS Toolbox and double-click the categories Vector → Develop map → Generalization, then
click on the v.generalize module to open its options window.

• Verificat,i dacă ‘ctour_100’ apare ca Nume pentru vectorul de intrare.

• From the list of algorithms, choose Chaiken’s. Leave all other options at their default, and scroll down to
the last row to enter in the field Name for output vector map ‘ctour_100_smooth’, and click [Run].

• The process takes several moments. Once Successfully finished appears in the output windows,
click [View output] and then [Close].

• Putet,i schimba culoarea vectorului pentru a-l afis, a în mod clar pe fundalul raster, s, i pentru a contrasta fat,ă
de curbele de nivel originale. Vet,i observa că noile curbe de nivel au colt,uri mai fine decât originalul, în
timp ce urmează fidel forma originală.

Tip: Alte utilizări pentru r.contour
The procedure described above can be used in other equivalent situations. If you have a raster map of precipitation
data, for example, then the same method will be used to create a vector map of isohyetal (constant rainfall) lines.
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Figure 18.7: GRASS module v.generalize to smooth a vector map

Crearea unui efect 3-D de umbrire

Several methods are used to display elevation layers and give a 3-D effect to maps. The use of contour lines, as
shown above, is one popular method often chosen to produce topographic maps. Another way to display a 3-D
effect is by hillshading. The hillshade effect is created from a DEM (elevation) raster by first calculating the slope
and aspect of each cell, then simulating the sun’s position in the sky and giving a reflectance value to each cell.
Thus, you get sun-facing slopes lighted; the slopes facing away from the sun (in shadow) are darkened.

• Begin this example by loading the gtopo30 elevation raster. Start the GRASS Toolbox, and under the
Raster category, double-click to open Spatial analysis → Terrain analysis.

• Apoi facet,i clic pe r.shaded.relief pentru a deschide modulul.

• Change the azimuth angle 270 to 315.

• Enter gtopo30_shade for the new hillshade raster, and click [Run].

• Când procesul se încheie, adăugat,i hărt,ii rasterul reliefat. Ar trebui să-l vedet,i afis, at în tonuri de gri.

• To view both the hillshading and the colors of the gtopo30 together, move the hillshade map below the
gtopo30 map in the table of contents, then open the Properties window of gtopo30, switch to the
Transparency tab and set its transparency level to about 25%.

Ar trebui să avet,i acum elevat,ia gtopo30 cu harta de cuori s, i transparent,a setate deasupra hărt,ii reliefu-
lui, în tonuri de gri. Pentru a observa mai bine efectele vizuale ale reliefării, desetat,i vizualizarea hărt,ii
gtopo30_shade, apoi resetat,i-o.

Folosirea consolei GRASS

The GRASS plugin in QGIS is designed for users who are new to GRASS and not familiar with all the modules
and options. As such, some modules in the Toolbox do not show all the options available, and some modules do
not appear at all. The GRASS shell (or console) gives the user access to those additional GRASS modules that
do not appear in the Toolbox tree, and also to some additional options to the modules that are in the Toolbox with
the simplest default parameters. This example demonstrates the use of an additional option in the r.shaded.relief
module that was shown above.

The module r.shaded.relief can take a parameter zmult, which multiplies the elevation values relative to the X-Y
coordinate units so that the hillshade effect is even more pronounced.

• Load the gtopo30 elevation raster as above, then start the GRASS Toolbox and click on the
GRASS shell. In the shell window, type the command r.shaded.relief map=gtopo30
shade=gtopo30_shade2 azimuth=315 zmult=3 and press [Enter].
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Figure 18.8: The GRASS shell, r.shaded.relief module
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• After the process finishes, shift to the Browse tab and double-click on the new gtopo30_shade2 raster
to display it in QGIS.

• As explained above, move the shaded relief raster below the gtopo30 raster in the table of contents, then
check the transparency of the colored gtopo30 layer. You should see that the 3-D effect stands out more
strongly compared with the first shaded relief map.

Figure 18.9: Displaying shaded relief created with the GRASS module r.shaded.relief

Statistici raster pentru o hartă vectorială

Următorul exemplu arată modul în care un modul din GRASS poate agrega datele rastere, apoi să adauge coloanele
de statistici pentru fiecare poligon din harta vectorială.

• Again using the Alaska data, refer to Importat,i datele într-o LOCAT, IE GRASS to import the trees shapefile
from the shapefiles directory into GRASS.

• Now an intermediate step is required: centroids must be added to the imported trees map to make it a
complete GRASS area vector (including both boundaries and centroids).

• Din Bara de instrumente aleget,i Vector → Manage features, apoi deschidet,i modulul v.centroids.

• Introducet,i ‘forest_areas’ pentru output vector map, apoi rulat,i modulul.

• Now load the forest_areas vector and display the types of forests - deciduous, evergreen, mixed - in

different colors: In the layer Properties window, Symbology tab, choose from Legend type ‘Unique
value’ and set the Classification field to ‘VEGDESC’. (Refer to the explanation of the symbology tab in
Style Properties of the vector section.)

• Mai departe, redeschidet,i Bara de instrumente GRASS, apoi deschidet,i Vector → Vector update din alte
hărt,i.

• Clic pe modulul v.rast.stats. Introducet,i gtopo30 s, i forest_areas.

• Only one additional parameter is needed: Enter column prefix elev, and click [Run]. This is a computa-
tionally heavy operation, which will run for a long time (probably up to two hours).

• Finally, open the forest_areas attribute table, and verify that several new columns have been added,
including elev_min, elev_max, elev_mean, etc., for each forest polygon.

18.14.3 Personalizarea Barei de Instrumente GRASS

Nearly all GRASS modules can be added to the GRASS Toolbox. An XML interface is provided to parse the
pretty simple XML files that configure the modules’ appearance and parameters inside the Toolbox.
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Un fis, ier XML es, antion, pentru generarea modulului v.buffer (v.buffer.qgm) arată în felul următor:

<?xml version="1.0" encoding="UTF-8"?>
<!DOCTYPE qgisgrassmodule SYSTEM "http://mrcc.com/qgisgrassmodule.dtd">

<qgisgrassmodule label="Vector buffer" module="v.buffer">
<option key="input" typeoption="type" layeroption="layer" />
<option key="buffer"/>
<option key="output" />

</qgisgrassmodule>

The parser reads this definition and creates a new tab inside the Toolbox when you select the module. A more
detailed description for adding new modules, changing a module’s group, etc., can be found on the QGIS wiki at
http://hub.qgis.org/projects/quantum-gis/wiki/Adding_New_Tools_to_the_GRASS_Toolbox.
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CHAPTER 19

Navigatorul Independent QGIS

Browser-ul QGIS este disponibil ca aplicat,ie independentă, dar s, i ca panou integra în QGIS. Acesta vă permite
să navigat,i cu us, urint,ă prin baza de date geospat,ială. Putet,i avea acces la fis, ierele vectoriale comune (cum ar fi
fis, ierele shape ESRI sau fis, ierele MapInfo), bazele de date (ex.: PostGIS, Oracle, Spatialite sau MSSQL Spatial)
s, i conexiunile OWS/WCS|WMS|WFS. Putet,i vizualiza, de asemenea, datele GRASS (pentru a aduce datele în
QGIS, parcurget,i Integrarea GRASS GIS).

Descrierea Panoului care găzduies, te Browser-ul QGIS este disponibilă în sect,iunea Panoul Navigatorului, astfel
că mai jos este tratat doar navigatorul independent.

Like the Browser panel, the standalone Browser helps you navigate through your filesystem and manage geodata.
It also helps you preview or create them and open them in a QGIS project by drag-and-drop.

Startat,i navigatorul QGIS

• Startat,i Navigatorul QGIS folosind meniul Start sau scurtăturile de pe desktop.

• Navigatorul QGIS este disponibil din folderul Aplicat,iilor dvs.

In figure_browser_standalone_metadata, you can see the enhanced functionality of the standalone QGIS Browser.
The Param tab provides the details of your connection-based datasets, like PostGIS or MSSQL Spatial. The
Metadata tab contains general information about the file (see Metadata Properties). With the Preview tab, you
can have a look at your files without importing them into your QGIS project. It’s also possible to preview the
attributes of your files in the Attributes tab.
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Figure 19.1: Navigatorul QGIS ca aplicat,ie desktop
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CHAPTER 20

Cadrul de procesare al QGIS

20.1 Introducere

Acest capitol introduce cadrul de prelucrare al QGIS, un mediu de geoprocesare care poate fi folosit pentru a apela
algoritmi nativi sau ai unei tert,e părt,i din QGIS, făcând sarcinile de analiză spat,ială mai productive s, i mai us, or de
realizat.

În următoarele sect,iuni, vom examina modul de a folosi elementele grafice ale acestui cadru s, i de a obt,ine mai
mult de la fiecare.

There are four basic elements in the framework GUI, which are used to run algorithms for different purposes.
Choosing one tool or another will depend on the kind of analysis that is to be performed and the particular
characteristics of each user and project. All of them (except for the batch processing interface, which is called
from the toolbox or the algorithm execution dialog, as we will see) can be accessed from the Processing menu
item. (You will see more than four entries. The remaining ones are not used to execute algorithms and will be
explained later in this chapter).

• The Toolbox. The main element of the GUI, it is used to execute a single algorithm or run a batch process
based on that algorithm.

Figure 20.1: Bara Instrumentelor Processing
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• The Graphical modeler. Several algorithms can be combined graphically using the modeler to define a
workflow, creating a single process that involves several subprocesses.

Figure 20.2: Modelatorul Processing

• The History manager. All actions performed using any of the aforementioned elements are stored in a
history file and can be later easily reproduced using the history manager.

Figure 20.3: Istoricul Processing

• The Batch processing interface. This interface allows you to execute batch processes and automate the
execution of a single algorithm on multiple datasets.

În următoarele sect,iuni, vom examina în detaliu fiecare dintre aceste elemente.

Note: About Vector Menu

Some processing algorithms can be accessed via the Vector menu which lists some tools from the processing
framework but also from plugins.
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Figure 20.4: Interfat,a de Procesare în Serie

20.2 Meniul Vectorial

Meniul Vectorilor oferă o resursă unică pentru o serie de activităt,i GIS specifice vectorilor. Meniul oferă o suită
crescătoare de funct,ii rapide, dedicată gestionării s, i analizei datelor spat,iale. Acestea fac parte din cadrul de
procesare. Ret,inet,i că unele pluginuri pot adăuga facilităt,i suplimentare, de aceea, în acest capitol, vor fi listate
numai funct,iunile implicite din cadrul de procesare.

Cadrul de lucru Processing este instalat s, i activat, în mod automat, s, i întocmai oricărui plugin, poate fi activat
s, i dezactivat cu ajutorul Managerului de Pluginuri (v. Dialogul Plugin-urilor). Atunci când este activat, plugin-
ul Processing adaugă un meniu Vector în QGIS, oferind funct,ii începând de la Instrumentele de Analiză sau
Cercetare, până la cele de Geoprocesare, precum s, i câteva Unelte de Management al Datelor.

See Cadrul de procesare al QGIS for more information about the processing framework.
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20.2.1 Instrumentele de analiză

Pic-
togramă

Unealta Scop

Matricea
distant,elor

Measure distances between two point layers, and output results as a) Square
distance matrix, b) Linear distance matrix, or c) Summary of distances. Can limit
distances to the k nearest features.

Însumează
lungimile
liniilor

Calculează suma totală a lungimilor liniilor aflate în interiorul fiecărui poligon
dintr-un strat vectorial cu poligoane.

Points in
polygon

Count the number of points that occur in each polygon of an input polygon vector
layer.

List unique
values

List all unique values in an input vector layer field.

Basic statistics
for text field

Compute basic statistics (mean, std dev, N, sum, CV) on an input text field.

Basic statistics
for numeric
field

Compute basic statistics (mean, std dev, N, sum, CV) on an input numeric field

Nearest
neighbor
analysis

Compute nearest neighbor statistics to assess the level of clustering in a point
vector layer.

Mean
coordinate(s)

Compute either the normal or weighted mean center of an entire vector layer, or
multiple features based on a unique ID field.

Line
intersections

Locate intersections between lines, and output results as a point shapefile. Useful
for locating road or stream intersections, ignores line intersections with length >
0.

Table tools 1: Default tools in Analysis group
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20.2.2 Research tools

Pic-
togramă

Unealta Scop

Select,ie aleatorie Randomly select n number of features, or n percentage of features.

Random selection
within subsets

Randomly select features within subsets based on a unique ID field.

Random points
inside polygons

Generate pseudo-random points over a polygon layer (variable number of
point or fixed number of point).

Random points in
extent

Generate pseudo-random points over a given extent.

Random points in
layer bounds

Generate pseudo-random points over bounds of a given input layer.

Puncte regulate Generate a regular grid of points over a specified region and export them as
a point shapefile.

Vector grid Generate a line or polygon grid based on user-specified grid spacing.

Select by location Select features based on their location relative to another layer to form a
new selection, or add or subtract from the current selection.

Polygon from
layer extent

Create a single rectangular polygon layer from the extent of an input raster
or vector layer.

Table Tools 2: Default tools in Research group

20.2.3 Geoprocessing tools

Pic-
togramă

Unealta Scop

Convex hull(s) Create minimum convex hull(s) for an input layer, or based on an ID
field.

Buffer with * fixed
distance * distance field

Create buffer(s) around features * based on fixed distance * based on
distance field

Intersect Overlay layers such that output contains areas where both layers
intersect.

Union Overlay layers such that output contains intersecting and
non-intersecting areas.

Symmetrical difference Overlay layers such that output contains those areas of the input and
difference layers that do not intersect.

Clip Overlay layers such that output contains areas that intersect the clip
layer.

Difference Overlay layers such that output contains areas not intersecting the
clip layer.

Dissolve Merge features based on input field. All features with identical input
values are combined to form one single feature.

Elimină poligoanele de
tip “as, chie”

Merges selected features with the neighboring polygon with the
largest area or largest common boundary.

Table Tools 3: Default tools in Geoprocessing group

20.2. Meniul Vectorial 363



QGIS User Guide, Release 2.18

20.2.4 Unelte de geometrie

Pic-
togramă

Unealta Scop

Verifică
validitatea
geometriei

Check polygons for intersections, closed holes, and fix node ordering. You can
choose the engine used by the in the options dialog, digitizing tab Change the
Validate geometries value. There is two engines: QGIS and GEOS which have
pretty different behavior. Another tools exists which shows different result as
well: Topology Checker plugin and ‘must not have invalid geometries’ rule.

Export/Add
geometry
columns

Add vector layer geometry info to point (XCOORD, YCOORD), line
(LENGTH), or polygon (AREA, PERIMETER) layer.

Polygon
centroids

Calculate the true centroids for each polygon in an input polygon layer.

Delaunay
triangulation

Calculate and output (as polygons) the Delaunay triangulation of an input point
vector layer.

Poligoane
Voronoi

Calculate Voronoi polygons of an input point vector layer.

Simplify
geometry

Generalize lines or polygons with a modified Douglas-Peucker algorithm.

Densificare
geometrie

Densify lines or polygons by adding vertices.

Multipart to
singleparts

Convert multipart features to multiple singlepart features. Creates simple
polygons and lines.

Singleparts to
multipart

Merge multiple features to a single multipart feature based on a unique ID field.

Polygons to
lines

Convert polygons to lines, multipart polygons to multiple singlepart lines.

Lines to
polygons

Convert lines to polygons, multipart lines to multiple singlepart polygons.

Extract nodes Extract nodes from line and polygon layers and output them as points.

Table Tools 4: Default tools in Geometry group

Note: The Simplify geometry tool can be used to remove duplicate nodes in line and polygon geometries. Just set
the Simplify tolerance parameter to 0 and this will do the trick.
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20.2.5 Data management tools

Pic-
togramă

Unealta Scop

Define
current
projection

Specify the CRS for shapefiles whose CRS has not been defined.

Join
attributes by
location

Join additional attributes to vector layer based on spatial relationship. Attributes
from one vector layer are appended to the attribute table of another layer and
exported as a shapefile.

Split vector
layer

Split input layer into multiple separate layers based on input field.

Merge
shapefiles to
one

Merge several shapefiles within a folder into a new shapefile based on the layer type
(point, line, area).

Create
spatial index

Create a spatial index for OGR- supported formats.

Table Tools 5: Default tools in Data management group

20.3 The toolbox

The Toolbox is the main element of the processing GUI, and the one that you are more likely to use in your daily
work. It shows the list of all available algorithms grouped in different blocks, and it is the access point to run them,
whether as a single process or as a batch process involving several executions of the same algorithm on different
sets of inputs.

Figure 20.5: Bara instrumentelor de procesare

The toolbox contains all the available algorithms, divided into so-called “Providers”.
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Providers can be (de)activated in the settings dialog. A label in the bottom part of the toolbox will remind you
of that whenever there are inactive providers. Use the link in the label to open the settings window and set up
providers. We will discuss the settings dialog later in this manual.

By default, only providers that do not rely on third-party applications (that is, those that only require QGIS
elements to be run) are active. Algorithms requiring external applications might need additional configuration.
Configuring providers is explained in a later chapter in this manual.

In the upper part of the toolbox, you will find a text box. To reduce the number of algorithms shown in the toolbox
and make it easier to find the one you need, you can enter any word or phrase on the text box. Notice that, as you
type, the number of algorithms in the toolbox is reduced to just those that contain the text you have entered in their
names.

If there are algorithms that match your search but belong to a provider that is not active, an additional label will
be shown in the lower part of the toolbox.

Figure 20.6: Processing Toolbox showing search results

If you click on the link in that label, the list of algorithms will also include those from inactive providers, which
will be shown in light gray. A link to active each inactive provider is also shown.

To execute an algorithm, just double-click on its name in the toolbox.

20.3.1 Dialogul algoritmului

Once you double-click on the name of the algorithm that you want to execute, a dialog similar to that in the figure
below is shown (in this case, the dialog corresponds to the ‘Polygon centroids’ algorithm).

Acest dialog este utilizat pentru a seta valorile de intrare pe care algoritmul trebuie să le execute. Vi se prezintă
un tabel în care trebuie setate valorile de intrare s, i parametrii de configurare. Cont,inutul va fi diferit, desigur, în
funct,ie de cerint,ele algoritmului care urmează să fie executat, creându-se automat pe baza acestor cerint,e.

Des, i numărul s, i tipul de parametri depind de caracteristicile algoritmului, structura este similară pentru toate.
Parametrii din tabel pot avea unul din tipurile de mai jos.
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Figure 20.7: Processing Toolbox showing search results

Figure 20.8: Dialogul Parametrilor
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• A raster layer, to select from a list of all such layers available (currently opened) in QGIS. The selector
contains as well a button on its right-hand side, to let you select filenames that represent layers currently not
loaded in QGIS.

• A vector layer, to select from a list of all vector layers available in QGIS. Layers not loaded in QGIS can
be selected as well, as in the case of raster layers, but only if the algorithm does not require a table field
selected from the attributes table of the layer. In that case, only opened layers can be selected, since they
need to be open so as to retrieve the list of field names available.

You will see an iterator button by each vector layer selector, as shown in the figure below.

Figure 20.9: Butonul de iterare vectorială

În cazul în care algoritmul cont,ine mai mult,i, se va putea alege doar unul. Dacă este apăsat butonul core-
spunzător unei intrări vectoriale, algoritmul va fi executat iterativ pentru fiecare dintre entităt,ile sale, în loc
de o singură dată pentru întregul strat, generându-se un număr de rezultate identic cu numărul de execut,ii
ale algoritmului. Acest lucru permite automatizarea procesului, atunci când toate entităt,ile dintr-un strat
trebuie să fie procesate separat.

• A table, to select from a list of all available in QGIS. Non-spatial tables are loaded into QGIS like vector
layers, and in fact they are treated as such by the program. Currently, the list of available tables that you will
see when executing an algorithm that needs one of them is restricted to tables coming from files in dBase
(.dbf) or Comma-Separated Values (.csv) formats.

• An option, to choose from a selection list of possible options.

• A numerical value, to be introduced in a spin box. You will find a button by its side. Clicking on it, you will
open the expression builder that allows you to enter a mathematical expression, so you can use it as a handy
calculator. Some useful variables related to data loaded into QGIS can be added to your expression, so you
can select a value derived from any of these variables, such as the cell size of a layer or the northernmost
coordinate of another one.

Figure 20.10: Intrare bazată pe o expresie

• A range, with min and max values to be introduced in two text boxes.

• A text string, to be introduced in a text box.
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• A field, to choose from the attributes table of a vector layer or a single table selected in another parameter.

• A coordinate reference system. You can type the EPSG code directly in the text box, or select it from the
CRS selection dialog that appears when you click on the button on the right-hand side.

• An extent, to be entered by four numbers representing its xmin, xmax, ymin, ymax limits. Clicking on
the button on the right-hand side of the value selector, a pop-up menu will appear, giving you three options:

– to select the value from a layer or the current canvas extent,

– to define it by dragging directly onto the map canvas, or

– to use the minimum coverage from all input layers.

Figure 20.11: Selectorul Extinderii

Dacă selectat,i prima opt,iune, vet,i vedea o fereastră similară cu cea următoare.

Figure 20.12: Lista Extinderilor

Dacă o selectat,i pe a doua, fereastra parametrilor se va ascunde, astfel încât să putet,i facet,i clic pe ea s, i să o
traget,i pe pânză. După ce at,i definit dreptunghiul selectat, dialogul va reapărea, având valorile în caseta de
text a extinderii.

Figure 20.13: Glisare Extindere

• A list of elements (whether raster layers, vector layers or tables), to select from the list of such layers
available in QGIS. To make the selection, click on the small button on the left side of the corresponding row
to see a dialog like the following one.

• A small table to be edited by the user. These are used to define parameters like lookup tables or convolution
kernels, among others.

Facet,i clic pe butonul din partea dreapta pentru a vedea tabelul s, i pentru a-i edita valorile.

În funct,ie de algoritm, numărul de rânduri poate fi modificat sau nu, cu ajutorul butoanelor din pe partea
dreaptă a ferestrei.
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Figure 20.14: Select,ie Multiplă

Figure 20.15: Tabelă Reparată
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Along with the Parameters tab, you will find another tab named Log. Information provided by the algorithm
during its execution is written in this tab, and allow you to track the execution and be aware and have more details
about the algorithm as it runs. Notice that not all algorithms write information to this tab, and many of them might
run silently without producing any output other than the final files.

On the right hand side of the dialog you wil find a short description of the algorithm, which will help you un-
derstand its purpose and its basic ideas. If such a description is not available, the description panel will not be
shown.

Some algorithms might have a more detailed help file, which might include description of every parameter it uses,
or examples. In that case, you will find a Help tab in the parameters dialog.

O notă privind proiect,iile

Algorithms that are run from the processing framework — this is also true for most of the external applications
whose algorithms are exposed through it — do not perform any reprojection on input layers and assume that all
of them are already in a common coordinate system and ready to be analyzed. Whenever you use more than one
layer as input to an algorithm, whether vector or raster, it is up to you to make sure that they are all in the same
coordinate system.

Note that, due to QGIS’s on-the-fly reprojecting capabilities, although two layers might seem to overlap and match,
that might not be true if their original coordinates are used without reprojecting them onto a common coordinate
system. That reprojection should be done manually, and then the resulting files should be used as input to the
algorithm. Also, note that the reprojection process can be performed with the algorithms that are available in the
processing framework itself.

By default, the parameters dialog will show a description of the CRS of each layer along with its name, making it
easy to select layers that share the same CRS to be used as input layers. If you do not want to see this additional
information, you can disable this functionality in the Processing settings dialog, unchecking the Show CRS option.

If you try to execute an algorithm using as input two or more layers with unmatching CRSs, a warning dialog will
be shown.

Putet,i încă să executat,i algoritmul, dar fit,i cons, tient,i de faptul că, în cele mai multe cazuri se vor produce rezultate
gres, ite, cum ar fi straturile goale datorate straturilor de intrare care nu se suprapun.

20.3.2 Obiecte de date generate de algoritmi

Obiectele de date generate de un algoritm pot fi oricare din următoarele tipuri:

• Un strat raster

• Un strat vectorial

• O tabelă

• Un fis, ier HTML (folosit pentru ies, iri de text s, i grafice)

These are all saved to disk, and the parameters table will contain a text box corresponding to each one of these
outputs, where you can type the output channel to use for saving it. An output channel contains the information
needed to save the resulting object somewhere. In the most usual case, you will save it to a file, but in the case of
vector layers, and when they are generated by native algorithms (algorithms not using external applications) you
can also save to a PostGIS or Spatialite database, or a memory layer.

To select an output channel, just click on the button on the right side of the text box, and you will see a small
context menu with the available options.

In the most usual case, you will select saving to a file. If you select that option, you will be prompted with a
save file dialog, where you can select the desired file path. Supported file extensions are shown in the file format
selector of the dialog, depending on the kind of output and the algorithm.

The format of the output is defined by the filename extension. The supported formats depend on what is supported
by the algorithm itself. To select a format, just select the corresponding file extension (or add it, if you are directly
typing the file path instead). If the extension of the file path you entered does not match any of the supported
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formats, a default extension will be appended to the file path, and the file format corresponding to that extension
will be used to save the layer or table. Default extensions are .dbf for tables, .tif for raster layers and .shp
for vector layers. These can be modified in the setting dialog, selecting any other of the formats supported by
QGIS.

If you do not enter any filename in the output text box (or select the corresponding option in the context menu),
the result will be saved as a temporary file in the corresponding default file format, and it will be deleted once you
exit QGIS (take care with that, in case you save your project and it contains temporary layers).

You can set a default folder for output data objects. Go to the settings dialog (you can open it from the Processing
menu), and in the General group, you will find a parameter named Output folder. This output folder is used as the
default path in case you type just a filename with no path (i.e., myfile.shp) when executing an algorithm.

When running an algorithm that uses a vector layer in iterative mode, the entered file path is used as the base path
for all generated files, which are named using the base name and appending a number representing the index of
the iteration. The file extension (and format) is used for all such generated files.

Apart from raster layers and tables, algorithms also generate graphics and text as HTML files. These results are
shown at the end of the algorithm execution in a new dialog. This dialog will keep the results produced by any
algorithm during the current session, and can be shown at any time by selecting Processing → Results viewer from
the QGIS main menu.

Some external applications might have files (with no particular extension restrictions) as output, but they do not
belong to any of the categories above. Those output files will not be processed by QGIS (opened or included into
the current QGIS project), since most of the time they correspond to file formats or elements not supported by
QGIS. This is, for instance, the case with LAS files used for LiDAR data. The files get created, but you won’t see
anything new in your QGIS working session.

Pentru toate celelalte tipuri de rezultate, vet,i găsi o casetă de selectare, pe care o putet,i folosi pentru a indica
algoritmului dacă să încarce fis, ierul după ce este generat de către algoritm, sau nu. În mod implicit, toate fis, ierele
vor fi deschise.

Optional outputs are not supported. That is, all outputs are created. However, you can uncheck the corresponding
checkbox if you are not interested in a given output, which essentially makes it behave like an optional output (in
other words, the layer is created anyway, but if you leave the text box empty, it will be saved to a temporary file
and deleted once you exit QGIS).

20.3.3 Configuring the processing framework

As has been mentioned, the configuration menu gives access to a new dialog where you can configure how algo-
rithms work. Configuration parameters are structured in separate blocks that you can select on the left-hand side
of the dialog.

Along with the aforementioned Output folder entry, the General block contains parameters for setting the default
rendering style for output layers (that is, layers generated by using algorithms from any of the framework GUI
components). Just create the style you want using QGIS, save it to a file, and then enter the path to that file in the
settings so the algorithms can use it. Whenever a layer is loaded by Processing and added to the QGIS canvas, it
will be rendered with that style.

Rendering styles can be configured individually for each algorithm and each one of its outputs. Just right-click on
the name of the algorithm in the toolbox and select Edit rendering styles for outputs. You will see a dialog like the
one shown next.

Select the style file (.qml) that you want for each output and press [OK].

Other configuration parameters in the General group are listed below:

• Use filename as layer name. The name of each resulting layer created by an algorithm is defined by the
algorithm itself. In some cases, a fixed name might be used, meaning that the same output name will be
used, no matter which input layer is used. In other cases, the name might depend on the name of the input
layer or some of the parameters used to run the algorithm. If this checkbox is checked, the name will be
taken from the output filename instead. Notice that, if the output is saved to a temporary file, the filename
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Figure 20.16: Rendering Styles

of this temporary file is usually a long and meaningless one intended to avoid collision with other already
existing filenames.

• Keep dialog open after running algorithm. Once an algorithm has finished execution and its output layers
are loaded into the QGIS project, the algorithm dialog is closed. If you want to keep it open (to run the
algorithm again with different parameters, or to better check the output that is written to the log tab), check
this option

• Use only selected features. If this option is selected, whenever a vector layer is used as input for an al-
gorithm, only its selected features will be used. If the layer has no selected features, all features will be
used.

• Pre-execution script file and Post-execution script file. These parameters refer to scripts written using the
processing scripting functionality, and are explained in the section covering scripting and the console.

Apart from the General block in the settings dialog, you will also find a block for algorithm providers. Each
entry in this block contains an Activate item that you can use to make algorithms appear or not in the toolbox.
Also, some algorithm providers have their own configuration items, which we will explain later when covering
particular algorithm providers.

20.4 Managerul istoricului

20.4.1 Procesarea istoricului

De fiecare dată când executat,i un algoritm, informat,iile despre proces sunt stocate în managerul istoricului. Îm-
preună cu parametrii utilizat,i, sunt salvate, de asemenea, data s, i ora executării.

În acest fel, sunt us, or de urmărit, de controlat s, i de reprodus toate lucrările care au fost dezvoltate cu ajutorul
cadrului de lucru Processing.

Managerul de istoric reprezintă un set de intrări de registru, grupate în funct,ie de data de executare, ceea ce
us, urează informat,iile despre un algoritm executat în orice moment anume.

Informat,iile procesului sunt păstrate ca o expresie pentru linia de comandă, chiar dacă algoritmul a fost lansat din
caseta de instrumente. Acest lucru îl face, de asemenea, util pentru cei care învat,ă cum să utilizeze interfat,a liniei
de comandă, deoarece aces, tia pot apela un algoritm folosind bara de instrumente s, i apoi să verifice managerul
istoricului, pentru a vedea cum ar putea acelas, i algoritm să fie apelat din linia de comandă.

Apart from browsing the entries in the registry, you can also re-execute processes by simply double-clicking on
the corresponding entry.

20.4.2 Jurnalul de Procesare

The history dialog only contains the execution calls, but not the information produced by the algorithm when
executed. That information is written to the QGIS log, in a Processing tab.
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Figure 20.17: Istoric

Third-party algorithms are usually executed by calling their command-line interfaces, which communicate with
the user via the console. Although that console is not shown, a full dump of it is written to the log each time you
run one of those algorithms. To avoid cluttering the log with that information, you can disable it for each provider,
looking for the corresponding option in the provider entry of the settings dialog.

Unii algoritmi, chiar dacă pot genera un rezultat pornind de la datele de intrare, pot insera în jurnal comentarii
sau informat,ii suplimentare, pentru a vă avertiza în cazul în care detectează eventuale probleme referitoare la date.
Asigurat,i-vă că at,i citit aceste mesaje atunci când obt,inet,i rezultate neas, teptate.

20.5 Modelatorul grafic

The graphical modeler allows you to create complex models using a simple and easy-to-use interface. When
working with a GIS, most analysis operations are not isolated, but rather part of a chain of operations instead. Us-
ing the graphical modeler, that chain of processes can be wrapped into a single process, so it is as more convenient
to execute as a single process later on a different set of inputs. No matter how many steps and different algorithms
it involves, a model is executed as a single algorithm, thus saving time and effort, especially for larger models.

Modelatorul poate fi deschis din meniul de prelucrare.

Modelatorul are un canevas de lucru în care sunt prezentate structura modelului s, i fluxul de lucru pe acesta care
îl reprezintă. În partea stângă a ferestrei, poate fi folosit un panou cu două file, pentru a adăuga noi elemente
modelului.

Crearea unui model de implică două etape:

1. Definirea intrărilor necesare. Aceste intrări vor fi adăugate la fereastra parametrilor, astfel încât utilizatorul
să le poată seta valorile la momentul execut,iei modelului. Modelul în sine reprezintă un algoritm, astfel
încât fereastra parametrilor este generată automat, as, a cum se întâmplă cu tot,i algoritmii disponibili în
cadrul procesării.

2. Definition of the workflow. Using the input data of the model, the workflow is defined by adding algorithms
and selecting how they use those inputs or the outputs generated by other algorithms already in the model.

20.5.1 Definit,ia intrărilor

The first step to create a model is to define the inputs it needs. The following elements are found in the Inputs tab
on the left side of the modeler window:

• Stratul raster

• Stratul vectorial
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Figure 20.18: Modelatorul

• S, irul

• Câmpul tabelei

• Tabela

• Extinderea

• Numărul

• Boolean

• Fis, ierul

Double-clicking on any of these elements, a dialog is shown to define its characteristics. Depending on the
parameter itself, the dialog may contain just one basic element (the description, which is what the user will see
when executing the model) or more of them. For instance, when adding a numerical value, as can be seen in the
next figure, apart from the description of the parameter, you have to set a default value and a range of valid values.

Figure 20.19: Definirea Parametrilor Modelului

Pentru fiecare intrare adăugată, un element nou este adăugat pe canevasul modelatorului.
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Figure 20.20: Model Parameters in canvas

Putet,i adăuga intrări, de asemenea, prin glisarea tipului de intrare din listă, s, i fixarea lui în canevasul modelatorului,
în pozit,ia în care dorit,i să-l plasat,i.

20.5.2 Definit,ia fluxului de lucru

Once the inputs have been defined, it is time to define the algorithms to apply on them. Algorithms can be found
in the Algorithms tab, grouped much in the same way as they are in the toolbox.

Figure 20.21: Model Inputs

To add an algorithm to a model, double-click on its name or drag and drop it, just like it was done when adding
inputs. An execution dialog will appear, with a content similar to the one found in the execution panel that is shown
when executing the algorithm from the toolbox. The one shown next corresponds to the SAGA ‘Convergence
index’ algorithm.

As you can see, some differences exist. Instead of the file output box that was used to set the file path for output
layers and tables, a simple text box is used here. If the layer generated by the algorithm is just a temporary result
that will be used as the input of another algorithm and should not be kept as a final result, just do not edit that text
box. Typing anything in it means that the result is final and the text that you supply will be the description for the
output, which will be the output the user will see when executing the model.

Selecting the value of each parameter is also a bit different, since there are important differences between the
context of the modeler and that of the toolbox. Let’s see how to introduce the values for each type of parameter.

• Layers (raster and vector) and tables. These are selected from a list, but in this case, the possible values are
not the layers or tables currently loaded in QGIS, but the list of model inputs of the corresponding type, or
other layers or tables generated by algorithms already added to the model.

• Numerical values. Literal values can be introduced directly in the text box. But this text box is also a list
that can be used to select any of the numerical value inputs of the model. In this case, the parameter will
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Figure 20.22: Model Algorithm parameters

take the value introduced by the user when executing the model.

• String. As in the case of numerical values, literal strings can be typed, or an input string can be selected.

• Table field. The fields of the parent table or layer cannot be known at design time, since they depend on the
selection of the user each time the model is executed. To set the value for this parameter, type the name of
a field directly in the text box, or use the list to select a table field input already added to the model. The
validity of the selected field will be checked at run time.

In all cases, you will find an additional parameter named Parent algorithms that is not available when calling
the algorithm from the toolbox. This parameter allows you to define the order in which algorithms are executed
by explicitly defining one algorithm as a parent of the current one, which will force the parent algorithm to be
executed before the current one.

When you use the output of a previous algorithm as the input of your algorithm, that implicitly sets the previous
algorithm as parent of the current one (and places the corresponding arrow in the modeler canvas). However,
in some cases an algorithm might depend on another one even if it does not use any output object from it (for
instance, an algorithm that executes a SQL sentence on a PostGIS database and another one that imports a layer
into that same database). In that case, just select the previous algorithm in the Parent algorithms parameter and
the two steps will be executed in the correct order.

Once all the parameters have been assigned valid values, click on [OK] and the algorithm will be added to the
canvas. It will be linked to all the other elements in the canvas, whether algorithms or inputs, that provide objects
that are used as inputs for that algorithm.

Elementele pot fi deplasate într-o pozit,ie diferită pe canevas, pentru a schimba modul în care este afis, ată structura
modulului, făcându-l mai clar s, i mai intuitiv. Legăturile dintre elemente sunt automat actualizate. Îl putet,i mări s, i
mics, ora cu ajutorul rotit,ei mouse-ului.

You can run your algorithm any time by clicking on the [Run] button. However, in order to use the algorithm
from the toolbox, it has to be saved and the modeler dialog closed, to allow the toolbox to refresh its contents.

20.5.3 Salvarea s, i încărcarea modelelor

Use the [Save] button to save the current model and the [Open] button to open any model previously saved.
Models are saved with the .model extension. If the model has been previously saved from the modeler window,
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you will not be prompted for a filename. Since there is already a file associated with that model, the same file will
be used for any subsequent saves.

Înainte de a salva un model, trebuie să introducet,i un nume s, i un grup pentru el, folosind casetele de text din partea
de sus a ferestrei.

Models saved on the models folder (the default folder when you are prompted for a filename to save the model)
will appear in the toolbox in the corresponding branch. When the toolbox is invoked, it searches the models
folder for files with the .model extension and loads the models they contain. Since a model is itself an algorithm,
it can be added to the toolbox just like any other algorithm.

Dosarul modelelor poate fi setat din dialogul de configurare pentru Processing, conform grupului Modeler.

Models loaded from the models folder appear not only in the toolbox, but also in the algorithms tree in the
Algorithms tab of the modeler window. That means that you can incorporate a model as a part of a bigger model,
just as you add any other algorithm.

20.5.4 Editarea unui model

Putet,i edita modelul pe care îl creat,i în mod curent, să redefinit,i fluxul de lucru s, i relat,iile dintre algoritmi s, i
intrările care definesc modelul în sine.

Dacă facet,i clic-dreapta pe un algoritm din canevas reprezentând modelul, vet,i vedea un meniu contextual ca cel
prezentat în continuare:

Figure 20.23: Clic-Dreapta pe Modelator

Selecting the Remove option will cause the selected algorithm to be removed. An algorithm can be removed only
if there are no other algorithms depending on it. That is, if no output from the algorithm is used in a different one
as input. If you try to remove an algorithm that has others depending on it, a warning message like the one you
can see below will be shown:

Figure 20.24: Nu se Poate S, terge Algoritmul

Selecting the Edit option will show the parameters dialog of the algorithm, so you can change the inputs and
parameter values. Not all input elements available in the model will appear in this case as available inputs. Layers
or values generated at a more advanced step in the workflow defined by the model will not be available if they
cause circular dependencies.

Select the new values and then click on the [OK] button as usual. The connections between the model elements
will change accordingly in the modeler canvas.

A model can be run partially, by deactivating some of its algorithms. To do it, select the Deactivate option in the
context menu that appears when right-clicking on an algorithm element. The selected algorithm, and all the ones
in the model that depend on it will be displayed in grey and will not be executed as part of the model.
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Figure 20.25: Modelul cu Algoritmi Deactivat,i

When right-clicking on an algorithm that is not active, you will instead see a Activate menu option that you can
use to activate it back.

20.5.5 Editarea fis, ierelor de ajutor s, i a meta-informat,iilor modelului

You can document your models from the modeler itself. Just click on the [Edit model help] button and a dialog
like the one shown next will appear.

Figure 20.26: Edit,ia Ajutorului

On the right-hand side, you will see a simple HTML page, created using the description of the input parameters
and outputs of the algorithm, along with some additional items like a general description of the model or its author.
The first time you open the help editor, all these descriptions are empty, but you can edit them using the elements
on the left-hand side of the dialog. Select an element on the upper part and then write its description in the text
box below.

Modelul ajutorului este salvat ca parte a modelului în sine.

20.5.6 Exporting a model as a Python script

As we will see in a later chapter, Processing algorithms can be called from the QGIS Python console, and new
Processing algorithms can be created as well using Python. A quick way of creating such a Python script is to
create a model and then to export is as a Python file.
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To do so, click on the Export as Python script button. Select the output file in the file chooser dialog, and
Processing will write in it the Python commands that perform the same operations defined in the current model.

20.5.7 Despre algoritmii disponibili

You might notice that some algorithms that can be be executed from the toolbox do not appear in the list of
available algorithms when you are designing a model. To be included in a model, an algorithm must have a
correct semantic, so as to be properly linked to others in the workflow. If an algorithm does not have such a
well-defined semantic (for instance, if the number of output layers cannot be known in advance), then it is not
possible to use it within a model, and thus, it does not appear in the list of algorithms that you can find in the
modeler dialog.

Additionally, you will see some algorithms in the modeler that are not found in the toolbox. These algorithms are
meant to be used exclusively as part of a model, and they are of no interest in a different context. The ‘Calculator’
algorithm is an example of that. It is just a simple arithmetic calculator that you can use to modify numerical
values (entered by the user or generated by some other algorithm). This tool is really useful within a model, but
outside of that context, it doesn’t make too much sense.

20.6 Interfat,a de prelucrare în serie

20.6.1 Introducere

All algorithms (including models) can be executed as a batch process. That is, they can be executed using not just
a single set of inputs, but several of them, executing the algorithm as many times as needed. This is useful when
processing large amounts of data, since it is not necessary to launch the algorithm many times from the toolbox.

Pentru a executa un algoritm sub formă de procedeu în serie, facet,i clic-dreapta pe numele său din caseta de
instrumente, apoi selectat,i opt,iunea Execute as batch process din meniul pop-up care va apărea.

Figure 20.27: Batch Processing from right-click

Dacă avet,i deschis dialogul de execut,ie a algoritmului, tot de acolo putet,i lansa interfat,a de prelucrare în serie,
făcând clic pe butonul de Executare ca proces în serie....

20.6.2 Tabela parametrilor

Executarea unui proces în serie este similară execut,iei unui singur algoritm. Des, i valorile parametrilor trebuie să
fie definite, în acest caz nu este de ajuns o singură valoare pentru fiecare parametru, ci un set, câte unul pentru
fiecare execut,ie a algoritmului. Valorile sunt introduse cu ajutorul unui tabel asemănător cu cel prezentat în
continuare.

Fiecare linie a tabelului reprezintă o singură execut,ie a algoritmului, iar fiecare celulă cont,ine valoarea unuia dintre
parametri. Acesta este similar cu dialogul parametrilor pe care îl vedet,i la execut,ia unui algoritm din caseta de
instrumente, însă cu un alt aranjament.

În mod implicit, tabelul cont,ine doar două rânduri. Putet,i adăuga sau elimina rânduri folosind butoanele din partea
de jos a ferestrei.
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Figure 20.28: Procesarea în Serie din Dialogul Algoritmului

Figure 20.29: Procesarea în Serie
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O dată ce dimensiunea tabelei a fost stabilită, acesta trebuie să fie umplută cu valorile dorite.

20.6.3 Completarea tabelei cu parametri

Pentru majoritatea parametrilor, setarea valorii este trivială. Trebuie doar să tastat,i valoarea sau să o selectat,i din
lista de opt,iuni disponibile, în funct,ie de tipul parametrului.

Filenames for input data objects are introduced directly typing or, more conveniently, clicking on the button
on the right hand of the cell, which will show a context menu with two option: one for selecting from the layers
currently opened and another to select from the filesystem. This second option, when selected, shows a typical
file chooser dialog. Multiple files can be selected at once. If the input parameter represents a single data object
and several files are selected, each one of them will be put in a separate row, adding new ones if needed. If the
parameter represents a multiple input, all the selected files will be added to a single cell, separated by semicolons
(;).

Identificatorii stratului pot fi introdus, i direct în caseta de text a parametrilor. Putet,i introduce calea completă către
un fis, ier sau numele unui strat care este încărcat în proiectul QGIS curent. Numele stratului va fi atas, at în mod
automat căii sursă. Ret,inet,i că, în cazul în care mai multe straturi au acelas, i nume, acest lucru ar putea duce la
rezultate neas, teptate, din cauza ambiguităt,ii.

Obiectele datelor de ies, ire sunt întotdeauna salvate într-un fis, ier s, i, spre deosebire de executarea unui algoritm din
caseta de instrumente, salvarea într-un fis, ier temporar sau într-o bază de date nu este permisă. Putet,i introduce
numele în mod direct sau de a folosi dialogul selectorului de fis, iere, care apare când facet,i clic pe butonul însot,itor.

După ce at,i selectat fis, ierul, este prezentat un nou dialog, care permite autocompletarea altor celule din aceeas, i
coloană (acelas, i parametru).

Figure 20.30: Salvarea Procesării în Serie

În cazul în care este selectată valoarea implicită (‘Autocompletarea nu are loc’), numele fis, ierului selectat va fi
introdus în celula selectată din tabelul de parametri. Dacă oricare dintre celelalte opt,iuni este selectată, atunci
toate celulele aflate sub cea selectată vor fi automat completate, pe baza unor criterii definite. În acest fel, este
mult mai us, oară completarea tabelei, procesul în serie putându-se defini cu efort redus.

Completarea automată se poate face prin simpla adăugare de numere corelative la calea fis, ierului selectat, sau prin
adăugarea valorii unui alt câmp în acelas, i rând. Acest lucru este deosebit de util pentru a denumi obiectele datelor
de ies, ire în funct,ie de cele de intrare.

20.6.4 Executare ca proces în serie

To execute the batch process once you have introduced all the necessary values, just click on [OK]. Progress of
the global batch task will be shown in the progress bar in the lower part of the dialog.

20.7 Utilizarea algoritmilor de procesare din consolă

The console allows advanced users to increase their productivity and perform complex operations that cannot be
performed using any of the other GUI elements of the processing framework. Models involving several algorithms
can be defined using the command-line interface, and additional operations such as loops and conditional sentences
can be added to create more flexible and powerful workflows.
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Figure 20.31: Calea către Fis, ierul de Procesare în Serie

There is not a processing console in QGIS, but all processing commands are available instead from the QGIS
built-in Python console. That means that you can incorporate those commands into your console work and connect
processing algorithms to all the other features (including methods from the QGIS API) available from there.

Codul pe care îl putet,i executa din consola Python, chiar dacă nu apelează nici o metodă de procesare specifică,
poate fi transformat într-un nou algoritm pe care să îl putet,i apela mai târziu din caseta de instrumente, din mode-
latorul grafic sau dintr-o componentă, similar oricărui alt algoritm. De fapt, unii algoritmi pe care îi putet,i găsi în
caseta de instrumente sunt simple script-uri.

În această sect,iune, vom vedea cum se utilizează algoritmii de procesare din Consola Python a QGIS, s, i, de
asemenea, cum să scriet,i algoritmi folosind Python.

20.7.1 Apelarea algoritmilor din consola Python

Primul lucru pe care trebuie să-l facet,i, este de a importa funct,iile de prelucrare cu ajutorul următoarei linii:

>>> import processing

Now, there is basically just one (interesting) thing you can do with that from the console: execute an algorithm.
That is done using the runalg() method, which takes the name of the algorithm to execute as its first parameter,
and then a variable number of additional parameters depending on the requirements of the algorithm. So the first
thing you need to know is the name of the algorithm to execute. That is not the name you see in the toolbox, but
rather a unique command–line name. To find the right name for your algorithm, you can use the algslist()
method. Type the following line in your console:

>>> processing.alglist()

You will see something like this.

Accumulated Cost (Anisotropic)-------->saga:accumulatedcost(anisotropic)
Accumulated Cost (Isotropic)---------->saga:accumulatedcost(isotropic)
Add Coordinates to points------------->saga:addcoordinatestopoints
Add Grid Values to Points------------->saga:addgridvaluestopoints
Add Grid Values to Shapes------------->saga:addgridvaluestoshapes
Add Polygon Attributes to Points------>saga:addpolygonattributestopoints
Aggregate----------------------------->saga:aggregate
Aggregate Point Observations---------->saga:aggregatepointobservations
Aggregation Index--------------------->saga:aggregationindex
Analytical Hierarchy Process---------->saga:analyticalhierarchyprocess
Analytical Hillshading---------------->saga:analyticalhillshading
Average With Mask 1------------------->saga:averagewithmask1
Average With Mask 2------------------->saga:averagewithmask2
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Average With Thereshold 1------------->saga:averagewiththereshold1
Average With Thereshold 2------------->saga:averagewiththereshold2
Average With Thereshold 3------------->saga:averagewiththereshold3
B-Spline Approximation---------------->saga:b-splineapproximation
...

That’s a list of all the available algorithms, alphabetically ordered, along with their corresponding command-line
names.

You can use a string as a parameter for this method. Instead of returning the full list of algorithms, it will only
display those that include that string. If, for instance, you are looking for an algorithm to calculate slope from a
DEM, type alglist("slope") to get the following result:

DTM Filter (slope-based)-------------->saga:dtmfilter(slope-based)
Downslope Distance Gradient----------->saga:downslopedistancegradient
Relative Heights and Slope Positions-->saga:relativeheightsandslopepositions
Slope Length-------------------------->saga:slopelength
Slope, Aspect, Curvature-------------->saga:slopeaspectcurvature
Upslope Area-------------------------->saga:upslopearea
Vegetation Index[slope based]--------->saga:vegetationindex[slopebased]

This result might change depending on the algorithms you have available.

It is easier now to find the algorithm you are looking for and its command-line name, in this case
saga:slopeaspectcurvature.

Once you know the command-line name of the algorithm, the next thing to do is to determine the right syntax to
execute it. That means knowing which parameters are needed and the order in which they have to be passed when
calling the runalg() method. There is a method to describe an algorithm in detail, which can be used to get a
list of the parameters that an algorithm requires and the outputs that it will generate. To get this information, you
can use the alghelp(name_of_the_algorithm) method. Use the command-line name of the algorithm,
not the full descriptive name.

Calling the method with saga:slopeaspectcurvature as parameter, you get the following description:

>>> processing.alghelp("saga:slopeaspectcurvature")
ALGORITHM: Slope, Aspect, Curvature

ELEVATION <ParameterRaster>
METHOD <ParameterSelection>
SLOPE <OutputRaster>
ASPECT <OutputRaster>
CURV <OutputRaster>
HCURV <OutputRaster>
VCURV <OutputRaster>

Now you have everything you need to run any algorithm. As we have already mentioned, there is only one single
command to execute algorithms: runalg(). Its syntax is as follows:

>>> processing.runalg(name_of_the_algorithm, param1, param2, ..., paramN,
Output1, Output2, ..., OutputN)

The list of parameters and outputs to add depends on the algorithm you want to run, and is exactly the list that the
alghelp() method gives you, in the same order as shown.

Depending on the type of parameter, values are introduced differently. The next list gives a quick review of how
to introduce values for each type of input parameter:

• Raster Layer, Vector Layer or Table. Simply use a string with the name that identifies the data object to use
(the name it has in the QGIS Table of Contents) or a filename (if the corresponding layer is not opened, it
will be opened but not added to the map canvas). If you have an instance of a QGIS object representing the
layer, you can also pass it as parameter. If the input is optional and you do not want to use any data object,
use None.

• Selection. If an algorithm has a selection parameter, the value of that parameter should be entered using an
integer value. To know the available options, you can use the algoptions() command, as shown in the
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following example:

>>> processing.algoptions("saga:slopeaspectcurvature")
METHOD(Method)

0 - [0] Maximum Slope (Travis et al. 1975)
1 - [1] Maximum Triangle Slope (Tarboton 1997)
2 - [2] Least Squares Fitted Plane (Horn 1981, Costa-Cabral & Burgess 1996)
3 - [3] Fit 2.Degree Polynom (Bauer, Rohdenburg, Bork 1985)
4 - [4] Fit 2.Degree Polynom (Heerdegen & Beran 1982)
5 - [5] Fit 2.Degree Polynom (Zevenbergen & Thorne 1987)
6 - [6] Fit 3.Degree Polynom (Haralick 1983)

In this case, the algorithm has one such parameter, with seven options. Notice that ordering is zero-based.

• Multiple input. The value is a string with input descriptors separated by semicolons (;). As in the case of
single layers or tables, each input descriptor can be the data object name, or its file path.

• Table Field from XXX. Use a string with the name of the field to use. This parameter is case-sensitive.

• Tabel fix. Tastat,i lista tuturor valorilor din tabel, separate prin virgulă (,) s, i incluse între ghilimele (").
Introducerea valorilor începe cu rândul de sus s, i se desfăs, oară de la stânga la dreapta. De asemenea, putet,i
utiliza o matrice 2-D cu valori care reprezintă tabelul.

• CRS. Introducet,i numărul de cod EPSG pentr CRS-ul dorit.

• Extindere. Trebuie să utilizat,i un s, ir cu valorile xmin, xmax, ymin s, i ymax separate prin virgule (,).

Parametrii boolean, fis, ier, s, ir s, i numeric nu au nevoie de explicat,ii suplimentare.

Input parameters such as strings, booleans, or numerical values have default values. To use them, specify None
in the corresponding parameter entry.

For output data objects, type the file path to be used to save it, just as it is done from the toolbox. If you want to
save the result to a temporary file, use None. The extension of the file determines the file format. If you enter
a file extension not supported by the algorithm, the default file format for that output type will be used, and its
corresponding extension appended to the given file path.

Unlike when an algorithm is executed from the toolbox, outputs are not added to the map canvas if you execute
that same algorithm from the Python console. If you want to add an output to the map canvas, you have to do it
yourself after running the algorithm. To do so, you can use QGIS API commands, or, even easier, use one of the
handy methods provided for such tasks.

The runalg method returns a dictionary with the output names (the ones shown in the algorithm description)
as keys and the file paths of those outputs as values. You can load those layers by passing the corresponding file
paths to the load() method.

20.7.2 Additional functions for handling data

Apart from the functions used to call algorithms, importing the processing package will also import some
additional functions that make it easier to work with data, particularly vector data. They are just convenience
functions that wrap some functionality from the QGIS API, usually with a less complex syntax. These functions
should be used when developing new algorithms, as they make it easier to operate with input data.

Below is a list of some of these commands. More information can be found in the classes under the
processing/tools package, and also in the example scripts provided with QGIS.

• getObject(obj): Returns a QGIS object (a layer or table) from the passed object, which can be a
filename or the name of the object in the QGIS Layers List

• values(layer, fields): Returns the values in the attributes table of a vector layer, for the passed
fields. Fields can be passed as field names or as zero-based field indices. Returns a dict of lists, with the
passed field identifiers as keys. It considers the existing selection.

• features(layer): Returns an iterator over the features of a vector layer, considering the existing
selection.
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• uniqueValues(layer, field): Returns a list of unique values for a given attribute. Attributes can
be passed as a field name or a zero-based field index. It considers the existing selection.

20.7.3 Crearea script-urilor s, i execut,ia lor din caseta de instrumente

You can create your own algorithms by writing the corresponding Python code and adding a few extra lines to
supply additional information needed to define the semantics of the algorithm. You can find a Create new script
menu under the Tools group in the Script algorithms block of the toolbox. Double-click on it to open the script
editing dialog. That’s where you should type your code. Saving the script from there in the scripts folder (the
default folder when you open the save file dialog) with .py extension will automatically create the corresponding
algorithm.

The name of the algorithm (the one you will see in the toolbox) is created from the filename, removing its extension
and replacing low hyphens with blank spaces.

Let’s have a look at the following code, which calculates the Topographic Wetness Index (TWI) directly from a
DEM.

##dem=raster
##twi=output
ret_slope = processing.runalg("saga:slopeaspectcurvature", dem, 0, None,

None, None, None, None)
ret_area = processing.runalg("saga:catchmentarea(mass-fluxmethod)", dem,

0, False, False, False, False, None, None, None, None, None)
processing.runalg("saga:topographicwetnessindex(twi), ret_slope[’SLOPE’],

ret_area[’AREA’], None, 1, 0, twi)

As you can see, the calculation involves three algorithms, all of them coming from SAGA. The last one calculates
the TWI, but it needs a slope layer and a flow accumulation layer. We do not have these layers, but since we have
the DEM, we can calculate them by calling the corresponding SAGA algorithms.

The part of the code where this processing takes place is not difficult to understand if you have read the previous
sections in this chapter. The first lines, however, need some additional explanation. They provide the information
that is needed to turn your code into an algorithm that can be run from any of the GUI components, like the toolbox
or the graphical modeler.

These lines start with a double Python comment symbol (##) and have the following structure:

[parameter_name]=[parameter_type] [optional_values]

Here is a list of all the parameter types that are supported in processing scripts, their syntax and some examples.

• raster. A raster layer.

• vector. A vector layer.

• table. A table.

• number. A numerical value. A default value must be provided. For instance, depth=number 2.4.

• string. A text string. As in the case of numerical values, a default value must be added. For instance,
name=string Victor.

• boolean. A boolean value. Add True or False after it to set the default value. For example,
verbose=boolean True.

• multiple raster. A set of input raster layers.

• multiple vector. A set of input vector layers.

• field. A field in the attributes table of a vector layer. The name of the layer has to be added after the
field tag. For instance, if you have declared a vector input with mylayer=vector, you could use
myfield=field mylayer to add a field from that layer as parameter.

• folder. A folder.

• file. A filename.

386 Chapter 20. Cadrul de procesare al QGIS



QGIS User Guide, Release 2.18

The parameter name is the name that will be shown to the user when executing the algorithm, and also the variable
name to use in the script code. The value entered by the user for that parameter will be assigned to a variable with
that name.

When showing the name of the parameter to the user, the name will be edited to improve its appearance, replacing
low hyphens with spaces. So, for instance, if you want the user to see a parameter named A numerical
value, you can use the variable name A_numerical_value.

Layers and table values are strings containing the file path of the corresponding object. To turn them into a QGIS
object, you can use the processing.getObjectFromUri() function. Multiple inputs also have a string
value, which contains the file paths to all selected object, separated by semicolons (;).

Outputs are defined in a similar manner, using the following tags:

• output raster

• output vector

• output table

• output html

• output file

• output number

• output string

The value assigned to the output variables is always a string with a file path. It will correspond to a temporary file
path in case the user has not entered any output filename.

When you declare an output, the algorithm will try to add it to QGIS once it is finished. That is why, although the
runalg() method does not load the layers it produces, the final TWI layer will be loaded (using the case of our
previous example), since it is saved to the file entered by the user, which is the value of the corresponding output.

Do not use the load() method in your script algorithms, just when working with the console line. If a layer is
created as output of an algorithm, it should be declared as such. Otherwise, you will not be able to properly use
the algorithm in the modeler, since its syntax (as defined by the tags explained above) will not match what the
algorithm really creates.

Hidden outputs (numbers and strings) do not have a value. Instead, you have to assign a value to them. To do so,
just set the value of a variable with the name you used to declare that output. For instance, if you have used this
declaration,

##average=output number

the following line will set the value of the output to 5:

average = 5

In addition to the tags for parameters and outputs, you can also define the group under which the algorithm will
be shown, using the group tag.

If your algorithm takes a long time to process, it is a good idea to inform the user. You have a global named
progress available, with two possible methods: setText(text) and setPercentage(percent) to
modify the progress text and the progress bar.

Several examples are provided. Please check them to see real examples of how to create algorithms using the
processing framework classes. You can right-click on any script algorithm and select Edit script to edit its code or
just to see it.

20.7.4 Documentarea script-urilor

As in the case of models, you can create additional documentation for your scripts, to explain what they do and
how to use them. In the script editing dialog, you will find an [Edit script help] button. Click on it and it will
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take you to the help editing dialog. Check the section about the graphical modeler to know more about this dialog
and how to use it.

Help files are saved in the same folder as the script itself, adding the .help extension to the filename. Notice that
you can edit your script’s help before saving the script for the first time. If you later close the script editing dialog
without saving the script (i.e., you discard it), the help content you wrote will be lost. If your script was already
saved and is associated to a filename, saving the help content is done automatically.

20.7.5 Script de interceptare a pre- s, i post-execut,iei

Scripts can also be used to set pre- and post-execution hooks that are run before and after an algorithm is run. This
can be used to automate tasks that should be performed whenever an algorithm is executed.

The syntax is identical to the syntax explained above, but an additional global variable named alg is available,
representing the algorithm that has just been (or is about to be) executed.

In the General group of the processing configuration dialog, you will find two entries named Pre-execution script
file and Post-execution script file where the filename of the scripts to be run in each case can be entered.

20.8 Writing new Processing algorithms as python scripts

You can create your own algorithms by writing the corresponding Python code and adding a few extra lines to
supply additional information needed to define the semantics of the algorithm. You can find a Create new script
menu under the Tools group in the Script algorithms block of the toolbox. Double-click on it to open the script
edition dialog. That’s where you should type your code. Saving the script from there in the scripts folder (the
default one when you open the save file dialog), with .py extension, will automatically create the corresponding
algorithm.

The name of the algorithm (the one you will see in the toolbox) is created from the filename, removing its extension
and replacing underscores with blank spaces.

Let’s have the following code, which calculates the Topographic Wetness Index (TWI) directly from a DEM

##dem=raster
##twi=output raster
ret_slope = processing.runalg("saga:slopeaspectcurvature", dem, 0, None,

None, None, None, None)
ret_area = processing.runalg("saga:catchmentarea", dem,

0, False, False, False, False, None, None, None, None, None)
processing.runalg("saga:topographicwetnessindextwi, ret_slope[’SLOPE’],

ret_area[’AREA’], None, 1, 0, twi)

As you can see, it involves 3 algorithms, all of them coming from SAGA. The last one of them calculates the TWI,
but it needs a slope layer and a flow accumulation layer. We do not have these, but since we have the DEM, we
can calculate them by calling the corresponding SAGA algorithms.

The part of the code where this processing takes place is not difficult to understand if you have read the previous
chapter. The first lines, however, need some additional explanation. They provide the information that is needed to
turn your code into an algorithm that can be run from any of the GUI components, like the toolbox or the graphical
modeler.

These lines start with a double Python comment symbol (##) and have the following structure

[parameter_name]=[parameter_type] [optional_values]

Here is a list of all the parameter types that are supported in processing scripts, their syntax and some examples.

• raster. A raster layer

• vector. A vector layer

• table. A table
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• number. A numerical value. A default value must be provided. For instance, depth=number 2.4

• string. A text string. As in the case of numerical values, a default value must be added. For instance,
name=string Victor

• longstring. Same as string, but a larger text box will be shown, so it is better suited for long strings,
such as for a script expecting a small code snippet.

• boolean. A boolean value. Add True or False after it to set the default value. For example,
verbose=boolean True.

• multiple raster. A set of input raster layers.

• multiple vector. A set of input vector layers.

• field. A field in the attributes table of a vector layer. The name of the layer has to be added after the
field tag. For instance, if you have declared a vector input with mylayer=vector, you could use
myfield=field mylayer to add a field from that layer as parameter.

• extent. A spatial extent defined by xmin, xmax, ymin, ymax

• folder. A folder

• file. A filename

• crs. A Coordinate Reference System

• selection. A dropdown menu that allows the user to select from a pre-populated list. For example
units=selection sq_km;sq_miles;sq_degrees

• name. Name of the script. This will be displayed as the algorithm name in the processing toolbox. For
example My Algorithm Name=name

• group. Folder name where the script will appear in the Processing Toolbox. For Example, adding
Utils=groups will put the script within a Utils folder within Scripts.

The parameter name is the name that will be shown to the user when executing the algorithm, and also the variable
name to use in the script code. The value entered by the user for that parameter will be assigned to a variable with
that name.

When showing the name of the parameter to the user, the name will be edited to improve its appearance, replacing
underscores with spaces. So, for instance, if you want the user to see a parameter named A numerical value,
you can use the variable name A_numerical_value.

Layers and tables values are strings containing the filepath of the corresponding object. To turn them into a QGIS
object, you can use the processing.getObjectFromUri() function. Multiple inputs also have a string
value, which contains the filepaths to all selected objects, separated by semicolons (;).

Outputs are defined in a similar manner, using the following tags:

• output raster

• output vector

• output table

• output html

• output file

• output number

• output string

• output extent

The value assigned to the output variables is always a string with a filepath. It will correspond to a temporary
filepath in case the user has not entered any output filename.

In addition to the tags for parameters and outputs, you can also define the group under which the algorithm will
be shown, using the group tag.
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The last tag that you can use in your script header is ##nomodeler. Use that when you do not want your
algorithm to be shown in the modeler window. This should be used for algorithms that do not have a clear syntax
(for instance, if the number of layers to be created is not known in advance, at design time), which make them
unsuitable for the graphical modeler

20.8.1 Manipularea datelor produse de algoritm

When you declare an output representing a layer (raster, vector or table), the algorithm will try to add it to QGIS
once it is finished. That is the reason why, although the runalg() method does not load the layers it produces,
the final TWI layer will be loaded, since it is saved to the file entered by the user, which is the value of the
corresponding output.

Do not use the load() method in your script algorithms, but just when working with the console line. If a layer
is created as output of an algorithm, it should be declared as such. Otherwise, you will not be able to properly
use the algorithm in the modeler, since its syntax (as defined by the tags explained above) will not match what the
algorithm really creates.

Hidden outputs (numbers and strings) do not have a value. Instead, it is you who has to assign a value to them. To
do so, just set the value of a variable with the name you used to declare that output. For instance, if you have used
this declaration,

##average=output number

the following line will set the value of the output to 5:

average = 5

20.8.2 Comunicarea cu utilizatorul

If your algorithm takes a long time to process, it is a good idea to inform the user. You have a global named
progress available, with two available methods: setText(text) and setPercentage(percent) to
modify the progress text and the progress bar.

If you have to provide some information to the user, not related to the progress of the algorithm, you can use the
setInfo(text) method, also from the progress object.

If your script has some problem, the correct way of propagating it is to raise an exception of type
GeoAlgorithmExecutionException(). You can pass a message as argument to the constructor of the
exception. Processing will take care of handling it and communicating with the user, depending on where the
algorithm is being executed from (toolbox, modeler, Python console...)

20.8.3 Documentarea script-urilor

As in the case of models, you can create additional documentation for your script, to explain what they do and
how to use them. In the script editing dialog you will find a [Edit script help] button. Click on it and it will take
you to the help editing dialog. Check the chapter about the graphical modeler to find out more about this dialog
and how to use it.

Help files are saved in the same folder as the script itself, adding the .help extension to the filename. Note that
you can edit your script’s help before saving it for the first time. If you later close the script editing dialog without
saving the script (i.e. you discard it), the help content you wrote will be lost. If your script was already saved and
is associated with a filename, saving is done automatically.

20.8.4 Example scripts

Several examples are available in the on-line collection of scripts, which you can access by selecting the Get script
from on-line script collection tool under the Scripts/tools entry in the toolbox.
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Figure 20.32: Processing Get Script

Please, check them to see real examples of how to create algorithms using the processing framework classes. You
can right-click on any script algorithm and select Edit script to edit its code or just to see it.

20.8.5 Cele mai bune practici pentru scrierea algoritmilor pentru script

Here’s a quick summary of ideas to consider when creating your script algorithms and, especially, if you want to
share with other QGIS users. Following these simple rules will ensure consistency across the different Processing
elements such as the toolbox, the modeler or the batch processing interface.

• Do not load resulting layers. Let Processing handle your results and load your layers if needed.

• Always declare the outputs your algorithm creates. Avoid things such as declaring one output and then
using the destination filename set for that output to create a collection of them. That will break the correct
semantics of the algorithm and make it impossible to use it safely in the modeler. If you have to write an
algorithm like that, make sure you add the ##nomodeler tag.

• Do not show message boxes or use any GUI element from the script. If you want to communicate with the
user, use the setInfo() method or throw an GeoAlgorithmExecutionException

• As a rule of thumb, do not forget that your algorithm might be executed in a context other than the Processing
toolbox.

20.8.6 Pre- and post-execution script hooks

Scripts can also be used to set pre- and post-execution hooks that are run before and after an algorithm is run. This
can be used to automate tasks that should be performed whenever an algorithm is executed.

The syntax is identical to the syntax explained above, but an additional global variable named alg is available,
representing the algorithm that has just been (or is about to be) executed.

In the General group of the processing config dialog you will find two entries named Pre-execution script file and
Post-execution script file where the filename of the scripts to be run in each case can be entered.

20.9 Configurarea Aplicat,iilor Externe

The processing framework can be extended using additional applications. Currently, SAGA, GRASS, OTB (Orfeo
Toolbox) and R are supported, along with some other command-line applications that provide spatial data analysis
functionalities. Algorithms relying on an external applications are managed by their own algorithm provider.

This section will show you how to configure the processing framework to include these additional applications,
and it will explain some particular features of the algorithms based on them. Once you have correctly configured
the system, you will be able to execute external algorithms from any component like the toolbox or the graphical
modeler, just like you do with any other geoalgorithm.

By default, all algorithms that rely on an external application not shipped with QGIS are not enabled. You can
enable them in the settings dialog. Make sure that the corresponding application is already installed in your
system.
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20.9.1 O notă pentru utilizatorii de Windows

If you are not an advanced user and you are running QGIS on Windows, you might not be interested in reading
the rest of this chapter. Make sure you install QGIS in your system using the standalone installer. That will
automatically install SAGA, GRASS and OTB in your system and configure them so they can be run from QGIS.
All the algorithms from these providers will be ready to be run without needing any further configuration. If
installing through OSGeo4W application, make sure you select for installation SAGA, GRASS and OTB as well.

If you want to know more about how these providers work, or if you want to use some algorithms not included in
the simplified toolbox (such as R scripts), keep on reading.

20.9.2 O notă privind formatele de fis, iere

When using an external software, opening a file in QGIS does not mean that it can be opened and processed as
well in that other software. In most cases, other software can read what you have opened in QGIS, but in some
cases, that might not be true. When using databases or uncommon file formats, whether for raster or vector layers,
problems might arise. If that happens, try to use well-known file formats that you are sure are understood by both
programs, and check the console output (in the history and log dialog) to know more about what is going wrong.

Utilizarea straturilor GRASS raster reprezintă, de exemplu, un caz în care at,i putea avea probleme, nefiind în
măsură să finalizat,i activitatea dacă apelat,i un algoritm extern asupra unui astfel de strat de intrare. Din acest
motiv, aceste straturi nu vor apărea ca fiind disponibile pentru algoritmi.

You should, however, find no problems at all with vector layers, since QGIS automatically converts from the
original file format to one accepted by the external application before passing the layer to it. This adds extra
processing time, which might be significant if the layer has a large size, so do not be surprised if it takes more
time to process a layer from a DB connection than it does to process one of a similar size stored in a shapefile.

Providers not using external applications can process any layer that you can open in QGIS, since they open it for
analysis through QGIS.

Regarding output formats, all formats supported by QGIS as output can be used, both for raster and vector layers.
Some providers do not support certain formats, but all can export to common formats that can later be transformed
by QGIS automatically. As in the case of input layers, if this conversion is needed, that might increase the
processing time.

20.9.3 O notă privind select,iile stratului vectorial

External applications may also be made aware of the selections that exist in vector layers within QGIS. However,
that requires rewriting all input vector layers, just as if they were originally in a format not supported by the
external application. Only when no selection exists, or the Use only selected features option is not enabled in the
processing general configuration, can a layer be directly passed to an external application.

În alte cazuri, este necesară exportarea doar a entităt,ilor selectate, care provoacă timpi de execut,ie mai lungi.

20.9.4 SAGA

SAGA algorithms can be run from QGIS if you have SAGA installed in your system and you configure the pro-
cessing framework properly so it can find SAGA executables. In particular, the SAGA command-line executable
is needed to run SAGA algorithms.

If you are running Windows, both the stand-alone installer and the OSGeo4W installer include SAGA along with
QGIS, and the path is automatically configured, so there is no need to do anything else.

If you have installed SAGA yourself and your QGIS installer did not include it, the path to the SAGA executable
must be configured. To do this, open the configuration dialog. In the SAGA block, you will find a setting named
SAGA Folder. Enter the path to the folder where SAGA is installed. Close the configuration dialog, and now you
are ready to run SAGA algorithms from QGIS.
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If you are running Linux, SAGA binaries are not included with Processing, so you have to download and install
the software yourself. Please check the SAGA website for more information.

In this case, there is no need to configure the path to the SAGA executable, and you will not see those folder entries.
Instead, you must make sure that SAGA is properly installed and its folder is added to the PATH environment
variable. Just open a console and type saga_cmd to check that the system can find where the SAGA binaries are
located.

Despre limitările sistemului grilă SAGA

Most SAGA algorithms that require several input raster layers require them to have the same grid system. That is,
they must cover the same geographic area and have the same cell size, so their corresponding grids match. When
calling SAGA algorithms from QGIS, you can use any layer, regardless of its cell size and extent. When multiple
raster layers are used as input for a SAGA algorithm, QGIS resamples them to a common grid system and then
passes them to SAGA (unless the SAGA algorithm can operate with layers from different grid systems).

Definirea acestui sistem grilă comun este controlată de către utilizator, acest lucru putând făcut din zona grupului
SAGA al ferestrei de setare. Există două modalităt,i de stabilire a sistemului grilă t,intă:

• Setare manuală. Putet,i defini extinderea, prin stabilirea valorilor următorilor parametri:

– Rees, antionare min X

– Rees, antionare max X

– Rees, antionare min Y

– Rees, antionare max Y

– Rees, antionare dimensiune celulă

Ret,inet,i că aplicat,ia QGIS va rees, antiona straturile de intrare la această extindere, chiar dacă acestea nu se
suprapun cu ea.

• Setare automată din straturile de intrare. Pentru a selecta această opt,iune, doar să verificat,i opt,iunea Use
min covering grid system for resampling. Toate celelalte setări vor fi ignorate, iar extinderea minimă care
acoperă toate straturile de intrare va fi utilizată. Dimensiunea celulei din stratul t,intă reprezintă maximul
dimensiunilor tuturor celulelor din straturile de intrare.

For algorithms that do not use multiple raster layers, or for those that do not need a unique input grid system, no
resampling is performed before calling SAGA, and those parameters are not used.

Limitări pentru straturile multi-bandă

Unlike QGIS, SAGA has no support for multi-band layers. If you want to use a multiband layer (such as an RGB or
multispectral image), you first have to split it into single-banded images. To do so, you can use the ‘SAGA/Grid
- Tools/Split RGB image’ algorithm (which creates three images from an RGB image) or the ‘SAGA/Grid -
Tools/Extract band’ algorithm (to extract a single band).

Limitări de mărime a celulelor

SAGA assumes that raster layers have the same cell size in the X and Y axis. If you are working with a layer with
different values for horizontal and vertical cell size, you might get unexpected results. In this case, a warning will
be added to the processing log, indicating that an input layer might not be suitable to be processed by SAGA.

Jurnalizare

When QGIS calls SAGA, it does so using its command-line interface, thus passing a set of commands to perform
all the required operations. SAGA shows its progress by writing information to the console, which includes the
percentage of processing already done, along with additional content. This output is filtered and used to update
the progress bar while the algorithm is running.
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Both the commands sent by QGIS and the additional information printed by SAGA can be logged along with other
processing log messages, and you might find them useful to track in detail what is going on when QGIS runs a
SAGA algorithm. You will find two settings, namely Log console output and Log execution commands, to activate
that logging mechanism.

Most other providers that use an external application and call it through the command-line have similar options,
so you will find them as well in other places in the processing settings list.

20.9.5 R. Creating R scripts

R integration in QGIS is different from that of SAGA in that there is not a predefined set of algorithms you can run
(except for a few examples). Instead, you should write your scripts and call R commands, much like you would do
from R, and in a very similar manner to what we saw in the section dedicated to processing scripts. This section
shows you the syntax to use to call those R commands from QGIS and how to use QGIS objects (layers, tables)
in them.

The first thing you have to do, as we saw in the case of SAGA, is to tell QGIS where your R binaries are located.
You can do this using the R folder entry in the processing configuration dialog. Once you have set that parameter,
you can start creating and executing your own R scripts.

Note: for Windows user, usually the R executable file is in the C:\Program Files\R\R-3.2 folder. Add
just the folder and NOT the binary!

Once again, this is different in Linux, and you just have to make sure that the R folder is included in the PATH
environment variable. If you can start R just typing R in a console, then you are ready to go.

To add a new algorithm that calls an R function (or a more complex R script that you have developed and you
would like to have available from QGIS), you have to create a script file that tells the processing framework how
to perform that operation and the corresponding R commands to do so.

R script files have the extension .rsx, and creating them is pretty easy if you just have a basic knowledge of R
syntax and R scripting. They should be stored in the R scripts folder. You can set this folder in the R settings group
(available from the processing settings dialog), just like you do with the folder for regular processing scripts.

Let’s have a look at a very simple script file, which calls the R method spsample to create a random grid within
the boundary of the polygons in a given polygon layer. This method belongs to the maptools package. Since
almost all the algorithms that you might like to incorporate into QGIS will use or generate spatial data, knowledge
of spatial packages like maptools and, especially, sp, is mandatory.

##polyg=vector
##numpoints=number 10
##output=output vector
##sp=group
pts=spsample(polyg,numpoints,type="random")
output=SpatialPointsDataFrame(pts, as.data.frame(pts))

The first lines, which start with a double Python comment sign (##), tell QGIS the inputs of the algorithm de-
scribed in the file and the outputs that it will generate. They work with exactly the same syntax as the Processing
scripts that we have already seen, so they will not be described here again.

Please have a look at the R Intro and the R Syntax Training Manual Chapters to have more information on how to
write your own R scripts-

When you declare an input parameter, QGIS uses that information for two things: creating the user interface to
ask the user for the value of that parameter and creating a corresponding R variable that can later be used as input
for R commands.

In the above example, we are declaring an input of type vector named polyg. When executing the algorithm,
QGIS will open in R the layer selected by the user and store it in a variable also named polyg. So, the name of
a parameter is also the name of the variable that we can use in R for accessing the value of that parameter (thus,
you should avoid using reserved R words as parameter names).
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Spatial elements such as vector and raster layers are read using the readOGR() and brick() commands (you
do not have to worry about adding those commands to your description file – QGIS will do it), and they are stored
as Spatial*DataFrame objects. Table fields are stored as strings containing the name of the selected field.

Tabelele sunt deschise folosind comanda read.csv(). În cazul în care un tabel introdus de către utilizator nu
este în format CSV, acesta va fi convertit înainte de importul în R.

În plus, fis, ierele raster pot fi citite prin utilizarea comenzii readGDAL() în loc de brick()‘‘atuni când
se foloses,te ‘‘##usereadgdal.

If you are an advanced user and do not want QGIS to create the object representing the layer, you can use the
##passfilenames tag to indicate that you prefer a string with the filename instead. In this case, it is up to you
to open the file before performing any operation on the data it contains.

Cu ajutorul informat,iilor de mai sus, putem înt,elege acum prima linie de primul nostru exemplu de script (prima
linie care nu începe cu un comentariu Python).

pts=spsample(polyg,numpoints,type="random")

The variable polygon already contains a SpatialPolygonsDataFrame object, so it can be used to call the
spsample method, just like the numpoints one, which indicates the number of points to add to the created
sample grid.

Since we have declared an output of type vector named out, we have to create a variable named out and store a
Spatial*DataFrame object in it (in this case, a SpatialPointsDataFrame). You can use any name for
your intermediate variables. Just make sure that the variable storing your final result has the same name that you
used to declare it, and that it contains a suitable value.

In this case, the result obtained from the spsample method has to be converted explicitly into a
SpatialPointsDataFrame object, since it is itself an object of class ppp, which is not a suitable class
to be returned to QGIS.

If your algorithm generates raster layers, the way they are saved will depend on whether or not you have used the
##dontuserasterpackage option. If you have used it, layers are saved using the writeGDAL() method.
If not, the writeRaster() method from the raster package will be used.

If you have used the ##passfilenames option, outputs are generated using the raster package (with
writeRaster()), even though it is not used for the inputs.

If your algorithm does not generate any layer, but rather a text result in the console instead, you have to indicate
that you want the console to be shown once the execution is finished. To do so, just start the command lines that
produce the results you want to print with the > (‘greater’) sign. The output of all other lines will not be shown.
For instance, here is the description file of an algorithm that performs a normality test on a given field (column) of
the attributes of a vector layer:

##layer=vector
##field=field layer
##nortest=group
library(nortest)
>lillie.test(layer[[field]])

The output of the last line is printed, but the output of the first is not (and neither are the outputs from other
command lines added automatically by QGIS).

Dacă algoritmul dvs. creează orice gen de grafic (folosind metoda plot()), adăugat,i următoarea linie:

##showplots

This will cause QGIS to redirect all R graphical outputs to a temporary file, which will be opened once R execution
has finished.

Ambele rezultate grafice cât s, i cele din consolă vor fi afis, ate în managerul rezultatelor procesării.

For more information, please check the script files provided with Processing. Most of them are rather simple and
will greatly help you understand how to create your own scripts.
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Note: rgdal and raster libraries are loaded by default, so you do not have to add the corresponding
library() commands (you just have to make sure that those two packages are installed in your R dis-
tribution). However, other additional libraries that you might need have to be explicitly loaded by typing,
library(ggplot2). If the package is not already installed on your machine, Processing will download and
install it. In this way the package will be also available in R Standalone. Be aware that if the package has to be
downloaded, the first time you run the script it might take a long time.

20.9.6 GRASS

Configuring GRASS is not much different from configuring SAGA. First, the path to the GRASS folder has to be
defined, but only if you are running Windows. Additionally, a shell interpreter (usually msys.exe, which can be
found in most GRASS for Windows distributions) has to be defined and its path set up as well.

By default, the processing framework tries to configure its GRASS connector to use the GRASS distribution that
ships along with QGIS. This should work without problems in most systems, but if you experience problems, you
might have to configure the GRASS connector manually. Also, if you want to use a different GRASS installation,
you can change that setting and point to the folder where the other version is installed. GRASS 6.4 is needed for
algorithms to work correctly.

Dacă lucrat,i pe Linux, trebuie doar să vă asigurat,i că GRASS este instalat corect s, i că poate fi rulat fără probleme
de la o consolă.

GRASS algorithms use a region for calculations. This region can be defined manually using values similar to
the ones found in the SAGA configuration, or automatically, taking the minimum extent that covers all the input
layers used to execute the algorithm each time. If the latter approach is the behavior you prefer, just check the Use
min covering region option in the GRASS configuration parameters.

20.9.7 GDAL

No additional configuration is needed to run GDAL algorithms. Since they are already incorporated into QGIS,
the algorithms can infer their configuration from it.

20.9.8 Orfeo Toolbox

Orfeo Toolbox (OTB) algorithms can be run from QGIS if you have OTB installed in your system and you have
configured QGIS properly, so it can find all necessary files (command-line tools and libraries).

As in the case of SAGA, OTB binaries are included in the stand-alone installer for Windows, but they are not
included if you are running Linux, so you have to download and install the software yourself. Please check the
OTB website for more information.

Once OTB is installed, start QGIS, open the processing configuration dialog and configure the OTB algorithm
provider. In the Orfeo Toolbox (image analysis) block, you will find all settings related to OTB. First, ensure that
algorithms are enabled.

Then, configure the path to the folder where OTB command-line tools and libraries are installed:

• Usually OTB applications folder points to /usr/lib/otb/applications and OTB command line
tools folder is /usr/bin.

• If you use any of the installers that include OTB, such as OSGeo4W, there is no need for further con-
figuration. Processing will detect the path automatically and will not show the corresponding configuration
entries. Otherwise, fill the OTB applications folder and OTB command line tools folder parameters with the
to the corresponding values for your installation.
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20.9.9 TauDEM

TauDEM (Terrain Analysis Using Digital Elevation Models) is a tools for the extraction and analysis of hydrolog-
ical information from Digital Elevation Models (DEM). TauDEM can be used from QGIS if you have it installed
in your system and configured QGIS properly, so it can find all necessary files.

There are two versions of TauDEM tools: singlefile (TauDEM 5.0.6 or 5.1.2) and multifile (TauDEM 5.2.0). The
difference between these versions in the supported inputs/outputs. Single files version accepts only single raster
file and write single file as output. Multifile version accepts a directory with rasters and writes directory with
rasters as output. Such directory should contain rasters that will be treated as a single DEM grid.

TauDEM Processing provider supports both single- and multifile versions of TauDEM and even allows to use them
simultaneously.

Note: While TauDEM Processing provider supports TauDEM 5.0.6, 5.1.2 and 5.2.0 we recommend to use 5.1.2
and/or 5.2.0 as this versions have some new tools available, like Gage Watershed and TWI.

Installing TauDEM under Windows

Please visit the TauDEM homepage and download desired version of the precompiled binaries for your platform
(32-bit or 64-bit), usually this is “Command Line Executables”. Also you need to download Microsoft HPC Pack
2012 MS-MPI. First install Microsoft HPC Pack 2012 MS-MPI by runing mpi_x64.Msi for 64-bit platforms
and mpi_x86.Msi for 32-bit platforms.

Note: If you want to use TauDEM 5.0.6

Installing TauDEM under Linux

Unfortunately there are no packages for most Linux distributions, so you should compile TauDEM by yourself.
As TauDEM uses MPI it is necessary to install first any MPI implementation e.g MPICH or OpenMPI. Use your
favorite package manager to install MPICH or OpenMPI.

Download TauDEM 5.2.0 source code package from GitHub repository and extract archive contents. Open termi-
nal and cd into src directory inside extracted folder. Create build directory and cd into it

mkdir build
cd build

Configure your build (change install prefix if necessary) and compile

CXX=mpicxx cmake -DCMAKE_INSTALL_PREFIX=/usr/local ..
make

When compilation finished install TauDEM tools by running

sudo make install

Note: Executable files will be installed into bin subdirectory inside prefix you specified at the con-
figure stage. For example if you specified prefix /opt/taudem5.2 than binaries will be installed into
/opt/taudem5.2/bin.

To use singlefile version — download source package here and perform above mentioned steps to compile and
install it.

Old TauDEM 5.0.6 also available. But before compiling this version it is necessary to edit some source files.

Open the linearpart.h file, and after line

#include "mpi.h"
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add a new line with

#include <stdint.h>

so you’ll get

#include "mpi.h"
#include <stdint.h>

Save the changes and close the file. Now open tiffIO.h, find line #include "stdint.h" and replace
quotes ("") with <>, so you’ll get

#include <stdint.h>

Save the changes and close the file.

Now configure, compile and install TauDEM 5.0.6 using same commands as described above.

Configuring TauDEM provider

Once TauDEM is installed, start QGIS, open the Processing options dialog from Processing → Options... and
configure the TauDEM algorithm provider. In the Providers group find TauDEM (hydrologic analysis) block, and
expand it. Here you will see all settings related to TauDEM.

First, ensure that algorithms are enabled, and activate provider if necessary.

Next step is to configure MPI. The MPICH/OpenMPI bin directory setting used to define location of the mpiexec
program. In most Linux distributions you can safely leave this empty, as mpiexec available in your PATH.

The Number of MPI parallel processes to use is a second setting related to MPI. It defines number of processes
that will be used to execute TauDEM commands. If you don’t know which value to use, it is better to leave this
value unchanged.

Now we need to configure the path to the folder(s) where TauDEM command-line tools are installed. As we
already mention TauDEM provider supports both single- and multifile TauDEM, so there are two settings for
TauDEM folders:

• TauDEM command line tools folder used to set location of the singlefile tools

• TauDEM multifile command line tools folder used to set location of the multifile tools

If you have both TauDEM versions installed in different directories it is possible to specify both options.

The last step is to define which TauDEM version to use:

• with Enable multifile TauDEM tools option checked you will use multifile TauDEM tools from directory,
specified in the TauDEM multifile command line tools folder. Multifile tools have same name as singlefile
with “(multifile)” suffix added

• with Enable single TauDEM tools option checked you will use multifile TauDEM tools from directory,
specified in the TauDEM command line tools folder.

It is possible to enable both tools simultaneously. In this case you will have two instances of each tool in toolbox
and can use them in your analysis.

Note: Be careful with developing Processing models using TauDEM!
As single- and multifile versions have different inputs, model created with singlefile algorithms will not work if
only multifile algorithms are available. If you plan to share your model please specify which TauDEM version
should be used or, better, provide two versions of your model: for single- and multifile TauDEM.
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20.10 QGIS Commander

Processing include un instrument practic care vă permite să rulat,i algoritmi, fără a fi nevoie să utilizat,i bara de
instrumente, doar prin tastarea numelui algoritmului pe care dorit,i să îl rulat,i.

Instrumentul este cunoscut ca s, i QGIS commander, s, i constă doar într-o simplă casetă de text cu autocompletare,
unde vet,i tasta comanda pe care dorit,i să o rulat,i.

Figure 20.33: QGIS Commander

The Commander is started from the Processing menu or, more practically, by pressing Shift + Ctrl + M
(you can change that default keyboard shortcut in the QGIS configuration if you prefer a different one). To close
it, just press ESC. Apart from executing Processing algorithms, the Commander gives you access to most of the
functionality in QGIS, which means that it gives you a practical and efficient way of running QGIS tasks and
allows you to control QGIS with reduced usage of buttons and menus.

Moreover, the Commander is configurable, so you can add your custom commands and have them just a few
keystrokes away, making it a powerful tool to help you become more productive in your daily work with QGIS.

20.10.1 Comenzi disponibile

Comenzile disponibile în Commander se încadrează în următoarele categorii:

• Algoritmi de procesare. Aces, tia sunt afis, at,i ca Algoritmi de procesare: <name of the
algorithm>.

• Menu items. These are shown as Menu item: <menu entry text>. All menus items available
from the QGIS interface are available, even if they are included in a submenu.

• Funct,ii Python. Putet,i crea funct,ii scurte Python care vor fi incluse în lista de comenzi disponibile. Acestea
sunt afis, ate ca Funct,ia: <function name>.

Pentru a rula oricare dintre categorii, este suficient să începet,i să tastat,i, apoi să selectat,i elementul corespunzător
din lista de comenzi disponibile, care apare după filtrarea întregii liste de comenzi, generată de textul introdus.

In the case of calling a Python function, you can select the entry in the list, which is prefixed by Function:
(for instance, Function: removeall), or just directly type the function name (removeall in the previous
example). There is no need to add brackets after the function name.

20.10.2 Crearea funct,iilor personalizate

Custom functions are added by entering the corresponding Python code in the commands.py file that is found
in the .qgis2/processing/commander directory in your user folder. It is just a simple Python file where
you can add the functions that you need.

The file is created with a few example functions the first time you open the Commander. If you haven’t launched
the Commander yet, you can create the file yourself. To edit the commands file, use your favourite text editor. You

20.10. QGIS Commander 399



QGIS User Guide, Release 2.18

can also use a built-in editor by calling the edit command from the Commander. It will open the editor with the
commands file, and you can edit it directly and then save your changes.

De exemplu, putet,i adăuga următoarea funct,ie, care elimină toate straturile:

from qgis.gui import *

def removeall():
mapreg = QgsMapLayerRegistry.instance()
mapreg.removeAllMapLayers()

După ce at,i adăugat funct,ia, ea va fi disponibilă în Commander, putând-o invoca prin tastarea removeall. Nu
este nevoie să facet,i nimic în afară de scrierea funct,iei în sine.

Functions can receive parameters. Add *args to your function definition to receive arguments. When calling the
function from the Commander, parameters have to be passed separated by spaces.

Aici este un exemplu al unei funct,ii care încarcă un strat, s, i care primes, te ca parametru numele de fis, ier a stratului
care se va încărca.

import processing

def load(*args):
processing.load(args[0])

If you want to load the layer in ;file:/home/myuser/points.shp, type in the Commander text box:

load /home/myuser/points.shp
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CHAPTER 21

Plugin-uri

21.1 Consola Python din QGIS

As you will see later in this chapter, QGIS has been designed with a plugin architecture. Plugins can be written in
Python, a very famous language in the geospatial world.

QGIS brings a Python API (see PyQGIS Developer Cookbook for some code sample) to let the user interact with
its objects (layers, feature or interface). QGIS also has a Python console.

The QGIS Python Console is an interactive shell for the python command executions. It also has a python file
editor that allows you to edit and save your python scripts. Both console and editor are based on PyQScintilla2
package. To open the console go to Plugins → Python Console (Ctrl+Alt+P).

21.1.1 Consola interactivă

Consola interactivă este alcătuită dintr-o bară de instrumente, o zonă de intrare s, i una de ies, ire.

Bara de instrumente

Bara instrumentelor propune următoarele instrumente:

• Clear console to wipe the output area;

• Import class: Processing, PyQt4.QtCore or PyQt4.QtGui class;

• Run command available in the input area: same as pressing Enter;

• Show editor: toggles Editorul de Cod visibility;

• Options...;

• Help....

Consola

The console main features are:

• Code completion, highlighting syntax and calltips for the following APIs:

– Python

– PyQGIS

– PyQt4
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– QScintilla2

– osgeo-gdal-ogr

• Ctrl+Alt+Space to view the auto-completion list if enabled in the Opţiuni;

• Execute code snippets from the input area by typing and pressing Enter or Run Command;

• Execute code snippets from the output area using the Enter selected from the contextual menu or pressing
Ctrl+E;

• Browse the command history from the input area using the Up and Down arrow keys and execute the
command you want;

• Ctrl+Shift+Space to view the command history: double-clicking a row will execute the command.
The Command History dialog can also be accessed from context menu of input area;

• Save and clear the command history. The history will be saved into the file
~/.qgis2/console_history.txt;

• Open QGIS API documentation by typing _api;

• Open PyQGIS Cookbook by typing _pyqgis.

Tip: Reuse executed commands from the output panel
You can execute code snippets from the output panel by selecting some text and pressing Ctrl+E. No matter if
selected text contains the interpreter prompt (>>>, ...).

Figure 21.1: The Python Console

21.1.2 Editorul de Cod

Use the Show editor button to enable the editor widget. It allows editing and saving Python files and offers
advanced functionalities to manage your code (comment and uncomment code, check syntax, share the code via
codepad.org and much more). Main features are:

• Code completion, highlighting syntax and calltips for the following APIs:

– Python

– PyQGIS

– PyQt4

– QScintilla2

– osgeo-gdal-ogr
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• Ctrl+Space to view the auto-completion list.

• Sharing code snippets via codepad.org.

• Ctrl+4 Verificare sintaxă.

• Search bar (open it with the default Desktop Environement shorcut, usually Ctrl+F):

– Use the default Desktop Environment shortcut to find next/previous (Ctrl+G and Shift+Ctrl+G);

– Automatically find first match when typing in find box;

– Set initial find string to selection when opening find;

– Pressing Esc closes the find bar.

• Object inspector: a class and function browser;

• Go to an object definition with a mouse click (from Object inspector);

• Execute code snippets with the Enter selected command;

• Execute the whole script with the Run script command (this creates a byte-compiled file with the extension
.pyc).

Note: Running partially or totally a script from the Code Editor outputs the result in the Console output area.

Figure 21.2: The Python Console editor

21.1.3 Opţiuni

Accessible either from the Console toolbar or the contextual menu of Console output panel or Code Editor, this
adds further settings to manage and control the Python console behavior:

• Autocompletion: If checked the code completion is enabled. You can get autocompletion from current
document, from installed APIs and both from APIs and current document.

• Autocompletion threshold: Sets the threshold to display the autocompletion list (in chars typed).

• Automatic parentheses insertion: If checked enables the autoclosing for bracket.

• Auto-save script before running: Allows you to save automatically the script to be executed in order to
avoid to save it after any modification. This action will store a temporary file into the temporary system
directory that will be automatically deleted after running.
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• Using preloaded APIs file: You can choose whether use the preload APIs file or load some APIs files saved
on your system.

• Using prepared APIs file: If checked the *.pap file will be used for code completion. To generate a
prepared APIs file you have to load at least an *.api file and then compile it by clicking on [Compile
Apis...] button.

Tip: Save the options
To save the state of console’s widgets you have to close the Python Console from the close button. This allows
you to save the geometry to be restored to the next start.

21.2 Plugin-uri QGIS

QGIS a fost conceput cu o arhitectură de plugin. Acest lucru permite adăugarea us, oară a multor caracteristici s, i
funct,ii noi. Multe dintre caracteristicile din QGIS sunt de fapt implementate ca plugin-uri.

21.2.1 Plugin-uri de bază s, i externe

Plugin-urile QGIS sunt implementate fie ca Plugin-uri de Bază, fie ca Plugin-uri Externe.

Core Plugins are maintained by the QGIS Development Team and are automatically part of every QGIS distribu-
tion. They are written in one of two languages: C++ or Python.

Most of External Plugins are currently written in Python. They are stored either in the ‘Official’ QGIS Repository
at http://plugins.qgis.org/plugins/ or in external repositories and are maintained by the individual authors. Detailed
documentation about the usage, minimum QGIS version, home page, authors,and other important information
are provided for the plugins in the Official repository. For other external repositories, documentation might be
available with the external plugins themselves. External plugins documentation is not included in this manual.

To install or activate a plugin, go to Plugins → Manage and install plugins....

Installed external python plugins are placed under ~/.qgis2/python/plugins folder. Home directory (de-
noted by above ~) on Windows is usually something like C:\Documents and Settings\(user) (on
Windows XP or earlier) or C:\Users\(user). On some platforms (e.g., macOS), the .qgis2 folder is hid-
den by default.

Paths to Custom C++ plugins libraries can also be added under Settings → Options → System.

Note: According to the plugin manager settings, QGIS main interface can display a blue link in the status bar to
inform you that there are updates for your installed plugins or new plugins available.

21.2.2 Dialogul Plugin-urilor

The menus in the Plugins dialog allow the user to install, uninstall and upgrade plugins in different ways. Each
plugin has some metadata displayed in the right panel:

• informat,ii despre caracterul experimental al plugin-ului

• descriere

• vot(urile) de evaluare (se poate vota pentru plugin-ul preferat!)

• etichete

• unele link-uri utile, ca pagina de start, cea a actualizărilor s, i a depozitului de cod

• autor(i)

• versiunea disponibilă
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At the top of the dialog, a Search function helps you find any plugin using metadata information (author, name,

description...). It is available in nearly every menu (except Settings).

The All tab

In the All tab, all the available plugins are listed, including both core and external plugins. Use [Upgrade
all] to look for new versions of the plugins. Furthermore, you can use [Install plugin] if a plugin is listed but
not installed, [Uninstall plugin] as well as [Reinstall plugin] if a plugin is installed. An installed plugin can be
temporarily de/activated using the checkbox.

Figure 21.3: The All tab

The Installed tab

In Installed tab, you can find only the installed plugins. The external plugins can be uninstalled and reinstalled
using the [Uninstall plugin] and [Reinstall plugin] buttons. You can [Upgrade all] here as well.

The Not installed tab

The Not installed tab lists all plugins available that are not installed. You can use the [Install plugin] button
to implement a plugin into QGIS.

The Upgradeable and New tabs

The Upgradeable and New tabs are enabled when new plugins are added to the repository or a new version

of an installed plugin is released. If you activated Show also experimental plugins in the Settings menu,
those also appear in the list giving you opportunity to early test upcoming tools.

Installation can be done with the [Install plugin], [Upgrade plugin] or [Upgrade all] buttons.
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Figure 21.4: The Installed tab

Figure 21.5: The Not installed tab
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Figure 21.6: The Upgradeable tab

The Invalid tab

The Invalid tab lists all installed plugins that are currently broken for any reason (missing dependency, errors
while loading, incompatible functions with QGIS version...). You can try the [Reinstall plugin] button to fix
an invalidated plugin but most of the times the fix will be elsewhere (install some libraries, look for another
compatible plugin or help to upgrade the broken one).

Fila setărilor

In the Settings tab, you can use the following options:

• Verificare actualizare la start. Ori de câte ori un nou plugin sau o actualizare de plugin este disponibilă,
QGIS vă va informa ‘de fiecare dată când se lansează QGIS’, ‘o dată pe zi’, ‘o dată la 3 zile’, ‘în fiecare
săptămână’, ‘la fiecare 2 săptămâni’ sau ‘în fiecare lună’.

• Arată, de asemenea, plugin-urile experimentale. QGIS vă va arăta plugin-urile aflate în stadii incipiente
de dezvoltare, care sunt, în general, improprii pentru utilizarea în product,ie.

• Show also deprecated plugins. Because they use functions that are no longer available in QGIS, these
plugins are set deprecated and generally unsuitable for production use. They appear among invalid plugins
list.

To add external author repositories, click [Add...] in the Plugin repositories section. If you do not want one or
more of the added repositories, they can be disabled via the [Edit...] button, or completely removed with the
[Delete] button.

The default QGIS repository is an open repository and you don’t need any authentication to access it. You can
however deploy your own plugin repository and require an authentication (basic authentication, PKI). You can get
more information on QGIS authentication support in Autentificarea chapter.
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Figure 21.7: The Invalid tab

Figure 21.8: The Settings tab
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21.3 Folosirea Plugin-urilor de Bază QGIS

Pic-
togramă

Plugin Descriere Manual de Referint,ă

Captură
coordonate

Capturează coordonatele mouse-ului
într-un CRS diferit

Plugin-ul de Captură a
Coordonatelor

DB Manager Gestionarea bazelor de date din QGIS Plugin-ul DB Manager

DXF2Shape
Converter

Converts from DXF to SHP file format Plugin-ul Convertor Dxf2Shp

eVis Instrumentul de Vizualizare a
Evenimentelor

Plugin-ul eVis

GDAL Tools GDAL raster functionality Plugin-ul Instrumentelor
GDAL

Geometry Checker Verificarea s, i repararea erorilor din
geometriile vectoriale

Plugin-ul Verificator de
Geometrie

Geometry Snapper Snap geometries to a reference layer Plugin-ul de Acros, are a
Geometriei

Georeferenţiator
GDAL

Georeferenţiere rastere folosind GDAL Plugin-ul de georeferent,iere

Instrumente GPS Instrumente pentru încărcarea s, i importul
datelor GPS

Plugin-ul GPS

GRASS Funct,ionalitatea GRASS Integrarea GRASS GIS

Heatmap Create heatmap rasters from input vector
points

Plugin-ul Heatmap

Interpolation
plugin

Interpolation on base of vertices of a
vector layer

Plugin-ul de Interpolare

Metasearch
Catalog Client

Interact with metadata catalog services
(CSW)

MetaSearch Catalog Client

Editarea Offline Editarea offline şi sincronizarea cu baza
de date

Plugin-ul de Editare Offline

Oracle Spatial
Georaster

Access Oracle Spatial GeoRasters Plugin-ul GeoRaster Oracle
Spatial

Managerul de
Plugin-uri

Gestionează plugin-uri de bază s, i externe Dialogul Plugin-urilor

Processing Cadrului de procesare al datelor spat,iale Cadrul de procesare al QGIS

Raster Terrain
Analysis

Compute geomorphological features
from DEMs

Plugin-ul de Analiză a
Terenurilor Raster

Road Graph plugin Shortest path analysis Plugin pentru Grafuri Rutiere

Spatial Query Spatial queries on vectors Pluginul de Interogare
spaţială

Verificatorul de
Topologie

Identificarea erorilor topologice în
straturile vectoriale

Plugin-ul de Verificare a
Topologiei

Zonal Statistics Calculate raster statistics for vector
polygons

Plugin-ul de statistici zonale
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21.4 Plugin-ul de Captură a Coordonatelor

Plugin-ul de captură a coordonatelor este us, or de utilizat s, i oferă capacitatea de afis, are a coordonatelor pe caneva-
sul hărt,ii, pentru cele două sisteme de coordonate de referint,ă selectate (CRS-uri).

Figure 21.9: Plugin-ul de Captură a Coordonatelor

1. Start QGIS, select Project Properties from the Settings (KDE, Windows) or File (Gnome, macOS) menu

and click on the Projection tab. As an alternative, you can also click on the CRS status icon in the lower
right-hand corner of the status bar.

2. Clic pe caseta de bifare Activare proiect,ie din zbor s, i selectat,i sistemul de proiect,ie a coordonatelor dorit
(v. Lucrul cu Proiect,ii).

3. Activate the coordinate capture plugin in the Plugin Manager (see Dialogul Plugin-urilor) and ensure that

the dialog is visible by going to View → Panels and ensuring that Coordinate Capture is enabled. The
coordinate capture dialog appears as shown in Figure figure_coordinate_capture. Alternatively, you can also

go to Vector → Coordinate Capture and see if Coordinate Capture is enabled.

4. Clic pe pictograma Click to the select the CRS to use for coordinate display s, i selectat,i un CRS diferit de cel selectat
mai sus.

5. To start capturing coordinates, click on [Start capture]. You can now click anywhere on the map canvas
and the plugin will show the coordinates for both of your selected CRS.

6. Pentru a activa urmărirea coordonatelor mouse-ului, efectuat,i clic pe pictograma mouse tracking.

7. De asemenea, se pot copia în clipboard coordonatele selectate.

21.5 Plugin-ul DB Manager

Pluginul DB Manager este parte a nucleului oficial QGIS, fiind destinat de a fi principalul instrument pentru
gestionarea integrată într-o interfat,ă unică a formatelor de baze de date spat,iale acceptate de QGIS (PostGIS,

SpatiaLite, Geopackage, Oracle Spatial, Straturi Virtuale). Pluginul DB Manager oferă mai multe funct,iuni.
Avet,i posibilitatea de a glisa straturile din browser-ul QGIS în DB Manager, s, i de a le importa în baza de date
spat,ială. Este suficient să glisat,i tabelele bazelor de date spat,iale, iar acestea vor fi importate.

Meniul Bazei de Date vă permite să vă conectat,i la o bază de date existentă, pentru a lansa fereastra SQL s, i pentru
a ies, i din Plugin-ul DB Manager. O dată ce vă conectat,i la o bază de date existentă, apar meniurile adit,ionale
Schemă s, i Tabelă.

Meniul Schema include instrumente pentru a crea s, i a s, terge scheme (vide) s, i, în cazul în care topologia este
disponibilă, (de exemplu, PostGIS 2), pentru a începe o TopoVizualizare.

The Table menu allows you to create and edit tables and to delete tables and views. It is also possible to empty
tables and to move tables from one schema to another. As further functionality, you can perform a VACUUM
and then an ANALYZE for each selected table. Plain VACUUM simply reclaims space and makes it available
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Figure 21.10: Dialogul DB Manager
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for reuse. ANALYZE updates statistics to determine the most efficient way to execute a query. Finally, you can
import layers/files, if they are loaded in QGIS or exist in the file system. And you can export database tables to
shape with the Export File feature.

The Tree window lists all existing databases supported by QGIS. With a double-click, you can connect to the
database. With the right mouse button, you can rename and delete existing schemas and tables. Tables can also be
added to the QGIS canvas with the context menu.

If connected to a database, the main window of the DB Manager offers three tabs. The Info tab provides informa-
tion about the table and its geometry, as well as about existing fields, constraints and indexes. It also allows you
to run Vacuum Analyze and to create a spatial index on a selected table, if not already done. The Table tab shows
all attributes, and the Preview tab renders the geometries as preview.

21.5.1 Lucrul cu fereastra SQL

You can also use the DB Manager to execute SQL queries against your spatial database and then view the spatial
output for queries by adding the results to QGIS as a query layer. It is possible to highlight a portion of the SQL
and only that portion will be executed when you press F5 or click the Execute (F5) button.

Figure 21.11: Executarea interogărilor SQL în fereastra SQL DB Manager

Note: The SQL Window can also be used to create Virtual Layers. In that case, instead of selecting a database,
select QGIS Layers under Virtual Layers before opening the SQL Window. See Creating virtual layers for
instructions on the SQL syntax to use.

21.6 Plugin-ul Convertor Dxf2Shp

Plugin-ul convertor dxf2shape poate fi folosit pentru a converti date vectoriale dintr-un DXF în format shapefile.
Este nevoie de următorii parametri care trebuie să fie specificat,i înainte de rulare:
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Figure 21.12: Plugin-ul Convertor Dxf2Shape

• Fis, ierul de intrare DXF: Introducet,i calea către fis, ierul DXF care trebuie convertit.

• Fis, ierul de ies, ire Shp: Introducet,i numele dorit pentru fis, ierul shape care trebuie creat.

• Tipul fis, ierului de ies, ire: Specificat,i tipul de geometrie dorit pentru fis, ierul shape de ies, ire. Tipuri de
acceptate în prezent sunt polilinie, poligon, s, i punct.

• Exportare etichete cu text: Când opt,iunea este selectată, un strat suplimentar de tip shapefile va fi creat,
iar tabela DBF asociată va cont,ine informat,ii despre câmpul ‘text’ din fis, ierul DXF, s, i s, irurile de caractere
în sine.

21.6.1 Utilizarea plugin-ului

1. Start QGIS, load the Dxf2Shape plugin in the Plugin Manager (see Dialogul Plugin-urilor) and click on the
Dxf2Shape Converter icon, which appears in the QGIS toolbar menu. The Dxf2Shape plugin dialog appears,

as shown in Figure_dxf2shape.

2. Introducet,i fis, ierul DXF de intrare, numele s, i tipul pentru fis, ierul shape de ies, ire.

3. Activat,i caseta de bifare Exportă etichetele cu text dacă dorit,i să creat,i un strat suplimentar, de tip punct,
cu etichete.

4. Clic pe [OK].

21.7 Plugin-ul eVis

(This section is derived from Horning, N., K. Koy, P. Ersts. 2009. eVis (v1.1.0) User’s Guide.
American Museum of Natural History, Center for Biodiversity and Conservation. Available from
http://biodiversityinformatics.amnh.org/, and released under the GNU FDL.)

The Biodiversity Informatics Facility at the American Museum of Natural History’s (AMNH) Center for Biodi-
versity and Conservation (CBC) has developed the Event Visualization Tool (eVis), another software tool to add
to the suite of conservation monitoring and decision support tools for guiding protected area and landscape plan-
ning. This plugin enables users to easily link geocoded (i.e., referenced with latitude and longitude or X and Y
coordinates) photographs, and other supporting documents, to vector data in QGIS.

eVis este instalat s, i activat automat în noile versiuni de QGIS s, i, similar tuturor plugin-urilor, poate fi dezactivat
s, i activat cu ajutorul Managerului de Plugin-uri (v. Dialogul Plugin-urilor).

Plugin-ul eVis este compus din trei module: ‘Database Connection tool’, ‘Event ID tool’, s, i ‘Event Browser’.
Acestea lucrează împreună pentru a permite vizualizarea fotografiilor geocodate s, i a altor documente care sunt
legate de entităt,i stocate în fis, iere vectoriale, baze de date sau foi de calcul.
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21.7.1 Browser-ul de Evenimente

The Event Browser module provides the functionality to display geocoded photographs that are linked to vector
features displayed in the QGIS map window. Point data, for example, can be from a vector file that can be input
using QGIS or it can be from the result of a database query. The vector feature must have attribute information
associated with it to describe the location and name of the file containing the photograph and, optionally, the
compass direction the camera was pointed when the image was acquired. Your vector layer must be loaded into
QGIS before running the Event Browser.

Lansarea modulului Event Browser

To launch the Event Browser module, click on Database → eVis → eVis Event Browser. This will open the
Generic Event Browser window.

The Event Browser window has three tabs displayed at the top of the window. The Display tab is used to view the
photograph and its associated attribute data. The Options tab provides a number of settings that can be adjusted to
control the behavior of the eVis plugin. Lastly, the Configure External Applications tab is used to maintain a table
of file extensions and their associated application to allow eVis to display documents other than images.

Înt,elegerea ferestrei de Afis, are

To see the Display window, click on the Display tab in the Event Browser window. The Display window is used
to view geocoded photographs and their associated attribute data.

Figure 21.13: Fereastra de afis, are eVis

1. Fereastra de afis, are: O fereastră în care va apărea fotografia.
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2. Zoom in button: Apropiat,i pentru a vedea mai multe detalii. Dacă nu se poate afis, a întreaga imagine vor
apărea bare de derulare în stânga s, i în josul ferestrei pentru a putea permite derularea imaginii.

3. Zoom out button: Depărtat,i pentru a vedea o zonă mai mare.

4. Butonul Zoom to full extent: Afis, ează întreaga fotografie.

5. Fereastra de informat,ii despre Atribute: Toate informat,iile atributelor punctului asociate cu fotografia
vizualizată sunt afis, ate aici. Dacă tipul de fis, ier ment,ionat în înregistrarea afis, ată nu este o imagine, dar este
un tip de fis, ier definit în fila de Configurare a Aplicat,iilor Externe, atunci când facet,i dublu-clic pe valoarea
câmpului care cont,ine calea către fis, ier, aplicat,ia îl va lansa, vizualizându-i sau ascultându-i cont,inutul.
Dacă extensia fis, ierului este recunoscută, datele atributului vor fi afis, ate în verde.

6. Navigation buttons: Folosit,i butoanele Anterior s, i Următor pentru a încărca entitatea precedentă sau urmă-
toare atunci când este selectată mai mult de o entitate.

Înt,elegerea ferestrei Opt,iuni

Figure 21.14: Fereastra de opt,iuni eVis

1. File path: A drop-down list to specify the attribute field that contains the directory path or URL for the
photographs or other documents being displayed. If the location is a relative path, then the checkbox must
be clicked. The base path for a relative path can be entered in the Base Path text box below. Information
about the different options for specifying the file location are noted in the section Specificat,i locat,ia s, i
numele unei fotografii below.

2. Compass bearing: A drop-down list to specify the attribute field that contains the compass bearing asso-
ciated with the photograph being displayed. If compass bearing information is available, it is necessary to
click the checkbox below the drop-down menu title.
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3. Compass offset: Compass offsets can be used to compensate for declination (to adjust bearings collected
using magnetic bearings to true north bearings). Click the Manual radio button to enter the offset in
the text box or click the From Attribute radio button to select the attribute field containing the offsets.
For both of these options, east declinations should be entered using positive values, and west declinations
should use negative values.

4. Directory base path: The base path onto which the relative path defined in Figure_eVis_options (A) will
be appended.

5. Replace path: If this checkbox is checked, only the file name from A will be appended to the base path.

6. Regula se aplică tuturor documentelor: Dacă se bifează, aceleas, i căi către reguli, care sunt definite pentru
imagini, vor fi utilizate pentru documentele non-imagine, cum ar fi filmele, documentele de tip text s, i
fis, ierele de sunet. Dacă nu se bifează, căile către reguli se vor aplica numai pentru imagini, iar restul
documentelor vor ignora parametrul Path Base.

7. Remember settings: If the checkbox is checked, the values for the associated parameters will be saved for
the next session when the window is closed or when the [Save] button below is pressed.

8. Resetare valori: Resetează valorile de pe această linie la setarea implicită.

9. Restore defaults: This will reset all of the fields to their default settings. It has the same effect as clicking
all of the [Reset] buttons.

10. Salvare: Acest lucru va salva setările fără a închide panoul Opt,iunilor.

Înt,elegera ferestrei de Configurare a Aplicat,iilor Externe

Figure 21.15: Fereastra Aplicat,iilor Externe eVis

1. Tabela de referint, ă a fis, ierelor: Un tabel care cont,ine tipurile de fis, iere care pot fi deschise cu eVis. Fiecare
tip de fis, ier are nevoie de o extensie s, i de o cale către o aplicat,ie care poate deschide acel tip de fis, ier. Astfel,
în plus fat,ă de imagini, este posibilă deschiderea unui număr mare fis, iere, cum ar fi filme, înregistrări sonore
s, i documente text.

2. Add new file type: Adaugă un nou tip de fis, ier cu o extensie unică s, i calea către aplicat,ia care poate
deschide acel fis, ier.

3. Delete current row: S, terge tipul de fis, ier evident,iat în tabel s, i definit de o extensie de fis, ier s, i o cale către
o aplicat,ie asociată.

21.7.2 Specificat,i locat,ia s, i numele unei fotografii

The location and name of the photograph can be stored using an absolute or relative path, or a URL if the pho-
tograph is available on a web server. Examples of the different approaches are listed in Table evis_examples.
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X Y FILE BEARING
780596 1784017 C:\Workshop\eVis_Data\groundphotos\DSC_0168.JPG 275
780596 1784017 /groundphotos/DSC_0169.JPG 80
780819 1784015 http://biodiversityinformatics.amnh.org/\

evis_testdata/DSC_0170.JPG 10
780596 1784017 pdf:http://www.testsite.com/attachments.php?\

attachment_id-12 76

21.7.3 Specificat,i locat,ia s, i numele altor documente justificative

Supporting documents such as text documents, videos, and sound clips can also be displayed or played by eVis. To
do this, it is necessary to add an entry in the file reference table that can be accessed from the Configure External
Applications window in the Generic Event Browser that matches the file extension to an application that can be
used to open the file. It is also necessary to have the path or URL to the file in the attribute table for the vector
layer. One additional rule that can be used for URLs that don’t contain a file extension for the document you want
to open is to specify the file extension before the URL. The format is — file extension:URL. The URL
is preceded by the file extension and a colon; this is particularly useful for accessing documents from wikis and
other web sites that use a database to manage the web pages (see Table evis_examples).

21.7.4 Lansarea modulului de Răsfoire a Evenimentelor

When the Event Browser window opens, a photograph will appear in the display window if the document refer-
enced in the vector file attribute table is an image and if the file location information in the Options window is
properly set. If a photograph is expected and it does not appear, it will be necessary to adjust the parameters in the
Options window.

If a supporting document (or an image that does not have a file extension recognized by eVis) is referenced in the
attribute table, the field containing the file path will be highlighted in green in the attribute information window if
that file extension is defined in the file reference table located in the Configure External Applications window. To
open the document, double-click on the green-highlighted line in the attribute information window. If a supporting
document is referenced in the attribute information window and the file path is not highlighted in green, then it
will be necessary to add an entry for the file’s filename extension in the Configure External Applications window.
If the file path is highlighted in green but does not open when double-clicked, it will be necessary to adjust the
parameters in the Options window so the file can be located by eVis.

If no compass bearing is provided in the Options window, a red asterisk will be displayed on top of the vector
feature that is associated with the photograph being displayed. If a compass bearing is provided, then an arrow will
appear pointing in the direction indicated by the value in the compass bearing display field in the Event Browser
window. The arrow will be centered over the point that is associated with the photograph or other document.

To close the Event Browser window, click on the [Close] button from the Display window.

21.7.5 Instrumentul Event ID

The ‘Event ID’ module allows you to display a photograph by clicking on a feature displayed in the QGIS map
window. The vector feature must have attribute information associated with it to describe the location and name of
the file containing the photograph and, optionally, the compass direction the camera was pointed when the image
was acquired. This layer must be loaded into QGIS before running the ‘Event ID’ tool.

Lansarea modulului Event ID

To launch the ‘Event ID’ module, either click on the Event ID icon or click on Database → eVis → Event ID
Tool. This will cause the cursor to change to an arrow with an ‘i’ on top of it signifying that the ID tool is active.

To view the photographs linked to vector features in the active vector layer displayed in the QGIS map window,
move the Event ID cursor over the feature and then click the mouse. After clicking on the feature, the Event
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Browser window is opened and the photographs on or near the clicked locality are available for display in the
browser. If more than one photograph is available, you can cycle through the different features using the [Previ-
ous] and [Next] buttons. The other controls are described in the Browser-ul de Evenimente section of this guide.

21.7.6 Conexiune la Baza de Date

Modulul ‘Database Connection’ pune la dispozit,ie unelte pentru conectarea s, i interogarea unei baze de date sau a
unei alte resurse ODBC, cum ar fi o foaie de calcul.

eVis can directly connect to the following types of databases: PostgreSQL, MySQL, and SQLite; it can also
read from ODBC connections (e.g., MS Access). When reading from an ODBC database (such as an Excel
spreadsheet), it is necessary to configure your ODBC driver for the operating system you are using.

Lansarea modulului de Conectare la Baza de Date

To launch the ‘Database Connection’ module, either click on the appropriate icon eVis Database Connection or click
on Database → eVis → Database Connection. This will launch the Database Connection window. The window
has three tabs: Predefined Queries, Database Connection, and SQL Query. The Output Console window at the
bottom of the window displays the status of actions initiated by the different sections of this module.

Conectarea la baza de date

Click on the Database Connection tab to open the database connection interface. Next, use the Database Type

combo box to select the type of database that you want to connect to. If a password or username is required,
that information can be entered in the Username and Password textboxes.

Introducet,i numele bazei de date în câmpul text Numele Bazei de Date. Opt,iunea nu este disponibilă dacă aleget,i
‘MS Access’ ca tip de bază de date. În cazul în care baza de date se află pe calculatorul dvs., va trebui să introducet,i
denumirea “localhost”.

Introducet,i numele bazei de date în câmpul text Database Name. Dacă selectat,i ‘ODBC’ ca tip de bază de date,
va trebui să introducet,i numele sursei de date.

When all of the parameters are filled in, click on the [Connect] button. If the connection is successful, a message
will be written in the Output Console window stating that the connection was established. If a connection was not
established, you will need to check that the correct parameters were entered above.

1. Tipul Bazei de Date: O listă derulantă în care se va specifica tipul bazei de date care va fi utilizată.

2. Database Host: Numele gazdei pentru baza de date.

3. Port: Numărul portului, atunci când tipul bazei de date este MySQL sau PostgreSQL.

4. Nume Bază de Date.: Numele bazei de date.

5. Conectare: Un buton pentru conectarea la baza de date, folosind parametrii definit,i mai sus.

6. Consola de Ies, ire: Fereastra consolei, în care sunt afis, ate mesajele referitoare la procesare.

7. Username: Nume utilizator care va fi utilizat atunci când o bază de date este protejată prin parolă.

8. Password: Parola care va fi utilizată atunci când o bază de date este protejată prin parolă.

9. Predefined Queries: Fila care va deschide fereastra “Interogărilor Predefinite”

10. Conectare la Baza de Date: Închide fereastra principală a Conexiunii la Baza de Date.

11. SQL Query: Fila care va deschide fereastra “SQL Query”.

12. Ajutor: Deschide fereastra de asistent,ă online.

13. OK: Închide fereastra principală a “Conexiunii la Baza de Date”.
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Figure 21.16: Fereastra de conectare la Baza de Date eVis

Rularea interogărilor SQL

SQL queries are used to extract information from a database or ODBC resource. In eVis, the output from these
queries is a vector layer added to the QGIS map window. Click on the SQL Query tab to display the SQL query
interface. SQL commands can be entered in this text window. A helpful tutorial on SQL commands is available at
http://www.w3schools.com/sql. For example, to extract all of the data from a worksheet in an Excel file, select
* from [sheet1$] where sheet1 is the name of the worksheet.

Click on the [Run Query] button to execute the command. If the query is successful, a Database File Selection
window will be displayed. If the query is not successful, an error message will appear in the Output Console
window.

In the Database File Selection window, enter the name of the layer that will be created from the results of the
query in the Name of New Layer textbox.

1. Fereastra Textului SQL de Interogare: O fereastră de introducere a interogărilor SQL.

2. Execut,ie Interogare: Butonul care va executa interogarea introdusă în Fereastra de Interogare SQL.

3. Fereastra Consolei: Fereastra consolei în care sunt afis, ate mesajele referitoare la procesare.

4. Ajutor: Deschide fereastra de asistent,ă online.

5. OK: Închide fereastra principală a Conexiunii la Baza de Date.

Use the X Coordinate and Y Coordinate combo boxes to select the fields from the database that
stores the X (or longitude) and Y (or latitude) coordinates. Clicking on the [OK] button causes the vector layer
created from the SQL query to be displayed in the QGIS map window.

To save this vector file for future use, you can use the QGIS ‘Save as...’ command that is accessed by right-clicking
on the layer name in the QGIS map legend and then selecting ‘Save as...’

Tip: Crearea unui strat vectorial dintr-o foaie de calcul Excel
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Figure 21.17: Fila de interogare eVis SQL

When creating a vector layer from a Microsoft Excel Worksheet, you might see that unwanted zeros (“0”) have
been inserted in the attribute table rows beneath valid data. This can be caused by deleting the values for these
cells in Excel using the Backspace key. To correct this problem, you need to open the Excel file (you’ll need to
close QGIS if you are connected to the file, to allow you to edit the file) and then use Edit → Delete to remove the
blank rows from the file. To avoid this problem, you can simply delete several rows in the Excel Worksheet using
Edit → Delete before saving the file.

Rularea interogărilor predefinite

With predefined queries, you can select previously written queries stored in XML format in a file. This is par-
ticularly helpful if you are not familiar with SQL commands. Click on the Predefined Queries tab to display the
predefined query interface.

To load a set of predefined queries, click on the Open File icon. This opens the Open File window, which is used
to locate the file containing the SQL queries. When the queries are loaded, their titles as defined in the XML file
will appear in the drop-down menu located just below the Open File icon. The full description of the query is
displayed in the text window under the drop-down menu.

Select the query you want to run from the drop-down menu and then click on the SQL Query tab to see that the
query has been loaded into the query window. If it is the first time you are running a predefined query or are
switching databases, you need to be sure to connect to the database.

Click on the [Run Query] button in the SQL Query tab to execute the command. If the query is successful, a
Database File Selection window will be displayed. If the query is not successful, an error message will appear in
the Output Console window.

1. Deschidere Fis, ier: Lansează navigatorul de fis, iere “Deschidere Fis, ier”, pentru a căuta fis, ierul XML care
cont,ine interogări predefinite.
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Figure 21.18: Fila Interogărilor eVis Predefinite

2. Interogări Predefinite: O casetă cu derulare verticală, care cont,ine interogările predefinite, dintr-un fis, ier
XML.

3. Descrierea interogării: O scurtă descriere a interogării. Această descriere face parte din fis, ierul XML de
interogări predefinite.

4. Fereastra Consolei: Fereastra consolei în care sunt afis, ate mesajele referitoare la procesare.

5. Ajutor: Deschide fereastra de asistent,ă online.

6. OK: Închide fereastra principală a “Conexiunii la Baza de Date”.

Formatul XML pentru interogări predefinite eVis

Etichetele XML citite de eVis
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Etichetă Descriere
interogare Defines, te începutul s, i sfârs, itul unei expresii de interogare.
scurtă
descriere

A short description of the query that appears in the eVis drop-down menu.

descriere O descriere mai detaliată a interogării afis, ată în Fereastra Textului de Interogare Predefinită .
database-
type

The database type, defined in the Database Type drop-down menu in the Database Connection
tab.

database-
port

The port as defined in the Port text box in the Database Connection tab.

database-
name

Numele bazei de date, as, a cum este definit în caseta de text Numele Bazei de Date din fila
Conexiunilor la Baza de Date.

databaseuser-
name

The database username as defined in the Username text box in the Database Connection tab.

databasep-
assword

The database password as defined in the Password text box in the Database Connection tab.

sqlstate-
ment

Comanda SQL.

autocon-
nect

A flag (“true”” or “false”) to specify if the above tags should be used to automatically connect to
the database without running the database connection routine in the Database Connection tab.

Modelul complet de fis, ier XML, cu trei interogări, este afis, at mai jos:

<?xml version="1.0"?>
<doc>
<query>
<shortdescription>Import all photograph points</shortdescription>
<description>This command will import all of the data in the SQLite database to QGIS

</description>
<databasetype>SQLITE</databasetype>
<databasehost />
<databaseport />
<databasename>C:\textbackslash Workshop/textbackslash

eVis\_Data\textbackslash PhotoPoints.db</databasename>
<databaseusername />
<databasepassword />
<sqlstatement>SELECT Attributes.*, Points.x, Points.y FROM Attributes LEFT JOIN

Points ON Points.rec_id=Attributes.point_ID</sqlstatement>
<autoconnect>false</autoconnect>

</query>
<query>
<shortdescription>Import photograph points "looking across Valley"</shortdescription>
<description>This command will import only points that have photographs "looking across

a valley" to QGIS</description>
<databasetype>SQLITE</databasetype>
<databasehost />
<databaseport />
<databasename>C:\Workshop\eVis_Data\PhotoPoints.db</databasename>
<databaseusername />
<databasepassword />
<sqlstatement>SELECT Attributes.*, Points.x, Points.y FROM Attributes LEFT JOIN

Points ON Points.rec_id=Attributes.point_ID where COMMENTS=’Looking across
valley’</sqlstatement>

<autoconnect>false</autoconnect>
</query>
<query>

<shortdescription>Import photograph points that mention "limestone"</shortdescription>
<description>This command will import only points that have photographs that mention

"limestone" to QGIS</description>
<databasetype>SQLITE</databasetype>
<databasehost />
<databaseport />
<databasename>C:\Workshop\eVis_Data\PhotoPoints.db</databasename>
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<databaseusername />
<databasepassword />
<sqlstatement>SELECT Attributes.*, Points.x, Points.y FROM Attributes LEFT JOIN

Points ON Points.rec_id=Attributes.point_ID where COMMENTS like ’%limestone%’
</sqlstatement>

<autoconnect>false</autoconnect>
</query>

</doc>

21.8 Plugin-ul Instrumentelor GDAL

21.8.1 Ce reprezintă Instrumentele GDAL?

The GDAL Tools plugin offers a GUI to the collection of tools in the Geospatial Data Abstraction Library,
http://gdal.osgeo.org . These are raster management tools to query, re-project, warp and merge a wide variety
of raster formats. Also included are tools to create a contour (vector) layer, or a shaded relief from a raster DEM,
and to make a VRT (Virtual Raster Tile in XML format) from a collection of one or more raster files. These tools
are available when the plugin is installed and activated.

Biblioteca GDAL

The GDAL library consists of a set of command line programs, each with a large list of options. Users comfortable
with running commands from a terminal may prefer the command line, with access to the full set of options. The
GDAL Tools plugin offers an easy interface to the tools, exposing only the most popular options.

21.8.2 Lista Instrumentelor GDAL

Figure 21.19: Meniul Instrumentelor GDAL
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Proiect,ii

Warp
(Re-
proiectare)

This utility is an image mosaicing, reprojection and warping utility. The program can
reproject to any supported projection, and can also apply GCPs stored with the image if the
image is “raw” with control information. For more information, you can read on the GDAL
website http://www.gdal.org/gdalwarp.html.

Asignare
proiect,ie

This tool allows you to assign projection to rasters that are already georeferenced but miss
projection information. Also with its help, it is possible to alter existing projection
definitions. Both single file and batch mode are supported. For more information, please visit
the utility page at the GDAL site, http://www.gdal.org/gdalwarp.html.

Extragere
proiect,ie

This utility helps you to extract projection information from an input file. If you want to
extract projection information from a whole directory, you can use the batch mode. It creates
both .prj and .wld files.

Conversion

Rasterizare
This program burns vector geometries (points, lines and polygons) into the raster band(s) of a
raster image. Vectors are read from OGR-supported vector formats. Note that the vector data
must in the same coordinate system as the raster data; on the fly reprojection is not provided.
For more information see http://www.gdal.org/gdal_rasterize.html.

Poligo-
nizare

Acest utilitar creează poligoanele vectoriale pentru toate regiunile pixelilor din raster, care
partajează valoarea unui pixel comun. Fiecare poligon este creat cu un atribut care indică
valoarea de pixel a acelui poligon. Utilitarul va crea sursa de date a vectorului de ies, ire în
cazul în care nu există deja, în mod implicit în formatul ESRI shapefile. Vedet,i s, i
http://www.gdal.org/gdal_polygonize.html.

Translat,ie
This utility can be used to convert raster data between different formats, potentially performing
some operations like subsetting, resampling, and rescaling pixels in the process. For more
information you can read on http://www.gdal.org/gdal_translate.html.

Din
RGB în
PCT

Acest utilitar va calcula un tabel optim cu pseudo-culori pentru o imagine RGB dată, folosind
un algoritm de decupare mediană pe o histogramă RGB sub-es, antionată. Apoi, transformă
imaginea într-una pseudo-colorată, folosind tabelul de culori. Această conversie utilizează
oscilat,iile Floyd-Steinberg (difuzia erorilor) pentru a maximiza calitatea vizuală a imaginii de
ies, ire. Utilitarul este descris, de asemenea, în http://www.gdal.org/rgb2pct.html.

Din
PCT în
RGB

Acest utilitar va converti o bandă de pseudoculori, din fis, ierul de intrare, într-un fis, ier RGB de
ies, ire, în formatul dorit. Pentru mai multe informat,ii, consultat,i
http://www.gdal.org/pct2rgb.html.

Extragere

Curbe
de nivel

This program generates a vector contour file from the input raster elevation model (DEM). On
http://www.gdal.org/gdal_contour.html, you can find more information.

Decupare
This utility allows you to clip (extract subset) rasters using selected extent or based on mask
layer bounds. More information can be found at http://www.gdal.org/gdal_translate.html.
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Analiză

Sită This utility removes raster polygons smaller than a provided threshold size (in pixels) and
replaces them with the pixel value of the largest neighbor polygon. The result can be
written back to the existing raster band, or copied into a new file. For more information,
see http://www.gdal.org/gdal_sieve.html.

Aproape
Negru

Acest utilitar va scana o imagine s, i va încerca să seteze tot,i pixelii, din jurul marginii,
care sunt aproape negri (sau aproape albi) exact la culoarea neagră (sau albă). Acest lucru
este adesea folosit pentru a “repara” aerofotogramele comprimate cu pierderi, astfel că
pixelii colorat,i pot fi tratat,i ca fiind transparent,i atunci când are loc mozaicarea.
Consultat,i, de asemenea, http://www.gdal.org/nearblack.html.

Umplere cu
fărădate

This utility fills selected raster regions (usually nodata areas) by interpolation from valid
pixels around the edges of the areas. On http://www.gdal.org/gdal_fillnodata.html, you
can find more information.

Proximitatea Acest utilitar generează o hartă raster de proximitate, care indică distant,a de la centrul
fiecărui pixel până la centrul celui mai apropiat pixel, identificat ca pixel t,intă. Pixelii
t,intă sunt aceia din rasterul sursă, pentru care valoarea pixelilor se află în setul de valori al
pixelilor t,intă. Pentru mai multe informat,ii, consultat,i
http://www.gdal.org/gdal_proximity.html.

Grilă
(Interpolare)

This utility creates a regular grid (raster) from the scattered data read from the OGR
datasource. Input data will be interpolated to fill grid nodes with values, and you can
choose from various interpolation methods. The utility is also described on the GDAL
website, http://www.gdal.org/gdal_grid.html.

DEM
(Modele ale
terenului)

Tools to analyze and visualize DEMs. It can create a shaded relief, a slope, an aspect, a
color relief, a Terrain Ruggedness Index, a Topographic Position Index and a roughness
map from any GDAL-supported elevation raster. For more information, see
http://www.gdal.org/gdaldem.html.

Diverse

Construire
Raster Virtual
(Catalog)

Acest program construies, te un VRT (Set de Date Virtual), care reprezintă un mozaic
de pe lista rasterelor de intrare acceptate de GDAL. Consultat,i, de asemenea,
http://www.gdal.org/gdalbuildvrt.html.

Îmbinare This utility will automatically mosaic a set of images. All the images must be in the
same coordinate system and have a matching number of bands, but they may be
overlapping, and at different resolutions. In areas of overlap, the last image will be
copied over earlier ones. The utility is also described at
http://www.gdal.org/gdal_merge.html.

Informat,ii This utility lists various information about a GDAL-supported raster dataset. On
http://www.gdal.org/gdalinfo.html, you can find more information.

Construire
Vederi de Ansamblu

The gdaladdo utility can be used to build or rebuild overview images for most
supported file formats with one of several downsampling algorithms. For more
information, see http://www.gdal.org/gdaladdo.html.

Index Plăcut,e Acest utilitar construies, te un fis, ier shape cu o înregistrare pentru fiecare fis, ier raster de
intrare, un atribut care cont,ine numele fis, ierului, s, i o geometrie poligonală care
conturează rasterul. Consultat,i s, i http://www.gdal.org/gdaltindex.html.

Setările Instrumentelor GDAL

Utilizat,i acest dialog pentru a încorpora variabilele GDAL.
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21.9 Plugin-ul Verificator de Geometrie

Geometry Checker is a powerful core plugin to check and fix the geometry validity of a layer. The Geometry
Checker dialog show differents grouped settings in the first tab (Settings):

• Input vector layer: to select the layer to check. A Only selected features checkbox can filter the geometry
to the one selected.

• Geometry validity: give to the user the choice between Self intersections, Duplicate nodes, Polygon with
less than 3 nodes.

• Tipuri de geometrii permise: sunt acceptate doar anumite tipuri de geometrie, cum ar fi punctul, multipunc-
tul, linia, multilinia, poligonul s, i multipoligonul.

• Geometry properties displays Polygons and multipolygons may not contain any holes and Multipart
objects must consist of more than one part.

• Geometry conditions: user can add some condition to validate the geometries with a minimal segment
length, a minimum angle between segment, a minimal polygon area and sliver polygons detection.

• Topology checks: checks for duplicates, for features within other features, overlaps smaller than a number,
for gaps smaller than a number.

• Tolerance: you can define here the tolerance for the check.

• Output vector layer gives the choice to the user how get the result between modifiy the current layer and
create a new layer.

After you are happy with the configuration, you can click on the [Run] button.

The results appear in the second tab and as an overview layer of the errors in the canvas (its name is checker). A
table list the geometry check result with one error by row: the first row is an ID, the second the reason of the error,
then the coordinates of the error, a value (depending on the type of the error) and finally the resolution column
which indicates the resolution of the error. At the bottom of this table, you can export the error into a shapefile.
At the left, you have the number of the errors and the fixed errors.

Plugin-ul Verificator de Geometrie poate găsi următoarele erori:

• Self intersections: a polygon with a self intersection,

• Duplicate nodes: two duplicates nodes in a segment

• Holes: hole in a polygon,

• Segment length: a segment length lower than a threshold,

• Minimum angle: two segments with an angle lower than a threshold,

• Minimum area: polygon area lower than a treshold,

• Silver polygon: this error come from very small polygon (with small area) with a large perimeter,

• Duplicates features,

• Feature within feature,

• Overlaps: polygon overlapping,

• Gaps: gaps between polygons

Figura următoare prezintă diferitele verificări efectuate de către plugin.

You can select a row to see the localisation of the error. You can change this behaviour by selecting another action

between error (default), Feature, Don’t move, and Highlight contour of selected features.

Below the zoom action when clicking on the table row, you can Show the selected features in attribute table, Fix
selected errors using default resolution and Fix selected errors, prompt for resolution method. In the latter, you
will see a window to choose the resolution’s method among which:
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Figure 21.20: Plugin-ul Verificator de Geometrie
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Figure 21.21: The Differents checks supported by the plugin
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• Merge with neighboring polygon with longest shared edge,

• Merge with neighboring polygon with largest area,

• Merge with neighboring polygon identical attribute value,if any, or leave as it

• Delete feature

• No action

Tip: Remediere erori multiple
You can fix multiple errors by selecting more than one row in the table with the CTRL + click action.

The default action could be changed with the last icon Error resolution settings. For some type of errors, you can
change the default action between some specific action or No action.

În cele din urmă, putet,i alege atributul care va fi utilizat, atunci când fuzionează entităt,ile după valoarea atribu-
tului.

21.10 Plugin-ul de Acros, are a Geometriei

Cu ajutorul instrumentului de Acros, are Geometrie, putet,i alinia în mod automat marginile s, i vertecs, ii unui strat
vectorial fat,ă de marginile s, i vertecs, ii unui al doilea strat, folosind o tolerant,ă definită de utilizator.

Interfat,a de mai jos arată setările acestui plug-in. Utilizatorul trebuie să aleagă stratul de schimbat (a se vedea
stratul vectorial de intrare) s, i straturile de referint,ă la care va avea loc acros, area. O distant,ă maximă de acros, are
(în unităt,i de hartă) permite schimbarea tolerant,ei de acros, are.

Se pot acros, a numai entit(ăt,ile) selectate, prin bifarea opt,iunii Numai entităt,ile selectate.

Output vector layer allows you to choose between Modifying input layer or Create a new layer.

Figure 21.22: Plugin-ul de Acros, are a Geometriei

21.11 Plugin-ul de georeferent,iere

The Georeferencer Plugin is a tool for generating world files for rasters. It allows you to reference rasters to
geographic or projected coordinate systems by creating a new GeoTiff or by adding a world file to the existing
image. The basic approach to georeferencing a raster is to locate points on the raster for which you can accurately
determine coordinates.
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Funct,ionalităt,i

Pictogramă Scop Pictogramă Scop

Deschidere raster Start georeferent,iere

Generare script GDAL Încărcare puncte GCP

Salvare puncte GCP ca Setări de transformare

Adăugare punct S, tergere punct

Mutare punct GCP Panoramare

Mărire Mics, orare

Mărire la nivelul stratului Nivelul de mărire anterior

Următorul nivel de mărire Legarea Georeferent,iatorului de QGIS

Legarea aplicat,iei QGIS de Georeferent,iator Întinderea completă a histogramei

Întinderea locală a histogramei

Table Georeferencer: Georeferencer Tools

21.11.1 Procedura uzuală

Pentru introducerea coordonatelor X s, i Y (DMS (dd mm ss.ss), DD (dd.dd) sau a coordonatelor proiectate
(mmmm.mm)), ce corespund cu punctul selectat din imagine, pot fi folosite două proceduri alternative:

• Uneori, rasterul are pe margine cruciulit,e cu coordonatele “scrise” pe imagine. În acest caz, putet,i introduce
manual coordonatele.

• Folosirea straturilor deja georeferent,iate. Acestea pot fi date raster sau vectoriale care cont,in aceleas, i
obiecte/entităt,i pe care le are s, i imaginea pe care dorit,i să o georeferent,iat,i, având s, i proiect,ia pe care o
dorit,i pentru imaginea dvs. În acest caz, putet,i introduce coordonatele, făcând clic pe setul de date de
referint,ă încărcat în canevasul hărt,ii QGIS.

Procedura standard de georeferent,iere a unei imagini implică selectarea mai multor puncte de pe raster,
specificându-le coordonatele s, i alegând o modalitate relevantă de transformare a tipului lor. Bazându-se pe
parametrii s, i datele introduse, plugin-ul va calcula parametrii fis, ierului hart,ii lumii. Cu cât oferit,i mai multe
coordonate, cu atât va fi mai bun rezultatul.

The first step is to start QGIS, load the Georeferencer Plugin (see Dialogul Plugin-urilor) and click on Raster
→ Georeferencer , which appears in the QGIS menu bar. The Georeferencer Plugin dialog appears as shown in
figure_georeferencer_dialog.

For this example, we are using a topo sheet of South Dakota from SDGS. It can later be visualized to-
gether with the data from the GRASS spearfish60 location. You can download the topo sheet here:
http://grass.osgeo.org/sampledata/spearfish_toposheet.tar.gz.

Introducet,i punctele de control din teren (GCPs)

1. Pentru a începe o georeferent,iere, trebuie să încărcat,i un raster fără referint,ă cu ajutorul butonului .
Rasterul va apărea în zona principală de lucru a dialogului. O dată ce rasterul este încărcat, putem începe să
introducem punctele de referint,ă.

2. Using the Add Point button, add points to the main working area and enter their coordinates (see Figure
figure_georeferencer_add_points). For this procedure you have three options:

• Facet,i clic pe un punct din imaginea raster s, i introducet,i coordonatele X s, i Y manual.
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Figure 21.23: Georeferencer Plugin Dialog

• Facet,i clic pe un punct din imaginea raster, apoi aleget,i butonul From map canvas pentru a adăuga
coordonatele X s, i Y, cu ajutorul unei hărt,i georeferent,iate, deja încărcate în canevasul hărt,ii QGIS.

• Cu ajutorul butonului , putet,i muta GCP-urile în ambele ferestre, dacă sunt pozit,ionate eronat.

3. Continuat,i să introducet,i puncte. Ar trebui să aibă cel put,in patru puncte, iar cu cât mai mult coordonate
introducet,i, cu atât mai bun va fi rezultatul. Există instrumente adit,ionale în dialogul pluginului, pentru
transfocarea s, i deplasarea zonei de lucru, în scopul localizării unui set relevant de puncte GCP.

Figure 21.24: Add points to the raster image

Punctele care sunt adăugate la hartă vor fi stocate într-un fis, ier text separat ([filename].points), de obicei,
alăturat imaginii raster. Acest lucru ne permite să redeschidem plugin-ul Georeferent,iator la o dată ulterioară s, i să
adăugăm noi puncte, sau să le s, tergem pe cele existente, pentru a optimiza rezultatul. Fis, ierul de puncte cont,ine

valori de forma: mapX, mapY, pixelX, pixelY. Putet,i utiliza butoanele de Încărcare puncte GCP s, i
Salvare puncte GCP ca... pentru a gestiona fis, ierele.
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Definirea setărilor de transformare

După ce at,i adăugat GCP / Ground Control Point = Puncte de Control pe Teren, la imaginea raster, va trebui să
definit,i parametrii transformării pentru procesul de georeferent,iere.

Figure 21.25: Defining the georeferencer transformation settings

Algoritmi de transformare disponibili

În funct,ie de cât de multe puncte de control at,i capturat din teren, poate că dorit,i să utilizat,i divers, i algoritmi de
transformare. Alegerea algoritmului de transformare depinde, de asemenea, de tipul s, i calitatea datelor de intrare,
s, i de valoarea distorsiunilor geometrice pe care dorit,i să le introducet,i în rezultatul final.

În mod curent, sunt disponibile următoarele tipuri de transformări:

• Algoritmul Liniar este utilizat la crearea unui fis, ier world, fiind diferit de alt,i algoritmi prin faptul că nu
transformă, de fapt, rasterul. Acest algoritm probabil că nu va fi suficient, atunci când vă confruntat,i cu un
material scanat.

• The Helmert transformation performs simple scaling and rotation transformations.

• Algoritmii Polinomiali 1-3 sunt printre cele mai utilizat,i algoritmi pe scară largă, pentru a se potrivi
punctelor de control sursă s, i destinat,ie, din teren. Cel mai folosit algoritm este transformarea polinomi-
ală de gradul doi, ceea ce permite o anumită curbură. Transformarea polinomială de gradul întâi (afină)
păstrează coliniaritatea, s, i permite numai scalarea, translat,ia s, i rotat,ia.

• Algoritmul Thin Plate Spline (TPS) este o metodă de georeferent,iere mai modernă, care este capabil de
a introduce deformări locale în date. Acest algoritm este util atunci când sunt georeferent,iate originale de
calitate foarte mică.

• Transformarea Projective efectuează translat,ia s, i rotat,ia liniară a coordonatelor.
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Definire metodă de reeşantionare

Tipul de rees, antionarea pe care o aleget,i va depinde în funct,ie de datele de intrare s, i de obiectivul final al
exercit,iului . Dacă nu dorit,i să modificat,i statistica imaginii , este posibil să dorit,i să aleget,i ” Cel mai apropiat
vecin ” , în timp ce un ” rees, antionare Cubică ” va oferi probabil un rezultat mai finisat .

Dacă este posibil, se va alege între cinci metode diferite de rees, antionare:

1. Cel mai apropiat vecin

2. Liniar

3. Cubic

4. Curbă Cubică

5. Lanczos

Definit,i setările de transformare

Există mai multe opt,iuni care trebuie definite pentru grila de ies, ire georeferentiată.

• Caseta de text Create world file este disponibilă numai dacă vă decidet,i să utilizat,i tipul de transformare
liniar, pentru că acest lucru înseamnă că imaginea raster nu va fi transformată, în realitate. În acest caz,
câmpul Output raster nu este activat, deoarece se va crea numai un nou fis, ier world.

• Pentru toate celelalte tipuri de transformare, trebuie să definit,i o Ies, ire raster. Implicit, un nou fis, ier ([file-
name]_modified) va fi creat în acelas, i dosar, împreună cu imaginea raster originală.

• Ca un pas următor, trebuie să definit,i Target SRS (Sistemul de Referint,ă Spat,ială) pentru rasterul
georeferent,iat (v. Lucrul cu Proiect,ii).

• Dacă dorit,i, putet,i genera o hartă PDF s, i, de asemenea, **un raport pdf **. Raportul include informat,ii cu
privire la parametrii utilizat,i de transformare, o imagine a reziduurilor s, i o listă cu toate GCP-urile s, i erorile
lor RMS.

• În plus, putet,i bifa caseta Setare Rezolut,ie T, intă, pentru a defini rezolut,ia pixelilor din rasterul de ies, ire.
Rezolut,iile orizontală s, i verticală implicite sunt 1.

• Opt,iunea Use 0 for transparency when needed poate fi activată, dacă pixelii cu valoarea 0 ar trebui să
fie transparent,i. În exemplul nostru toposheet, toate zonele albe ar trebui să fie transparente.

• În cele din urmă, Load in QGIS when done încarcă automat rasterul rezultat în canevasul hărt,ii QGIS,
atunci când are loc transformarea.

Afis, area s, i adaptarea proprietăt,ilor rasterului

Clicking on the Raster properties option in the Settings menu opens the Layer properties dialog of the raster file
that you want to georeference.

Configurarea georeferent,iatorului

• Putet,i defini dacă să arătat,i coordonatele s, i/sau ID-urile GCP.

• Ca unităt,i reziduale, se pot alege pixelii s, i unităt,ile de hartă.

• Pentru raportul PDF, pot fi definite o margine stângă s, i una dreaptă s, i, de asemenea, dimensiunea hârtiei
pentru harta PDF.

• În final, putet,i bifa caseta Arată fereastra Georeferent,iatorului andocată.
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Execut,ie transformare

After all GCPs have been collected and all transformation settings are defined, just press the Start georeferencing

button to create the new georeferenced raster.

21.12 Plugin-ul Heatmap

Plugin-ul Heatmap foloses, te Evaluarea Densităt,ii Nucleului pentru a crea un raster al densităt,ii (o hartă calorică)
dintr-un strat de puncte vectoriale de intrare. Densitatea se calculează pe baza numărului de puncte dintr-o locat,ie,
un număr mai mare de puncte într-o aglomerare determinând valori mai mari. Hărt,ile calorice permit identificarea
cu us, urint,ă a “punctelor fierbint,i” s, i a aglomerărilor de puncte.

21.12.1 Activarea plugin-ului Heatmap

First this core plugin needs to be activated using the Plugin Manager (see Dialogul Plugin-urilor). After activation,

the heatmap icon can be found in the Raster Toolbar, and under the Raster → Heatmap menu.

Selectat,i meniul View → Toolbars → Raster pentru a arăta Bara de Instrumente, dacă aceasta nu este vizibilă.

21.12.2 Folosirea plugin-ului Heatmap

Clicking the Heatmap tool button opens the Heatmap plugin dialog (see figure_heatmap_settings).

Dialogul are următoarele opt,iuni:

• Stratul punctelor de intrare: Listează toate straturile vectoriale de tip punct din proiectul curent, fiind
utilizat la selectarea stratului care urmează să fie analizat.

• Rasterul de ies, ire: Permite folosirea butonului pentru a selecta directorul s, i numele de fis, ier pe care
le generează plugin-ul Heatmap pentru imaginea rasterului de ies, ire. O extensie de fis, ier nu este necesară.

• Output format: Selects the output format. Although all formats supported by GDAL can be chosen, in
most cases GeoTIFF is the best format to choose.

• Radius: Is used to specify the heatmap search radius (or kernel bandwidth) in meters or map units. The
radius specifies the distance around a point at which the influence of the point will be felt. Larger values
result in greater smoothing, but smaller values may show finer details and variation in point density.

Atunci când este bifată caseta Advanced, vor fi disponibile opt,iuni adit,ionale:

• Rows and Columns: Used to change the dimensions of the output raster. These values are also linked to
the Cell size X and Cell size Y values. Increasing the number of rows or columns will decrease the cell size
and increase the file size of the output file. The values in Rows and Columns are also linked, so doubling
the number of rows will automatically double the number of columns and the cell sizes will also be halved.
The geographical area of the output raster will remain the same!

• Cell size X and Cell size Y: Control the geographic size of each pixel in the output raster. Changing these
values will also change the number of Rows and Columns in the output raster.

• Kernel shape: The kernel shape controls the rate at which the influence of a point decreases as the distance
from the point increases. Different kernels decay at different rates, so a triweight kernel gives features
greater weight for distances closer to the point then the Epanechnikov kernel does. Consequently, triweight
results in “sharper” hotspots, and Epanechnikov results in “smoother” hotspots. A number of standard
kernel functions are available in QGIS, which are described and illustrated on Wikipedia.

• Decay ratio: Can be used with Triangular kernels to further control how heat from a feature decreases with
distance from the feature.
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– O valoare de 0 (=minimum) indică o căldură concentrată în centrul razei date, s, i complet stinsă la
margine.

– O valoare de 0.5 indică faptul că pixelii de la marginea razei vor primi jumătate din “căldura” pe care
o primesc pixelii aflat,i în centrul razei de căutare.

– O valoare de 1 semnifică distribuirea uniformă a căldurii pe întreaga rază a cercului de căutare. (Acest
lucru este echivalent cu kernel-ul ‘Uniform’.)

– O valoare mai mare decât 1 indică o căldură mai mare înspre marginea razei de căutare, decât în centru.

Stratul punctelor de intrare poate avea, de asemenea, câmpuri atribut, care pot afecta modul de influent,are a hărt,ii
calorice:

• Use radius from field: Sets the search radius for each feature from an attribute field in the input layer.

• Use weight from field: Allows input features to be weighted by an attribute field. This can be used to
increase the influence certain features have on the resultant heatmap.

Când este specificat ca ies, ire un nume de fis, ier raster, butonul [OK] poate fi utilizat pentru a crea harta calorică.

21.12.3 Tutorial: Crearea unei Hărt,i Calorice

For the following example, we will use the airports vector point layer from the QGIS sample dataset (see
Sample Data). Another excellent QGIS tutorial on making heatmaps can be found at http://www.qgistutorials.com.

In Figure_Heatmap_data, the airports of Alaska are shown.

Figure 21.26: Aeroporturile din Alaska

1. Select the Heatmap tool button to open the Heatmap dialog (see Figure_Heatmap_settings).

2. In the Input point layer field, select airports from the list of point layers loaded in the current
project.

3. Specify an output filename by clicking the button next to the Output raster field. Enter the filename
heatmap_airports (no file extension is necessary).
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4. Lăsat,i GeoTIFF ca Format de ies, ire implicit.

5. Schimbat,i valoarea Razei la 1000000 metri.

6. Click on [OK] to create and load the airports heatmap (see Figure_Heatmap_created).

Figure 21.27: Dialogul Hărt,ii Calorice

QGIS will generate the heatmap and add the results to your map window. By default, the heatmap is shaded in
greyscale, with lighter areas showing higher concentrations of airports. The heatmap can now be styled in QGIS
to improve its appearance.

1. Open the properties dialog of the heatmap_airports layer (select the layer heatmap_airports,
open the context menu with the right mouse button and select Properties).

2. Selectat,i fila Stil.

3. Schimbat,i Tipul randării pe ‘Singleband pseudocolor’.

4. Selectat,i o Hartă de culoare , cum ar fi YlOrRed.

5. Clic p butonul [Load] pentru a obt,ine valorile minime s, i maxime din raster, apoi facet,i clic pe butonul
[Classify].

6. Apăsat,i [OK] pentru a actualiza stratul.

The final result is shown in Figure_Heatmap_styled.

21.13 Plugin-ul de Interpolare

The Interpolation plugin can be used to generate a TIN or IDW interpolation of a point vector layer. It is very
simple to handle and provides an intuitive graphical user interface for creating interpolated raster layers (see
Figure_interpolation). The plugin requires the following parameters to be specified before running:

• Straturile vectoriale de intrare: Specificat,i strat(urile) vectoriale de intrare, de tip punct, dintr-o listă de
straturi încărcate. În cazul în care sunt specificate mai multe straturi, atunci vor fi folosite pentru interpolare
datele din toate straturile. Notă: Este posibilă introducerea liniilor sau poligoanelor ca s, i constrângeri pentru
triangulare, prin specificarea “punctelor”, a “liniilor de structură” sau a “liniilor de întrerupere” în caseta

Tip .
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Figure 21.28: După încărcare, harta calorică arată ca o suprafat,ă gri

Figure 21.29: Harta calorică, stilizată, a aeroporturilor din Alaska
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• Atributul de interpolare: Selectat,i coloana atributului care se va utiliza pentru interpolare, sau activat,i

caseta de Utilizare a Coordonatei Z, pentru a folosi valorile Z stocate în strat.

• Metoda de Interpolare: Selectat,i metoda de interpolare. Aceasta poate fi ori ‘Ret,ea Neregulată Triangulată
(TIN)’, ori ‘Distant,a Inversă Ponderată (IDW)’. Cu ajutorul metodei TIN putet,i crea o suprafat,ă alcătuită
din triunghiuri, cu ajutorul celor mai apropiate puncte învecinate. Pentru a face acest lucru, sunt create
cercuri în jurul punctelor selectate, iar intersect,iile lor sunt conectate la o ret,ea de triunghiuri, pe cât posibil,
nesuprapuse s, i compacte. Suprafet,ele rezultate nu sunt netede. Atunci când se utilizează metoda IDW,
punctele sunt ponderate pe durata interpolării, în as, a fel încât influent,a unui punct în raport cu altul, scade
o dată cu distant,a fat,ă de punctul necunoscut, pe care dorit,i să-l creat,i. Metoda de interpolare IDW are s, i
unele dezavantaje: calitatea rezultatului interpolării poate scădea în cazul în care distribut,ia punctelor este
inegală. Mai mult, valorile maxime s, i minime ale suprafet,ei interpolate pot apărea numai pentru datele de
tip punct. Rezultatul constă în mici vârfuri s, i gropi, în jurul punctelor din es, antion.

• Configurarea Metodei de Interpolare: Asigură configurarea metodei de interpolare pe care at,i ales-o.
Pentru metoda TIN putet,i alege între metodele de interpolare Liniară s, i Clough Toucher (cubică). De aseme-
nea, putet,i salva triangulat,ia în format de fis, ier shape. Pentru interpolarea IDW se poate seta coeficientul de
distant,ă.

• Numărul de coloane/rânduri: Specificat,i numărul de rânduri s, i coloane pentru fis, ierul de ies, ire raster.

• Fis, ierul de ies, ire: Specificat,i un nume pentru fis, ierul raster generat.

• Adăugat,i rezultatul în proiect pentru a-l vedea pe canevasul hărt,ii.

Ret,inet,i că dacă utilizat,i liniile ca s, i constrângeri pentru interpolarea triangulării (metoda TIN), putet,i folosi fie
‘linii de structură’ fie ‘linii de întrerupere’. Atunci când folosit,i ‘linii de întrerupere’ vet,i produce treceri brus, te
pe suprafat,ă, în timp ce ‘liniile de structură’ vor produce treceri continue. Triangularea este modificată de către
ambele metode, astfel încât nici o muchie nu traversează o linie de întrerupere sau de structură.

Figure 21.30: Plugin-ul de Interpolare

21.13.1 Modul de utilizare a plugin-ului

1. Lansat,i QGIS s, i încărcat,i un strat vectorial de tip punct (cum ar fi elevp.csv).

2. Load the Interpolation plugin in the Plugin Manager (see Dialogul Plugin-urilor) and click on the Raster

→ Interpolation → Interpolation menu, which appears in the QGIS menu bar. The Interpolation plugin
dialog appears as shown in Figure_interpolation.

3. Selectat,i un strat de intrare (cum ar fi elevp ) s, i o coloană (de ex.: ELEV) pentru interpolare.

4. Selectat,i o metodă de interpolare (de exemplu, ‘Ret,ea Neregulată Triangulată (TIN)’), s, i specificat,i o di-
mensiune a celulelor de 5000, precum s, i numele fis, ierului de ies, ire raster (de exemplu, elevation_tin).
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5. Clic pe [OK].

21.14 MetaSearch Catalog Client

21.14.1 Introducere

Metasearch este un plug-in QGIS care acceptă standardul Serviciului de Catalogare OGC pentru Web (CSW),
fiind dedicat interact,iunii cu serviciile de catalogare a metadatelor.

MetaCăutarea oferă o abordare simplă, intuitivă, s, i o interfat,ă prietenoasă, pentru căutarea în cataloagele cu meta-
date din QGIS.

Figure 21.31: Search and results of Services in Metasearch

21.14.2 Instalare

MetaSearch is included by default with QGIS 2.0 and higher. All dependencies are included within MetaSearch.

Install MetaSearch from the QGIS plugin manager, or manually from http://plugins.qgis.org/plugins/MetaSearch.

21.14.3 Lucrul cu Catalogul Metadatelor în QGIS

CSW (Serviciu de Catalogare pentru Web)

CSW (Catalog Service for the Web) is an OGC (Open Geospatial Consortium) specification, that defines common
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interfaces to discover, browse and query metadata about data, services, and other potential resources.

Iniţializare

To start MetaSearch, click icon or select Web → MetaSearch → MetaSearch via the QGIS main menu. The
MetaSearch dialog will appear. The main GUI consists of three tabs: Services, Search and Settings.

Gestiunea Serviciului Catalog

Figure 21.32: Gestiunea Serviciului Catalog

The Services tab allows the user to manage all available catalog services. MetaSearch provides a default list of
Catalog Services, which can be added by pressing [Add default services] button.

To all listed Catalog Service entries, click the dropdown select box.

To add a Catalog Service entry, click the [New] button, and enter a Name for the service, as well as the URL
(endpoint). Note that only the base URL is required (not a full GetCapabilities URL). Clicking [OK] will add the
service to the list of entries.

To edit an existing Catalog Service entry, select the entry you would like to edit and click the [Edit] button, and
modify the Name or URL values, then click [OK].

To delete a Catalog Service entry, select the entry you would like to delete and click the [Delete] button. You will
be asked to confirm deleting the entry.

MetaSearch allows for loading and saving connections to an XML file. This is useful when you need to share
settings between applications. Below is an example of the XML file format.

<?xml version="1.0" encoding="UTF-8"?>
<qgsCSWConnections version="1.0">

<csw name="Data.gov CSW" url="https://catalog.data.gov/csw-all"/>
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<csw name="Geonorge - National CSW service for Norway" url="http://www.geonorge.no/geonetwork/srv/eng/csw"/>
<csw name="Geoportale Nazionale - Servizio di ricerca Italiano" url="http://www.pcn.minambiente.it/geoportal/csw"/>
<csw name="LINZ Data Service" url="http://data.linz.govt.nz/feeds/csw"/>
<csw name="Nationaal Georegister (Nederland)" url="http://www.nationaalgeoregister.nl/geonetwork/srv/eng/csw"/>
<csw name="RNDT - Repertorio Nazionale dei Dati Territoriali - Servizio di ricerca" url="http://www.rndt.gov.it/RNDT/CSW"/>
<csw name="UK Location Catalogue Publishing Service" url="http://csw.data.gov.uk/geonetwork/srv/en/csw"/>
<csw name="UNEP/GRID-Geneva Metadata Catalog" url="http://metadata.grid.unep.ch:8080/geonetwork/srv/eng/csw"/>

</qgsCSWConnections>

To load a list of entries, click the [Load] button. A new window will appear; click the [Browse] button and
navigate to the XML file of entries you wish to load and click [Open]. The list of entries will be displayed. Select
the entries you wish to add from the list and click [Load].

Click the [Service info] button to displays information about the selected Catalog Service such as service iden-
tification, service provider and contact information. If you would like to view the raw XML response, click the
[GetCapabilities response] button. A separate window will open displaying Capabilities XML.

Searching Catalog Services

Figure 21.33: Searching catalog services

The Search tab allows the user to query Catalog Services for data and services, set various search parameters and
view results.

Următorii parametri de căutare sunt disponibili:

• Keywords: free text search keywords;

• From: the Catalog Service to perform the query against;

• Bounding box: the spatial area of interest to filter on defined by Xmax, Xmin, Ymax, and Ymin. Click [Set
global] to do a global search, click [Map extent] to do a search on the visible area only or manually enter
custom values as desired.
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Clicking the [Search] button will search the selected Metadata Catalog. Search results are displayed in a list and
are sortable by clicking on the column title. You can navigate through search results with the directional buttons
below the search results. Clicking the [View search results as XML] button opens a window with the service
response in raw XML format.

Clicking a result will provides the following options:

• if the metadata record has an associated bounding box, a footprint of the bounding box will be displayed on
the map;

• double-clicking the record displays the record metadata with any associated access links. Clicking the links
opens the link in the user’s web browser;

• if the record is an OGC web service (WMS/WMTS, WFS, WCS), the appropriate [Add to
WMS/WMTS|WFS|WCS] buttons will be enabled for the user to add to QGIS. When clicking this but-
ton, MetaSearch will verify if this is a valid OWS. The OWS will then be added to the appropriate QGIS
connection list, and the appropriate WMS/WMTS|WFS|WCS connection dialog will then appear.

Figure 21.34: Afis, area metadatelor unei înregistrări

Setări

Putet,i rafina MetaCăutatea cu ajutorul următoarelor setări:

• Connection naming: when adding an OWS connection (WMS/WMTS|WFS|WCS), the connection is stored
with the various QGIS layer provider. Use this setting to set whether to use the name provided from
MetaSearch, whether to overwrite or to use a temporary name;

• Results paging: when searching metadata catalogs, the number of results to show per page. Default value is
10;

• Timeout: when searching metadata catalogs, the number of seconds for blocking connection attempt. De-
fault value is 10.
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Figure 21.35: Metasearch setting

21.15 Plugin-ul de Editare Offline

Pentru colectarea datelor, lucrul în teren cu un laptop sau un telefon mobil, neconectate la ret,ea, reprezintă o
situat,ie comună. La revenirea ret,elei, modificările trebuie să fie sincronizate cu sursa de date de master (cum
ar fi o bază de date PostGIS). Dacă mai multe persoane lucrează simultan la aceleas, i seturi de date, este dificilă
fuzionarea editărilor individuale, chiar dacă nimeni nu modifică aceleas, i entităt,i.

Pluginul de Editare Offline automatizează sincronizarea, prin copierea cont,inutului unei surse de date (de obicei
PostGIS sau WFS-T) într-o bază de date SpatiaLite, s, i prin stocarea offline a modificărilor, într-o tabelă dedicată.
După reconectarea la ret,ea, este posibilă aplicarea modificărilor efectuate asupra setului de date de master în
perioada lipsei conexiunii la ret,ea.

21.15.1 Utilizarea plugin-ului

• Deschidet,i un proiect cu unele straturi vectoriale (de ex. dintr-o sursă de date PostGIS sau WFS-T).

• Go to Database → Offline Editing → Convert to offline project and select the layers to save. The content
of the layers is saved to SpatiaLite tables.

• You can check Only synchronize selected features if a selection is present allowing the offline editing to
only save and work on a subset. It can be invaluable in case of large layers.

• Editarea offline a straturilor.

• După restabilirea conexiunii, actualizat,i modificările folosind Baza de date → Editare Offline → Sin-
cronizare.
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Figure 21.36: Creare proiect offline din PostGIS sau din straturile WFS.

21.16 Plugin-ul GeoRaster Oracle Spatial

In Oracle databases, raster data can be stored in SDO_GEORASTER objects available with the Oracle Spatial

extension. In QGIS, the Oracle Spatial GeoRaster plugin is supported by GDAL and depends on Oracle’s database
product being installed and working on your machine. While Oracle is proprietary software, they provide their
software free for development and testing purposes. Here is one simple example of how to load raster images to
GeoRaster:

$ gdal_translate -of georaster input_file.tif geor:scott/tiger@orcl

Acesta va încărca rasterul în tabela GDAL_IMPORT, sub forma unei coloane denumite RASTER.

21.16.1 Gestionare conexiuni

Firstly, the Oracle GeoRaster Plugin must be enabled using the Plugin Manager (see Dialogul Plugin-urilor). The
first time you load a GeoRaster in QGIS, you must create a connection to the Oracle database that contains the

data. To do this, begin by clicking on the Add Oracle GeoRaster Layer toolbar button – this will open the Select
Oracle Spatial GeoRaster dialog window. Click on [New] to open the dialog window, and specify the connection
parameters (See Figure_oracle_raster_connection):

• Nume: Introducet,i un nume pentru conexiunea la baza de date.

• Instant,a bazei de date: Introducet,i numele bazei de date la care vă vet,i conecta.

• Numele de utilizator: Numele utilizatorului care va fi utilizat pentru accesarea bazei de date.

• Parola: Parola asociată numelui de utilizator care este cerut la accesarea bazei de date.

Now, back on the main Oracle Spatial GeoRaster dialog window (see Figure_oracle_raster_selection), use the
drop-down list to choose one connection, and use the [Connect] button to establish a connection. You may also
[Edit] the connection by opening the previous dialog and making changes to the connection information, or use
the [Delete] button to remove the connection from the drop-down list.
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Figure 21.37: Dialogul de Creare a conexiunilor Oracle

21.16.2 Selectarea unui GeoRaster

O dată ce o conexiune a fost stabilită, fereastra subseturilor de date va arata numele tuturor tabelelor care cont,in
coloanele GeoRaster din această bază de date, în formatul unui nume de subset de date GDAL.

Facet,i clic pe unul dintre subseturile de date enumerate s, i apoi pe [Select], pentru a alege numele tabelei. În
acest moment, se va deschide o altă listă de subseturi de date, împreună cu numele coloanelor GeoRaster din acea
tabelă. Aceasta este, de obicei, o listă scurtă, din moment ce majoritatea utilizatorilor nu vor avea mai mult de una
sau două coloane GeoRaster într-o singură tabelă.

Facet,i clic pe unul dintre subseturile de date enumerate s, i apoi pe [Select], pentru a alege una dintre combinat,iile
tabelă/coloană. Caseta de dialog va arăta acum toate rândurile care cont,in obiecte GeoRaster. Ment,ionăm că lista
subseturilor de date va prezenta acum perechile alcătuite din Tabelele cu Date Raster s, i Id-urile Rasterelor.

În orice moment, intrarea select,iei poate fi editată pentru a merge direct la un GeoRaster cunoscut, sau pentru a
reveni la început s, i pentru a selecta un alt nume de tabelă.

Figure 21.38: Selectarea Dalogului Oracle GeoRaster

Datele de intrare selectate pot fi folosite, de asemenea, pentru a introduce o clauză WHERE la sfârs, itul
s, irului de identificare (ex.: geor:scott/tiger@orcl,gdal_import,raster,geoid=). Parcurget,i
http://www.gdal.org/frmt_georaster.html pentru mai multe informat,ii.
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21.16.3 Afis, area GeoRaster-ului

În cele din urmă, prin selectarea unui GeoRaster din lista Tabelelor de Date Raster s, i Id-urile Raster, imaginea
raster va fi încărcată în QGIS.

The Select Oracle Spatial GeoRaster dialog can be closed now and the next time it opens, it will keep the same
connection and will show the same previous list of subdatasets, making it very easy to open up another image
from the same context.

Note: GeoRasterele care cont,in piramide se vor afis, a mult mai rapid, dar piramidele trebuie să fie generate în
afara QGIS., folosind Oracle PL/SQL sau gdaladdo.

Următorul exemplu foloses, te gdaladdo:

$ gdaladdo georaster:scott/tiger@orcl,georaster\_table,georaster,georid=6 -r
nearest 2 4 6 8 16 32

Acesta este un exemplu care foloses, te PL/SQL:

$ sqlplus scott/tiger
SQL> DECLARE
gr sdo_georaster;

BEGIN
SELECT image INTO gr FROM cities WHERE id = 1 FOR UPDATE;
sdo_geor.generatePyramid(gr, ’rLevel=5, resampling=NN’);
UPDATE cities SET image = gr WHERE id = 1;
COMMIT;

END;

21.17 Plugin-ul de Analiză a Terenurilor Raster

The Raster Terrain Analysis Plugin can be used to calculate the slope, aspect, hillshade, ruggedness index
and relief for digital elevation models (DEM). It is very simple to handle and provides an intuitive graphical user
interface for creating new raster layers (see Figure_raster_terrain).

Descrierea analizei:

• Pante: Calculează unghiul de înclinare, în grade, pentru fiecare celulă (pe baza primei comenzi de estimare
derivativă).

• Aspectul: Expozit,ia (începe cu 0 pentru direct,ia nordului, în grade, în sens invers acelor de ceasornic).

• Umbrirea reliefului: Creează o hartă umbrită folosind lumina s, i umbra, pentru a oferi un aspect pronunt,at
tridimensional unei hărt,i cu relief umbrit. Harta de ies, ire are o singură bandă, care reflectă valoarea de gri a
pixelilor.

• Indicele de Robustet,e: O măsurare cantitativă a eterogenităt,ii terenului, as, a cum este descris de către Riley
s, i colab. (1999). Se calculează pentru fiecare locat,ie, prin rezumarea schimbărilor de altitudine, în grila 3x3
pixeli.

• Relieful: Creează o hartă a reliefului umbrit, din datele digitale ale elevat,iei. Este implementată o metodă de
alegere a culorilor de elevat,ie, prin analizarea distribut,iei de frecvent,ă. Harta de ies, ire este de tip multibandă,
cu trei benzi care reflectă valorile RGB ale reliefului umbrit.

21.17.1 Utilizarea plugin-ului

1. Pornit,i QGIS s, i încărcat,i stratul raster, gtopo30, din locat,ia es, antionului GRASS.

2. Încarcă plugin-ul de Analiză a Terenului Raster din Managerul de Plugin-uri (v. Dialogul Plugin-urilor).
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Figure 21.39: Plugin-ul de Modelare a Terenurilor Raster (calculul pantei)

3. Select an analysis method from the menu (e.g., Raster → Terrain Analysis → Slope). The Slope dialog
appears as shown in Figure_raster_terrain.

4. Specificat,i o cale s, i un tip pentru fis, ierul de ies, ire.

5. Clic pe [OK].

21.18 Plugin pentru Grafuri Rutiere

Road Graph este un plugin C++ pentru QGIS, care calculează calea cea mai scurtă dintre două puncte de pe orice
strat de tip polilinie, trasând apoi această cale pe ret,eaua de drumuri.

Figure 21.40: Plugin pentru Grafuri Rutiere

Caracteristici principale:

• Calculează calea, precum s, i lungimea s, i durata călătoriei.
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• Optimizarea se face în funct,ie de lungimea sau de timpul călătoriei.

• Exportă calea într-un strat vectorial.

• Evident,iază direct,iile drumurilor (aceasta e desfăs, oară lent, utilizându-se, în principal, pentru scopuri de
depanare s, i pentru testarea setărilor).

Ca s, i strat al drumurilor, putet,i utiliza orice strat vectorial de tip polilinie, în orice format acceptat de QGIS. Două
linii cu un punct comun sunt considerate conectate. Ret,inet,i că trebuie să utilizat,i CRS-ul stratului ca CRS pentru
proiect, în timpul editării stratului de drumuri. Acest lucru se datorează faptului că recalcularea coordonatelor între
diferite CRS-uri introduce unele erori care pot duce la discontinuităt,i, chiar s, i atunci când se foloses, te ‘acros, area’.

În tabela de atribute a stratului, pot fi folosite următoarele câmpuri:

• Viteza din sect,iunea drumurilor (câmp numeric).

• Direct,ia (orice tip care pot fi exprimat înr-un s, ir). Direct,iile înainte s, i înapoi corespund unui drum cu sens
unic, ambele direct,ii indicând un drum cu două sensuri.

Dacă unele câmpuri nu au nici o valoare sau nu există, se folosesc valorile implicite. Putet,i modifica valorile
implicite s, i unele setări de plugin, din caseta de dialog a setărilor.

21.18.1 Utilizarea plugin-ului

After plugin activation, you will see an additional panel on the left side of the main QGIS window. Now, en-
ter some parameters into the Road graph plugin settings dialog in the Vector → Road Graph menu (see fig-
ure_road_graph_settings).

Figure 21.41: Setările plugin-ului Road graph

După setarea Unităt,ilor de timp, a Unităt,ilor de distant,ă s, i a Tolerant,ei topologiei, putet,i alege stratul vectorial
din fila Stratului de transport. Aici putet,i alege, de asemenea, Câmpul direct,iei s, i Câmpul vitezei. În fila Setărilor
implicite, putet,i seta Direct,ia pentru calcule.

În cele din urmă, în panoul Shortest Path, selectat,i un punct de Start s, i unul de Stop în stratul ret,elei de drumuri,
apoi facet,i clic pe [Calculate].
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21.19 Pluginul de Interogare spaţială

Plugin-ul de Interogare Spat,ială vă permite să efectuat,i o interogare spat,ială (cum ar fi, selectarea entităt,ilor) într-un
strat t,intă, cu referire la un alt strat. Funct,ionalitatea sa se bazează pe biblioteca GEOS s, i depinde de stratul cu
entităt,i selectat.

Posibilii operatori sunt:

• Cont,ine

• Este egal

• Se suprapune

• Se încrucis, ează

• Se intersectează

• Este separat

• Atinge

• Este în interior

21.19.1 Utilizarea plugin-ului

Ca exemplu, ne dorim să găsim regiunile care cont,in aeroporturi, din setul de date Alaska.Sunt necesari următorii
pas, i:

1. Lansat,i QGIS s, i încărcat,i straturile vectoriale regions.shp s, i airports.shp.

2. Încărcat,i plugin-ul de Interogare Spat,ială din Managerul de Plugin-uri (v. Dialogul Plugin-urilor) s, i

efectuat,i clic pe pictograma Interogare Spat,ială, care apare în bara de meniuri QGIS. Se va afis, a dialogul
plugin-urilor.

3. Selectează stratul regiuni ca sursă, s, i stratul airporturi ca referint,ă pentru entităt,i.

4. Selectat,i ‘Cont,ine’ ca oprator, apoi facet,i clic pe operatorul [Apply].

Din interogare, vet,i obt,ine o listă de ID-uri ale entităt,ilor, cu mai multe opt,iuni, as, a cum se arată în fig-
ure_spatial_query.

• Clic pe Creează stratul cu lista elementelor.

• Selectat,i un ID din listă s, i efectuat,i clic pe Creează stratul cu select,ia.

• Selectat,i ‘Eliminarea din select,ia curentă’ din câmpul S, i foloses, te rezultatul la .

• Putet,i bifa Transfocare pe item sau guilabel:Jurnalizează mesajele.

• În plus, în ID-urile Entităt,ilor Rezultate cu opt,iunile ‘Sursă nevalidă’ s, i ‘Referint,e nevalide’ activate, putet,i
arunca o privire la entităt,ile cu erori geometrice. Aceste entităt,i nu sunt utilizate în interogare.

21.20 Plugin-ul de Verificare a Topologiei

Topologia descrie relat,iile dintre puncte, linii s, i poligoane, care reprezintă entităt,ile unei regiuni geografice. Cu
ajutorul plugin-ului Topology Checker, putet,i trece prinntre fis, ierele vectoriale s, i le putet,i verifica topologia, în
funct,ie de diverse reguli. Aceste reguli determină dacă între entităt,ile dvs. se află relat,ii spat,iale de tipurile ‘Equal’,
‘Contain’, ‘Cover’, ‘CoveredBy’, ‘Cross’, ‘Disjoint’, ‘Intersect’, ‘Overlap’, ‘Touch’ sau ‘Within’. Depinde de
întrebările dvs. individuale care dintre regulile topologice se vor aplica datelor vectoriale (de exemplu, în mod
normal, nu vet,i accepta depăs, iri în straturile de tip linie, dar în cazul unor străzi înfundate, nu dorit,i ca acestea să
fie eliminate din stratul vectorial).
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Figure 21.42: Analiza de Interogare Spat,ială - regiunile care cont,in aeroporturi

Figure 21.43: Plugin-ul de Verificare a Topologiei

450 Chapter 21. Plugin-uri



QGIS User Guide, Release 2.18

QGIS are o caracteristică de editare topologică încorporată, care este foarte bună pentru crearea fără erori a noilor
entităt,i. Dar erorile datelor existente s, i erorile introduse de utilizator sunt greu de găsit. Acest plugin vă ajută să
găsit,i astfel de erori, folosind o listă de reguli.

Este foarte simplă crearea regulilor de topologie cu plugin-ul Topology Checker.

În straturile de tip punct sunt disponibile următoarele reguli:

• Trebuie să fie acoperit de: Aici putet,i alege un strat vectorial din proiectul dvs. Punctele care nu sunt
acoperite de stratul vectorial dat, apar în câmpul ‘Eroare’.

• Trebuie să fie acoperit de punctele finale din: Aici putet,i alege un strat de tip linie din proiectul dvs.

• Trebuie să se afle în interior: Aici putet,i alege un strat poligonal din proiect. Punctele trebuie să fie în
interiorul unui poligon. Altfel, QGIS va înregistra o ‘Eroare’ pentru punct.

• Nu trebuie să aibă duplicate: Ori de câte ori un punct este reprezentat de două sau de mai multe ori, el va
apărea în câmpul ‘Eroare’.

• Nu trebuie să aibă geometrii nevalide: Verifică dacă geometriile sunt valabile.

• Nu trebuie să aibă geometrii-multi-parte: Toate punctele multi-parte sunt înscrise în câmpul ‘Eroare’.

În straturile de tip linie, sunt disponibile următoarele reguli:

• Punctele de capăt trebuie să fie acoperite de: Aici putet,i selecta un strat de tip punct din proiectul dvs.

• Nu trebuie să aibă răsuciri: Aceasta va arăta depăs, irile din stratul de tip linie.

• Nu trebuie să aibă duplicate: Ori de câte ori o linie este reprezentată de două sau de mai multe ori, ea va
apărea în câmpul ‘Eroare’.

• Nu trebuie să aibă geometrii nevalide: Verifică dacă geometriile sunt valabile.

• Nu trebuie să aibă geometrii multi-parte: Uneori, o geometrie poate fi de fapt o colect,ie de simple
geometrii (simple-părt,i). O astfel de geometrie poartă denumirea de geometrie multi-parte. În cazul în
care cont,ine doar un singur tip de geometrie simplă, o denumim multi-punct, multi-linie sau multi-poligon.
Toate liniile multi-parte sunt scrise în câmpul ‘Error’.

• Nu trebuie să aibă pseudo noduri: Punct final al unei geometrii de tip linie ar trebui să fie conectat la
capetele celorlalte două geometrii. În cazul în care capătul este conectat la punct final al unei singure
geometrii, acesta este denumit pseudo nod.

În straturile de tip poligon, sunt disponibile următoarele reguli:

• Trebuie să cont,ină: Strat poligonal trebuie să cont,ină cel put,in geometria unui punct din al doilea strat.

• Ar trebui să nu aibă duplicate: Poligoanele din acelas, i strat nu trebuie să aibă geometrii identice. Ori de
câte ori un poligon este reprezentat de două sau de mai multe ori, el va apărea în câmpul ‘Eroare’.

• Nu trebuie să aibă lacune: Poligoane adiacente nu trebuie să formeze goluri între ele. Granit,ele adminis-
trative ar putea fi ment,ionate ca un exemplu (poligoanele statelor din SUA nu au nici un fel de spat,ii între
ele...).

• Nu trebuie să aibă geometrii nevalide: Verifică dacă geometriile sunt valabile. Unele dintre regulile care
definesc o geometrie validă sunt:

– Inelele poligonale trebuie să fie închise.

– Inelele care definesc găurile ar trebui să fie situate în interiorul inelelor care definesc limitele exte-
rioare.

– Inelele pot să nu de auto-intersecteze (pot să nu se atingă sau să nu se suprapună).

– Inelele pot să nu se atingă cu alte inele, cu except,ia unui punct.

• Nu trebuie să aibă geometrii multi-parte: Uneori, o geometrie poate fi de fapt o colect,ie de simple
geometrii (simple-părt,i). O astfel de geometrie poartă denumirea de geometrie multi-parte. În cazul în care
cont,ine doar un singur tip de geometrie simplă, o denumim multi-punct, multi-linie sau multi-poligon. De
exemplu, o t,ară formată din mai multe insule poate fi reprezentată ca un multi-poligon.
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• Nu trebuie să se suprapună: Poligoanele adiacente nu ar trebui să partajeze nici un spat,iu comun.

• Nu trebuie să se suprapună cu: Poligoanele adiacente dintr-un strat nu ar trebui să partajeze nici un spat,iu
comun cu alt strat.

21.21 Plugin-ul de statistici zonale

Cu ajutorul plugin-ului Statistici zonale, putet,i analiza rezultatele unei clasificări tematice. Acesta vă per-
mite calcularea mai multor valori ale pixelilor dintr-un strat raster cu ajutorul unui strat vectorial poligonal (v.
figure_zonal_statistics). Alegând o bandă de culoare, plugin-ul generează coloane de ies, ire în stratul vectorial,
utilizând un prefix definit de utilizator, s, i calculează pentru fiecare poligon statistici cu privire la pixelii pe care îi
cont,ine. Statisticile disponibile sunt:

• Numărul: pentru a returna numărul de pixeli

• Suma: pentru a însuma valorile pixelilor

• Media: pentru a obt,ine valorile medii ale pixelilor

• Mediana: pentru a obt,ine valorile mediane ale pixelilor

• StDev: pentru a obt,ine deviat,ia standard a valorilor pixelilor

• Min: pentru a obt,ine valorile minime ale pixelilor

• Max: pentru a obt,ine valorile maxime ale pixelilor

• Intervalul: pentru a obt,ine intervalul de valori (max - min) ale pixelilor

• Minoritatea: pentru a obt,ine valorile pixelilor cel mai put,in reprezentat,i

• Majoritatea: pentru a obt,ine valorile pixelilor cel mai des reprezentat,i

• Varietatea: pentru a returna numărul de pixeli cu valori distincte

Figure 21.44: Dialogul statisticilor zonale
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CHAPTER 22

Asistent,ă s, i Ajutor

22.1 Liste de discut,ii

QGIS este în curs de dezvoltare activă s, i, ca atare, nu va funct,iona întotdeauna as, a cum vă as, teptat,i. Modul
preferat de a obt,ine ajutor este prin folosirea listei de discut,ii a utilizatorilor QGIS. Întrebările dvs. vor ajunge la
un public mai larg, iar răspunsurile să fie în beneficiul altor persoane.

22.1.1 Utilizatori QGIS

This mailing list is used for discussion of QGIS in general, as well as specific questions regarding its
installation and use. You can subscribe to the qgis-users mailing list by visiting the following URL:
http://lists.osgeo.org/mailman/listinfo/qgis-user

22.1.2 Dezvoltatori QGIS

If you are a developer facing problems of a more technical nature, you may want to join the qgis-developer mailing
list. This list is also a place where people can chime in and collect and discuss QGIS related UX (User Experience)
/ usability issues. It’s here: http://lists.osgeo.org/mailman/listinfo/qgis-developer

22.1.3 Echipa Comunităt,ii QGIS

This list deals with topics like documentation, context help, user guide, web sites, blog, mailing lists, forums, and
translation efforts. If you would like to work on the user guide as well, this list is a good starting point to ask your
questions. You can subscribe to this list at: http://lists.osgeo.org/mailman/listinfo/qgis-community-team

22.1.4 QGIS Translations

This list deals with the translation efforts. If you like to work on the translation of the website, manuals or the
graphical user interface (GUI), this list is a good starting point to ask your questions. You can subscribe to this list
at: http://lists.osgeo.org/mailman/listinfo/qgis-tr

22.1.5 Comitetul de Dirijare a Proiectului QGIS (PSC)

This list is used to discuss Steering Committee issues related to overall management and direction of QGIS. You
can subscribe to this list at: http://lists.osgeo.org/mailman/listinfo/qgis-psc

453

http://lists.osgeo.org/mailman/listinfo/qgis-user
http://lists.osgeo.org/mailman/listinfo/qgis-developer
http://lists.osgeo.org/mailman/listinfo/qgis-community-team
http://lists.osgeo.org/mailman/listinfo/qgis-tr
http://lists.osgeo.org/mailman/listinfo/qgis-psc


QGIS User Guide, Release 2.18

22.1.6 QGIS User groups

In order to locally promote QGIS and contribute to its development, some QGIS communities are orga-
nized into QGIS User Groups. These groups are places to discuss local topics, organize regional or na-
tional user meetings, organize sponsoring of features... The list of current user groups is available at
http://qgis.org/en/site/forusers/usergroups.html

You are welcome to subscribe to any of the lists. Please remember to contribute to the list by answering questions
and sharing your experiences.

22.2 IRC

We also maintain a presence on IRC - visit us by joining the #qgis channel on irc.freenode.net. Please wait for a
response to your question, as many folks on the channel are doing other things and it may take a while for them to
notice your question. If you missed a discussion on IRC, not a problem! We log all discussion, so you can easily
catch up. Just go to http://qgis.org/irclogs and read the IRC-logs.

Commercial support for QGIS is also available. Check the website http://qgis.org/en/commercial-support.html for
more information.

22.3 BugTracker

While the qgis-users mailing list is useful for general ‘How do I do XYZ in QGIS?’-type questions, you
may wish to notify us about bugs in QGIS. You can submit bug reports using the QGIS bug tracker at
http://hub.qgis.org/projects/quantum-gis/issues. When creating a new ticket for a bug, please provide an email
address where we can contact you for additional information.

Please bear in mind that your bug may not always enjoy the priority you might hope for (depending on its severity).
Some bugs may require significant developer effort to remedy, and the manpower is not always available for this.

Cererile de funct,ionalităt,i pot fi depuse, de asemenea, folosind acelas, i sistem de tichete ca s, i pentru erori.
Asigurat,i-vă că at,i selectat tipul Feature.

If you have found a bug and fixed it yourself, you can submit either a Pull Request on the Github QGIS Project
(prefered) or a patch also. The lovely redmine ticketsystem at http://hub.qgis.org/projects/quantum-gis/issues has
this type as well. Check the Patch supplied checkbox and attach your patch before submitting your bug.
One of the developers will review it and apply it to QGIS. Please don’t be alarmed if your patch is not applied
straight away – developers may be tied up with other commitments.

Note that if you supply a Pull Request, your change would be more likely be merged into the source code!

22.4 Blog

The QGIS community also runs a weblog at http://planet.qgis.org/planet/, which has some interesting articles for
users and developers as well provided by other blogs in the community. You are invited to contribute your own
QGIS blog!

22.5 Plugin-uri

The website http://plugins.qgis.org provides the official QGIS plugins web portal. Here, you find a list of all stable
and experimental QGIS plugins available via the ‘Official QGIS Plugin Repository’.
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22.6 Wiki

Lastly, we maintain a WIKI web site at http://hub.qgis.org/projects/quantum-gis/wiki where you can find a variety
of useful information relating to QGIS development, release plans, links to download sites, message-translation
hints and more. Check it out, there are some goodies inside!
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CHAPTER 23

Contribut,ii

QGIS is an open source project developed by a team of dedicated volunteers and organisations. We strive to be
a welcoming community for people of all race, creed, gender and walks of life. At any moment, you can get
involved.

23.1 Autori

Below are listed people who dedicate their time and energy to write, review, and update the whole QGIS docu-
mentation.

Tara Athan Radim Blazek K. Koy Godofredo Contreras Martin Dobias
Peter Ersts Anne Ghisla Stephan Holl N. Horning Magnus Homann
Werner Macho Denis Rouzaud Tyler Mitchell Claudia A. Engel Lars Luthman
Otto Dassau Brendan Morely David Willis Jürgen E. Fischer Yoichi Kayama
Alex Bruy Anita Graser Victor Olaya Marco Hugentobler Gary E. Sherman
Tim Sutton Larissa Junek Raymond Nijssen Richard Duivenvoorde Andreas Neumann
Astrid Emde Yves Jacolin Alexandre Neto Alessandro Pasotti Hien Tran-Quang
Andy Schmid Arnaud Morvan Akgar Gumbira Giovanni Allegri Diethard Jansen
Andy Allan Matthias Kuhn Chris Berkhout Carson J.Q. Farmer Steven Cordwell
Eric Goddard Frank Sokolic Luca Casagrande Harrissou Sant-anna Saber Razmjooei
Ilkka Rinne Jacob Lanstorp Ujaval Gandhi Jean-Roc Morreale Salvatore Larosa
João Gaspar Joshua Arnott Thomas Gratier Marco Bernasocchi Marie Silvestre
Ko Nagase Larry Shaffer Luigi Pirelli Konstantinos Nikolaou Maning Sambale
Manel Clos Mattheo Ghetta Bernhard Ströbl Luca Manganelli Nathan Woodrow
Nick Bearman Paul Blottière Vincent Picavet Maximilian Krambach René-Luc D’Hont
Tom Chadwin Patrick Sunter Nyall Dawson Milo Van der Linden Paolo Cavallini
Paolo Corti Hugo Mercier Gavin Macaulay Stefan Blumentrath Nicholas Duggan
David Adler Vincent Mora Tudor Barascu QGIS Koran Translator Stéphane Brunner
Jaka Kranjc Tom Kralidis Zoltan Siki Sebastian Dietrich Uros Preloznik
Dick Groskamp Mezene Worku Alexandre Busquets Dominic Keller Andre Mano
ajazepk icephale Andrei GiordanoPezzola zstadler
Ramon embelding

23.2 Traducători

QGIS is a multi-language application and as is, also publishes a documentation translated into several lan-
guages. Many other languages are being translated and would be released as soon as they reach a reason-
able percentage of translation. If you wish to help improving a language or request a new one, please see
http://qgis.org/en/site/getinvolved/index.html.

The current translations are made possible thanks to:
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Limba Contribut,ii
Bahasa
Indoneziană

Emir Hartato, I Made Anombawa, Januar V. Simarmata, Muhammad Iqnaul Haq Siregar,
Trias Aditya

Chineză
(Tradit,ională)

Calvin Ngei, Zhang Jun, Richard Xie

Olandeză Carlo van Rijswijk, Dick Groskamp, Diethard Jansen, Raymond Nijssen, Richard
Duivenvoorde, Willem Hoffman

Finlandeză Matti Mäntynen, Kari Mikkonen
Franceză Arnaud Morvan, Augustin Roche, Didier Vanden Berghe, Dofabien, Etienne Trimaille,

Harrissou Sant-anna, Jean-Roc Morreale, Jérémy Garniaux, Loïc Buscoz, Lsam, Marc-André
Saia, Marie Silvestre, Mathieu Bossaert, Mathieu Lattes, Mayeul Kauffmann, Médéric
Ribreux, Mehdi Semchaoui, Michael Douchin, Nicolas Boisteault, Nicolas Rochard, Pascal
Obstetar, Robin Prest, Rod Bera, Stéphane Henriod, Stéphane Possamai, sylther, Sylvain
Badey, Sylvain Maillard, Vincent Picavet, Xavier Tardieu, Yann Leveille-Menez, yoda89

Galiciană Xan Vieiro
Germană Jürgen E. Fischer, Otto Dassau, Stephan Holl, Werner Macho
Hindi Harish Kumar Solanki
Italiană Alessandro Fanna, Anne Ghisla, Flavio Rigolon, Giuliano Curti, Luca Casagrande, Luca

Delucchi, Marco Braida, Matteo Ghetta, Maurizio Napolitano, Michele Beneventi, Michele
Ferretti, Roberto Angeletti, Paolo Cavallini, Stefano Campus

Japoneză Baba Yoshihiko, Minoru Akagi, Norihiro Yamate, Takayuki Mizutani, Takayuki Nuimura,
Yoichi Kayama

Coreeană Capitolul OSGeo Coreean
Poloneză Andrzej Świąder, Borys Jurgiel, Ewelina Krawczak, Jakub Bobrowski, Mateusz Łoskot,

Michał Kułach, Michał Smoczyk, Milena Nowotarska, Radosław Pasiok, Robert Szczepanek,
Tomasz Paul

Portugheză Alexandre Neto, Duarte Carreira, Giovanni Manghi, João Gaspar, Joana Simões, Leandro
Infantini, Nelson Silva, Pedro Palheiro, Pedro Pereira, Ricardo Sena

Portugheză
(Brazilia)

Arthur Nanni, Felipe Sodré Barros, Leônidas Descovi Filho, Marcelo Soares Souza, Narcélio
de Sá Pereira Filho, Sidney Schaberle Goveia

Română Alex Bădescu, Bogdan Pacurar, Georgiana Ioanovici, Ionut, Iosifescu-Enescu, Sorin Călinică,
Tudor Bărăscu

Rusă Alexander Bruy, Artem Popov
Spaniolă Carlos Dávila, Diana Galindo, Edwin Amado, Gabriela Awad, Javier César Aldariz, Mayeul

Kauffmann
Ucrainiană Alexander Bruy
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CHAPTER 24

Anexă

24.1 Licent,a Publică Generală GNU

Versiunea 2, Iunie 1991

Copyright (C) 1989, 1991 Free Software Foundation, Inc. 59 Temple Place - Suite 330, Boston, MA 02111-1307,
USA

Oricui îi este permisă copierea şi distribuirea de copii identice ale acestui document, dar fără modificarea lui.

Preambul

Licent,ele majorităt,ii programelor sunt concepute pentru a vă priva de libertatea de a le partaja s, i de a le modifica.
Prin contrast, intent,ia Licent,ei Publice Generale GNU este de a vă garanta libertatea de a distribui s, i modifica
programele gratuite - pentru a se asigura că programele sunt gratuite pentru tot,i utilizatorii. Această Licent,ă Pub-
lică Generală se aplică majorităt,ii programelor apart,inând Free Software Foundation precum s, i tuturor celorlalte
programe ai căror autori decid să o folosească. (În schimb, alte programe apart,inând Free Software Foundation
se află sub Licent,a Publică Generală GNU pentru Biblioteci.) De asemenea, ea poate fi aplicată s, i programelor
dumneavoastră.

Când vorbim de software gratuit, ne referim la libertate, s, i nu la pret,. Licent,ele noastre sunt concepute să vă
garanteze libertatea de a distribui copii ale programelor gratuite (s, i de a oferi acest serviciu contra cost, dacă
dorit,i), de a primi sau de a obt,ine codul sursă, dacă dorit,i, de a schimba programul sau a folosi port,iuni din el în
noi programe libere, s, i de a s, ti că putet,i face toate aceste lucruri.

Pentru a vă proteja drepturile, trebuie să impunem restrict,ii împotriva oricui ar încerca să vă conteste aceste
drepturi sau să vă ceară să renunt,at,i la ele. Aceste restrict,ii implică anumite responsabilităt,i pentru dumneavoastră
dacă distribuit,i copii ale programelor, sau dacă le modificat,i.

De exemplu, dacă distribuit,i copii ale unui astfel de program, indiferent dacă o facet,i gratuit sau contra unei sume
de bani, trebuie să cedat,i beneficiarilor toate drepturile pe care le avet,i dumneavoastră. Trebuie să vă asigurat,i că
ei primesc, sau pot primi, codul sursă. În plus, trebuie să le arătat,i care sunt termenii în care primesc programul,
pentru a s, ti care le sunt drepturile.

Vă protejăm drepturile în două rânduri: (1) prin stabilirea drepturilor de autor pentru program, s, i (2) prin această
Licent,ă care vă conferă dreptul legal de a copia, distribui s, i/sau modifica programul.

De asemenea, pentru propria noastră protect,ie cât s, i pentru cea a autorilor, vrem să ne asigurăm că toată lumea
înt,elege că nu există niciun fel de garant,ie pentru acest program gratuit. Dacă programul este modificat de altcineva
s, i distribuit mai departe, vrem ca beneficiarii programului să s, tie că ceea ce au nu este originalul, în as, a fel încât
nicio problemă introdusă de altcineva nu va avea un efect negativ asupra reputat,iei autorilor init,iali.

În final, orice program liber este în mod constant amenint,at de patentele software. Vrem să evităm pericolul ca cei
ce redistribuie programele libere să obt,ină patente, practic transformând programul într-unul proprietar. Pentru a
preveni aceasta, facem clară pozit,ia noastră conform căreia orice patent trebuie acordat fie în as, a fel, încât să poată
fi licent,iat s, i fără restrict,ii pentru uzul gratuit al oricui, fie să nu necesite licent,ă.

Termenii s, i condit,iile exacte de copiere, distribuire s, i modificare sunt specificate în următoarele paragrafe. TER-
MENI S, I CONDIT, II PENTRU COPIERE, DISTRIBUIRE S, I MODIFICARE
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0. Această Licent,ă se aplică oricărui program sau proiect ce cont,ine o ment,iune a det,inătorului drepturilor de
autor spunând că poate fi distribuit în termenii acestei Licent,e Publice Generale. Prin “Program”, în contin-
uare, vom înt,elege orice asemenea program sau proiect, iar prin “lucru bazat pe Program” vom înt,elege fie
programul fie orice alt proiect derivat din Program, conform cu legea drepturilor de autor: adică, un proiect
ce cont,ine Programul sau port,iuni din el, fie în forma originală fie modificată s, i/sau tradusă în altă limbă. (În
restul acestui document traducerile vor fi incluse fără restrict,ii în termenul “modificare”.) Fiecare persoană
autorizată de această Licent,ă va fi desemnată prin termenul “dumneavoastră”.

Activităt,ile care nu sunt de copiere, distribuire s, i modificare nu sunt acoperite de această Licent,ă; ele sunt
în afara scopului ei. Activitatea de executare a Programului nu este restrict,ionată, iar rezultatul Programului
este acoperit de licent,ă doar în cazul în care cont,inutul său constituie un proiect bazat pe Program (indepen-
dent de faptul că a fost obt,inut prin rularea Programului). Măsura în care acest lucru este adevărat depinde
de natura Programului.

1. Puteţi copia şi distribui copii nemodificate ale codului sursă al Programului în forma în care îl primit,i, prin
orice mediu, cu condit,ia să specificaţi vizibil pe fiecare copie autorul şi lipsa oricărei garant,ii, să păstrat,i
intacte toate notele referitoare la această Licenţă şi la absenţa oricărei garant,ii şi să distribuiţi o copie a
acestei Licenţe cu fiecare copie a Programului.

Puteţi pretinde o retribut,ie financiară pentru actul fizic de transfer al unei copii, şi putet,i oferi garant,ie contra
cost.

2. Putet,i efectua modificări asupra copiilor Programului, sau asupra oricăror port,iuni ale sale, creând astfel
un proiect bazat pe Program, iar copierea s, i distribuirea unor asemenea modificări sau proiecte se pot face
conform termenilor Sect,iunii 1 de mai sus, doar dacă toate condit,iile următoarele sunt îndeplinite:

(a) Trebuie ca fis, ierele modificate să cont,ină notit,e proeminent vizibile, care să ment,ioneze faptul că
dumneavoastră le-at,i modificat, precum s, i data fiecărei modificări.

(b) Trebuie ca orice proiect pe care îl distribuit,i sau publicat,i, care în întregime sau în parte cont,ine sau
este derivat din Program, sau din oricare parte a acestuia, să poată fi licent,iat gratuit s, i în întregime
tuturor părt,ilor tert,e, în termenii acestei Licent,e.

(c) Dacă programul modificat cites, te comenzi în mod interactiv, trebuie să îl modificat,i în as, a fel încât,
atunci când este pornit în mod interactiv, să afis, eze un mesaj referitor la drepturile de autor, precum s, i o
notă în care se ment,ionează lipsa oricărei garant,ii (sau faptul că dumneavoastră oferit,i o garant,ie). De
asemenea, trebuie specificat faptul că utilizatorii pot redistribui programul în aceste condit,ii, precum
s, i o explicat,ie a modalităt,ii în care poate fi obt,inut textul acestei Licent,e. (Except,ie: dacă Programul
este interactiv, dar nu afis, ează în mod normal un asemenea mesaj, nu este necesar ca proiectul bazat
pe Program să afis, eze un mesaj.)

Aceste cerint,e se aplică Programului modificat în întregime. Dacă pot fi identificate sect,iuni ale proiectului
care nu sunt derivate din Program, s, i pot fi considerate de sine stătătoare, atunci această Licent,ă s, i termenii
săi nu se aplică acelor sect,iuni când sunt distribuite ca proiecte separate. Când distribuit,i aceleas, i sect,iuni ca
parte a unui întreg care este un proiect bazat pe Program, distribuirea întregului proiect trebuie să fie făcută
în acord cu termenii acestei Licent,e, ale cărei permisiuni pentru alte licent,e se extind asupra întregului, s, i
deci asupra fiecărei sect,iuni în parte, indiferent de autor.

Astfel, nu este în intent,ia acestei sect,iuni să pretindă drepturi sau să conteste drepturile dumneavoastră
asupra unui proiect efectuat în întregime de dumneavoastră. Intent,ia este de a exercita dreptul de a controla
distribut,ia proiectelor derivate sau colective bazate pe Program.

În plus, pura agregare pe un mediu de stocare sau distribut,ie cu Programul (sau cu un proiect bazat pe
Program) a unui alt proiect, care nu este bazat pe Program, nu aduce acel proiect sub incident,a acestei
Licent,e.

3. Putet,i copia s, i distribui Programul (sau un proiect bazat pe el, conform Sect,iunii 2) în format obiect sau
executabil conform termenilor Sect,iunilor 1 s, i 2 de mai sus, cu condit,ia să îndeplinit,i una dintre condit,iile
de mai jos:

(a) Să îl oferit,i însot,it de codul sursă corespunzător, în format citibil de către mas, ină, care trebuie să fie
distribuit în termenii Sect,iunilor 1 s, i 2 de mai sus, pe un mediu de distribut,ie uzual transportului de
software; sau
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(b) Să îl oferit,i însot,it de o ofertă scrisă, validă pentru cel put,in trei ani, pentru o taxă care să nu depăs, ească
costul fizic al efectuării distribut,iei sursei, de a oferi o copie completă, în format citibil de către mas, ină,
a codului sursă, distribuit în termenii Sect,iunilor 1 s, i 2 de mai sus, pe un mediu de distribut,ie uzual
transportului de software; sau

(c) Să îl oferit,i însot,it de informat,ia pe care at,i primit-o referitoare la oferta de a distribui codul sursa
corespunzător. (Această alternativă este permisă numai pentru distribuiri necomerciale s, i doar dacă
at,i primit programul în format obiect sau executabil împreună cu această ofertă, în conformitate cu
Subsect,iunea b de mai sus.)

Codul sursă al unui proiect este forma preferată în care se fac modificări asupra proiectului. Pentru un proiect
executabil, codul sursă complet înseamnă codul sursă al tuturor modulelor pe care le cont,ine, împreună cu
toate fis, ierele asociate cont,inând definit,ii ale interfet,elor s, i scripturile folosite pentru a controla compilarea s, i
instalarea executabilului. Cu toate acestea, ca o except,ie, nu este obligatorie distribuirea împreună cu codul
sursă a acelor componente care sunt în mod normal distribuite (în format sursă sau binar) cu componentele
majore (compilator, nucleu, etc.) ale sistemului de operare sub care rulează executabilul, exceptând situat,ia
în care acea componentă acompaniază executabilul.

Dacă distribut,ia executabilului sau codului obiect este făcută prin oferirea permisiunii de copiere dintr-un
loc dedicat, atunci oferirea permisiunii de copiere a codului sursă din acelas, i loc este considerată distribuire
a codului sursă, chiar dacă beneficiarul nu este obligat să copieze codul sursă împreuna cu codul obiect.

4. Nu putet,i copia, modifica, sub-autoriza sau distribui Programul decât as, a cum este prevăzut în această
Licent,ă. Orice încercare de a copia, modifica, sub-autoriza sau distribui Programul în alt,i termeni va duce
la anularea drepturilor ce vă revin conform acestei Licent,e. Cu toate acestea, nu vor fi anulate drepturile
celor ce au primit copii sau drepturi de la dumneavoastră conform cu această Licent,ă, atâta timp cât rămân
în conformitate cu ea.

5. Nu suntet,i obligat,i să acceptat,i această Licent,ă, deoarece nu at,i semnat-o. Cu toate acestea, numai această
Licent,ă vă permite să modificat,i Programul sau proiectele derivate din el. Aceste act,iuni sunt interzise prin
lege dacă nu acceptat,i această Licent,ă. În consecint,ă, prin modificarea sau distribuirea Programului (sau a
oricărui proiect bazat pe Program), indicat,i în mod implicit acceptarea acestei Licent,e s, i a tuturor termenilor
s, i condit,iilor de copiere, distribuire sau modificare a Programului sau proiectelor bazate pe el.

6. De fiecare dată când redistribuit,i Programul (sau orice proiect bazat pe Program), beneficiarul primes, te o
licent,ă de la licent,iatorul original care îi permite să copieze, distribuie sau modifice Programul în aceias, i
termeni s, i condit,ii. Nu putet,i impune nici o restrict,ie adit,ională asupra exercitării drepturilor pe care desti-
natarul le primes, te prin această Licent,ă. Nu suntet,i responsabil cu impunerea respectării acestei Licent,e de
către o tert,ă parte.

7. În cazul în care, ca o consecint,ă a unei decizii judecătores, ti, sau pretinsă încălcare a unui patent, sau pentru
orice altă cauză (nu neapărat limitată la chestiuni legate de patente), vi se impun condit,ii (prin hotărâre
judecătorească, înt,elegere sau alte mijloace) care contravin condit,iilor acestei Licent,e, acest lucru nu vă
permite nerespectarea condit,iilor acestei Licent,e. Dacă nu putet,i face în as, a fel încât să satisfacet,i simultan
obligat,iile din această Licent,ă s, i alte obligat,ii pertinente, atunci, ca o consecint,ă, vă este interzisă distribuirea
Programului. De exemplu, dacă o autorizat,ie de folosire a unui patent nu vă permite redistribuirea gratuită
a Programului de către oricine îl primes, te de la dumneavoastră, direct sau indirect, atunci singurul mod în
care putet,i satisface simultan aceste condit,ii s, i Licent,a de fat,ă este să nu distribuit,i Programul în niciun fel.

Dacă vreo port,iune a acestei sect,iuni este invalidată sau de neaplicat în anumite circumstant,e, restul sect,iunii
continuă să se aplice, iar sect,iunea în întregime se aplică în toate celelalte circumstant,e.

Nu este în intent,ia acestei sect,iuni să vă determine să încălcat,i vreun patent sau alte pretent,ii de drepturi
de proprietate, sau să contestat,i valabilitatea oricăror asemenea pretent,ii; această sect,iune are ca scop unic
protejarea integrităt,ii sistemului de distribuire de programe libere, care este implementat prin licent,e publice.
Multe persoane au contribuit generos la spectrul larg de programe distribuite prin acest sistem, bazându-se
pe aplicarea sa consistentă; este la latitudinea autorului/donatorului să decidă dacă este dispus să distribuie
programe prin orice alt sistem, s, i o persoană autorizată să folosească acele programe nu poate impune acea
decizie.

Această sect,iune este dedicată clarificării a ceea ce este considerat a fi o consecint,ă a restului acestei Licent,e.

8. Dacă distribut,ia s, i/sau folosirea Programului este restrict,ionată în anumite t,ări, din cauza patentelor, sau din
cauza unor interfet,e aflate sub incident,a unor drepturi de autor restrictive, det,inătorul drepturilor de autor
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ce plasează Programul sub această Licent,ă poate adăuga o limitare geografica a distribuirii ce exclude acele
t,ări, în as, a fel încât distribuirea să fie permisă doar în, sau între, t,ările care nu sunt excluse. Într-un asemenea
caz, Licent,a încorporează această limitare ca s, i cum ar fi scrisă în corpul acestei Licent,e.

9. Free Software Foundation poate publica din când în când noi versiuni s, i/sau versiuni revăzute, ale Licent,ei
Publice Generale. Asemenea versiuni noi vor fi similare în spirit versiunii prezente, dar pot diferi în anumite
detalii, pentru a adresa noi probleme sau situat,ii.

Fiecărei versiuni îi este asociat un număr unic. Dacă programul specifică faptul că i se aplică o versiune
a acestei Licent,e s, i “orice altă versiune ulterioară”, avet,i opt,iunea de a urma termenii s, i condit,iile acelei
versiuni, sau ai oricărei versiuni ulterioare publicate de Free Software Foundation. Dacă Programul nu
specifică un număr de versiune, putet,i alege orice versiune publicată vreodată de Free Software Foundation.

10. Dacă dorit,i să incorporat,i părt,i ale Programului în alte programe libere ale căror condit,ii de distribut,ie sunt
diferite, ceret,i permisiunea autorului. Pentru programe ale căror drepturi de autor apart,in Free Software
Foundation, ceret,i permisiunea de la Free Software Foundation; uneori facem except,ii pentru aceasta. De-
cizia noastră va fi ghidată de cele două scopuri de a prezerva statutul liber al tuturor proiectelor derivate din
programele noastre libere s, i de a promova distribuirea s, i refolosirea programelor în general.

NICIO GARANT, IE

11. DEOARECE PROGRAMUL ESTE OFERIT SUB O LICENT, Ă CE NU IMPLICĂ NICI UN COST,
NU EXISTĂ NICIO GARANT, IE PENTRU PROGRAM, ÎN MĂSURA PERMISĂ DE LEGILE CE SE
APLICĂ. EXCEPTÂND SITUAT, IILE UNDE ESTE SPECIFICAT ALTFEL ÎN SCRIS, DET, INĂTORII
DREPTURILOR DE AUTOR S, I/SAU ALTE PĂRT, I IMPLICATE OFERĂ PROGRAMUL “ÎN FORMA
EXISTENTĂ” FĂRĂ NICIO GARANT, IE DE NICIUN FEL, EXPLICITĂ SAU IMPLICITĂ, IN-
CLUZÂND, DAR FĂRĂ A FI LIMITATĂ LA, GARANT, II IMPLICITE DE VANDABILITATE S, I CON-
FORMITATE UNUI ANUMIT SCOP. VĂ ASUMAT, I ÎN ÎNTREGIME RISCUL ÎN CEEA CE PRIVES, TE
CALITATEA S, I PERFORMANT, A ACESTUI PROGRAM. ÎN CAZUL ÎN CARE PROGRAMUL SE
DOVEDES, TE A FI DEFECT, VĂ ASUMAT, I ÎN ÎNTREGIME COSTUL TUTUROR SERVICIILOR,
REPARAT, IILOR S, I CORECT, IILOR NECESARE.

12. ÎN NICIO SITUAT, IE, EXCEPTÂND CAZURILE ÎN CARE ESTE CERUT DE LEGEA APLICABILĂ
SAU CA REZULTAT AL UNEI ÎNT, ELEGERI SCRISE, UN DET, INĂTOR AL DREPTURILOR DE
AUTOR, SAU ORICE ALTĂ PARTE CARE POATE MODIFICA S, I/SAU REDISTRIBUI PROGRA-
MUL CONFORM PERMISIUNILOR DE MAI SUS NU VA FI FĂCUT RĂSPUNZĂTOR PENTRU
PAGUBELE DUMNEAVOASTRĂ, INCLUSIV CELE GENERALE, SPECIALE, ÎNTÂMPLĂTOARE
SAU REZULTANTE, APĂRUTE DIN FOLOSIREA SAU INABILITATEA DE A FOLOSI PROGRAMUL
(INCLUZÂND, DAR FĂRĂ A FI LIMITAT LA PIERDEREA SAU DETERIORAREA DATELOR, SAU
PIERDERILE SUFERITE DE DUMNEAVOASTRĂ SAU TERT, E PERSOANE, SAU O INCAPACITATE
A PROGRAMULUI DE A INTEROPERA CU ALTE PROGRAME), CHIAR DACĂ DET, INĂTORUL
SAU TERT, A PARTE A FOST PREVENITĂ ASUPRA POSIBILITĂT, II UNOR ASEMENEA PAGUBE.

Except,ia QGIS Qt de la GPL

In addition, as a special exception, the QGIS Development Team gives permission to link the code of this program
with the Qt library, including but not limited to the following versions (both free and commercial): Qt/Non-
commerical Windows, Qt/Windows, Qt/X11, Qt/Mac, and Qt/Embedded (or with modified versions of Qt that use
the same license as Qt), and distribute linked combinations including the two. You must obey the GNU General
Public License in all respects for all of the code used other than Qt. If you modify this file, you may extend this
exception to your version of the file, but you are not obligated to do so. If you do not wish to do so, delete this
exception statement from your version.

24.2 Licent,a GNU pentru Documentat,ia liberă

Versiunea 1.3, 3 November 2008

Copyright 2000, 2001, 2002, 2007, 2008 Free Software Foundation, Inc

http://fsf.org/

Oricui îi este permisă copierea şi distribuirea de copii identice ale acestui document, dar fără modificarea lui.
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Preambul

Scopul acestei Licenţe este de a conferi “gratuitate” unui manual, colect,ii de texte, sau altui document funct,ional
s, i folositor, în sensul libertăt,ii: de a asigura tuturor permisiunea de copiere şi redistribuire, cu sau fără modificări,
în scopuri comerciale şi necomerciale. Ca scop secundar, această Licenţă rezervă autorului şi editorului dreptul
de a fi creditaţi pentru munca lor, atât timp cât nu sunt responsabili pentru modificările efectuate de către alţii.

Acestă Licent,ă conferă un fel de “obligat,ii”, ceea ce înseamnă că lucrările derivate dintr-un document trebuie să
fie s, i ele libere, la rândul lor. Această Licent,ă este inspirată de Licent,a Publică Generală GNU, care este o licent,ă
similară, concepută pentru a acoperi softul liber.

We have designed this License in order to use it for manuals for free software, because free software needs free
documentation: a free program should come with manuals providing the same freedoms that the software does.
But this License is not limited to software manuals; it can be used for any textual work, regardless of subject
matter or whether it is published as a printed book. We recommend this License principally for works whose
purpose is instruction or reference.

1. APLICABILITATE ŞI DEFINIŢII

Această Licenţă se aplică oricărei lucrări sau manual, în orice mediu, care conţine o notă, inclusă de către deţină-
torul dreptului de autor, care permite distribuţia în termenii acestei Licenţe. Această notă conferă dreptul universal,
fără indemnizaţie şi nelimitat ca durată de a folosi lucrarea în condiţiile de fat,ă. Termenul Document, de mai jos,
se referă la un astfel de manual sau lucrare. Orice membru din public este un beneficiar al acestei Licenţe şi va
fi desemnat prin termenul Dvs.. Se consideră, în mod automat, că aţi acceptat termenii acestei Licenţe, în urma
copierii, modificării sau distribuirii unei lucrări într-un mod care necesită permisiunea autorului, în condit,iile legii
drepturilor de autor.

O “Versiune Modificată” a Documentului este orice lucrare conţinând Documentul sau o porţiune de-a lui, copiată
identic sau cu modificări şi/sau tradusă într-o altă limbă.

O “Secţiune Secundară” este o anexă cu titlu, sau o secţiune menţionată în cuprins care are ca scop exclusiv
descrierea relaţiei editorilor sau a autorilor Documentului cu subiectul Documentului (sau cu aspecte conexe)
şi care nu conţine referiri directe la subiectul Documentului. (Astfel, dacă Documentul este în parte manual de
matematică, o Secţiune Secundară nu poate conţine deloc explicaţii matematice.) Poate exista doar o conexiune is-
torică cu subiectul s, i cu problemele înrudite cu subiectul, ori pot fi prezentate puncte de vedere legale, comerciale,
filozofice, etice sau politice legate de acesta.

“Secţiunile Neschimbabile” sunt anumite Secţiuni Secundare ale căror titluri sunt specificate ca fiind acele titluri
de Secţiuni Neschimbabile din nota ce permite distribuţia Documentului sub acoperirea acestei Licenţe. Dacă o
secţiune nu este conformă cu definiţia de mai sus a unei Secţiuni Secundare atunci ea nu poate fi desemnată ca
fiind Neschimbabilă. Documentul poate să nu conţină Secţiuni Neschimbabile. Dacă Documentul nu specifică
vreo Secţiune Neschimbabilă atunci se consideră că nu există nici una.

“Textele De Copertă” sunt anumite pasaje scurte de text care sunt listate ca Texte Pentru Coperta I sau ca Texte
Pentru Coperta IV în nota care specifică distribuirea Documentului sub acoperirea acestei Licenţe. Un Text Pentru
Coperta I poate avea cel mult 5 cuvinte, iar un Text Pentru Coperta IV poate avea cel mult 25 de cuvinte.

O copie “Transparentă” a Documentului este o copie în format electronic, reprezentată într-un format ale cărui
specificaţii sunt disponibile publicului, fiind uşor de modificat cu ajutorul unui editor de text generic sau (pentru
imagini compuse din pixeli) cu un editor grafic generic ori (pentru desene) cu un editor larg răspândit de grafică
vectorială, şi care poate fi folosit ca intrare în procesoarele de text sau de transformare automată în diverse formate
adecvate ca intrare pentru procesoarele de text. O copie făcută într-un format de fişier Transparent dar care, prin
prezenţa sau absenţa anumitor elemente specifice formatului, descurajează sau împiedică modificările ulterioare,
nu reprezintă o copie Transparentă. Un format de imagine nu este Transparent dacă este folosit pentru a reprezenta
o cantitate substanţială de text. O copie care nu este “Transparentă” se numes, te “Opacă”

Exemple de formate compatibile cu copiile Transparente: textul ASCII fără marcaje, formatul de intrare Tex-
info, formatele de intrare LaTeX, SGML şi XML folosind un DTD public, HTML simplu şi standard, fişierele
PostScript şi PDF modificabile. Exemple de formate Transparente pentru imagine: PNG, XCF şi JPG. Formatele
Opace includ formate de text ce pot fi citite şi editate doar de procesoare de text proprietare, SGML şi XML pentru
care DTD-ul şi/sau uneltele de procesare nu sunt disponibile, HTML generat automat, documentele PostScript şi
PDF produse de diverse procesoare de text doar în scopul printării/afişării.
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“Pagina de Titlu” înseamnă, pentru o carte tipărită, pagina cu titlul şi paginile următoare, necesare pentru a
prezenta, lizibil, materialul care trebuie tipărit, conform acestei Licenţe, pe Pagina de Titlu. Pentru lucrări care
nu au o pagină cu titlu propriu-zisă, “Pagina de Titlu” este textul aflat lângă principala apariţie a titlului lucrării,
precedând începutul corpului Documentului.

“Editorul” reprezintă orice persoană sau entitate care distribuie copii ale documentului pentru public.

O secţiune “Numită XYZ” este o subunitate a Documentului, al cărei titlu este, fie XYZ, fie conţine XYZ în
paranteze, după textul care traduce XYZ în altă limbă. (Aici XYZ înlocuieşte nume specifice ce vor fi menţionate
mai jos, ca de exemplu “Mulţumiri”, “Dedicaţii”, “Giruri” sau “Istorie”.) Pentru a “Păstra Titlul” unei astfel de
secţiuni atunci când modificaţi Documentul înseamnă că va rămânea o sect,iune “Numită XYZ”, conform acestei
definiţii.

Documentul poate include Limitări de Responsabilitate ataşate notificării care afirmă că această Licenţă se aplică
Documentului. Aceste se consideră a fi incluse prin referinţă în această Licenţă, dar numai cu privire la limitările
de responsabilitate: orice alte implicaţii pe care aceste Limitări de Responsabilitate le-ar putea avea sunt nule şi
nu au nici un efect asupra înţelesului acestei Licenţe.

2. COPII IDENTICE

Puteţi copia şi distribui Documentul pe orice mediu, fie comercial sau necomercial, atâta timp cât această Licenţă,
notificările de drepturi de autor şi notificarea de licenţă care spune că această Licenţă se aplică acestui Document,
sunt reproduse în toate copiile, şi atâta timp cât nu adăugaţi nici un fel de altă condiţie în afară de cele prezente
în această Licenţă. Nu aveţi dreptul să luaţi măsuri tehnice de a obstrucţiona sau controla citirea sau recopierea
copiilor pe care le faceţi sau le distribuiţi. Aveţi totuşi dreptul să acceptaţi compensaţii în schimbul copiilor. Dacă
distribuiţi un număr suficient de mare de copii, atunci trebuie să respectaţi şi condiţiile din secţiunea 3.

Avet,i, de asemenea, dreptul să împrumutat,i copii în aceleas, i condit,ii ca cele de mai sus, s, i avet,i dreptul să afis, at,i
copii.

3. COPIEREA ÎN CANTITĂT, I MARI

Dacă publicat,i copii tipărite (sau copii în medii care folosesc de obicei copert,i tipărite) ale Documentului, în număr
mai mare de 100 s, i dacă notificarea de licent,ă a Documentului cere Texte de Copertă, trebuie să includet,i copiile
pe copert,i care să cont,ină, clar s, i lizibil, toate aceste Texte de Copertă: Textele Pentru Coperta I pe coperta I s, i
Texte Pentru Coperta IV pe coperta IV. Ambele copert,i trebuie de asemenea să vă identifice în mod clar s, i lizibil
ca editor al respectivelor copii. Coperta I trebuie să prezinte titlul în întregime, cu toate cuvintele din titlu la fel
de vizibile s, i proeminente. Putet,i adăuga alte materiale pe copertă în plus. Copierea cu modificările limitate la
copert,i, atâta timp cât satisfac aceste condit,ii, pot fi tratate în toate celelalte aspecte ca s, i copii identice.

Dacă textele necesare pentru oricare dintre copert,i sunt prea voluminoase pentru a încăpea în mod lizibil, trebuie
să punet,i primele rânduri (atâtea cât încap în mod rezonabil) pe coperta efectivă s, i să continuat,i cu restul pe pagini
adiacente.

Dacă publicat,i sau distribuit,i copii Opace ale Documentului în număr mai mare de 100, trebuie ori să includet,i
câte o copie Transparentă în format electronic împreună cu fiecare copie Opacă, ori să specificat,i în sau împreună
cu fiecare copie Opacă o locat,ie din ret,eaua electronică la care publicul general care foloses, te ret,eaua să aibă
acces pentru a descărca, folosind un protocol standard public, copii complete, Transparente ale documentului,
fără adăugarea oricărui material adit,ional. Dacă folosit,i a doua opt,iune trebuie să facet,i demersuri rezonabil
de prudente ca atunci când începet,i distribuirea copiilor Opace să vă asigurat,i că această copie Transparentă va
rămâne accesibilă, în acest fel, la locat,ia respectivă timp de cel put,in un an după distribut,ia ultimei copii Opace
(în mod direct sau prin agent,i ori distribuitori) a respectivei edit,ii pentru public.

Se cere, dar nu în mod necesar, să contactat,i autorii Documentului cu o perioadă bună înainte de a distribui orice
cantitate mare de copii, pentru a le da ocazia să vă pună la dispozit,ie o versiune actualizată a Documentului.

4. MODIFICĂRI

Putet,i copia s, i distribui o Versiune Modificată a Documentului în condit,iile sect,iunilor 2 s, i 3 de mai sus, cu condit,ia
de a acoperi Versiunea Modificată sub exact această Licent,ă, cu Versiunea Modificată t,inând locul Documentului,
astfel licent,iind distribuirea s, i modificările Versiunii Modificate oricui intră în posesia unei copii ale acesteia. În
plus, trebuie să facet,i următoarele lucruri în Versiunea Modificată:

1. Folosit,i în Pagina de Titlu (s, i pe copert,i, dacă există) un titlu diferit de cel al Documentului, s, i de versiunile
sale anterioare (care trebuie, dacă există, să fie listate în sect,iunea de Istorie a Documentului). Putet,i folosi
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acelas, i titlu ca o versiune anterioară dacă editorul original al acelei copii vă dă permisiunea.

2. Listat,i pe Pagina de Titlu, ca autori, una sau mai multe dintre persoanele sau entităt,ile responsabile în calitate
de autori pentru modificările Versiunii Modificate, împreună cu cel put,in cinci dintre autorii principali ai
Documentului (tot,i autorii principali, dacă are mai put,in de cinci), în afară de cazul că aces, tia vă eliberează
de această obligat,ie.

3. Includet,i pe Pagina de Titlu numele editorului Versiunii Modificate în calitate de editor.

4. Păstrat,i toate notificările de drepturi de autor ale Documentului.

5. Adăugat,i o notificare de drepturi de autori relevantă pentru modificările Dvs. adiacent celorlalte notificări
de drepturi de autor.

6. Includet,i, imediat după notificările de drepturi de autor, o notificare de licent,ă dând permisiune publică de a
folosi Versiunea Modificată în condit,iile acestei Licent,e, sub forma prezentată în Apendicele de mai jos.

7. Păstrat,i în acea notificare de licent,ă lista integrală a Sect,iunilor Neschimbabile s, i Textele de Copertă nece-
sare, date în notificarea de licent,ă a Documentului.

8. Includet,i o copie nealterată a acestei Licent,e.

9. Păstrat,i sect,iunea Numită “Istorie”, Păstrat,i-i Titlul s, i adăugat,i-i un element care să indice măcar titlul, anul,
noii autori s, i editorul Versiunii Modificate as, a cum este dat pe Pagina de Titlu. Dacă nu există o sect,iune
Numită “Istorie” în Document, creat,i una în care indicat,i titlul, anul, autorii s, i editorul Documentului as, a
cum este dat pe Pagina de Titlu al acestuia s, i apoi adăugat,i un element care să descrie Versiunea Modificată
as, a cum a fost cerut în fraza precedentă.

10. Păstrat,i locat,ia de ret,ea, dacă există, dată în Document pentru acces public la o copie Transparentă a Doc-
umentului, cât s, i locat,iile de ret,ea date în Document pentru versiunile mai vechi pe care s-a bazat acesta.
Acestea pot fi incluse în sect,iunea Numită “Istorie”. Putet,i omite locat,ia de ret,ea a unei lucrări care a fost
publicată cu cel put,in patru ani înainte de Documentul în sine, sau dacă editorul original al versiunii la care
se referă vă dă permisiunea.

11. Pentru orice sect,iune Numită “Mult,umiri” sau “Dedicat,ii” Păstrat,i Titlul sect,iunii s, i păstrat,i în sect,iunile
respective toată substant,a s, i tonul mult,umirilor s, i/sau dedicat,iilor fiecărui contribuitor.

12. Păstrat,i toate Sect,iunile Neschimbabile ale Documentului, nealterate ca text s, i ca titluri. Numerotarea
sect,iunilor sau echivalentul numerotării nu sunt considerate ca făcând parte din titlurile sect,iunilor.

13. S, terget,i orice sect,iune Numită “Giruri”. O astfel de sect,iune nu poate fi inclusă în Versiunea Modificată.

14. Nu modificat,i titlul nici unei sect,iuni existente pentru a fi Numită “Giruri” sau pentru a intra în conflict cu
vreo Sect,iune Neschimbabilă.

15. Păstrat,i toate Limitările de Responsabilitate.

Dacă Versiunea Modificată include sect,iuni noi incluse în titlu sau anexe care se califică drept Sect,iuni Secundare
s, i nu cont,in material copiat din Document, avet,i dreptul la alegerea Dvs. să numit,i unele sau toate acestea ca
fiind Neschimbabile. Pentru a face aceasta, adăugat,i-le titlurile la lista de Sect,iuni Neschimbabile în notificarea
de licent,ă a Versiunii Modificate. Aceste titluri trebuie să fie distincte fat,ă de toate celelalte titlurile de sect,iune.

Putet,i adăuga o sect,iune Numită “Giruri” doar dacă aceasta cont,ine numai girurile a diverse entităt,i asupra Ver-
siunii Modificate—de exemplu recenzii sau faptul că textul a fost aprobat de o organizat,ie ca fiind o definit,ie
autoritară a unui standard.

Putet,i adăuga un pasaj de cel mult cinci cuvinte ca Text Pentru Coperta I s, i un pasaj de cel mult 25 de cuvinte
ca Text Pentru Coperta IV la sfârs, itul Textelor De Copertă în Versiunea Modificată. Numai un singur pasaj poate
fi adăugat la Textul Pentru Coperta I s, i unul la Textul Pentru Coperta IV de către (sau prin aranjament cu) orice
entitate. Dacă Documentul cont,ine deja texte de copertă pentru coperta respectivă, adăugat în prealabil de Dvs.
sau prin aranjament cu aceeas, i entitate în numele căreia act,ionat,i, atunci nu putet,i adăuga un altul, însă putet,i să-l
înlocuit,i pe cel vechi numai cu permisiunea explicită a editorului anterior care l-a adăugat pe cel vechi.

Autorul (autorii) s, i editorul (editorii) Documentului nu vă dau prin această Licent,ă permisiunea de a le folosi
numele pentru publicitate sau pentru a pretinde sau implica vreo girare a oricărei Versiuni Modificate.

5. COMBINAREA DOCUMENTELOR
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Putet,i combina Documentul cu alte documente acoperite de această Licent,ă sub termenii definit,i în sect,iunea 4 de
mai sus pentru versiuni modificate, cu condit,ia să includet,i în versiunea combinată toate Sect,iunile Neschimbabile
ale tuturor documentelor originale, nemodificate, s, i să le listat,i pe toate ca Sect,iuni Neschimbabile ale versiunii
combinate în notificarea de licent,ă, cât s, i să păstrat,i toate Limitările de Responsabilitate.

Versiunea modificată nu trebuie să cont,ină decât o singură copie a acestei Licent,e, iar duplicatele identice ale
Sect,iunilor Neschimbabile pot fi înlocuite cu o singură copie. Dacă există Sect,iuni Neschimbabile cu nume
identice s, i cont,inut diferit, schimbat,i-le numele adăugând la sfârs, itul titlului, în paranteză, ori numele autorului
sau al editorului original al acelei sect,iuni dacă acesta este cunoscut, ori un număr unic. Facet,i aceleas, i modificări
respective titlurilor sect,iunilor în lista de Sect,iuni Neschimbabile din notificarea de licent,ă a versiunii combinate.

În versiunea combinată trebuie să combinat,i s, i toate sect,iunile Numite “Istorie” din diversele documente originale,
creând o sect,iune unică Numită “Istorie”; la fel trebuie să combinat,i s, i toate sect,iunile Numite “Mult,umiri” cât s, i
cele Numite “Dedicat,ii”. Trebuie să s, terget,i toate sect,iunile Numite “Giruri”.

6. COLECT, II DE DOCUMENTE

Putet,i crea o colect,ie formată din Document s, i alte documente acoperite de această Licent,ă s, i să înlocuit,i copiile
individuale ale acestei Licent,e din diversele documente cu o singură copie care să fie inclusă în colect,ie cu condit,ia
să urmat,i regulile acestei Licent,e pentru copii identice pentru fiecare document în toate celelalte privint,e.

Putet,i să extraget,i un document dintr-o astfel de colect,ie s, i să-l distribuit,i individual sub această Licent,ă cu condit,ia
de a include o copie a acestei Licent,e în documentul extras s, i să urmat,i condit,iile acestei Licent,e în toate celelalte
privint,e în legătură cu copiile identice ale acelui document.

7. AGREGAREA CU LUCRĂRI INDEPENDENTE

O compilat,ie a Documentului sau a unui derivat al său cu orice document sau lucrare separată independentă,
în sau pe un volum de stocare sau distribuire se numes, te “agregat” dacă drepturile de autor rezultate în urma
compilării nu sunt folosite pentru a limita drepturile legale ale utilizatorilor compilat,iei mai mult decât permit
lucrările individuale. Când Documentul este inclus într-un agregat, această Licent,ă nu se aplică celorlalte lucrări
din agregat care nu sunt ele însele rezultate derivate ale Documentului.

Dacă cerint,ele legate de Textele de Copertă din sect,iunea 3 se aplică acestor copii ale Documentului, atunci dacă
Documentul este mai put,in de jumătate din întregul agregat atunci Textele de Copertă ale Documentului pot fi
puse pe copert,i care să separe Documentul în cadrul agregatului, sau pe un echivalent electronic al acestora, dacă
Documentul se prezintă în format electronic. Altfel ele trebuie să apară pe copert,ile tipărite care îmbracă întreg
agregatul.

8. TRADUCERE

Traducerea este considerată o formă de modificare, drept care putet,i distribui traduceri ale Documentului sub
cerint,ele sect,iunii 4. Înlocuirea Sect,iunilor Neschimbabile cu traduceri ale acestora necesită permisiune specială
din partea celor care det,in drepturile de autor, însă putet,i include traduceri ale unora dintre sau tuturor Sect,iunilor
Neschimbabile împreună cu variantele originale ale acestora. Putet,i include o traducere a acestei Licent,e cât s, i
toate notificările de licent,ă din Document, cât s, i Limitările de Responsabilitate atâta timp cât includet,i s, i versiunea
originală în engleză a acestei Licent,e, plus versiunile originale ale respectivelor notificări de licent,ă s, i limitări de
responsabilitate. În cazul aparit,iei oricăror discrepant,e între versiunea tradusă s, i versiunea originală a acestei
Licent,e, a vreunei notificări de licent,ă sau a vreunei limitări de responsabilitate, versiunea originală are prioritate.

Dacă vreo sect,iune din Document este Numită “Mult,umiri”, “Dedicat,ii” sau “Istorie” cerint,a (din sect,iunea 4) de
a-i Păstra Titlul (sect,iunea 1) va necesita în mod normal schimbarea titlului în sine.

9. REZILIERE

Nu putet,i copia, modifica, sublicent,ia sau distribui Documentul decât în condit,iile specificate explicit în această
Licent,ă. Orice copiere, modificare sau redistribuire a Documentului în vreo altă condit,ie este nulă s, i vă va anula
în mod automat drepturile conferite de această Licent,ă.

Cu toate acestea, dacă încetat,i orice încălcare a acestei Licent,e, licent,a din partea titularului dreptului de autor este
reinstaurată (a) cu titlu provizoriu, cu except,ia cazului când titularul dreptului de autor încetează în mod explicit
s, i în cele din urmă licent,a, s, i (b) permanent, în cazul în care titularul dreptului de autor nu vă anunt,ă încălcarea,
prin mijloace reonabile, în termen de 60 de zile de la încetare.

În plus, licent,a de la titularul particular al dreptului de autor este repusă permanent în cazul în care titularul
dreptului de autor vă anunt,ă de încălcare prin mijloace rezonabile, s, i este prima dată când at,i primit o notificare de
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încălcare a acestei Licent,e (pentru orice lucrare), din partea titularului dreptului de autor, s, i at,i încetat încălcarea
cu 30 de zile înainte de primirea notificării.

Încetarea drepturilor dumneavoastră, în conformitate cu această sect,iune, nu încetează licent,ele părt,ilor care au
primit copii sau drepturi de la dumneavoastră sub această Licent,ă. Dacă drepturile dumneavoastră au fost terminate
s, i nu s-au repus permanent, primirea unei copii ale aceluias, i material nu vă dă nici un drept să-l folosit,i.

10. VERSIUNI VIITOARE ALE ACESTEI LICENT, E

The Free Software Foundation may publish new, revised versions of the GNU Free Documentation License from
time to time. Such new versions will be similar in spirit to the present version, but may differ in detail to address
new problems or concerns. See http://www.gnu.org/copyleft/.

Fiecărei versiuni ale acestei Licent,e îi este asociat un număr de versiune distinct. Dacă Documentul specifică
un anumit număr de versiune “sau orice versiune ulterioară” al acestei Licent,e, avet,i de ales între a vă conforma
termenilor s, i condit,iilor ori ale versiunii specificate explicit sau ale oricărei variante ulterioare publicate (nu ca
variantă preliminară) de către Free Software Foundation. Dacă Documentul nu specifică un număr de versiune
al acestei Licent,e atunci putet,i alege orice versiune publicată (nu ca variantă preliminară) de către Free Software
Foundation.

11. RELICENŢIEREA

“Site-ul de Colaborare Masivă a Multiautorilor” (sau „MMC Site”) înseamnă orice server www care publică
lucrări posibil de a fi supuse drepturilor de autor şi, de asemenea, oferă facilităţi proeminente pentru oricine
editează aceste lucrări. Un server pubic wiki este un exemplu în care oricine poate edita lucrări scrise. Un
“Site de Colaborare Masivă a Multiautorilor” (sau „MMC Site”) în conţinutul său înseamnă o mulţime de lucrări
susceptibile de a fi supuse licenţelor supsue site-ului MMC.

“CC-BZ-SA” înseamnă licenţă a Creative Commons Attribution-Share Alike 3.0 publicată de Corporaţia Cre-
ative Commons, o corporaţie nonprofit cu sediul principal la San Francisco, California, şi deasemenea viitoarele
variante de “obligat,ii” a acestei licenţe publicată de aceeaşi organizaţie.

„Încorporarea” înseamnă publicarea ori republicarea unui Document, în întregime sau în parte, ca parte a unui alt
document.

Un MMC este “eligibil pentru reautorizare” dacă este licent,iat sub această Licent,ă, s, i în cazul în care toate lucrările
care au fost publicate mai întâi în această Licent,ă în altă parte decât acest MMC, s, i, ulterior, au fost încorporate
în totalitate sau în parte în MMC, (1) nu a avut texte de copertă sau sect,iuni invariante, s, i (2) au fost astfel incluse
până la 1 noiembrie 2008.

Operatorul unui site MMC poate republica un MMC cont,inut în site sub CC-BY-SA în acelas, i loc, în orice moment
înainte de 1 august 2009, cu condit,ia ca MMC să fie eligibil pentru reautorizare.

ADDENDUM: Cum să utilizaţi această licenţă pentru documentele dvs.

Pentru a utiliza această licenţă într-un document pe care l-aţi scris, includet,i o copie a Licenţei în document şi
introducet,i următoarele notificări referitoare la dreptul de autor s, i la licenţă, imediat după pagina de titlu:

Copyright © YEAR YOUR NAME.
Permission is granted to copy, distribute and/or modify this document
under the terms of the GNU Free Documentation License, Version 1.3
or any later version published by the Free Software Foundation;
with no Invariant Sections, no Front-Cover Texts, and no Back-Cover Texts.
A copy of the license is included in the section entitled "GNU
Free Documentation License".

Dacă avet,i Sect,iuni Neschimbabile, Texte pentru Coperta I s, i Texte pentru Coperta IV, înlocuit,i linia “cu ... Texte.”
cu:

with the Invariant Sections being LIST THEIR TITLES, with the
Front-Cover Texts being LIST, and with the Back-Cover Texts being LIST.

Dacă avet,i Sect,iuni Neschimbabile, fără Texte de Copertă, sau o altă combinat,ie a celor trei, fuzionat,i ambele
alternative pentru a se potrivi situat,iei.
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Dacă documentul cont,ine exemple netriviale de cod de programare, vă recomandăm publicarea acestor exemple,
în paralel, sub o licent,ă pentru softul liber, cum ar fi Licent,a Publică Generală GNU, pentru a permite utilizarea
lor în software-ul liber.

468 Chapter 24. Anexă
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2.5D, 139

Actions, 56, 169
Define an action, 169
Examples, 170
Using actions, 170

Add actions, 191
Add layers, 87
Adding features, 206
Ajutor contextual, 35
Annotation, 57
Apache, 293
Append features, 106
ArcInfo ASCII Grid, 87
ArcInfo Binary Coverage, 91
ArcInfo Binary Grid, 87
Arrow, 32
Atlas generation, 278
Attribute Actions, 169
Attribute table, 189, 263
Attributes

Columns, 191
Selection, 193

Avoid intersections, see Topology, 204

Bare de instrumente, 30
Layout, 30

Bookmarks, 59
Browse data, 87
Built-in form, 161

Calculatorul de Câmpuri, 196
CAT, 283
Catalog services, 439
CGI (Common Gateway Interface), 292
Classes, 132
Color interpolation, 226
Color map, 226
Colors, 46, 69, 121

Color brewer, 121
Color ramp, 121
Custom color ramp, 121
Gradient color ramp, 121

Columns
Attributes, 191

Combinat,ii de taste, 78
Comma Separated Values, see CSV, see CSV
Command line options, 14
Compose maps, 246
Composer Item

Arrow, 273
Basic shape, 274
Node-based shape, 275

Composer items, 246
Composer manager, 238
composer map, 250
Composer template, 237
Configuration, 65
Connecting to database, 95
Contrast enhancement, 225
Contribut,ii

Autori, 457
Traducători, 457

Copyright, 61
Core plugins, see Plugins, 407
Create maps, 234, 246
Create new layers, 101
Creating new layer, see GRASS
Crop layout to content, 276
CRS, 72, 81, 84

Custom CRS, 84
Default CRS, 81
On-the-fly transformation, 82

CRS (Coordinate Reference System), 81, 287
CRS Selection, 83
CSV, 92, 111, 112, 208
CSVT, 112
Custom form, 161
Custom functions, 188

Data, 87
Data Management tools, 364
Data sample, 13
Data-defined override, 54

Labels, 156
Database tools, 95
Datum transformation, 72, 85
DB Manager, 88, 116, 410
DB2 Spatial, 116
Debian, 293
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Decorat,iuni, 60
Default values, 158
Delimited text files, 92, 111
Derived Fields, 196
Deselect

Select, 52
Diagrams, 163
Digitizing, see Attribute table, 205, 425

Snapping, 203
Topology, 204

Digitizing configuration, 71
Digitizing tools, 205

Ştergere Inel, 212
Ştergere Parte, 211
Adăugare Inel, 212
Adăugare Parte, 211
Advanced panel, 216
Anulare, 210
Automatic tracing, 215
Curbe de Compensare, 213
Divizare Entităt,i, 213
Divizare Părt,i, 214
Extend lines, 212
GRASS, 346
Merge Attributes, 214
Offset Point Symbols, 215
Refacere, 210
Reshape Feature, 212
Rotate Feature, 210
Rotit,i Simbolurile Punctelor, 214
Simplificare Entitate, 211
Umplere Inel, 212
Unificare Entităt,i Selectate, 214

Discrete, 226
Displacement circle, 137
Displacement plugin, 137
documentation, 3
DXF, 87, 412
DXF Export, 107

Edit widget, 158
Editări curente, 210
Editarea, see Digitizing
Editarea topologică, 204
Editing, see GRASS
Embed layers and groups, 60
Embedded form, 200
Embedded widget, 176, 230
Environment

QGIS Server, 304
Environment variables, 66
EPSG (European Petroleum Search Group), 81
Equal Interval, 133
Erdas Imagine, 87
Errors, 425
ESRI, 110
Esri Personal Geodatabase, 89
eVis, 413

Export as image, 276
Exportare ca PDF, 276
Exportare ca SVG, 276
Expresii, 176

Named parameters, 177
Expression

Labels, 153
Expressions, 63

FastCGI, 292
Feature form, 200
Feature simplification, 173
Field configuration, 158
Fields, 157
Fields constraints, 158
Fields edit, 196
Foreign key, 199
Form, 161
Format, 87
Formatare condit,ionată, 193
Forms, 157
Functions, 177

Named parameters, 177

GDAL, 87, 423
Generalisation, 173
Geocoding photo, 413
GeoJSON, 208
Geometry, 429
Geometry validity, 425
Geometryless Data, 189
Geometryless feature, 207, 211
GeoPackage, 87
Geoprocessing tools, 363
Georeferencing images, 429
GeoTIFF, 87
GeoTiff, 110
GML, 283
GPS tracking, 313
GPX, 101
GRASS, 87, 340

Attribute linkage, 346
Attribute storage, 346
Customize toolbox, 355
Digitizing tools, 346
Display results, 350
Region, 348
Region editing, 348
Style, 348
Toolbox, 349

GRASS vector data model, 345
Grilă, 60
Grile, 252
Grup, 37

Heatmap, 139
Plugins, 434

Histogram, 133, 230
HTML frame, 270
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Identify features, 55
IDW (Inverse Distance Weighted), 436
IGNF (Institut Geographique National de France), 81
Installation, 13
Instrumentele de analiză, 361
InteProxy, 290
Interpolation, 436
Items alignment, 249

Join layers, 163
Jointure, 163
Jurnalizarea

QGIS Server, 305

Keyword, 175

Labels
Custom placement, 156
Data-defined override, 156
Expression, 153

Layer, 37
Layer properties, 38, 223
Layers

Initial visibility, 43
Order, 38

Layout maps, 246
Legend, 35, 176, 230
Legend composer, 256
Licent,ei Publice Generale GNU, 459
License document, 459
Line to polygon, 208
Linked forms, 200
Loading raster, 89
Loading vector, 89
Log messages, 41

Magnification, 33
Main window, 21
Many-to-many relation

Relation, 202
Map

Overview, 41
Map grid, 252
Map layout, 234
Map legend, 256
Map navigation, 50
Map template, 237
Map Tips, 173
Map tools, 70
Map view, 32
Mapserver, 290
Measure

Angles, 51
Areas, 51
Distances, 51
Tools, 50

Menu, 21
Metadata, 175, 230, 439

WMS, 289

Modul de randare, 248
Mouse wheel, 32
MSSQL Spatial, 95
Multi Band Raster, 224
Multi edit, 198
Multiline, 211
Multipoint, 211
Multipolygon, 211
Multivariate analysis, 136
MySQL, 89

Named parameters, 177
Natural Breaks (Jenks), 133
Nesting projects, 60
Network, 73
New GeoPackage layer, 102
New GPX layer, 103
New SpatiaLite layer, 102
New Temporary Scratch layer, 103
nginx, 294
Node tool, 206
Nodes, 207
Non Spatial Attribute Tables, 189
North arrow, 62

ODBC, 89
OGC (Open Geospatial Consortium), 283
OGDI, 89
OGR, 87, 110
ogr2ogr, 114
On-the-fly reprojection, 72
Opţiuni, 65
Oracle database, 443
OSM (OpenStreetMap), 94
Output

Save as image, 18
Output map, 234
Overwrite file, 106
Overwrite language, 72

Paint effects, 142
Pan, 32, 50
Panouri, 31, 35

Layers, 35
Log messages, 41
Overview, 41
Redo, 41
Statistic, 39
Style, 38
Undo, 41

Personalizare, 77
pgsql2shp, 114
Picture database, 269
Plugins, 404

Geometry checker, 425
Geometry snapper, 429
Heatmap, 434
Metasearch, 439
Offline editing, 442
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Plugin manager, 404
Road graph, 447
Spatial Georaster, 443
Spatial query, 448
Terrain analysis, 446
Topology Checker, 449
Zonal statistics, 452

Polygon to line, 208
PostGIS, 87, 112

ogr2ogr, 114
shp2pgsql, 113
Spatial index, 114
ST_Shift_Longitude, 115

PostGreSQL, 87
PostgreSQL, 112
Preset visibility, 36
Pretty Breaks, 133
Print composer, 18

Tools, 240
Printing

Export map, 275
Proiect, 22
Proj.4, 83
Project

Properties, 75
Project properties, 75
Projections, 81
Projects, 17
Proportional symbol, 136
Proxy, 73, 285
Proxy server, 285
Pyramids, 229
Python, 401

QGIS Server, 292
Environment, 304
Jurnalizarea, 305

QML, 44
QSpatiaLite, 116
Quantile, 133
Query builder, 129
Quick print, 18

Răsfoire date, 356
Randare, 41

Halting, 43
Options, 43
Quality, 44
Speed-up, 44
Suspending, 43

Randarea stratului, 140
Raster, 87, 223

Align Raster, 233
Georeference, 429

Raster analysis, 232
Raster calculator, 232
Raster Statistics, 452
Rasterisation, 173
Raza de căutare, 204

Redo, 41
Relations, 199
Renderer, 131
Rendering, 68
Rendering effects

Blending modes, 48
Rendering scale dependent, 43
Research tools, 362
Revert layout actions, 245
Rotated north arrow, 269
Rubber band, 206
Rule-based renderer

Create a rule, 136

Save layer, 103
Save properties, 44
Save style, 44
Scale, 43
Scale bar, 62
Scale calculate, 33
Scalebar

Map scalebar, 260
Secured OGC Authentication, 290
Select, see Selection tools

Deselect, 52
Selection

Attributes, 193
Selection tools

Invert selection, 52
Select all, 52
Select by expression, 52
Select by form, 52
Select by freehand, 52
Select by polygon, 52
Select by radius, 52
Select by rectangle, 52
Select by value, 53

Settings
Project, 75

SFS, 283
Shapefile, 101, 110
Shared polygon boundaries, see Topology, 204
Shortest path, 447
shp2pgsql, 113
Simbologie, 131

2.5D renderer, 139
Categorized renderer, 132
Graduated renderer, 133
Heatmap renderer, 139
Inverted polygon renderer, 139
No symbols renderer, 132
Point displacement renderer, 137
Rule-based renderer, 136
Single symbol renderer, 131

Single Band Raster, 224
Size assistant, 136
SLD, 44, 292
SLD/SE, 292
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Snapping, 203, 429
Snapping on intersections, 205
Sort columns, 191
Sort features, 140
Spatial bookmarks, see Bookmarks
Spatial index

GiST index, 114
SpatiaLite, 87, 101
Spatialite, 94, 116
Spatialite manager, 116
SQLite, 94, 116
SRS (Spatial Reference System), 287
Start QGIS, 14
Statistic, 39
Stop QGIS, 14
Style, 38, 131
Style Manager, 119
Symbology, 224
Symbols levels, 141

Tab
Actions, 168

Three Band Color Raster, 224
Tiger Format, 91
TIN (Triangulated Irregular Network), 436
Toleranţa de acros, are, 203
Tools

Georeferencer tools, 430
Measure, 50

Topology, 425, 429, 449
Transparency, 229

Ubuntu, 293
UK National Transfer Format, 91
Undo, 41
Unelte de geometrie, 363
US Census Bureau, 91

Variables, 63, 73, 176
Vector, 87, 360
Vertex, 207
Vertex editor, 208
Vertices, 207
Virtual Fields, 196
Virtual layers, 107
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